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1 Introduction

Welcome to the MotiveWave™ User’s Guide! If you are reading this document then you have already
installed MotiveWave™ on your computer and you are ready to start using the application.

If you have not yet installed MotiveWave™ or registered for a trial on our website, please read the
Installation Guide before continuing on with this document.

1.1 MotiveWave™ Editions and Modules

If you are currently working with the trial version of MotiveWave™ (available from our website), then
you most likely have the Ultimate Edition of MotiveWave™. This edition includes all of our features and
functionality (Note: excludes partner modules and studies). If you are currently on a trial and you would
like to try a specific edition/module, please contact sales@motivewave.com.

1.1.1 Editions

There are several editions of MotiveWave™ available to address the different needs and budgets of
traders and market analysts. Detailed information on these editions and the functionality that they
provide can be found on our website: http://www.motivewave.com/purchase/compare-editions.htm

1. Ultimate Edition — This edition includes all of our features and is recommended if you are a
professional trader and you are using advanced features such as Elliott Wave, Gann or Gartley.

2. Professional Edition — This is for professional traders that do not used advanced features such as
Elliott Wave, Gann or Gartley

3. Strategy Edition — Expands on the Trade Edition to provide support for strategy back testing and
optimization.

4. Trade Edition — Expands on the Charts Edition to provide trading capabilities

5. Charts Plus Edition — Expands on the Charts Edition and adds popular features such as Replay
Mode, Chart Templates, Multi-Time Frame studies and more.

6. Charts Edition — This entry level edition contains a full set of studies and basic tools for doing
analysis.

1.1.2 Modules

Modules can be added to editions to extend their capabilities. For a full list of available modules and
their capabilities see: http://www.motivewave.com/purchase/modules.htm

1.2 Starting MotiveWave ™

If you are on Mac OSX™, MotiveWave ™ will be found from your Launch Pad or in your Applications
folder. Just click on the MotiveWave™ icon to start the application. If you installed MotiveWave™ on a
Windows™ machine double click on the MotiveWave™ icon on your desktop. Alternatively, choose Start
-> All Programs -> MotiveWave -> MotiveWave.exe

The first screen that you will see when you start MotiveWave is the startup screen. Normally you will
open a workspace from this screen. Select the workspace from the drop down and press the Continue
button.
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MotiveWave™ Startup Screen

Select a workspace from
-Please Select a Workspace- the drop down and press

Continue to open it

x Exit , Options

This drop down
contains more options

Embedded Java Virtual

Machine Version/Mode
Choosing Workspace Java: 1.8.0_121 (64-bit)
{c) Copyright 2010-2017 MotiveVWave Software all rights reserved Version: 5.0.0

MotiveWave Version —J

Depending on the broker or data service that you have chosen for the workspace, you may see a dialog
that asks for login information. The example below is a login dialog for a CQG workspace. In this case
enter your User ID and password for your CQG account.

Please Note: there is no user name or password for MotiveWave™, just a license key. If you are being
asked for a login ID and password, then this would be for the broker or data service that you chose for
the workspace.

CQG Login Dialog

CQG Login x

A password is required to access your account. Please enter your
password in the field below and press the Connect button.

r
Username

r
Password

Connection | Demo ~
v'| Remember Password

Need Login ID? Click Here

Work Offline Quit

Connecting to Service: CQG Java: 1.8.0_121 (64-bit)
(c) Copyright 2010-2017 MotiveWave Software all rights reserved Version: 5.0.0
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1.3 License

When you create a trial for MotiveWave™ from our website, you will be sent an email that contains a
license key. This key will need to be entered as part of the installation process (see the Install Guide).
This license key uniquely identifies your profile and will not change (even when you purchase).

If you think this key has been compromised, you can send a request to our support team
(support@motivewave.com) to request a new key. This key will be sent to the email address that you

registered with.

1.3.1 Changing your License Key
Your license key can be changed from the startup screen in MotiveWave™. From the Options menu
button select the Licence option.

Update License

-

Continue

® Exit | Options ~

Workspaces
Select License from the Ligence
Options drop down Appearance
Auto Update
Log Files
About

oosing Workspace Jay: Purchase Updates

(c) Copyright 2010-2017 MotiveWave Software all rights reserved Version: 5.0.0

Enter your new licence key into the Licence Key field. Press the Update button to validate this key and
change the licence key that MotiveWave™ will use going forward. Note: to avoid mistyping the licence
key, it is recommended that you copy and paste the key from the email message instead.

Update License Dialog
El Update Licence x

If your licence key was recently compromised or updated you may have received a new
key in your email inbox. Type (or copy and paste) this key into the input field below.
(Hint: it will look like: XXOC-XOOCOC-XOOOCEO-XKXX) Click Update to continue.

Warning: Do not share this key, it is specific to your account and it will violate your
licence agreement if shared with a third party. If you suspect your licence key may be

compromised contact customer support ( support@motivewave. Enter your new

Licence Key ( -~

license key here

T

Update Cancel
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1.3.2 Licence Status

You can easily check which MotiveWave™ Edition and Modules that are assigned to your license by
choosing Help -> About from the top menu bar of the Console. The About dialog will display your
license key, email address, edition, modules and lease/support expiry dates.

Check License Information

&~ MotiveWave - Console (fx2)

File Edit WView Study Strategy Format Configure Window | Help
QII B e~ @ |3 2| w~ & @~ W Users Guide [ 1 day -
Components i SPX500 1D X ||_SPx50015m il USOIl 1D ;:Erials

v General SPXﬁDD 1 day How To

Pﬁoi_abel Pn'o:ilbel ‘ + i']'"‘ L09K|:||es ’T -Tﬁ.

Pu rchase Updates

Support  Resistance : ' i é :
o o ww
i T L P
About Dialog
(Y About MotiveWave x
/ Motive

Analyze, Trade. Evolve

Licence Key
Licensed To
Licence Type OWN
Support Expires 02/04/2017
Edition Ultimate Edition
Version 5.0.0
Java Version 1.8.0_121 (64-bit)
(c) Copyright 2010-2017 MotiveWave Software all rights reserved
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2 Console

After you have installed MotiveWave™ and configured your workspace the first window that you will see
when opening that workspace will be the Console. The console provides access to all the features in
MotiveWave™ and it is initially configured with a default layout.

Default Console Layout

~ MotiveWave - Console (tradier) 2o- X
File Edit View Siudy Strategy Format Configure  Window  Help
AAPL -~ O |H B sv@E W e v + "[I] &2~ 15min - 400 [ S mO S o
Compeonents X |AAPL 15m X | MSFT 15m + /\ LI
¥ General AAPL - 15 min Tool B £110.49 Trade x
. ool Bar .
= -= ' ++'L.*I l *D I I:E :I Order  Bid/Ask
i i T ]
Price Label Prics Label " D [ pf D. md]ﬁ'?T il TTJIE 110.00 Buy Mkt | sell Mkt |
Tﬁ] d i [ wal=
= = 1094
Support  Resistance
T3 Zone Trade Panel
o k3 09.00 simulated -
Time Label Time Label L LI
3108 50 | Entry/Exit »
Horizontal Extended 3108.00
Line Horizontal
Line MotiveWave ‘ ) , . Birds Eye View | L : 1 1
| 12:00 14:00 16:00 18:00 Nov4 11:00 13:00 1500 7-00
Vertical ~ Extended x
Line Vertical 110 00
Line Oct-18 Oct-20 Oct-23 Oct-26 Oct-28 Nov-2016 Nov-03 Nov-0
» Basic Components 1imin 5min 10min 15min  20min 30min 45min 1hour 2hour 6hour 1day 1week >3 s v @ |=l~ &
» Commentary NYSE (36) X | NASDAQ (21)  Aleis  + i QA @ Mindices@) x |+ [Pl QS D"
» Markers Symbol Bid Ask  Dividen.. Spread LastTime Open Close Low High  Volume Change + K& 15:4302 X
» Eibonacci AEO 16.41 1642 3.00% 001 155803 1619 16.55 s2v (R0
» Gann AXP 66.97 6698  196% 001 155802 66.65 67.33 33M
» Elliott Wave BTU P 0.00 0.00 0.00 0.00 0.00 || j7s0a6s LI 024263
= ages = g o le——————
> Garlley : SN 7 N& I AAOL N N4 AR-RR-N7T 24 an 2n an 24 2an Ly 15:43:03 xl
Status Bar
il Home X Ll Charts 8 Account @ Options  [&! Scan  {}f Optimize  +

Nov-07 15:58:03

The console is organized into different pages (see screen shot above, please note: pages are only
available in the Professional and Ultimate editions of MotiveWave™). To access a different page, simply
click on the page tab at the bottom of the console window. The default set of pages are as follows:

1. Home — The home page contains a sample layout that has a single chart area and two spots at
the bottom for watch lists.

2. Charts — Sample layout of 6 charts

3. Account — Layout containing information about your account, orders, positions and historical
trades.

4. Options — Sample layout containing Option Chains. Note: this page is only available on brokers
that support options trading.

5. Scan — Layout for using the scanning functionality within MotiveWave™

6. Optimize — Contains a strategy optimizer panel for Back Testing, Optimization and Walk Forward
testing of automated strategies.

7. News — If supported by your Broker/Data service, you may see a page for news

The following screen shots illustrate the default set of pages in the console:
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MotiveWave

Evoly

Charts Page
~ MotiveWave - Console (tradier) 2 - X
File Edit View Study Strategy Format Configure Window  Help
1BM MY BN Al I B wvQ i~ + T[T 2-[15mn__ ~ | LG mDON
Components X [1BM15m x |+ & *|[AXP 15m "1 + @ *|[F15m x] + [EI
Gi | i i i 11.62
e e v o P ? |
S S My A i T
i
Price Label Price Label H "Hﬁ? I*!ﬂ h iIHTUﬁ
ot l
-y HU - D{,um‘il I 1150
L - IDT '
Support  Resistance
Zone Zone
U“HWHWLI e
T & f ) '
Time Label Time Label SN —— i _ wh 76771
Nov-07 11:00 13:00 15:00 12:00 14:00 Nov-07 11:00 13:‘00 15:00 | 16:00  Nov-07 gihﬂ 1100 13:00 15:00
— = S5min  10min _15min_ *52 = g @ |+~ || 5min 10min 15 min | >4z |5min 10min 15 min 32 s oy @ ¢+ B
Horizontal Extended  [GE 15m x | + HPQ 15m x | + GOOGL 15m x | + B
Line Fbrlijr?:la\ GE . 15 min D HPQ - 15 min l GOOQGL - 15 min
Volume Wolume *W l Volume
[ " i
I !
Vertical  Extended &u*ljﬂ'mlﬁﬂ! i
Line Vertical #ﬁ "h-lﬂ
Line - +D_‘l
» Basic Components - b "
» Commentary i
» Markers T[J‘*lﬂlﬂ
» Fibonacci I I H
» Gann o —
» Elliott Wave 16:00 MNov-07 900 11:00 13:00 1500 [ 1200 Nov-07 11:00 1300 1500 [ 1z00 Nov-07 1100 13:00 15:00
» Gartley S5min  10min _15min_ *32 = By @ Hr B |5min 10 min 15 min =32 v @ |=|> A |5min 10 min 15 min =32 S ey @ |« B
il Home  lbl Charis X 8 Account @ Options [t Scan  {lf Optimize  +

Accounts Page

O

> MotiveWave - Console (tradier) B o B
File View Configure Window Help
NYSE (36) x | + 3 =] = ,.”|[Accounts (4) x | + =
00:00:00 X Default Account Curre.. Type cash ur PL SessionPL  TotalPL  Status AccountVa.. *
N Simulated usD 100,000.00 99,922.00
N  6YA05708  USD cash 39377 32562 active 53,070.77
N 6YA05991 USD  margin 100,000.00 active 100,000.00
N  6YAODD05  USD margin 535557 active 535557
Orders(5)x]+ + w7
Account  Ticket Symbol Order.. Expires Action Qua.. Type Price Stopl.. Sto.. Limit Limi.. Fill.. Filled Status Gr. *
BYADS708 207729 AA 1354841 GTC 1 MKT c
6YA0S708 202727  SSRI161110:40:47 GTC 1 MKT C
6YAD5991 202703  AA 1102921 GTC 1 MKT c
180 181°1 181% 6YA0S708 202724  SSRI  110:40:01 GTC 1 MKT C
ol DY ot TR Buy 6YAD5991 191485  AAP 1124343 GTC 1 MKT c
RS0.00 | 000 | RE:000 |RS:0.00 | 0.00 | RE:0.00
mees  (ON 18068 | | 179.00 [ 00z ] 18150 |
Positions x}Trades (14) + + 2.7
Open Positions (3) | Closed Positions
Account Ticket symbol Quantity  Entry Price  Stop/Trail  Stop PIL Limit LimitP/L  Unrizd PEL  Market Value = LastPrice  Close 4 *
6YAOSTOS 58328 Qaa 25 88.80 0 0 2,910.00 116.35 [Nl
BYAO5708 58329 SPY 225 19831 0 0 3336 75 47,956.50 21315
6YAOST08 62804 TWTR 100 19.89 0 0 1,839.00 18.4
387675
sl Home  Lul Charts .8 Account X < Options i} optimize  +
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Options Page
~ MotiveWave - Console (tradier) R o B
File View Configure Window Help
AAPL Nov-25 16 X | + -
Underlying Q, Search || Nov-25 16 -
Symbol Position Bid Size Bid Ask Ask Size Last Price
AAPL 2 110.37 11041 40 110.41
Position  PIL Orders Bid Size  Bid Ask  Ask Size LastPrice Strike Price LastPrice Bid Size  Bid Ask  Ask Size Orders PIL Position
Buy b2 133 138 1y 139 11200 281 1y Z25b PR 2
904 1.79 1.85 i 1.87 111.00 2.54 268 234 24
10 236 24 55 238 110.00 1.91 421 1.89 1.96 101
6 297 3.05 100 2.99 109.00 1.51 238 1.52 1.58 l
197 365 375 149 341 108.00 1.36 13 1.22 1.27 13
220 4.40 4.50 99 4.40 107.00 1.02 18 088 1.03 18
simulated - DAY - Flatten | Cancel All
GOOG Nov-2516 X | + . O
Underlying GOOG Q Search | Nov-2516 -
Symbol Position Bid Size Bid Ask Ask Size Last Price
GOOG 3 782.53 783.75 2 782.52
Position PIL Orders Bid Size Bid Ask Ask Size LastPrice Strike Price Last Price Bid Size Bid Ask Ask Size Orders PIL Position
6 9.60 10.70 21 9.50 7390.00 21.81 & 16.00 17.90 14
6 10.50 11.90 11 12.20 787.50 21.48 11 14.70 16.60 14
8 1210 13.30 17 11.06 785.00 24.50 10 13.60 15.40 1
6 13.40 14.60 8 12.48 78250 14.80 8 12.50 14.20 8
8 14.80 16.20 18 13.55 780.00 12.20 6 11.80 13.10 15
6 16.10 17.70 7 10.06 77750 12.11 1 10.60 12.10 11
simulated  ~ DAY  ~
Ll Home | Charts .8 Account @ Options X [& Scan  {lf Optimize  +

Scan Page
~ MotiveWave - Console (tradier) B - X
File Edit View Siudy Stralegy Formal Configure  Window  Help
CsX rQh B R s G I 2w~ 0~ + T[T~ [1day i | 2 WG ESmD SR
EW Wave 2 x | + =l & IS «”||Harmonic x | + =l & IS &
¥ || Pause | I Loading: WYNN (46 of 57) ¥ || Pause | I Loading: WYNN (46 of 57)
Symbol Bar Size Scan Time & Pattern Score . Symbol Bar Size Scan Time & Pattern Score .
AXP 1 day 16-01-45 Wave 2 Fair @|[csx 1 day 16:02-16 Alternate Bat Good e
csx 1 day 16:02:16 Wave 2 Good et TGEy EDZBIC Socd
FoxX 1 cay 16:02-17 Wave 2 Fair CsX 1 day 16:02:16 Shark Excellent
FCX 1 day 16:02-17 Wave 2 Fair 12 DM (PR ST iy
Gs 1 day 16:02:18 Wave 2 Fair DE 1 day 16:02:16 Ga Very Good
HAL 15 min 1602 18 Wave 2 Vers Gond DE 1day 16:02:16 Crab Good
AEO 1D X | + = "
CSX - 1day ) i
el I
=27 3075 | H40.00
T |
- |
|
||um ||||||‘ ” :
n|\“ | ‘\‘ “I"I‘HH ||I|\””‘ - | 73500
(P - | ™y e |
f il 1y ; |
IIM\N"I ! ‘| h ‘l \Umlull ‘ !
T, I i I i M i |
b ‘ I h R i 130.00
" | by e ! .
! || |||“”‘"l"'||‘“‘\-u'u"“‘”‘"'-"HM !
I |
1 i e I
i || I“””\ |||I|\whIIII I II| | H‘I |
| L I | J25.00
1 -~ I
1 I
| |
: |
| |
I |
MotiveWave | | 720.00
I | |
Sep-2014 Nov-2014 Jan-2015 Mar-2015 May-2015 Jul-2015 Sep-2015 Nov-2015 Jan-2016 Mar-2016 May-2016 Jul-2016 Sep-2016 Nov-2016 Jan-2017
1min 5min 10min 15min  20min  30min 45min 1hour 2hour 6hour 1day 1week 2week 1monih 3 month = oy @ |4~ B
lml Home |l Charts 8 Account @ Options |8 Scan % {lf Optimize + iy
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Optimize Page
~ MotiveWave - Console (tradier) £ L
Fie View Configure Window Help

MA Cross | + h = =

Symbol Parameters Start End Net Profit Gross Profit Gross Loss E i C issi Max D +
IBM C.EMA,20,C,EMA, 15 (Fast Input,F Aug/06/16 Novi06/16

$0.00 $493.0

Fast Input,Fz Au 0
IBM C.EMA 15 C EMA, 15 (Fast Input F Aug/06/16 Nowv/06/16 $0.00 $0.00 $0.00 0 $0.00 $0.01
IBM C.EMA.20,C,EMA 20 (Fast Input,F Aug/06/16 Novi06/16 $0.00 $0.00 $0.00 0 $0.00 $0.0:
IBM C.EMA 20,C,EMA 30 (Fast Input F Aug/06/16 Now/06/16 ( $1,706.00 (% ) 56 $0.00 $497.0
IBM C.EMA,10,C,EMA_15 (Fast Input,F Aug/06/16 Nov/i06/16 ( 107 $0.00 $797.0
1BM C.EMA 5,C.EMA,20 (Fast Input, Fz Aug/06/16 Novi06/16 125 $0.00 $822.0
1o Caanac oo Cmnt femt oA ainr Ao - en o eznn
S0l Chart Reports Periods Trades(153) Executions (154)
Strategy MA Cross Strategy ~ Start Date Aug/06/16
Type Optimize End Date Nov/06/16
Symbol IBM Parameters C.EMA,5,C EMA,15 (Fast Input,Fast Method,Fast Period,Slow Input, Slow Method, Slow Period)
Bar Size 5 min
Metric All Trades Long Trades Short Trades +
Total Net Profit (Inc Commissions) $119.00 ($218.00) $£337.00
Total Profit (Gross - Loss) $119.00 ($218.00) $337.00
Gross Profit $3,118.00 $1,282.00 $1,836.00
Gross Loss ($2,999.00) ($1,500.00) ($1,499.00)
Commission $0.00 $0.00 $0.00
Profit Factor 1.040 0.855 1.225
Max. Drawdown $876.00 $665.00 $379.00
Max Drawdown (%) 0.88% 0.67% 0.38%
Total # Trades 153 76 7
Percent Profitable 33.99% 30.26% 37.66%
# Winning Trades 52 23 29

H 1 nrina Teadan oo £a

il Home  lbl Charis 8 Account @ Options [t Scan  {lf Optimize x +

News Page
~ MotiveWave - Console (google) P
File View Configure Window Help
News | +
Time Frame: Al « | Symbol: GOOG Search Text Filter
Symbols Released v Sourca Headline .
GUUGL 2016-11-U6 1 1ecn 1imes Alp Inc's Gaprais n

2016-11 Profit Confidential G Sto ¢ Report is Great News for Alphabet Inc
GOOGL 2016-11-04 Profit Confidential Alphabet Inc: This GOOG Stock Trend Line is all that Matters L]
GOOGL 2016-11-03 08:11 EDT Investorplace.com Why You Shouldn't Buy Alphabet Inc (GOOGL) Stock Now
<Back | Forward > | hitp://www.profitconfidential.com/stock/google-stock-new-report-great-news-alphabet-inc/ Go
PROF IT HOME EDITORS ¥ COMPANYwv TOPICSY HOTSTOCKSwv

CONFIDENTIAL

By Stephen Karmazyn

susished noververs 20 GOO0G Stock: New Report Is Great News for
ABOUT THE AUTHOR Alphabet Inc

0
oa@ano

Tradespo
TRADE SMARTER
Know which stocks to BUY or SELL

in 10 minutes per day!
'

Why Google Stock Is Loving the .l

Smartphone Market Instantly Predict Daily Lows & Highs >

< Stephen Karmazyn for ANY Stock or ETF with High Success

Read Full Bio Alphabet Ine (NASDAQ:GO0G) and Google stock

may be ready to make a huge splash in the phone

Would a Trump U.S.
Presidential Election Win Sink
Dow Jones and S&P 500

market as a new report shows “Android” phone sales Editors' Picks
dominating globally.

88% of the 375 million new smartphones shipped
Elon Musk Delivers Blunt

worldwide were running the Android operating
Assessment of Donald Trump

system, according to a new report from Strategy Analytics. With Apple Inc.’s George Leong, B.Comm.
Facebook Inc: Analyst Jssues (NASDAQ:AAPL)"i0S” platform and Android accounting for 87.3% of the worldwide smartphone

Dire Warning on FB Stock market share, Google continually looks to place its new smartphone offering, “Pixel,” in opposition
to Apple’s “iPhone.”

Take-Two Interactive Software, Inc.:
TTWO Stock Looking Great

lwl Home  Lul Charts 8 Account  [&t Scan (i Optimize News X =+
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2.1 Preferences

The Preferences Dialog (choose Configure -> Preferences from the Console menu bar) provides a
centralized location for configuring MotiveWave™. This dialog contains many configuration panels

organized under tabs (and sub tabs).

Preferences
(% MotiveWave - Console (google)
File Edit View Study Strategy Format | Configure | Window  Help
MSFT > Q| H B 6 # & Workspaces T &2~ |15 min -
Components X [AAPL15m |MSFT 15m x E8d Instruments ¢
B Active Tickers
v General : i \ =
bl 15 min_ € Repository
E= Choose Configure -> & Preff\\;gnces
I3 SaveConfiguration

Preferences from the top
menu bar.

Price Label Price

fi
uhy
Support  Resistance
Zone Zone

&

I%I

Crder Presets
Commissions

(' Clear All Local Data

[£] update License
&% Choose Language
il Layout

'I\H'I

Preferences Dialog

Lo

Preferences

mmeme cnarf| Top Level Tabs !Qatios Eliott Wave Gartley Tick Charls OFA® Orders Alerts (v

Keyboard Mouse Fonts Quick Search Ticker Tape Linking Dock Trading Hours Simulated Accot (=

24 Hour Clock: |V
Confirm Exit: v/
Use Native Windows:
News In Browser:
Link Stacked Charts: v/
Show Bar Size in Tabs: V'
Show Watch List Count: v/
Auto Save Enabled:

Auto Save Interval: {Seconds)

Google Poll Interval: (Seconds)
Tick History Limit: 2000

Filter Bad Historical Ticks: V'

This panel contains general preferences tonﬁgure for MotiveWave.

Apply || Cancel

Feel free to explore the configuration options within MotiveWave™ by looking at the tabs and sub tabs
available in this dialog. More detail on specific configuration options can be found in other parts of this

document.
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2.2 Workspaces

Connections to Brokers and Data Services are managed through workspaces. Each workspace is a
separate instance of MotiveWave™ and contains its own local database. All data, settings and analyses
are separate between each workspace (with the exception of themes and historical data).

Workspaces can be managed from the Console or from the startup screen (click on the Options drop
down and select Workspaces).

Manage Workspaces from Startup Screen

MotiveWave®

-Please Select a Workspace-

& Options ~

Workspaces
Licenu::ek
Appearance
Auto Update
Log Files
About
Choosing Workspace Jay: Purchase Updates
(c) Copyright 2010-2017 MotiveWave Sofiware all rights reserved Version: 5.0.0

Manage Workspaces from the Console menu bar

MotiveWave - Console (google)

N i

Strategy Format | Configure | Window  Help

L B G 4 & Wgrkspaces
L 15m MSFT 15m K Ingfruments Choose Configure ->
T - 15 min o) Active Tickers 0 Workspaces
) g Repository i~ .
. £} Preferences e H'!I g‘,n‘,-‘?*i
i Save Configuration m q]lE]
m Order Presets J
Commissions
(* Clear All Local Data
[E] Update License
&) Choose Language
il Layout

FRNPRAT WY LT S Y

———

g et S

The Manage Workspaces dialog enables you to create new workspaces or to edit/modify existing
workspaces. The order in which they appear in the startup workspace drop down can also be modified
from this dialog. Click on the New Workspace button to create a new workspace.
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Manage Workspaces Dialog

= Manage Workspaces

Workspaces are used to manage connection(s) to brokers and/or data services and to store
information such as analyses, scans, open charts, layouts, instruments or watch lists. The table

below contains existing workspaces.

Name Service

test GoogleYahoo
rithmic Rithmic
iq These are existing
tk workspaces
iqtest2
igtesti IQFeed
esignal eSignal
GAIN GAIN
amp_test AMP Global Clearing
cac? Click here to create cac

a new workspace
goog GooglelYahoo

—
v
New Workspace Close

2.2.1 Professional/Ultimate Editions

Starting with version 4.0 the Professional and Ultimate editions allow multiple broker and/or data
service connections within a single workspace.

Create Workspace Dialog

+ Create Workspace

General Information

The workspace name uniquely identifies a workspace. All information related to the workspace
(configuration, market data, analysis files etc) are stored in a local database.

Workspace Name

Connections

Choose a unigue name I

| Eg: jsmith123" or 'simulated acct’

for the workspace

The table below services that are configured for this workspace.
Click Add Connection {0 add a new connection or select an existing connection and click
Modify to change its properties.

Add Connection
A

Service
Click here to add a

connection to the
workspace.

Click "Add Connection”

Cancel
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From the connection dialog (see below) you can choose the broker or data service that you want to add
to the workspace. Connection information will depend on the broker/data service that you choose.

Add Connection Dialog

&~ Add Connection X

A Connection represents a connection to a specific broker or data service and enapsulates the required
connection information

General Information

The name uniquely identifies the name of the Connection within the workspace. Typically the name is the same
as the name of the Service.

r
Connection:

Connection Information

The name uniquely identifies the name of the Connection within the workspace. Typically the name is the same
as the name of the Service

Service: | -Select Service- A e from the drop down list

Select broker or
data service from
drop down

-Select Service-
Google/Yahoo
OANDA

AMP Global Clearing - Rithmic
AMP Global Clearing

BarChart

IQFeed

QuoteMedia

esignal

TradesStation

ion' button to test if the
b correct and that
Motive\Wave can connect successfully.

Cancel

The following dialog shows an example of a workspace with three connections (TradeStation, OANDA

and TD Ameritrade).
+ Create Workspace X
General Information
The workspace name uniquely identifies a workspace. All information related to the workspace
(configuration, market data, analysis files etc) are stored in a local database.
r
Workspace Name My Workspace Eg: 'jsmith123" or 'simulated acct'
Connections
The table below contains all of the brokers/data services that are configured for this workspace.
Click Add Connection to add a new connection or select an existing connection and click
Modify to change its properties.
Add Connection
Name Service
TS TradeStation
OANDA OANDA
TDA TD Ameritrade
Create Workspace || Cancel
Version 5.0 ©2017 MotiveWave™ Software Page 17 of 213
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2.2.2 Single Broker Editions

For the other editions of MotiveWave (Charts, Charts Plu
to a broker or data service is allowed within a workspace

ive

LT T T

/ MotiveW:

s, Trade and Strategy) only a single connection
. The following diagram illustrates the create

workspace dialog for these editions. Simply choose a name for the workspace and choose the

connection type from the service drop down.

Create Workspace Single Broker Editions

General Information

+ Create Workspace X

market data, analysis files etc) are stored in a local database.

The workspace name uniguely identifies a workspace. All information related to the workspace (configuration,

r
Workspace Name <Enter Workspace Eq: jsmith123" or 'simulated acct’
Enter workspace name

Connection Information

as the name of the Service.

Service: | -Select Service-

-Select Service-
Google/Yahoo
OANMDA

The name uniquely identifies the name of the Connection within the workspace. Typically the name is the same

Choose your broker/data service from the drop down list
to see specific help.

Select Broker/Data Service |itton to test if the
from the drop down and that

AMP Global Clearing - Rithmic
AMP Global Clearing
BarChart

|QFeed

QuoteMedia

eSignal

TradeStation

Cancel

2.3 Changing the Default Layout

The console layout is highly configurable. All pages can have their layouts modified and pages can be
added or removed. The following screen shot illustrates the page area and some of the available

options:
Page Area
i3 It TEER e e TR fiar2016 [Mar20  |Apr207 Sep-20 Get2016 —Oct16 = g T

1min 5min 10min  15min 20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month >4 = v @ |olv B
NYSE (35) X | NASDAQ (21)  Alers  + e Q8 = 7| Indices (10) x | + i e’

Symbol Exchange LastPr.. LastTime Change % Chan.. Open Close High Low EPS PIER* 10:26:00 X — X

050452 | 45045

AEO NYSE 85.20 10:44.00 014 1767 1772 792 4751 1260 1

AXP NYSE 70.05 10:44:00

BTU NYSE 47.58

69.97 7011 70.34
2.07 207 0.00
31.69 4.21 34.53 34.47
90.21 0.47 90.70 90.98
51.95 4.12 13.80 14.26

\_' Scan (i} Optimize News  +

Left click on a page
tab to activate it and
show its contents

| Shadedtabis
the active page

Click here to add a
new page.

Ll Home X Ll Charts

Click the 'X' to
remove a page

69.75 5.630 1

0.00 -112.960 1
34.06 1.800 1
89.69 4.990 1
13.10 -6.763 |

Rs:0.00 | 0.00 | RE:0.00

This button will
create a copy of
the active page.

10:44:00 X

2158*" | 2 584

N =

RS:0.00 | 000 | RE:0.00

RS:0.00 | 000 | RE:0.00
7

Click this button to
choose a preset layout

wov-11 10:44:13
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2.3.1 Creating a new page

To add a page to the console, click on the New Page button (see above). The New Page dialog will
appear (see below). You will need to specify a name for your page. This name is displayed on the page
tab when it is added to the console.

There are many different layouts available for your page. Just choose the one that most closely matches
what you want to have on the page. Several categories are available in the tabs at the top of the dialog.
The icon matching the category will be displayed on the page tab that you are creating (making it easier
to identify).

New Page Dialog

i New Page X

This dialog allows you to add a %| Enter a name for the page. This Wow, choose a layout (see below) and click on "OK™.

"
Page Name: My Charts will be displayed on the page tab.

Lul Chart | 8 Account [ Scan {lf Optimize News

—/

Available layouts are
grouped into categories %

.

Several preset layouts
are available. Scroll
down to see more.

il

I il

=

Click OK to add the
page to the console.

/ [

g‘( Cancel

2.3.2 Modifying a Page

You can change the name of a page and optionally its layout. To modify the current page, click on the
Edit Page button on the right hand side of the page area.

Click here to edit the
active page.

Nov-11 11:00:05

This will open the Edit Page dialog where you can change the name of the page and optionally select a
new layout for the page.

Version 5.0 ©2017 MotiveWave™ Software Page 19 of 213



VotivelVave ™ J MotiveWave
User’s Guide B

At the bottom of the Edit Page dialog you will see a button called Reset Layout. This button can be used
to reset the console layout to the default. This will reset all of the pages including their layouts to be the
same as when you first created the workspace (see Default Console Layout screen shot).

Edit Page Dialog
T Edit Page X

Optionally change the name of the page below, choose a layout (see below) and click on "OK". %

Page Name: “-mme }

Enter a new name for the
—| page and optionally
choose a new layout.

il Chart | 8 Account [& Scan 1| Optimize 3\ News

This will reset all of the
pages and their layouts to
the default layout when the
workspace was first created.

| N/ | HIN
'

OK Reset Layout Cancel

2.3.3 Changing the Page Order

If you would like to change the order of the pages, simply click and drag the page tab to the desired
location:

Change Page Order

R e e N ] o n P -
AXP NYSE +71.02 11:04:00 - 0.: 69.97 7011 7034 6975 5630

BTU NY'SE 44749 2.07 2.07 0.00 0.00 -112.9860

csx 34 21 3453 3447 3406  1.800

DE Left click and drag the 90 47 9070 9098 8969  4.990
tab to the left or right

FCX 14.12 1380 1426 1310  -6.763

Vertical blue bar indicates where
the page will be dropped

il optimize |

[l Home x [l Charts 2 Account [ Scan

2.3.4 Resizing Panels

The size of the panels displayed in a page can be resized by clicking and dragging the area between each
panel. Notice that the mouse cursor will change when you hover over these areas. The following screen
shot illustrates changing the vertical space between the chart area and watch list area in the Home

page:
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Resize Panels
AR TR g A ertrer g Tt i, from et TR e e B TV T T e R AT et
Z)? 12:00 1400 MNov-03 12:00 1400 MNov-09 12:00 1400 MNov-10 12:00 1400 MNov-11  12:00 14:00

> 160.00

50.00

Mar-20 Apr-2016 Sep-20 Oct-2016
jday 1week 2week 1month >=4 = vy @ |-l B

Click and drag resize area I = =
— P& X 8 4 @ .7|[indices (10) x | +
D 10:55:00 X

up/down (in this case).
- ose High Low EPS PIER *
Click and drag the space
between panels to resize.

1772 1792 1751 1260

7011 7034 6975 5628 ”

2,07 2.07 0.00 0.00 -112.960 ey _r oo || om0

34.21 3453 3447 3406 1800 1 | QLS 000X LK
90.98 8969 4990 3

1426 1310, _ 6.763 sen RN cuv [l se R -

2.3.5 Adding New Panel Tabs

New panel tabs can be added to each panel area in the active page. Simply click on the New Tab button
to the right of the existing tabs. The follow screen shots show the sequence to add a new chart to the
main panel of the Home page. In this example, three charts are stacked on top of each other with the
active chart showing with the highlighted tab (in white).

Add New Panel Tab

(Y MotiveWave - Console (go
File Edit View Study Strat i Window  Help
MSET ~ 0| i e~ | Click'+ button to add a i~ + ==[T| &~ 15min -
AAETTET T MSET 15m X | +<L new tab to this panel. J }
MSFT 15min | ul Chart i
Volume i = wWi.gh List ro | fEY I H'h ﬁ.#Ti
E 'I,g _I?lepth O‘; I‘galrket Choose the type from the E
| = Ol:Tc:zrapablea es list of available options *
11 Position Table ;
| ®, Trade History Table | '
Pk : : :
l.r PR T D*Ml* q 1 Account Table | :
| News | |
'* [I |Gt Scanner | i
+ i Optimizer ; |
73 Alert Table | |

New Chart Tab Dialog

m I X
Enter Symbol )
Please select an ose the bar size.
symool: |MER " -]
Analysis: | Primary Analysis -

Bar Size: | 15 min | Click OK to create

the new panel tab

Link: | &2 =

QK Cancel
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New Tab Added

&~ New Chart Tab MotiveWave - Console (goo

File Edit View Study| added here
INTC ~ 0| & S
AAPL 15m MSFT 12m INTC 15m % | +
INTC - 15 min

Vaolume

o
-

Configure  Window  Help
K Elw-Q i~ + BT 2v(15mn ~

i
p I*ME‘J’

Other chart tabs still exist, but are "stacked' ljllﬁ
behind the active tab. Just click on the tab IJ
to activate and bring to the front. *.I}H'u

itnﬂw

YTWUQ}

—_-—

2.3.6 Creating a Custom Layout

MotiveWave™ includes a number of built-in page layouts which are available when you create or edit
the page. You can organize the panels in the page however you like by left clicking and dragging the tabs
around. Asyou drag the tab, you will see a highlighted blue area where the panel will be created when
you release the mouse button. This feature provides you the flexibility to create any layout with any
number of panels. The following screen shot illustrates moving the chart tab that we created in the
previous section (MSFT symbol) and creating a new panel area by horizontally dividing the existing panel
into two.

Custom Layout Step 1

- MotiveWave - Console (google) Ho- oA X
File Edit View Study Strategy Format Configure Window Help
MSFT oM = E e @ K Elwvre v+ T[Tl a~[15mn - (W8 W TSmO B
AAPL 15m  |MSF] 15m x | + = 7
MSFT - 15 min 0
i ™
Click and drag this tab P T i uﬁ ! '“u.{ﬁﬂ +DT 60.50
using the left mouse button f ‘D T ot Tll fI]‘l-’ n
W { l t] [F
I 6000
Wi
i L T ' |
1 * i MSFT 15m x
lUTT } ”i . ot 5050
f +1'¢T1'¢*“| 1N it
T e []* l,ﬂ¢¢7¢-.+??4.!+*
q *! Cursor changes and
m I shows the dragged tab in
Blue highlighted the background. Release
area illustrates the mouse button to
where the panel "drop" the chart here.
will be created.
g I T T e r—— -|'|l||n it e snmnag --I|U|ﬂ|nﬂﬂl panmmeaagsnnnd gl nanmong
14:00 Nov-03 1200 14:.00 Nov-04 12:00  14:00 Neov-07 1200 14:00 Nov-08 12:00  14:00 Nov-09 1200 14:00 Nov-10 1200 14:00 Nov-11  12:00 14:00 16:00 18:00
imin 5min 10min  15min 20 min 30min 45min 1hour 2hour Ghour 1day 1week 2week 1month 3 month = gy @ |0 M
N et b A 1S e ot p— P B o e R e e L SRS
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~ MotiveWave - Console (google) - A X
File Edit View Study Strategy Format Configure Window  Help
MSFT  ~|Q|h E & e @ Krelevr@ -+ F[T|@~[15mn ~ L@OXCWMD OB
AAPL 15m X | + B 7|[MSFT 15m x | + = 7
AA| 15m|n T|-15 mi 50.50
W e
ll;l +T* l H111.00
- gt
]Ij New Panel is created )
Ik here with the "MSFT"
M QTIJI] 'U e /Opticna"v use chart tab that was
n ‘Ij this divider to dragged and dropped in 45950
Q resize the panel Ij ﬂ this position.
409 0
TT[; “']T i U“MT 1088 o [J T! | 59.17)
u 59.00
i, b d
?* 'Iﬁ*?lﬂ:] I ',u 108.07) [;]+ T, I][;! ? li lﬂ* 5378
W W
0 107.00 l i
| 1065 'I 58.07)|
T — Uhﬂﬂﬂﬂhpnn " pﬂﬂlnllﬂdl Tntcaranagon Iﬂﬂlﬂln iwanfare £ 2046% mlylﬂkﬂﬂ”ﬂnw-n Lnafily I“I e R e 1753
1400 Nov-09 12:00  14:00 Nov-10 1200 14:00 Now-11 1200 1400 Nov-09 12:00 14:00 Nov-10 1200 14!!0 NOVH 12:00 1400 WEUD 1800
1min Smin 10min | 15min  20min 30min 45 min **g = @ @ |#~ || 1mn Smin 10min | 15min 20min 30 min 45 min g s vy @ ¢+ @2

2.4 Changing the Look and Feel

MotiveWave™ provides several options for changing the look and feel of the window decorations,
docking framework, table colors and chart colors. Use the Preferences dialog to change these attributes
(as well as many others). This dialog can be opened by pressing the Preferences button at bottom right
of the console window or by choosing Configure -> Preferences from the top menu bar.

Preferences Button

{ 7 & .7 '...xL o E Qe

General Preferences
Button

Nov-11 16:22:49

If you would like to modify the preferences for the docking framework, click on the General tab then on
the Dock sub tab. Several options are available from this panel (see below):
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Dock Preferences

o] Preferences

Tneme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email

b

-

General Keyboard Mouse Fonts Quick Search Ticker Tape Linking gnlil«s

Trading Hours Simulated Accol =

Click on the Dock
sub tab of the
General section

This panel contains preferences forthe d Location of the
I tab
Tab Location: | Top hd panel tabs

Page Bar Location: | Boltom ~

Location of the

Show Tab Icons Page tabs

| Confirm Remove Page

OK || Apply || Cancel

The Themes tab provides several options for changing the look and feel of the window decorations as
well as the colors for the chart, tables and buy/sell boxes. Custom Chart and Bar themes can be defined

under the corresponding tabs of this section:

Themes

£ Preferences

Genera\cnart Tool Bar Sounds Ratios Elliott\Wave Gartley Tick Charts Orders Alerts Email

X

-

Bar Themes Chart Themes < Custom bar and chart themes can

l be defined under these tabs.

Themes are used to change the look of the Ul COmmp
Theme). Use the drop down options below to configure Ihemes for MollveWave Click OK to apply your changes

Window Theme: Light ~
Chart Theme: = Light -

Bar Theme: Black/White

Buy/Sell Colors: Red/Blue - Colors to be used when
displaying P/L or Bid/Ask

OK | Apply || Cancel

(Chart Theme) and bar colors (Bar

The following screen shot shows an example of some theme changes:
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File  Edit
AAPL

=

Components
¥ General

== =
Price Label Price Label

1;.
=
Support

Zone

v QK
Lul Home X Ll Charts

Theme Sample
MotiveWave - Console (google)
Strategy ~ Format

Configure  Window Help

H ey Iy + B I 2v[15mn -

Optimize News
i op 2 RiEE ar Page Bar at the top

Twilight and Red/Blue
themes for the chart

Dark Window

Theme

Trade
Posilion Order Bid/Ask
111.00
Buy Mkt Sell Mkt

Red/Green
Buy/Sell colors

1na nn
I?I L 108.87)
Time Label Time Label 108.43

Entry/Exit
108.00 b

simulated

N/A N/A

Horizontal ~Extended
Line Horizontal
Line

i 06 55)

Vertical  Extended
Line Vertical
Line

107.00

Hane nn

Basic Components min  5min  10min | 15min 20 min 30 min 2 hour 6hour 1day

NYSE (35) X | NASDAQ (21)
Symbol

Commentary Alerts +

QE S @ ndiceso) x|+ PO E S =
PIER: + D 18:20:00 X
7% w785 [ 785
Sell | 1% Buy

w KB =
" Hooo [Looo OGN Ho00

T | | (T —
Nov-11 16:35:04

Fonts and icon sizes can be changed from the Fonts panel. Select the General Font/Icon Size option to
adjust the overall size of the icons and fonts for the windows and dialogs. This option can be particularly
useful on a high resolution screen.

Markers Exchange LastPr.. LastTime Change

Fibonacci AEO 0.57

% Change Open Close i EPS
3.22% 17.67 17.72 7 1.260 14
70.50 :00:00 0.39 56%  69.97 70.11 5.630 1z

Elliott Wave BTU 0.00 0.00 0 00 60 0
nay

0.04

Gartley

»
»
| 3
»
» Gann AXP
»
| 3
=

& eve

f o) Preferences x
Theme Chart ToolBar Sounds Ratios Eliott Wave GCartley Tick Chaits OFA® Orders Alerts ~
General Keyboard Mouse Quick Search Ticker Tape Linking Dock Trading Hours Simulated Accot =
SEE Rl Chart Fonts
The fields below allow you to adjust the general foo ation.
General Font/icon Size: | Defauit Sy Font and icon size of
Ly | windows and dialogs.
[ET i Default
Small
News Table 0 Enabled
IMedium
Quote Sheet Group Med-Large Enabled
DOM Table | Large Enabled
Time & Sales Table Extra Large) Enabled
OK | Apply Cancel

Fonts can also be adjusted for the charts on the Chart Fonts tab:
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Lo

=B meme Chant ToolBar Sounds Ratios Elliott Wave _Gartley Tick Charts OFA® Orders _Alerts

Preferences

1

General Keyboard Mouse [[gipeg Quick Search Ticker Tape _Linking Dock Trading Hours _Simulated Accol

System Fonts Eﬁlﬁﬂ

The fields below allow you to adjust the fonts displayed on charts.

Time Axis
Birds Eye View
Vertical Axis
Indicator

Ratio Label
Info Points
Comment
Chart Title
Chart Label
Study Label
Legend

TH Label

TH Info

TH Arrow

Arial:13.0
Arial:13.0
Arial:13.0
Arial:13.0
Arial;12.0
Arial;12.0
Arial;12.0
Arial Bold;13.0
Arial Bold;12.0
Arial Bold;12.0
Arial;11.0
Arial Bold;11.0
Arial;11.0

Arial Bold;11.0

Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled
Enabled

Enabled

OK || Apply

Cancel

2.5 Instruments

Stocks, FOREX pairs, futures contracts, indices etc are generically referred to as Instruments in
MotiveWave™. The available instruments will depend on the broker or data service that you chose for
the workspace. When you initially create a workspace in MotiveWave™ a default set of instruments will
be populated in the local database. Additional instruments can be added by searching for them or
defining them.

All instruments can be centrally managed from the Manage Instruments dialog available from the
Console (Configure -> Instruments from the top menu bar).

Manage Instruments

MotiveWave - Console (google)

(%

File Edit View Study Strategy Format | Configure | Window  Help
AAPL > Q| S R O # & Workspaces "¢ |2 | & ~]15 min x| A

. Inst t

Ll Home X Ll Charts 8 Account  |&! Scan i :;i%“ﬁgkirs Choose Configure ->
AAPL 15m x | MSFT 15m + 8 Repository Instruments from the
AAPL - 15 min : ; L+ Preferences top menu bar
olume ! | I= save Configuration ; ~
: i i Order Presets “ g

: i i Commissions I.I “

i i " i | ' Clear All Local Data i

: ' + .l 'I I** [E] Update License i

: ' ] !

: ““I l!! ! Ihhﬂﬁh TTJ'T ! h Q_) Choose Language !

| ﬂ A i il Layout i

m‘r

i
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The Manage Instruments dialog displays all of the instruments that are defined in the local database.
You can filter the list by typing in a symbol (or partial symbol) or choosing a specific instrument type or
exchange.

Manage Instruments Dialog

—]| Manage Instruments x

The following table contains instruments that currently exist in the local database. From this dialog you can add, remove or edit
these instruments. (Hint: use the CTRL key to select multiple rows).

Symbol: Type:  All w | Exchange: All v
Underlying 4 cription Type Expiry Date currency Exchange *
DJl Type symbol here to  |nes Indus Index usD ]
DJT filter the list nesTrans  Index USD
FTSE FTSE FTSE 100 Index UsD
HSI HSI HAMNG SENG Ind Index usb
ANX AMX S&P 500 Index Index UsD
IXIC IXIC NASDAQ Compo Index usb
N225 N225 NIKKEI 225 Index usb
NDX NDX NASDAQ 100 Ind Index usb
TWI TWI TSEC Weighted | Index usb
Australian Agricul Stock AUD ASX
Ardent Leisure Gi Stock AUD ASX
Apple Inc Stock UsD NASDAQ
Click to search for
instruments Ausenco Limited Stock Select one or more rows above
available from your Adelaide Brightor Stock and click "Delete” to remove
broker/data service Abacus Property Stock them from the local database
Total Instrume A: 459 \/

Q, Search || & Import | Define | Custom Advanced | Cancel

Additional instruments can be added to the local database by either clicking the Search, Import or Define
buttons (Note: the Define and Import buttons are not available for all brokers/data services).

The Search button will utilize the broker/data service’s search capabilities to discover new instruments
that you can add to the local database.

2.5.1 Importing Instruments

For convenience, the Import button will allow you to import a set of instruments from a CSV (comma
separated values) file. This file can be created using a spreadsheet (such as Microsoft Excel) and saving
it as a CSV file. For details on the format of the file, see:
http://www.motivewave.com/data/import_instruments.htm
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Import Instruments Dialog

g Import Instruments p

This dialog allows you to import instruments into the local database from a CSV or ASCI| file.
Click here for information on the format of the import files.

Data Files

Click here to ~
Add
add a data file J—

Click import to read the
data files and add them
to the local database

N\ J/
\%

Cancel

2.5.2 Trading Hours

Trading hours define the days and time of day that an Instrument is traded. For most instruments the
trading hours may be assigned automatically by MotiveWave™. When you create your workspace,
MotiveWave™ will create a default set of Trading Hours. You can create your own trading hours and
override the instrument settings. Trading hours can be created/modified from the Preferences dialog
(Configure -> Preferences from the Console menu bar, click on General then on Trading Hours).

Trading Hour Preferences

o Preferences X
=R treme chart ToolBar Sounds Ratios Eliott Wave Gartley Tick Charts_Orders Alerts Email (v

Select trading hours below and jﬂck Search Ticker Tape Linking Dock Trading LUUTEN Simulated Accol (=

click here to edit. Note: built-in J

hours cannot be edited. rading hours for historical data retrieved from your data provider. Click on the '+

To assign trading hours to an instrument, edit the instrument and choose the
approp trading hours from the Trading Hours drop down.

Built In

true

Click here to add o
custom Trading Hours

true

oTC true

CHX true

Xetra true

ASX true

OK || Apply Cancel

The Trading Hours dialog will appear when you click the add button (‘+" icon) above. If an exchange is
chosen, then the hours defined in this dialog will be used as the default trading hours for instruments on

that exchange.
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Trading Hours Dialog

+

This panel allows you to define trading hours that may be applied to a single instrument or an exchange. Most trading hours
will be defined as a time frame (session) Monday - Friday as regular trading hours. Some instruments such as CME futures
may have two trading sessions within a day (see Start2, End2 below). Optionally, extended hours may be defined for
instruments that have trading hours outside of the regular session. Specifying an exchange below will set these hours as the
default for instruments within that exchange.

Trading Hours x

Name: [ Custom Hours 1|

Note: name must be unique

Time Zone:

Exchange: | -Select Exchange-

Regular Hours;

Sunday: -
Monda) For some exchanges,
Tuesda| (such as Saudi
Arabian) trading
Wednesdal .y te on Saturday
Thursda =
Friday: Start) 09 || 30 +
Saturday: Start - -

Extended Hours:

Click this box to define

hours outside of the

regular trading period -
ursday. Sian - -
Friday: Start - -
Saturday: Start - -

America/New_York

Week Begins On Saturd

> + Default Trading Hours for Selected Exchange

This will make the Trading
Hours the default for a

End + | specific exchange. + End 2 - - Enabled
nd| 16v| 30~ Start 2 - ~ End2 v + | [V Enabled
nd| 16w | 30~ Start 2 - ~ End2 - ~ | |v/| Enabled
nd| 16w | 30~ Start 2 - ~ End2 - ~ | |V/| Enabled
nd| 16~ | 30~ Start 2 - ~ End2 - ~ | |v/| Enabled

End| 16~ 30~ Start 2 - ~ End2 - - | |v| Enabled

End v A Start 2 - ~ End2 - - Enabled

End M v - ~ |[End 2 - -

End v v - ~ |[End 2 - -

End v v - ~ |[End 2 - -

End v v v ¥ |[End 2 - -

End - - Start 2 - + End 2 - -

End v - Start 2 - * End 2 - -

End v - Start 2 - + End 2 - -

OK Cancel

The Trading Hours for an instrument can be assigned from the Advanced tab of the Instrument dialog.

This dialog can be accessed from the

Manage Instruments dialog (Configure -> Instruments from the

Console menu bar) or from the context menu of a chart (right click on a chart and choose Edit

Instrument).
Edit Instrument
(> MotiveWave - Console (go
File Edit View Study Strategy Format Configure  Window  Help
AAPL ~QE SR s Kelerq i~ + BI|@v[15mn ~
Ll Home X Ll Charts S8 Account [ Scan {4} Optimize News  +
AAPL 15m X |MSFT 15m  + >
AAPL - 15 min “
Wolume i 1 iT I+I i+i 1
| L T “&
; £} Chart Settings I "
Edit Instrument
“ Right click on the Bar Size » *
' *lfu “! chart and choose 1 Wolume Interval »l T Il
ﬂ’ 'Edit Instrument’ Range Interval 8 i!
‘* Renko Interval v
l Template b
* Link 4
Add Study ’
Tools »
Trade b
I TP L W IR I T I SR NI S S S B i
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Edit Instrument — Trading Hours

General

Edit Instrument - AAPL

Modify the fields below and press OK to save ya Click on the

Commissions ERGUENE:D]

Trading Hours:
Minimum Tick:
Point Size:

Display Mask:

l Custom Hours 1 - l +

-Select Trading Hours-
ASX

CHX

Nasdaq g

Hours
from th

Select the Trading

hat you defined
e drop down

NYSE
oTC
TSX

| Xetra

OK Order Presets Delete

Cancel

2.6 Watch Lists

Watch Lists provide a convenient way to organize a related set of instruments together in one location.
MotiveWave™ will create a default set of Watch Lists when you first create your workspace.

There are two ways to view a Watch List:

1. Table View — In this tabular view, each row displays an instrument. The table view will have a
default set of columns, but these can be configured by the user to show or hide any of the
available instrument values. Optionally, you can sort this table view by any of the columns in
ascending or descending order.

Buy/Sell View — This view shows a Buy/Sell box for each instrument. The current Best Bid and

Best Ask values are shown along with the last price, last time, daily high/low and spread. Market
orders can be placed directly by clicking on the Buy or Sell areas.

The following screen shot shows the default set of watch lists displayed on the Home page.

.“."."dﬁ".;“‘"."ﬂ.‘ﬁlrhllll T |

Wkrmq\anwmﬂﬂ"mhfﬂmﬁw
h

Default Watch Lists
I WP o

MR  m i,
H

Jillllnﬂu aaliind émlllhm,.... "“'1I||||..

e,

Use this button to
switch between table

1200 Nov07 1200 1400 Nov08

1200 14:00 Nov09

12:00 14:00 MNov-10 12:00 14:00 Nov-11  12:00

:'I!‘ H’M“ET Entry/Exit

12:00

1min 5 min

10min (15min  20min 30min 45min 1hour 2hour Ghour 1day 1week 2week 1month 3month

and Buy/Sell views.
i~ @ ||~ £

Aaon

NYQF 11-9/-0N

NYSE (35) X |NASDAQ (21)  Aleits  + o Q8 = "

Symbol Exchange LastPr.. LastTime Change % Change Open Close  High Low EPS  PIERatio 52Wee *
AEO NYSE 18.64 11:24:00 1829 1829 878 1826 1257 1475 1'

e =
AXP NYSE 7215 11:25:00 7080 704 it on any column to sort. 12.77 7
BTU NYSE $19.95 0.00 207 24 First click sorts ascending, 0.00 8
csx - o 0.00 3472 344 second descending and the 19.35 3
DE I\!ule: Default Watch. 11:25:00 9097 o1 third click removes the sort. 18.37 g
Fox Lists and contents will 11:25:00 1404 1394 1405 1371  6.760 0.00
vary depending on the

FDX broker or data service 11:24-00 [ IEED 18450 18369 18568 18346 6630 2768
Gs 11:25:00 20415 20384 21177 20415 12461 1681

A7 R A2 N1 AR /A

A7 20 R R71

nnn

Nov-14 11:25:23
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2.6.1 Watch List Tool Bar

Several features are available from the tool bar in the top right area of the watch list panel. These
buttons are as follows:

1. Link With Chart — If this button is on (shaded background), clicking on a row in the watch list will
set the instrument for the active chart on this page.

2. Table/Buy Sell View — Toggles the view of the watch list between the table view and the Buy/Sell
boxes view

3. Search/Add Instrument — Launches the search dialog to search for an instrument and add it to
the watch list.

4. Import Instruments — Click this to import a set of instruments from a CSV file (not available on all
workspaces)

5. Edit Watch List — Edits the watch lists properties

6. Open in Window — Opens this watch list in a separate window

7. Maximize — Maximizes the watch list panel to use all of the available space on the page

The following screen shot shows these buttons in the tool bar:

Watch List Tool Bar
B e e i T T Tt e i v [

! ] Entry/E
| Import

1.6M

Table/B
.| |||||l|||lpu..|..pl|||||| |||I|I|Illpmluq---..il.“{szu Efef

Nov-09 12:00 14:00 Nowv-10 12:00 14:00 Mow-11
1hour 2hour 6hour 1day 1week 2week 1 month

Openin
Window

Instruments

® |+~ &

rWatch List Tool Bar E = i QA E L e ﬁ Maximize P
T + Ll 11:10:00 X

|
% Change Open Close  High Cow
1829 1829 18.78 18| Link with |} Search/Add
. Chart
70.80  70.50 71.89 70{ -ha Instrument Com | Ream
000% 207 207 0.00 000 -112.960 0.00 8 |row [l How
000% 3472 3458 35.06 34.62 1.800 19.35 3

Edit Watch
List

11:25:00 X

2.6.2 Sorting Options

The table view of the watch list can be either sorted or unsorted. This mode can be toggled by clicking
on the column headers within the table view. Clicking a column header once sorts it by ascending order.
Clicking a second time will sort in descending order. A third click will make the table unsorted returning
it to its natural order.

2.6.2.1 Unsorted View

In the unsorted view, you can arrange the instruments in the list by clicking and dragging them to the
desired location. Alternatively, right click on a row and choose Move Up / Move Down to adjust their
locations.
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Unsorted Watch List

NlOLIVcVVd\’f‘

........
bl

NYSE (35) X | NASDAQ (21)  Alerts  + - Qe = "
Symbol Exchange LastPrice LastTime Change % Change Open Close  High Low EPS PIERatio 52We*
AEO NYSE 18.78 13:47:00 18.29 1829  18.80 1826  1.260  14.96
AXP NYSE 72.63 13:47:00 2.13 7080 7050 7258 7062 5630  12.89 l
BTU NYSE %3 0.00 0.00 0.00% 207 207 0.00 0.00 -112.960 0.00
csX NYSE 000, [ Click and drag (left 000% 3472 3458 3512 3462 1800  19.45
DE NYSE 91,62 | mouse button) to the 90.97 9110 9200  90.97  4.990  18.37
NYSE 13.89 | desired location 14.04 1394 1405 1355  -6.763 0.00
185.85 13:46:00 18450 18369 18644  183.46
209.48 13:47:00 20415 203.94 21177 20415
HaAl hYF AT 27 - i AT R1 A2 N1 AR RA AT A R R7TN nnn

2.6.3 Buy/Sell Boxes

A Buy/Sell box shows the current Best Bid and Best Ask prices for an instrument and makes it easy to
quickly place a market order to buy or sell the instrument. The following diagram shows the elements of

a Buy/Sell box:

Buy/Sell Box
Instrument Last Trade
Symbol Time Remove
" Box

Best Bid
Price

10:60:87 X

. Best Ask

\I Price

Day Low

-
RS:-0.05 n.59 L Buy/sell
L1.37474 H:1.37762 | Quantity

h

Spread I |DE|1,'H|g

The colors of the box will change as the prices change. If the price goes up the label will flash blue (or

green depending on preferences). If the price

goes down, the label will flash red.

You can modify the preferences for the Buy/Sell boxes from the Preferences dialog (Configure ->

Preferences from the Console menu bar).
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#

& Preferences X
I ToolBar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email Trade H\stowm_v

Use this dialog to configure how buy/sell boxes are displayed in the Instrument Organizer.
‘See Orders -> Submission panel to configure order options for these boxes

& Preferences X
Charl Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email Trade His =

Bar Themes _Chart Themes

Themes are used to change the look of the Ul components (Window Theme), chart colors (Chart Theme) and bar colors (Bar

Red/Green

Red/Blue

OK || Apply

Cancel

Box Size: | Tiny - Default size is Tiny. Other Theme). Use the drop down options below to configure themes for MotiveWave. Click OK to apply your changes.
options are: Small, Medium )
i window Theme: | Light ~
V| Show Last Price | _ 4 Large g
/| Show Bid/Ask Spream Chart Theme: | Light -~
Bar Theme: | Red/Blue -
Buy/Sell Colors: | Red/Blue - Use the drop down
b o switch between

blue and green

OK || Apply || Cancel

2.6.4 Create Watch List

Choose File -> New -> New Watch List from the Console menu bar to create a new watch list.

Create New Watch List

v

File | Edit View Study Strategy Format  Configure
New ' [l Mew Page
Open * | = New Watch List

i il Nelv Deskiop
Chart » | il New Chart Window Ctri+N

£! Backup il New DOM Window

B Restore 9 New Time&Sales Window
Disconnect Custom Instrument
Shutdown I 4 i

i | | |

M

Window He

Q iv+ =
e News

[

On the first page of the New Watch List wizard, you will be asked for the name of the Watch List. This

name will be displayed on the panel tab.
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New Watch List — Page 1

New Watch List
New Watch List/Quote Sheet

view).
1. Specify Name of the Watch List
2. Specify Columns to Display
3. Specify Instruments to Display

Click 'Next' to continue

Name | Top 50 Stocks This is the name displayed
Quote Sheet in the panel tab.

Quote Sheets allow you
to group the instruments

in a watch list (not
available in all editions).

This Wizard will enable you create a watch list or quote sheet to display a tabular view of instruments (or Buy/Sell box

Click Next to

choose columns

Next = Cancel

On the next page of the wizard, you will be asked to specify the columns. If you would like to add one or
more columns to the list, select them from the Available Columns list (hint: use the Ctrl key or Cmd key
on OSX to select multiple rows) and press the >’ button to move them to the Selected Columns list. If
you would like to remove one or more columns, select them from the Selected Columns list and press

the ‘<’ button.

New Watch List — Select Columns

New Watch List
Choose Columns

Select the columns that you wish to display

Available Columns Selected Columns

Account Symbol

Ask E

Avg Price Click this button to
add the selected
columns

?OEJE:'ERa Click a column to e I;::;ﬂ

select. Hold down Ctrl =

Descriptio key to select multiple Close

Dividend A (Cmd on O5X) Change

Dividend Yremr % Change

Expiry Date

Change (Inv) Use this button to

% Change (Inv) remove columns

% Off High 52 Week Low

% Off Low

% Qff Cynon

pip| Note: you can also click and

Po: drag columns to add/remove

Use these buttons
to change the
column order

| Click Next to select

or change the order in the
watch list.

instruments

Cancel

< Back Next =

The last step is to choose the set of instruments that will be displayed in the Watch List. Type the name

of the symbol in the -Choose Symbol- field and press Enter to add it to the list.

Alternatively, select a
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name from the drop down. You can also search for a particular symbol by clicking the Search/Add

button. If supported by your broker/data service you can import a set of symbols by clicking on the
import button (see below).

New Watch List — Choose Instruments

New Watch List

Click here to search

Add Instrumen

Select the instruments

and add a symbol.
pressing the '+ or search buttons below.

-Choose Symbol- > QB
A

ple Inc
rkshire Hathawa Imp
MSFT soft Corporatiorr

ort from CSV file I

"Enter” to add it to the
list. Alternatively, select
from the drop down.

Click to save the

watch list.
Total Instruments: 6

—,—

< Back Save

Cancel

2.6.5 Edit Watch List
Click on the Edit Watch List button (pencil icon) on the Watch List tool bar to open the Edit Watch List

dialog. From this dialog you can change the name, available columns or the instruments.

Edit Watch List - Configuration

= Edit Watch List X
Watch Lists are used to organize related instruments. Use the > and < buttons to add or remove columns. When
you are finished, click OK to save your changes.
Instruments Use this panel to change |
— r NYSE tfje name er columns i
displayed in the Watch list

Available Columns Selected Columns

Account Symbeol

Ask Exchange

Avg Price Last Price

Bid Last Time

Day Range Change

% Day Range % Change

= Open

Descliption Close

Dividend Amount High

Dividend Yield 7> | | Low

Expiry Date == | |EPS

Change (Inv) P/E Ratio

9% Change (Inv) 52 Week High

% Off High 52 Week Low

% Oftow Click here t th

ic ere 1o save ese

l}(f OnOnen columns as the default

Pips for new watch lists.

Position

OK Save Columns Cancel
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Edit Watch List - Instruments
Edit Watch List

X

Watch Lists are used to organize related instruments. Use the > and < buttons to add or remove columns. When
you are finished, click OK to save your changes

Configuration IEMH
hoose Symbol-| > QB

AEQ - American Eagle Outfitters
AXP - American Express

BTU - Peabody Energy

CSX - CSX Corporation

DE - Deere Co.

FCX - Freeport-McMoRan Copper & Gold Inc.
FDX - Fed Ex

GS - Goldman Sachs

HAL - Halliburton

HD - Home Depot

HES - Hess Corporation

KO - Coca-Cola, Co.

LOW - Lowes Companies

PER - Petro Brasileiro Petrobas
PHM - Pulte Group

POT - Potash Saskatchewan
RIG - Transocean

UA - Under Armor, Inc.

Total Instruments: 35

OK Save Columns Cancel

For convenience, columns can be modified directly from the Watch List. Click and dra

g a column header

to change the order. On the right hand side of the column header, there is a button that can be used to

show or hide columns.

Edit Watch List Columns

NYSE (35) NASDAQ(21)  Alerts | Top 50 Stocks (10) X | + - Qe = "
Symbol Exchange LastPr.. LastTime  High Low  Open ange % Chan.. . EPS P/ERatio 52W*
AAPL  NASDAQ 105.50 135600 107.81  104.08 107.71 108.43 8310 1268 /‘
BRKA NYSE  236146.00 13:52:00 237100.00 234930.00 36150.00 34860 55.24

MSFT  NASDAQ 57.93 13:56:00  59.08  57.28 5902 59 Clickand drag column 2.08 cg;’“el to hidfe l
ORCL NYSE 0.00 3067 3911 3939 go| Neadertochangeorder. f o, A7 70 Hne oM
GOODY SAUDI 0.00 0.00 0.00 0.00 000  000%  0.00 :

GOOGL NASDAQ 756567 13:56:00 77178 74359 77176 77175 27320 2765 I
GOZDE SAUDI 0.00 0.00 0.00 0.00 000  000%  0.000 0.00

IBM  NYSE 158.16 13:56:00 161.86 15758 16125 16127 12270 12.86

TR ATY nnn nnn nnn n nin n nn N Nines. _NNAN n nin

2.7 Quote Sheets

A Quote Sheet is a special version of a Watch List that can be divided into sub groups.

When creating

Watch List, make sure to select the Quote Sheet option on the first page of the Watch List wizard.

On the first page of the Watch List Wizard, you will be asked to enter a name for the Quote Sheet.
Similar to the Watch List, this will be displayed in the tab of the Quote Sheet Panel. Make sure to check

the “Quote Sheet” option below the Name entry field.
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New Quote Sheet Wizard
New Quote Sheet x

New Watch List/Quote Sheet
This Wizard will enable you create a watch list or quote sheet to display a tabular view of instruments (or Buy/Sell box
view)

1. Specify Name of the Watch List
2. Specify Columns to Display
3. Specify Instruments to Display %

Click 'Next' to continue.

Name r Key Stocks

v | Quote Sheet

Check this box to make
a Quote Sheet.

Click next to select
the columns.

Next = Cancel

Choosing the columns for the Quote Sheet is the same as you would for a Watch List. Select the
column(s) you would like to add from the Available Columns list and use the ‘>’ button to add them to
the Selected Columns list.

New Quote Sheet — Select Columns

= New Watch List X
Choose Columns
Select the columns that you wish to display.
Available Columns Selected Columns

Account Symbol

hanae
Click this button to
add the selected
columns
AV Low
>

Open

Avg Price

Use these buttons
to change the
column order

Day Ranfe
% Day Ra|
Volume

Click a column to
select. Hold down Ctrl

Descriptio key to select multiple Close
Dividend A (€md on O5X) Change
Dividend Yrem % Change
Expiry Date EPS

Change (Inv) Use this button to
% Change (Inv) remove columns

% Off High 52 Week Low
% Off Low

9, (MfNnon

pip| Note: you can also click and
pod drag columns to add/remove
or change the order in the
watch list.

Click Next to select
instruments

N A—

< Back Next = Cancel

Quote Sheets organize instruments into groups. Click on the New Group button to add one or more
groups to the Quote Sheet. You can add instruments to each group by selecting the group from the
Group drop down and then using the Add Instrument/Search Instrument buttons (see below).
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New Quote Sheet — Add Groups/Instruments

Group

Total: 0

-Select Group- v

New Quote Sheet

Add Instruments

Instruments are organized into groups. Click on New Group to create a new group. Select the instruments to add to the
watch list by pressing the '+' or search buttons below

New Group

-

Label Colors

Click here to
create a group
Foreground
B New Group x [Background

Quote Sheets are organized in to groups. Choose a
unigue name for your group and press the OK button.

Name: |' Tech Sector

‘< Enter a name and

click OK.

OK || Cancel

< Back

Save

Cancel

The following screen shot shows a sample Quote Sheet. Noticed that there are groups in the Quote
Sheet table that divide the instruments into different categories. Optionally each group can have
different colors for the dividers.

Sample Quote Sheet

NYSE (35) NASDAQ(21)  Alerts  Top 50 Stocks (10) | Key Stocks (17) X | + - QB = "
Symbol Exchange LastPr.. Last Time High Low Open Close Change % Chan.. EPS P/ERatio *

AAPL NAIDAQ 10574 16:00:00  107.81 10408 107.71 108.43 g 8310 1272
AMZN NASDAQ  718.93 16:00:00 74600 71010 74551 739.01 4360  164.72
csco NASDAC 31.37 16:00:00 3167 3135 3143 2110 14.86
YHOO NASDAQ 39.30 16:00:00  40.39  38.87 40.36 4042 -5.107 0.00
MSFT NASDAQ 58.12 160000  59.08  57.28 59.02 59.02 2088 2787
GOOGL  NASDAQ 1 77178 74359 77176 77175 ) 27.320 2755
INTC NASDAQ ;L;zt;if:ie EaCh 3473 3420 3456 3461 2130 1620
HPQ NYSE different color. 1619 1580 1585  15.82 0.28 1.880 8.56
ORCL NYSE 3967 3911 3939 3945 (KRB 2110 1869
AGK ASX 0.00 0.00 0.00 0.00 000%  -0610 0.00
BPT ASX 0.76 11:10:00 0.78 075 078 079 -0.396 0.00
HSE TSE 14.30 15:52:00 1435 1415 1426 1435 0620  23.18
GDPAQ  OTCMKIS 0.00 dct-11 10:31:00 0.00 0.00 0.00 -5.489 0.00
uPL FRA 6.62 15:00:00 6.63 663 663 667 : 0.902 7.35

v noustrigs -
DAL NYSE 47.47 16:01:00  47.44 4661 4662 4638 6.170 7.69
DLX ASX 6.07 11:10:00 6.16 605 613  6.09 0.340  18.12
(e
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2.8 Backup/Restore

The Backup/Restore feature enables you to export settings, analyses, instruments, watch lists, scans and
open windows/positions to a single backup file. This backup file can be archived to be restored later in
case something happens to your computer. Alternatively, you can use this feature to transfer your
workspace to another computer.

2.8.1 Creating a Backup

Choose File -> Backup from the Console menu bar to create a backup file. When you choose this option,
you will see the Backup Workspace dialog.

Create a Backup

" Moti
File | Edit View Study Strategy Format Configure  Window  Help
New v B B B Helera o1~ + "5 ]
Open ' 0 i} Optimize News  +
Chart 2 ?s:wcth: ?icltulf"lenu i i
& Bacgkup i ) iT“H E
& ReStore [ Tt -! ﬂi n !h"H*TI
Disconnect e Ll lh'
Shutdown Uy i

f

Backup Dialog
= Backup Workspaca X
By default the backup will be
created on the Desktop. Click
Browse to change

This dialog allows you to create a backup of the ¢
used for archive purposes or may be used fo mo

Click the Browse button to select a backup file, tl =]
backup.
Backup File: |' Ci\Users\Tony\Desktop\google Nov-14 16-33.zip | Browse

Create Cancel

When you click the Create button, a backup file will be created on your computer desktop. This backup
file will be named <Workspace Name> <Date>.zip (where <Workspace Name> is the name of your
workspace and <Date> is the current date/time). If you would like to change the name and location,
click on the Browse button.

You can store this file in a safe place (such as Drop Box or Google Drive) or move it to another computer
to restore it into an existing workspace.
2.8.2 Restore From Backup

Choose File -> Restore from the Console menu bar to restore from a previously created backup.

Restore From Backup

(Y Motivel
File | Edit View Study Strategy Format Configure Window  Help
New » H =~ 6 Klerq I~ + "I
Open * | 1§ Account | Scan 1} Optimize News  +
Chart v | X , ! ,
&! Backup Choose Restore : i'l'l |
1 + i
g store from the File menu -! 'i*!l ! !I!“H‘*T:
connect wit :Tlhm* :
Shutdown 'HT'T i il I
i 1 +
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Restore Dialog

E Restore Workspace x

This dialog allows you to restore a workspace from a recent| click Browse to locate

utility will overwrite analysis files that currently exist Wi . 0 o cviously created

Click the Browse button to select a backup file, then click t
the workspace. v

Backup File: | || Browse

v'| Restore Console/\Windows /| Restore Preferences

v'| Restore Watch Lists v'| Restore Scans
v'| Restore Strategy Analyses Delete Existing Analyses
Cancel

Click on the Browse button and locate the backup file that you created previously. The options available
for restore are as follows:

1. Restore Console/Windows — Restores console layout/pages and open windows from the backup
file.

Restore Preferences — These are the settings from the Preferences dialog.

Restore Watch Lists — Watch Lists and Quote Sheets

Restore Scans — Scan criteria saved from the backup

Restore Strategy Analyses — Restore back test/optimization executions.

Delete Existing Analyses — If you check this option, all of the existing analyses in the workspace
will be deleted before importing the analyses from the backup.

oukwnN

Click the Restore button to begin the restore process. You will see a progress indicator that reports the
status of the restore. Depending on your computer and the size of the backup, this could take up to a
minute or two to complete.

Note: The file format for the backup has changed in version 5 (compressed zip format).

2.8.2.1 Restoring to a Different Workspace Service

In the typical case, the workspace service (ie broker or data service) will match the service from the
backup. You can restore from a backup that was created with a different service, but you may
encounter some issues. Each service has a different naming symbology for the instruments that they
support and the target service may not support all of the instruments that are in the backup.

MotiveWave™ will attempt to map the symbols from the backup service to the target service. However,
you may find that some analyses are missing in the new workspace if MotiveWave™ could not find a

mapping.

2.9 Repository

MotiveWave™ maintains a local database for each workspace. This database contains the following
information:

1. Instruments/Exchanges/Trading Hours/Order Presets
2. Preferences/Keyboard Shortcuts

3. Watch Lists/Quote Sheets

4. Historical News
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5. Analysis

6. Alerts

7. Chart Templates
8. Scan Criteria

9. Strategy Analyses
10. Historical Trades

11. Historical Data — Historical data is stored in 1, 5, 30 and daily bars. This is used to reduce load on
the servers and is also available in Offline mode.

Optionally, data that is normally stored in the local database can be stored in the file system. This can
be very useful if you want to synchronize this data (using Google Drive or Drop Box) with other

computers or use as an alternative

way to create backups.

Choose Configure -> Repository from the Console menu bar to access the Repository settings.

Repository Settings

-

: H Mall
' i
ity | ar, [l g™ = Clear All Local Data
bl lf'l'* Ty, b

(W) MotiveWave - Console (google)
File Edit View Study Strategy Format | Configure | Window Help

AAPL Ml | S O] # & Workspaces T | &~ 15min -

|l Home X Ll Charts .9 Account | Scan —] Instruments +

BPT 15m AAPL 15m X | + 12 Actlvej\ckers L Choose Repository from
l—'i g Repos&)ry the Configure menu

AAPL - 15 min ' £} Preferésices

Volume i

i Save Configuration Fhi*:

Order Presets i *
s
o
‘i*m" |

il ﬂ*

Commissions
[Z] Update License

&) Choose Language
il Layout

Repository Dialog

Repository

By default, all information within Motive\Wave is stored in the local databa
store information externally in the file system for greater flexibility. Additio
can also be specified below.

Repository

Click Browse to select

this information will be

—

Directory:

Analysis Sources

Uncheck to store information
/| Use Local Database in the File System

the root directory where

stored.
vV

v/ | Override Repository

Add

Analysis Sources may be used
to share and view analyses
with other MotiveWave users.

Cancel

i | }
| |\. . _M“T*“-l illl.ml+*”

Uncheck the Use Local Database option to store information in the File System instead of the database.
You will need to choose the root directory for this information by clicking the Browse button. If you
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would like to share this data using Google Drive or Drop Box, make sure to choose a location inside the
shared folder.

Optionally you can choose to store the following types of information by checking the boxes below:

1. Include Preferences — this is the settings in the Preferences dialog and other configured settings.
2. Include Watch Lists — watch lists and quote sheets

3. Include Chart Templates — any study templates that you have setup in your system

4. Include Windows & Layouts — open window information and locations as well as the Console
layout

Include Scans — scan criteria

6. Include Global Alerts — this applies to price alerts.

b

2.9.1 Sharing using Google Drive or Drop Box

Storing data in the File System provides the flexibility to share this information with other computers
using utilities such as Google Drive or Drop Box. Note: this feature is not limited to these two services.
Any cloud based service that interacts with your local file system should work just as well.

For more information on these services, see their websites:

1. https://www.dropbox.com/
2. https://drive.google.com/

Note: some issues have been found with Google Drive. These issues are related to the behavior of
Google Drive when sharing files. For more information see: http://www.techrepublic.com/blog/google-
in-the-enterprise/steering-around-the-potholes-with-google-drive/

2.9.2 Folder Structure
If you look at the root folder for the repository you will see two folders:

1. analysis — contains analysis files. This directory contains several sub folders that organize
analysis by instrument type and instrument symbol.
2. config — contains configuration files

The following diagram shows an example repository structure for an FXCM workspace.
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LT 1T T L

Repository Folder Structure

- -

Mame Date modified Type Mame te modified Type
| analysis M P | CASH AKA FOREX. the folders  b3/2n14 411PM  File folder
| config 17/03/2014 1:05 PM  File folder |\ CFD) here will depend on the 3/2014 3:43PM  File folder
|| PRECMTL broker or data service 3/2014 411 PM  File folder
IZ;?:&:?ntsh:\n\:thufbo:gi;arlst: This is the analysis folder.
analysis and config Analyses are organized by
Instrument Type and
Instrument (see below)
[ 1 | < m | r
Name‘r - Date modified TEa Mame W : Date modified Type Ll
= alerts 15/04/2014 209PM XML Document i AUDCAD i
=| commissions 15/04/2014 209PM XML Document 4 AUDUSD Sl AR
=] config R ument . EURCAD 13/03/2014 3:10 PM  File folder
) console layout This i.s the config .folder. It R | EURCHF — 12/03/2014 2:39 PM__ Eile fplder =
) console scitings cont.alns s?vefal files t.hat have . | EURDKK :I'hls is the CASH folder. .Each . Ider
- configuration information. | EURGRP instrument type folder will contain f.,
=| order_presets RUEEEE ‘. EURIPY a folder for each instrument. der
2] scans 15/04/2014 203 PM XML Document EURUSD These sub folders will contain an " |
| templates 15/04/2014 2:09 PM XML Dc%ment : GBaCAD analysis file for each analysis "
=) trading_hours 15/04/2014 2:03 PM XML Document :
] watchlists 15/04/2014 209 PM XML Docurnent ¢ GBRUSD BRI R
[ windows 15/04/2014 209 PM XML Docurment i USTCAD PLMEPNE VL) [k =
e e 4nna At a1 meeora
v = ‘ - < m b
Namelyf : odified Type
[E] Alternate1 File name will matchthe [411.31 .. mwmL File
=] Primary Analysis | N3Me of the analysis 41131 ..  MWML File

Default Analysis

These are the analysis files under
the EURUSD folder. Each
instrument folder will contain a file
for each analysis you created for
the symbol

4 I 2

2.9.3 Analysis Sources

Analysis sources provide a way to share specific analyses or to access analyses from other
MotiveWave™ users. Analysis sources are defined by a folder that exists in your local file system. You
would need to use a service such as Google Drive or Drop Box to perform the sharing and
synchronization.

Analysis sources are defined in the Repository Dialog (Configure -> Repository from the Console menu
bar)
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Repository Dialog — Analysis Sources

g Repository X

By default, all information within MotiveWave is stored in the local database. Use the options below to

store information externally in the file system for greater flexibility. Additional sources for analysis files
can also be specified below.

Repository

v/| Use Local Database

Directory:

Analysis Sources

v/| Override Repositor
A\ P y rCIick here to add an
N LAnalysis Source Add

If an analysis with the same
name exists in your repository,
it will be overridden by the
analysis source.

Cancel

Click on the Add button to define an analysis source. You can have multiple analysis sources. The

Override Repository option is important if there are naming conflicts between your local repository and
the analysis sources.

For example if you created an analysis called “Wave 3 Intraday” for the EUR/USD pair and one of the
analysis sources also has an analysis called “Wave 3 Intraday” for EUR/USD, MotiveWave™ will need to
determine which one to display. If Override Repository is checked, it will display the one from the
analysis source (instead of the local repository).

The following dialog will appear when you click the Add button. Each analysis source will require a
name. This name can be anything you like, but should reflect the source of the analyses. In the example
below, we chose the name “Trading Analysis” (this is one of our partners). Choose a directory (folder)

for the source by clicking on the Browse button. (Note: this will be a folder that is synchronized using
Google Drive/Drop Box).

The Read Only attribute indicates if you are going to be modifying the analyses or just viewing them.
Uncheck this option if you are intending to publish analyses to this source.

Add Analysis Source Dialog

= Analysis Source X

An analysis source specifies a directory where additional analysis files may be loaded. Enter a name
and choose a directory below (click the Browse button). Check the Read ©nly option if you are not
intending to modify Analyses from this Jocation

r .
MName: Tradlng Analysis Give the source a name 1

Directory: | C\Users\Tony\

v/| Read Only

Uncheck if you intend to share l
your analyses to this source. J

Select the root
OK || Cancel directory
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2.9.3.1 Publishing Analyses

If you are planning to share your analyses with other users, then you would create an analysis source
and uncheck the Read Only attribute. Analyses that exist in your repository are not automatically
shared; you will need to explicitly publish each analysis to this new source.

If you would like to publish an analysis to an analysis source, choose File -> Save To -> <Analysis Source
Name> (where <Analysis Source Name> is the name you chose in the Add Analysis Source Dialog) from
the chart menu bar (Note: it is File -> Chart -> Save To -> <Analysis Source Name> from the Console).

This action will save this analysis (make a copy) to a sub folder in the analysis source folder that you
defined earlier.

The file synchronization software that you setup (ie Drop Box etc) will take care of synchronizing that file
with the folders of all your users.

In the following example, we have created an analysis source called My Group. The Read Only attribute
has been unchecked to tell MotiveWave™ that it can publish analyses to this location. This analysis
source will now be available in the Save To menu (see below).

Setup for My Group

= Analysis Source X

An analysis source specifies a directory where additional analysis files may be loaded. Enter a name
and choose a directory below (click the Browse button). Check the Read Only option if you are not
intending to modify Analyses from this location.

Name: | My Group

Directory: | C:\Users\Tony\Desl Browse
This needs to be unchecked
Read Only to enable publishing

OK || Cancel

Publishing to My Group

( MotiveWave - Console (google)
File | Edit Wiew Study Strategy Format  Configure  Win| The Analysis Source My Group was
[ New , B =~ 63 WoElwr @ 0 previously setup in the Repository Dialog
Open » | Account (@ Scan 114 Optimize above. The Read Only attribute was
- - unchecked to ensure that it is available in
Chart » - the Save To menu below. [
8! Backup B New Analysis ; : i
8t Restore = Manage Analyses ' i |
Disconnect I=. Save As !:MI : :
Shutdown Save To » 3 : 1
IR Template " I‘ﬁ Group Choose File -> Chart -»
&' Import Data | Save To -> My Group
£ Export Data

&a Export Analysis  Ctri+J
[8] Save As Image

i &b Import Analysis  Cirl+K

“i“ﬂ“* éxll“ﬁlﬂ'whr*-.l“i

il

2.10 Email Configuration

MotiveWave™ may be configured to send out email messages as part of alerts or signals generated by
studies. You will need to configure the SMTP (Simple Mail Transfer Protocol) settings in the Preferences
dialog to enable this feature. These settings will be found under the Email tab. Choose Configure ->
Preferences from the Console menu bar to display the Preferences dialog.
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Email Preferences Dialog
fo Preferences X

General Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts gayEll

This dialog allows you configure your SMTP setj £ b iL
Allow Outgoing Email Chec.k this box to enable J
email messages

SMTP Server:

Click on the
Email tab

SMTP Port:

Usermname:

Password:
SMTP settings will vary

From Email: depending on your email provider.
If this is a corporate email

To Email: address, contact your network

Protocol — administrator for specific

The Test Email button will

send a test email to verify
that the settings are working.

Apply Cancel

If you are using a corporate email address, you will need to contact your network administrator to get
the specific SMTP settings.

Settings for public email addresses can be found online, just do a web search. Here are some useful links
for some common email providers:

2.10.1 Gmail

Gmail settings can be found here:
http://email.about.com/od/accessinggmail/f/Gmail SMTP Settings.htm

For some user accounts you may need to create an application specific password in order for this to
work. For more information see: https://support.google.com/mail/answer/1173270?hl=en

2.10.2 Yahoo Mail

Yahoo mail settings can be found here:
http://email.about.com/od/accessingyahoomail/f/Yahoo Mail SMTP Settings.htm

Similar to Gmail you may need to setup an application specific password if you have to bypass the
second sign-in verification: https://help.yahoo.com/kb/yahoo-account/SLN5013.html?impressions=true

2.10.3 Windows Live / Hotmail

The following link explains the Hotmail SMTP settings:
http://email.about.com/od/accessinghotmail/f/Windows Live Hotmail SMTP Settings.htm
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There is also a two-step verification process for Hotmail as well. For more information see:
http://windows.microsoft.com/en-ca/windows/two-step-verification-fag
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3 Charts

MotiveWave™ has perhaps some of the most advanced charting capabilities of any charting application
available. In this section we will be exploring some of the basics of working with charts in

MotiveWave™.

You can work with charts within the Console window or you can open separate chart windows to work
with charts independently. The simplest way to open a chart window is to press the Open Chart
Window button from the top right section of a chart panel. Alternatively, choose File -> New -> New
Chart Window from the top menu bar.

Open Chart Window

- e X
FEL DD R IO NN o
im N 3
A

: I Click this button to Lj'@ L4

i open this chart in ]

i its own window. q111.00
109.99

L APTLTS
Ll et

This action will open a chart window similar to the one in the screen shot below. Regardless of whether
you choose to work with charts in the console or separate chart windows, the features described in this

section are the same.

Chart Window

4

v AAPL - Primary Analysis - 15 min o o 3
File Edit View Study Strategy Format Window Help
AAPL AR ER ErED IR e 1y + T[T 2 [15mn ~ | LmeMmDP o
Components X [AAPL 15m* x |MSFT15m  + N =
¥ General AAPL _15 min Tool Bar Trade x
Volume MA Cross(C,EMA, 1 - | | 111023 m Order  Bid/Ask
S —= \ Optional chart tabs for TI " " 109.69
5 e \ | i7i i Price Indicator
Price Label Price Label organizing multiple -+
Study L d Buy Mkt
\ ucy teaen | charts in one window. l+ m
\ [ 102]=
\ wl J100.00 =
= =
Support  Resistance L/ Trade Panel i:-=_
Zone Zone “' I
/ -108.00
7 2 4 simulated -
Tl Tl : |‘ ijﬂ- NA NIA
: .* J107.00 i
1\ l [ Entry/Exit »
o 106.60
- - T Components Panel E /
Horizontal ~Extended : f J106.00
Line Horizontal b
Line i m\ liﬁ“
L )
Vertical  Extended
Line Vertical | || 3.9M
= il ol M | h
/ latpsun | IIIlIIII"Ill Infanal I|||IIII||I]|I|I|I I““Imq PPPTTLULL "“I'Illgl-llllnplﬂl ) 1.2
s 12:00 14:00 Now-11  12:00 14:00 Nﬂ\.' 14 12:00 14:00 Now-15  12:00 14:00 Now-16 12:00 4o 8:00
» Basic Components ! ! I Tk
MACD(C,EMA,12,26,9) 1 0.50025
» Commentary "__.nllllllll._i, auasay e 0.000
» Markers I Jo.500
» Fibonacci
x
EaCann Bar Size Selector J100.00
» Elliolt Wave 2016 Feb2li6 fiar2016 Apr2)
» Gartley imin 5min 10min | A5min  20min  30min 45min 1 hour 2hour 6 hd

Nov-16 17:01:53
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3.1 Settings
3.1.1 Default Chart Settings and Options

Default chart settings can be set from the Preferences dialog (Configure -> Preferences from the Console
menu bar). You will find the settings for charts in the tabs underneath the Chart tab.

Global Chart Settings
T Preferences 5

General Theme TOOI Bar Sounds Ratios Elliott Wave Gartley Tick Charts OFA® Orders Alerts (=

(EGERDIOLEE Indicators Labels Templates Options Bar Sizes Bar Size Selector

The fields below allow you to adjust the default settings for charts

Default Took ¥ ~ Max Linear Bars:
Revert to Default Tool: V' Max Non Linear Bars
BarType: 0l ~ Minimum Bars
Bar Scheme: Normal - Popup Delay (seconds) /| Enabled
BarSize: 15min  ~ Bar Width (Pixels):
Bar Thickness: — 1.0 ~ Price Axis Spacing
Axis Style: | Inside - Time Axis Spacing:
Shade: None - Top Inset (pixels) 5%
Shift + Click:  Text - Bottom Inset (pixels). [ 5 =
Cirl + Click:  Price Guide - Display Bars %
CHrl + Alt + Click: | Time Guide - Study Height (pixels)
Line Method: = Time/Price - SIUG)" Layout Horizontal -
Fill Area: Time Zone: -
Fill Alpha: 25 2 | Use Default

Calendar Days

OK || Apply Cancel

The following are options that are available from the Chart Settings tab:

1. Default Tool — This is the default tool to use on a chart.
2. Revert to Default Tool - When completing an action with the selected tool, the chart will
automatically switch back to the default tool (see above)
Bar Type — The default type of bar to display when opening a chart
4. Bar Scheme — Determines the color scheme for the bars. Normal displays bar color based on if the
close is higher/lower than the open value. Available Bar Schemes include:
a. Normal - Displays a different color if the bar closes higher than open verses lower than open
b. Inside/Outside — Colors change if bar closes higher/lower than open, if the bar has a lower
high/higher low than previous bar (inside) and if the bar has a higher high/lower low than the
previous bar (outside)
c. Day Of Week — Bar color changes based on the day of the week
d. Alternate Day — Bar color alternates each day
e. Alternate Hour — Bar Color alternates each hour
Bar Size — default bar size when opening a new chart
Bar Thickness — Default thickness for the bar outline (default 1 pixel)
Axis Style — Style of the price and time axis
Shade — draws a shaded area at time or price intervals on the

w

O N,
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9. Shift + Click — Object to draw when the user holds down on the Shift Key and clicks the left mouse
button on the chart.

10. Ctrl + Click — Object to draw when the user holds down on the Ctrl Key and clicks the left mouse
button on the chart.

11. Shift + Alt + Click — Object to draw when the user holds down on the Ctrl and Alt Keys and clicks the
left mouse button on the chart.

12. Line Method — Calculation method for calculating the lines on a wedge (Time/Price or Angle)

13. Fill Area — If true, the area of a wedge will be filled

14. Fill Alpha — Alpha value for the fill color

15. Max Linear Bars — Maximum number of linear bars to load when opening a chart

16. Max Non Linear Bars — Maximum number of non-linear bars (ie Range, Renko etc) to load when
opening a chart

17. Minimum Bars — Minimum number of bars to load when opening a chart.

18. Bar Width (pixels) — Default spacing for the price bars

19. Price Axis Spacing — Default spacing between the numbers that are displayed on the price axis

20. Time Axis Spacing — Default spacing between the labels that are displayed on the time axis

21. Top Inset (pixels) — Default spacing to add to the top of the price plot when auto scale is enabled

22. Bottom Inset (pixels) - Default spacing to add to the bottom of the price plot when auto scale is
enabled

23. Display Bars — percentage of bars to display when first opening a chart (ie fill 90% of the chart area)

24. Study Height (pixels) — Default height for study plots

25. Study Layout — Layout preference for the study labels displayed in the legend area (horizontal or
vertical)

26. Time Zone — Default time zone for the chart.

27. Calendar Days — If enabled, space will be preserved for non-trading days when displaying daily bars
(normally this space is removed)

Additional chart options can be found under the Options tab of the Chart section in the Preferences
dialog.
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Global Chart Options
o Preferences X
General Theme E®)ENE Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts OFA® Orders Aleris =
Chart Seltings Indicators Labels Templates Bar Sizes Bar Size Selector
The fields below allow you to adjust the default settings for charts
v/| Show Extended Data /| Double Cross Hair v/| Expand Status Bar Link
Show Instrument Title Solid Cross Hair /| Show Bar Size Selector
v'| Snap Open/Close v Auto Scale Show Bird's Eye View
Show Components Panel Auto Scale Price Only /| Show Bird's Eye Lines
Show Trade Panel Semi Log Scale Resolve Trend Lines
Show DOM Panel Lock Scroll Group Studies
Show Grid Lock Studies v'| Show Study Labels
/| Show Major Times /| Show Info on Select Study Bar Updates
v'| Show Chart Buttons Show Info v/| Study Dock Long Names
Show PJL Ladder v/| Show Range Outline Use Account Position
Show Exchange Show Middle Line Show Values In Legend
/| Show Symbol /| Show Menu Bar /| Simple Study Title
v'| Show Bar Size v'| Show Tool Bar v'| Overlay Volume
v'| Show Analylsis Name v'| Show Status Bar v'| Draw Candle Outline
Show Cross Hair v/| Confirm on Close v'| Auto Load Studies
Global Cross Hair /| Link Minimize/Restore
CK | Apply | Cancel
1. Show Extended Data — If true, after hours data is show by default when opening a chart
2. Show Instrument Title — Displays the title of the instrument in the top left corner of the chart
3. Snap Open/Close — If this is enable the mouse tools will automatically snap to open and closing
points on the price bars
4. Show Components Panel — Displays the components panel by default when opening a new chart.
5. Show Trade Panel — Displays the Trade panel by default when opening a new chart
6. Show DOM Panel — Displays the DOM (Depth of Market) panel by default when opening a new chart
7. Show Grid — Displays horizontal and vertical lines on the chart
8. Show Major Times — Show vertical dashed lines for major time on the chart
9. Show Chart Buttons — Enables the display buttons on the chart for adjusting the vertical space and
bar width. This also applies to the remove study button on study plots.
10. Show P/L Ladder — Displays the profit/loss ladder on the chart.
11. Show Exchange — Toggles the display of the exchange as part of the title on the chart
12. Show Symbol — Displays the instrument symbol on the chart.
13. Show Bar Size — Displays the current bar size on the chart
14. Show Cross Hair — Toggles the default display of the cross hair feature for the mouse cursor
15. Global Cross Hair — If enabled, the cross hair (where enabled) will be updated across multiple charts
that display the same instrument
16. Double Cross Hair — Displays two vertical lines encompassing the bar where the cursor is currently
(instead of a single vertical line)
17. Solid Cross Hair — Displays a solid line instead of a dashed line for the cross hair
18. Auto Scale — Default scale setting when opening a new chart
19. Auto Scale Price Only — If enabled, only the price action will be included in the auto scaling of the
chart (components are excluded)
20. Semi-Log Scale — displays a chart using semi-log scale by default.
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21.
. Lock Studies — Default Lock Studies state (see Lock Studies feature)
23.
24.
25.
26.
27.
28.
29.
30.
31.

22

32.
33.
34.
35.
36.

37.

38.
39.

40.

41.
42.

43.

Lock Scroll — Default lock scroll state (see Lock Scroll feature)

Show Info on Select — Turns on the Show Info feature when selecting a component

Show Info — Enables the show info feature when creating a new component

Show Range Outline — Turns on the range outline on the latest bar for Range/Renko bars

Show Middle Line — Turns on the display of the middle line for channel components

Show Menu Bar — Turns on the display of the menu bar for windows

Show Tool Bar — Turns on the display of the tool bar for windows

Show Status Bar — Turns on the display of the status bar at the bottom of the windows

Confirm on Close — If enabled will display a warning message when closing a chart window

Link Minimize/Restore — If enabled, for linked chart windows all windows in the group will be
minimized when one of them is minimized. Likewise when one of them is restored, all windows in
the group will be restored

Expand Status Bar Link — Expanded mode for the color link control in the status bar

Show Bar Size Selector — Toggles the default display of the Bar Size Selector on charts

Show Bird’s Eye View — Toggles the default display of the Bird’s Eye View when opening a chart
Show Bird’s Eye Lines — Display of the vertical lines on the Bird’s Eye plot

Resolve Trend Lines — If enabled, MotiveWave™ will attempt to load enough data to properly display
all trend lines on a chart. By default it will estimate where the starting point of a trend line is based
on the available data. This option will force the loading of data all the way back to the beginning of
trend lines to improve the accuracy of the plot. Warning: this option can cause a lot of data to be
loaded from your broker or data service. It is recommended that you leave this option of and turn it
on where desired from the Chart Settings dialog (see next section).

Group Studies — If enabled, study plots will be grouped together at the bottom of the chartin a
stacked panel.

Show Study Labels — Enables the display of study labels in the legend

Study Bar Updates — Toggles the live updating of studies from level 1 data verses calculating the
most recent study values on the close of a bar.

Show Values in Legend — If enabled, current study values will be displayed next to the study label in
the study legend

Simple Study Title — Simplified display of the title in the legend area

Overlay Volume — Displays the volume information as an overlay on the chart instead of a separate
plot.

Draw Candle Outline — Draws the outline of the candle rectangle.

3.1.2 Chart Specific Settings

Chart settings that apply to the selected chart only can be accessed by right clicking on the chart and
choosing Chart Settings (you can also double click on the chart). The settings configured here can be
saved as default settings by clicking on the Save Defaults button. Descriptions of items below can be
found in the preceding sections.
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Chart Settings Dialog
Lo Chart Settings o

Scaling Bar Settings Theme Display Labels Watermark Trade Elliott Wave OFA®

The fields below allow you to adjust general settings specifically for this chart. Default settings may be changed from the
Preferences Dialog (Configure -> Preferences from the Console Menu Bar).

Mouse Tool ¥ ~ Bar Width (Pixels):
Shade: MNone - Price Axis Spacing: 25 ¥
Axis Style: | Inside - Time Axis Spacing: 25 3
Semi-Log Scale Minimum Bars:
Show Cross Hair Resolve Trend Lines
Solid Cross Hair Calendar Days
/| Double Cross Hair Time Zone: ~ | |v/| Use Default

Global Cross Hair
Lock Scroll
Group Studies

v/| Show Study Labels

Lock Studies
This dialog allows you to configure

preferences specifically for this chart.
Use the "Save Defaults” button below to
apply changes to other charts.

OK Save Defaults Reset Defaults Cancel

3.2 Price Indicators
Price indicators display current price, high low (etc) on the price axis of a chart. By default,
MotiveWave™ will display (where available) the Last Price, Best Bid, Best Ask, Daily High and Daily Low.

Other indicators may be (optionally) displayed in the vertical axis from overlays such as a Moving
Average. If you would like to show a vertical line that moves with the indicator just double click on it

(this will toggle the display of the line).

Price Indicators

' —%130.25
U |

3130.00

Double click on indicator

iL it . i Cianas)

to toggle the display of the [129.00
horizantal line
H128.00

[
|'
J127.75

I I I I I
00 13:00 14:00 15:00 Feb-02 11:00
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You may change the price indicators that are displayed from the Preferences dialog. Click on Chart, then

on Indicators.

Price Indicator Settings

e} Preferences

x

General Theme ReIEGE Tool Bar Sounds Ratios Elliott Wave Garlley Tick Charis OFA® Orders Alerts =

chart settings [[ITeERae] Labels Templates Options _Bar Sizes Bar Size Selector

The fields below allow you to adjust the default settings for indicators displayed on the price axis

Last Price: v Enanﬁclick on the check box

Hest Bid- | Enabled to show/hide indicator
Best Ask: /| Enabled
Bid/Ask Midpoint: Enabled
Daily High: /| Enabled
Daily Low: v/| Enabled
Opening Price: Enabled

Closing Price:| Click on the Edit button to

modify colors, show lines

OK | Apply || Cancel

3.3 Chart Spacing

There are several options for adjusting the horizontal and vertical spacing on the chart. The simplest
way is to use the mouse to drag either the time axis (horizontal spacing) or the price axis (vertical
spacing). Note: in order to adjust the vertical spacing, you need to click and drag the space between the
price labels and the chart area (see below)
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File Edit View Study Strategy Format Configure Window Help

AAPL - O | K E =~ 6 %é‘\f:f.vqﬂv+:c,’)v1da}r - FEL D NS
Ll AAPL 1D X |lil AAPL 15m  + E « =+
AAPL - 1day ! l 130.00
i HL 126 47
! H127 50
1
1
1 : 1125.00
! !
! | H122.50
| ot |
! !
! Loml. ; H120.00
Y
! |jdf' ? In order to adjust the
i.l. +E|:|. E]? n IJ___ I D vertical space with the H117.50
T +* J]!ﬁ il &'* . $E] mouse, click and drag the
* ﬂ T space between the labels 115.00
.4, -|- ++ .LI_ h# : and the chart area.
1
DT *ql * I : J112.50
L D'l'Tq:i.ee* |j |
1
‘ ‘?E; Té l:]FdJH : 411000
i Click and drag from the bottom
d] i upwards to add space to the 5107.50
| bottom of the chart =2
| - +7105.00
Click and drag the time axis to ! =
adjust the space between bars !
MotiveWanle : []102:50
| | L L ! L L L ! !
Oct-2016  Oct-11  Oct-19 Nov-2016 Nov-05  Nov-17 Dec-2016 Dec-09 Dec-19 Jan-2017 Jan-11  Jan-20 Feb-2017  Feb-10
1min Smin 10min 15min 20min 30min  45min  1hour 2hour 6&hour 1day 1week 2week 1month 3 month = v @ - ;B
|l Home X Lul Charts .8 Account |20 Scan  flf Optimize News  + im N O

=

= 25 ® ¢ Feb-212017, 105.81 Feb-02 10:45:53

3.4 Bar Sizes

Bar sizes are useful for changing the resolution of a chart based on time, price or volume movements.
MotiveWave™ supports several different types of bars:

1. Linear —time interval based bars (such as 1 minute, 15 minute, 1 day, 2 week etc)
Range — bars are based on price movements of a specific price range
Renko/Hybrid Renko — these are special price range based bars

Tick — these bars are based on a specific number of price ticks (or trades)

Volume — each of these bars will have a fixed trading volume

6. Point & Figure

nkwnN

There are several ways to change the bar size and type. Perhaps the most convenient way is to use the
Bar Size Selector at the bottom of the chart. Alternatively, you can use the bar size drop down from the
tool bar or right click on the chart and select the bar size from the context menu.
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Select Bar Size

Motive

~wangEEw--

’

~ MotiveWave - Console (google) B o
File Edit View Study Strategy Format Configure Window Help
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AAPL - 1lday 15 min i 130.00
20 min | T3 d
30 min ) 1127.50
You can also click here to Alternatively,
45 min choose the bar size
display a drop down to H125.00
change the bar size. 1 hour from the tool bar. .
20 min 122.50
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our ‘Hj-% H120.00
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3.4.1 Custom Bar Sizes

Feb-02 10:49:25

W ave

.

MotiveWave™ comes with a default set of bar sizes, but you can create your own bar sizes from the
Preferences Dialog (Configure -> Preferences from the Console menu bar). You can create second based
bars provided you have access to historical tick data.

Custom Bar Sizes

e

General Theme [EeGE

Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Crders Alerts Email

Preferences

x

=

Chart Settings Indicators Labels Templates Options Bar Size Selector

Add | Remove

Click to add a
new bar size.

5 min
10 min
15 min
20 min
30 min
45 min
1 hour
90 min
2 hour
3 hour
4 hour
5 hour
& hour
8 hour
10 hour
12 hour
1 day
2 day

r \\‘

Bar Sizes can also be
removed to reduce clutter.

This panel allows you to configure the available bar sizes for each chart.

+

Interval Type: = Minute

Interval: 15 =

New Bar Size

Please enter the new bar size below by choosing a time interval
(Month, Week, Day, Hour, Minute) and a i

-

X

Choose the Interval Type
(second, minute, hour, day)
and select the interval.

oK Cancel |

OK

Apply

Cancel
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3.4.2 Bar Size Selector

The Bar Size Selector is a convenient way access common bar sizes by simply clicking on one of the tabs
at the bottom of the chart. The Bar Size Selector is visible by default on all charts. If you would like to
hide this, choose View -> Display -> Bar Size Selector from the top menu bar to toggle its visibility. (Note:
the default behavior can modified in the Preferences dialog, click on Chart the on Options, see Show
Bar Size Selector option).

o

You can configure the tabs available in the Bar Size Selector by right clicking on one of the tabs and
choosing Configure. You can put any type of bar size in the selector. For example you could have
Range(3) or Constant Volume(500).

Configure Bar Size Selector

1
ct-19 MNov-2016 MNov-09
15min - 20min 30 min 45 min

SDAQ (21)

Right click on a tab and
L INLchoose Configure

T Alerts | = Top 50 Stocks (10) x | +

1 hour 2 hour 6 hour

1 1 1
ec-19 Jan-2017 Jan-11  Jan-20

itPr... Last Time High

Low

1: Canfigure ?th e
=y Remove Bar Size E Indices
Mext Bar Size Shift+—  §

Open Close ( preyipus Bar Size Shift+— | |

o

General Theme [JeEN

Preferences

Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email -

x

Chart Seitings Indicators Labels Templates Options Bar Sizes JEEIgSrR Swivg

Add

Reset

1 min

50
10
15
20

Use the Add/Remove buttons
to configure the tabs available
in the Bar Size Selector

This panel allows you to customize the bar sizes available in the Bar Size Selector.

30 min
45 min
1 hour
2 hour
6 hour

1 day

1 week
2 week
1 menth
3 month

F

Bar Size:

Interval Type:

Linear

Minute

Add Bar Size

Select the type of bar size and parameters below.

-

-

Interval:

Cancel

Choose the Bar Size type
and settings. Any bar size
type is allowed.

OK || Apply Cancel

The Bar Size Selector also has some buttons on the right hand side (configurable in Preferences). These
can be convenient for the following (in order from left to right):

1.

nkwn

Toggle Semi-Log Scale — Toggles semi-log scaling
Choose Study Template — Allows you to choose a study template
Toggle Birds Eye View — Toggles the display of the Birds Eye View
Display Time Frame — Choose a specific time frame to display on the chart (ie 2 week, 1 day etc)
Go To Date — Go to a specific date in history
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Bar Size Selector Buttons

lwﬂ*ﬂ

mﬁﬁ Hﬂ-ﬁ]”u ||

4

2 Days
This Wee
1 Week
2 Weeks
This Mon'
1 Month
2 Months
3 Months
6 Months
This Year
1 Year

2 Years
5 Years
10 Years
15 Years
| 20 Years

!

|wDl

Toggle Birds

Choose Template Eye View

I I
Jul-2016 Sep-2016 Toggle Semi-
r [ 1week 2week 1 month | Log Scale

Choose Time
Span

3.5 Importing Data

Historical data may be imported into MotiveWave™ by choosing File -> Import Data from the top menu
bar (File -> Chart -> Import Data from the Console menu bar). Two types of data formats are supported:

1. CSV - Comma Separated Values. This is a very common format for many historical data services.
The format of the data file will be automatically detected when specifying files of this type.

2. MetaStock™ Database — MetaStock™ Database files containing 1 or more instruments may be
imported into MotiveWave’s historical database.

This dialog has the following elements:

1. Data Files — Specify one or more data files by clicking on the Add button to left of the Data Files

list.

2. Time Zone — Choose the time zone for the input file. This is important for resolving the
data/time values for each historical price bar in the input file.

w

Exchange — Optionally Choose the Exchange for the instrument(s) in the input file(s).

4. Trading Hours — If a value is chosen for Trading Hours, it will be assigned to the instrument when
it is created from this dialog.

5. Adjust for Stock Splits — If the file does not contain split adjusted values, this will detect and
adjust historical prices for splits.

6. Automatically Create Instrument (Do Not Prompt) — If the instrument does not already exist in
the local database, it will be automatically created if this is checked.

7. Replace Existing Data — Replaces data that is already in the local historical database.

8. Monitor Input File For Changes — If checked, MotiveWave™ will monitor the timestamp on the
input file to see if it changes in the future. If it does change, the new data will be automatically
loaded into MotiveWave™ when a chart is loaded.
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g Import Data X

This dialog allows you to import data from a MetaStock Database, CSV or ASCII file.

Data Files: p
Click here to add 1 Add -
or more data files

Time Zone: | America/New_York - Use Default

Exchange: @ -Select Exchange- ~ || +

Trading Hours: | -Select Trading Hours- ~ || +

v/| Adjust for Stock Splits (Stocks Only) Replace Existing Data

Automatically Create Instument (Do Not Prompt) || Monitor Input File for Changes

3.6 Exporting Data

Historical data may be exported from MotiveWave™ in several different formats. Choose File -> Export
Data from the top menu bar (File -> Chart -> Export Data from the Console menu bar). This dialog has
the following elements:

1. Symbol — Choose the instrument that you would like to export. By default this is the instrument
from the chart where the dialog was launched.
2. Bar Size — Choose the Bar Size for the historical data
3. Bar Count — Number of Bars to Export. Choose All Available to export all available data in the
historical database
4. Regular Trading Hours (RTH) Data — Check this to only include bars that are part of the regular
trading session
5. Data File — Click on the Browse button to the right to choose the data file where the data will be
saved.
6. Format — Choose the Export Format
a. CSV-yyyy™mMdd HHmmss,O,H,L,C,V
b. CSV-dd/MM/yyyy HH:mm:ss,O,H,L,C,V
c. Ninja Trader — Start Of Bar Time
d. Ninja Trader — End Of Bar Time
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Symbol: |V v | Q
Bar Size: 1 min -

Bar Count: All Available

v/ | Regular Trading Hours (RTH) Data

Chart Data
|
Data File: = C:\Users\Tony\Desktop\AAPL - 1 min - RTH.csv Browse
Format. | CSV - yyyyMMdd HHmmss, O, H,L,.C.V -

Ok Cancel

3.7 Bird’s Eye View

The Birds Eye View provides a convenient way to view the larger picture of the available historical data.
Choose View -> Display -> Bird’s Eye View from the top menu bar to toggle the display of this feature.

The Bird’s Eye View is displayed at the bottom of the chart. The highlighted area (transparent yellow
area) illustrates the data that is currently visible in the chart. You can click and drag this area to the
left/right to move the visible area. The width of the highlighted area depends on the bar width for the
chart. If you would like to change the width, click and drag the time axis.

Bird’s Eye View

[V

Drag the divider up/down
to change the height

105.00

U | i |
| *Ij'l'u i 100.00

95.00

Click and drag the time axis
to change the size of the
highlighted area below

Highlighted area shows
what is visible in the
chart. Click an drag to
X change the visible data.
Nov-2016 Jar=zuTT =

MotiveWave -
. L N L . !
Jul-2015 Sep-2015 Nov-2015 JanVS Mar-2016 May-2016 Jul-2b45 Sep-2016

X 100.00
This graph shows closing prices 50.00
for historical data available in
200 200312000 [2005| the local database. o9 |2010 2011|212 201 2016 0.00
imin S5min 10min 15 min 20 min 6hour 1week 2week 1 month 3 Toggles the display of x @ |~ A
lil Home X Ll Charts .8 Account |3 Scan (i Optimize News  + the Birds Eye view m O

3.8 Cursor Data

Cursor Data refers to the data points and their values at the current position of the mouse cursor. There
are several different ways to view cursor data.

3.8.1 Cursor Data Window

The Cursor Data Window is a separate window that displays data at the current mouse location. This
window works across all charts. This window may be opened by choosing View -> Display -> Cursor Data
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Window from the top menu bar. For convenience this window is always displayed on top of other

windows.
Cursor Data Window
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the cursor is located.
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3.8.2 Cursor Data Panel

The Cursor Data Panel is essentially the same as the Cursor Data Window except that it is a panel inside
of the chart. This panel only works for the enclosing chart. To open this panel, choose View -> Cursor
Data from the top menu bar.

Cursor Data Panel

i B
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3.8.3 Bar Status

Data on the selected price bar can be found in the status bar at the bottom of the window. This reflects
the price bar at the position of the mouse cursor.

e

Information for the bar

at the mouse cursor is
displayed here.

e n :

Bar Status
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1
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Mar-27 2016,172.56 0:231.61 H:247 .90 L:225.00 C:237.59 V:35.8M R:22 90

3.8.4 Hover Popup

A popup will be displayed with information about the price bar if you place the mouse cursor over a
price bar and leave it there for about 2 seconds.

3.8.5 Cross Hair

T#+UTH+I$¢“¢"

[ A

Price Bar Hover Popup

-~

)

Place the mouse cursor
over a price bar and
leave it for 2 seconds
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The cross hair feature draws thin horizontal and vertical lines at the current mouse cursor location to
indicate the vertical axis and time axis values.
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There are several configuration options for the cross hair. These can be found under the Chart ->
Options tab of the Preferences dialog (Configure -> Preferences from the Console menu bar).

Cross Hair Preferences

Lo

General Theme @kl

Tool Bar

Preferences

Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email

X

=

Chart Seitings Indicators Labels Templates Bar Sizes Bar Size Selector

v/| Show Extended Data

Show Instrument Title

The fields below allow you to adjust the.dafault cattinas for charte

v/| Double Cross Hair

Solid Cross Hair

Show Cross Hair

Global Cross Hair

v/| Snap Open/Close v/ Auto Scale
Show Components Panel Auto Scale Price Only
Show Trade Panel Semi Log Scale
Show DOM Panel Lock Scroll
Show Grid k Studies

v/| Show Major 7] €r0ss Hair Options B 15 on select

v/| Show Chart Buttons |"Show Info
Show P/L Ladder v/| Show Range Outline
Show Exchange Show Middle Line

v/| Show Symbol v'| Show Menu Bar

/| Show Bar Size /| Show Tool Bar

v/| Show Analylsis Name v/| Show Status Bar

v/| Confirm on Close

v/ Link Minimize/Restore

OK || Apply

v
v/ Show Bar Size Selector

Expand Status Bar Link

Show Bird's Eye View
v/ Show Bird's Eye Lines
Resolve Trend Lines
Group Studies
v/ Show Study Labels
Study Bar Updates
v/| Study Dock Long Names
Use Account Position
Show Values In Legend
v
v

v/ Draw Candle Qutline

simple Study Title

Overlay Volume

v/| Auto Load Studies

Cancel
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3.8.5.1 Global Cross Hair

The Global Cross Hair provides a convenient way to locate the mouse cursor position between several
different charts that are displaying the same instrument. This option can be enabled in the Preferences

dialog (see previous section).

In the following screen shot you will notice that the current location of

the mouse cursor in one chart adjusts the cross hair location in the other charts that show the same

instrument.
Global Cross Hair
~ MotiveWave - Console (google) o3 I
File Edit View Study Sirategy Format Configure Window Help
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i “ Cursor placed here is g ?l' HDD‘T
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& GOOGL - 1 hour l 3 & GOOGL - 1day 3
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il % -
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" ‘ Ha30.00 A] ' Il] !
! ?"lu'*nmuqllﬁ L ﬂ | +ﬁ ] ﬁﬂﬁiﬂ !' F | 177500
———————————————————————————— 822.19 i
1 W“l TEM
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1min 5min 10min  15min  20min 30 min 45min | 1 hour >* = vy @ |4+ B | 15min 20min 30 min 45min  1hour 2hour 6hour | 1day 7 = vy @ |« B
LWl Home  Lul Charts X [8 Account [g Scan  flf Optimize News + mE O

10:27,622.00 0:621.75 H:621.84 L:821.35 C:821.35 V:2.6K R:0.49

Feb-02 11:45:40

3.9 Time & Sales

The Time & Sales panel shows historical ticks for the selected instrument. The data and columns
available in this panel will depend on the broker or data service that you have chosen. The following
example shows the Time & Sales panel for the e-Mini S&P contract:
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Time & Sales Panel

MotiveWave - Console (CQG2)

1figure  Window  Help
w~vQ v + "5 T|&~|15min

|
.*i+ T o

ey - ¢ X
Click here to show/hide
- the time&sales panel IR«
Z = = A~
Rows: | 100 4| CEJL O X
_53% %Q Time Price Bid Ask Volume AskT.a +
:—'5' 11:49:26 227350 227350 227375 1 N
11:4926 227350 227350 227375 2 N
d2278.00 11:49:26 227350 227350 227375 13 N
] 11:49:26 227375 227350 227375 1 Y
] 11:49:26 227350 5227350 227375 15 N
h Historical Ticks E.DD 11:49:26 227375 127350 227375 1Y
- 11:49:26 227350 207350 227375 2 N
11:49:25 22735 ama ama—=s 1 N
‘%"mj 114925 227375 Red/Blue colors 1y
,2273.50 Crmom EEeEl indicate if the tick was = -
] o 1 Aill at the Ask (blue) or
] 11:49:25  2273.5( i 2 N
[12972.00 at the Bid (red)
] 11:49:25 22735 1 N
11:49:24 227350 2273507 227375 13 N
_:2270.00 11:49:24 227375 227350 §,2273.75 1 Y
1 11:49:24 227350 227350 227375 19 N
11:49:24 227350 227350 2273.75 1 N
oogso0 | 114924 227350 227350 227375 i N

For convenience, a button is available on the tool bar to toggle the display of this panel. Alternatively
choose View -> Display -> Time & Sales Panel from the top menu bar.

3.10 Depth Of Market (DOM) Panel

The Depth Of Market (DOM) panel shows a tabular view of the current bid and ask sizes. Choose View -
> Display -> DOM Panel from the top menu bar to show or hide this panel on a chart. For convenience a
toggle button is also available on the tool bar. For details on how to use the DOM panel see Depth Of

Market section.
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MotiveWave - Console (CQG2) bR o X
ormat  Configure  Window  Help Click here to toggle the
K 2le-Q §~ + F[Ee~(15mn |4~ dselayolthe DOV PSS D @ &
ERE
1 | Limit Order - 1 %)= 18 & %
1 12 35 10 15 20
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1 50.00 2273.50 1169 14.4K
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I ' d‘j doo7000 | 3750 1269 227175 Last Trade 19.0K
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] -100.00 998 2270.50 8220
f2266.00 | -112.50 1118 227025 9247
] 10.5K 20 105K
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Feb-02 11:54:25

3.11 Chart Labels

Chart labels display information on the Price Plot of the chart.

corners. The following example shows some chart labels:

These labels can appear in any of the 4
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il SPX500 - Primary Analysis - 15 min T I S
File Edit View Study Strategy Format Window Help
SPX500 |~ | Q| W - S o [ W~ 2w~ Q& I~ M~ + "B[T|2~[15mn ~ | »
SPX5001- 15 min D H:2283.3 L:2268.0 Bar: 14:11
i 22850
Daily High/Low Time Remaining
in Last Bar r]2286.0
H2284 .0
22833
‘ H2282.0

|
| .

l '[J n H2278.0
ﬂ | $+ Labels may be displayed in any of 1
T * the 4 corners of the chart. The U
l+ ﬂ ' [j| order, color, font etc can also be 0
!ﬂ " *I customized. ﬂ H2274.0

Y.
lJJ Date/Time
PL:0.70 4:% Current Unrealized P/L !ﬁﬁﬂ Tl'nﬂlu?*ﬁﬁ !ﬁlﬁn 22700

02/02/2017 1:30 PM

1 1 1 1 1 T 1 1 1 1 1 1 1 1 1 T
Feb-2017 3:00 500 7:00 500 12:00 14:00 16:00 20:00 22:00 Feb-02 2:00 4:00 6:00 8:00 10:00 12:00 1400

Amin 5min 10min  15min 20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month ==, = ey @ =l B
[ ] 6:30,2274 5 02272 1 H:22731 L2271 9 C22719V 40 R:1.2 Feb-02 13:30:48

You can configure the labels displayed on a chart from the Chart Settings dialog (double click on the
chart). You will find the labels under the Labels tab:

Chart Label Settings

o Chart Settings X
General Scaling Bar Settings Theme Display BELEER Watermark Trade Elliott Wave
The list below shows the labels that are displayed on the price graph (such as Spread, Day Range efc).
Available Labels Labels
13 Week High Buy Button |
13 Week Low Sell Button Adjust the order here
26 Week High Day High to change the order
26 Week Low Day Low displayed on the chart.
52 Week High Bar Countdown
52 Week Low Date/Time
ATR Profit/Loss
Account
Ask Price
Bid Price Chart Label: Bar Countdown X
Change 1+
The fields below allow you to adjust the settings for the chart label.
Change % I
Cursor Close Label Prefix:  Bar
Cursor High Location: = Top Right -
Cursor Low . .
c 0 Outline:  MNone - Specific properties of the
ursor Pen label can be configured in
Cursor Price Border: this dialog. {Double click on
Cursor Time Text Color V| Use Defg |abel or select and press the
Cusor Volume Edit button on the right).
Date Fill Color
Day Close Font: Arial Bold;12.0 v/| Use Default
Day Open
Day Range Cancel
Day Range % ‘ |
Nividand Data
OK Save Defaults Reset Defaults Cancel
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Double click on one of the labels in the right hand box (or select and press the edit button, ie pencil icon)
to edit the properties of the label (see embedded dialog above). From there you can choose which
corner to display the label and adjust the color, font etc. The order in which the labels are displayed is
determined using the up/down arrow buttons in the Chart Settings dialog (see above).

3.12 News

If supported by your Broker/Data Service, news articles specific to the instrument can be displayed on
the chart by showing the News Headlines panel. Choose View -> Display -> News Headlines from the
top menu bar.

News Headlines Panel

&~ MotiveWave - Console (goog) Ho- X
File Edit | View | Study Strategy Format Configure Window Help
MSFT = Link » W~ & i~ + "B[T &~ |15min - Ame | oSN
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& Cursor Data Alt+D 7 Time & Sales Panel ) ) ] 6550
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# Auto Analyze F& News Vie®er T
Lock Scroll v BarSize Selector li !
214 Lock Studies @ Bird's Eye View !
i o o500
k= Group Studies & Cursor Data Window T I+Q lID i
VIl Show Volume Bl Study Log !
@ Increase Hide Below Degree  Ctri+1 L Object Viewer Alt+V :
& Decrease Hide Below Degree Ctri+| I Alert History Window ! 5ﬁ| i Q*D 1 H64.50
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(' Clear Local Data + ™ Show Commentary 1
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 Compact F7
K&
! F# ++“ T v Menu Bar H } +{"
| D !l L) ! v Tool Bar ! ﬁﬂ * I
i |i Vv Slatus Bar | 1 'HW
[ *T . '
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! ! '
*n H H ! !
#D : ! : i ﬁl‘
| g | ” n” ﬂ i 'téﬂ*“ﬂ
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imin 5Smin 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1monih 3 month = v @ |4+ &2
X tChIiCk herel to hide Released v Source &
is panel. Click headline to vi
017-02-02 11:50 EST Sports Perspectives Microsoft Corporation (MSFT) Rating Increasq . o o o0 ne TOVIEW g
in your web browser or
MSFT]AMZN 2017-02-02 11:30 EST Investorplace.com 3 Big Stock Charts for Thursday: Microsoft C{ neows Viewer. Inc
MSFT 2017-02-01 13:45 EST Seeking Alpha Watch Microsoft In 2017
MSFT 2017-01-31 12:03 EST Investerplace.com Is Microsoft Corporation (MSFT) Resurrecting the Cursed Windows RT?
w |MSFT 2017-01-30 05:34 EST Seeking Alpha Microsoft Is Very Likely To Fall Now
E MSFT 2017-01-29 10:15 EST Library For Smart Investors Published Patent Suggests Microsoft Corporation (NASDAQ:MSFT) Might Be ...
Ll Home % Lil Charis 8 Account  [& Scan  {lf Optimize News  + i W

Feb-02 13:42:01

If you click on a headline in the news headlines panel, it will display the news article in the internal news
viewer by default. If you right click on the headline, you can optionally display the news article in your
web browser.

WH“ M ,.-'.nn.ii',.n|ﬂlJ‘ETl’Iﬂlninnﬂlgmllll_r;ﬂﬂlllﬂI

~ Show News Article

| [ W
m“n" Talli ﬂﬂimhm,l nn.uﬂﬂnllhhlﬂﬂnﬂ!:inn )

M‘Wﬁnﬂnﬂ’ll‘ snataafall

In 5,|ﬂ||'| Ty

vETs
Jan25 1200 1400 Jan-26 1200 14.00 Jan-27 1200 1400 Jan-30  12:00 14:00 Jan-31 1200 Feb-2017 1200 1400 Feb02 1200 1400 1600 1600
1min Smin 10min 15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1menth 3month = v @ &~ @
x Symbols Released v Source Headline *
MSFT 2017-02-02 11:50 EST Sports Pel cjick to show in Microsoft Corpg Right click to choose to open in - Neutral at Atlantic Securities [ ]
3 Big Stock Cha Browser orthe News Viewer  Lyion (MsFT), Amazon.com, Inc ...

MSFTIAMZN 2017-02-02 11:30 EST Investerp| News Viewer
MSFT 2017-02-01 13:45 EST p

2017-01-31 12:03 EST Investorplace.com Is Microsoft ClEIRLE=eVEE Ik esurrecting the Cursed
MSFT 2017-01-30 05:34 EST Seeking Alpha Microsoft Is ' SNOW In Viewer oy

MSFT 2017-01-29 10:15 EST Library For Smart Investors Published Patent Suggests Microsoft Corporation (NASDAQ:MSFT) Might Be ...

Watch Microsoft In 20

Windows RT?

Home X lul Charts .8 Account  [&f Scan  {lf Optimize News  + LK
Feb-02 13:45.09

The foIIowing screen shot shows an example of displaying a news article in the News Viewer:

w
=
3
=z

Ll
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M  MotiveWave
=/

News Viewer

il InvestorPlace Menu ¥

din|vlc|=]s

Is Microsoft Corporation (MSFT) Resurrecting the
Cursed Windows RT?

Don't look now, but Windows RT just might be back as Windows 10 Cloud

By Brad Moon, InvestorPlace Contributor | Jan 31, 2017, 12:10 pm EST

Don’t look now, but Microsoft Corporation (NASDAQ:MSFT) looks to be taking another run at
Alphabet Inc’s (NASDAQ.GOOGL, NASDAQ:GOOQG) Chrome operating system. References
have begun popping up in builds of the Windows 10 Creators Update (which is due to arrive in
April) to Windows 10 Cloud.

Speculation is growing that Windows 10 Cloud is in = Soures: Micrasolt
fact a new simplified version of Microsoft’s operating = |
system, designed to run on devices powered by

S\ News Viewer - Is Microsoft Corporation (MWSFT) Resurrecting the Cursed Windows RT? - W X
Forward > http:/finvestorplace.com/2017/01/microsoft-windows-10-cloud/ Go
Protect Your Business Now (i

(Cost Effective Frotection Again omwere &

Other Zero-Day Exploita. Go to

3.13 Watermark

The Watermark feature in MotiveWave™ enables you to display a semi-transparent label with the
instrument’s symbol and/or description. You can also choose the location and font of this label. The
watermark can be configured from the Chart Settings dialog, see Watermark tab.

Watermark Settings

Chart Settings
[Settings Theme Display Labels BUEIGEERE Trade Elliott Wave

Click here to enable
the Watermark

1ons below allow you to configure the symbol to be shown as a watermark on the price chart.

v | Show Watermark

Opacity determines
how transparent the

Opacity:
Location: | Center - Choose t}-'we location
on the price plot.
Color V| Use De

: 1 * | |v| Enabled
Sapeoiont Arl al — These options allow you to

. R choose to display the
Description Fent: Arjal Bold 52 ErEEE Symbol and/or Description

OK Save Defaults Reset Defaults Cancel

The following screen shot shows the watermark description for Microsoft:

Analyze. Trade. Evolve
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3.14 Scaling

Several different scaling options are available for scaling the price/time range of the price plot. By
default the chart price range is automatically scaled from the visible data and components (Auto Scale).
The following are the available scaling options:

1. Auto Scale — Price range is adjusted according to visible data and visible components (optionally,
only the data range can be considered). This option will lock the vertical movement of the chart.

2. Price Range — This option keeps the price range constant and enables you to manually move the
graph up/down.

3. Square — This option will set a fixed number of points per bar width. If the bar width is expanded
(or contracted) the price range will be updated to reflect.

Scaling options can be found under the Scaling tab of the Chart Settings dialog.
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Scaling Options
o Chart Settings x

GsneraIE\arSEﬂings Theme Display Labels Watermark Trade Elliott Wave

Choose the scaling type and settings below. This = at chart
Scale Type: | Auto Scale - Choose t.he Scale Type: Auto
Scale, Price Range, Square

Auto Scale Price Only

Top Inset (pixelsy: [ 5 3 Options available will
Bottom Inset (pixels): depend on the Scale Type

¥ |4

4

Save Defaults Reset Defaults Cancel

3.15 Analyses

MotiveWave™ employs the concept of an Analysis to encapsulate the work that you have done in a
chart to analyze price movement. An analysis will contain the following types of information:

1. Components —any components that you have added to the chart including: trend lines, Elliott
Waves, Gann components, Gartley patterns, commentary etc

2. Studies — Any studies that you have added to the chart

3. Time/Price Guides — These are guides that you have added to the horizontal or vertical axes.

It is important to understand that an analysis is a separate entity from a chart. A chart is a view or an
analysis file. This is an important distinction and is fundamental to the underlying design of
MotiveWave™. While this concept may seem a little confusing at first, it has numerous advantages:

1. View in Multiple Time Frames — A single analysis can be viewed at multiple time frames
simultaneously. You can have several open charts that reference the same analysis and edit
them from each chart.

2. Alternate Analyses — Each instrument can have any number of analyses. The name of an analysis

is scoped to the instrument so it does not have to be unique across symbols.

Saved in Repository — You can save an analysis and load it later after the chart has been closed

4. Share with other People — Analyses can be exported in XML format and shared with your friends.
You can also share analyses using the Analysis Sources feature.

w

The following diagram illustrates the relationship between charts and analyses. Each instrument may
have multiple analyses which are saved in the local database (repository). When you open a chart, you
are opening an analysis. MotiveWave™ allows you to open an analysis from more than one chart at the
same time. Changes made in either chart are synchronized between the two so you do not have to
worry about overwriting you modifications.

Version 5.0 ©2017 MotiveWave™ Software Page 71 of 213



MotiveWave™ / MotiveW
User's Guide By o

Charts and Analyses

r/r'u!'b.r'«::rlvcs.l::atr.*«ve.l A

Instrument 1 — Instrument 1 — Instrument 2 — Instrument 2 —
Primary Analysis Alternate 1 Primary Analysis Primary Analysis
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Y : ﬁ 'lll = -~
opent chart open chart open'chart open_.chart
\ ; | e
g / | -
Instmrﬁent 1 / Instrument2 -~

Primary L]

Primary Altemate Alternate }
Analysis

Analysis 1

Analysis nan;e;s ?r:a R@.‘a-.rad ) savfad _, Saved analysis (but
) scoped o the > not currently open)
instrument (names -~ Analysls Files

may be reused

Local Database

Import ! Export
(xml format)

3.15.1 Creating a New Analysis

The default analysis for any instrument is called the Primary Analysis. Whenever you open a chart for
the first time, it will open the Primary Analysis. The net effect of this behavior is that all changes
between the open charts for that instrument will be synchronized between them.

If you do not want these changes to be synchronized, you can create one or more Alternate Analyses.

There are several ways to do this; perhaps the most convenient is to use the New Analysis button on the

tool bar.
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New Analysis

il MSFT - Primary Analysis - 15 min*®
File Edit View Study Strategy Format Window Help
MSFT Mol N A o] K 2wy 1~ +°

Mew Analysis

Click this button to
create a new analysis.

WO gty |l
Ut X: Tlmu

The following dialog will appear when you create a new analysis. Enter a name for the analysis. By
default, analyses are named Alternate 1, Alternate 2 etc. You can however choose any name you like for
the analysis. A new analysis may be empty (just price bars) or you can base an analysis on an existing
analysis by choosing one from the Based On drop down.

New Analysis Dialog

[ ] New Analysis - Microsoft Corporation X
This dialog allqws you to create a n
Corporation. Wyou select an existij By default analyses are named

down, the contents of that analysis
Click the Empty check box to cre

'Alternate 1', "Alternate 2" etc,
but you can choose whatever

name you like.

Name: | JAlternate 1 i
Empty | Use these options to copy
Based On: | Primary Analysis = | an existing analysis as a

| starting point.

OK || Cancel |

Once you have created the new analysis, the chart will display a set of tabs at the top where the active
tab is named with the new analysis.

Chart with New Analysis
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Primary Analysis 15m |Altemate 115m x | =
. ! T
MSFT (Alternate 1}- 15 min | ! 6600
I
m+n* , Newly created analysis is !
u !5 displayed in a separate tab !
Analysis name is ! H65.50
displayed as part !
of the title !
My i g |
T, ™, H i 6500
T[P AT I'[| |
El |
+ i
f'ml D*T'IDI ¢D*DI | de4.50
TLL ++i
I
I
I
! ﬂ. 46400
| *I +
| + '
g Wt
I
| LT
I
I
: [J‘ f
I
‘ T ¥
1 : Nl
I
Motlvetave, . . ‘ | . ‘ ‘ . ‘
14:00 Jan-30 12:00 14:00 Jan-31 12:00 Feb-2017 12:00 14:00 Feb-02 12:00  14:00 16:00
imin Smin 10min [ 15min 20min 30min 45min 1hour 2hour 6hour 1day >4 = vy @ ¢l B

Feb-02 14:06:24
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3.15.2 Open Existing Analysis

If you want to quickly open an analysis, just click on the small black triangle next to the open button on
the tool bar. Alternatively, choose File -> Open/Manage Analyses from the top menu bar (File -> Chart -
> Open/Manage Analyses from the Console menu bar).

Open Analysis

KA

ol M S sis - 15 min ew -
Fle Edit View Study Strategy Chckontheblack £

triangle here. _
MSFT ~ Q| K E =~ +Q U~ + " I|&~|15min -

FT-15min | Afternate 1 . l
m;m-w”i w i v Phinary Analysis g
D m ’D i New Analysis | Select the analysis
& Import Analysis  Ctri+K | | you want to open
- Manage Analyses | from the drop down.
il 1
l *[;]Tli i i :
(| R H ! i
1 |
1 |
+|A]i " ) i

3.15.3 Manage Analyses

The Manage Analyses dialog allows you to open, export, rename, delete or create new analyses for the
given instrument. This dialog can be access from the menu bar: File -> Open/Manage Analyses from the
top menu bar (File -> Chart -> Open/Manage Analyses from the Console menu bar).

Manage Analyses Dialog
= Analyses - MSFT X

The list below contains the available analyses for this instrument. From here,
you can create, rename and remove analyses using the buttons below.

Name Last Updated *
Alternate 1 Feb-02 14:06
Primary Analysis I,\\;- Feb-02 14:06

Click on an analysis and
use the buttons below.

New Analysis Open Export Rename Delete Close

3.15.4 Import/Export Analyses
Import and export are very valuable tools for sharing your analysis with another MotiveWave™ user.

When you export an analysis file, the file will contain all of the information related to your analysis as
well as information about the instrument. The exported file will be in JSON format and will have an
extension of .mwml (MotiveWave Markup Language).

Choose File -> Export Analysis from the top menu bar (File -> Chart -> Export Analysis from the Console)
to open the Export Analysis dialog. By default the analysis file will be saved on your computer desktop in
the form <Symbol> — <Analysis Name>.mwml. You may change this name and location if you like. Click
on the Save button to export the analysis to the selected file.
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Export Analysis Dialog

Search Desktop

Date modified

31242,

f2012 57 PM
f202 1:29 PM
2016 1:51 PM

2016 11:25 AM

4/23/2016 11:00 AM

Click Save to

Export Analysis
4 B > ThisPC » Desktop > v B
Organize » MNew folder
[ Documents # ~  Name By default the file is saved
to your Deskto
; Downloads o anal Y P
&= | Pictures - Archive
cursars Certs
FXCM Test docs
install FACM Test N
GIMP /1
MotiveWave :
iStock Photos /2
@ OneDrive
Default name for
[ This PC the Analysis File
[ Desktop
File name: | MSFT.MASDAQ - Alternate 1

create the

Save as type! | Analysis Files

» Hide Folders

analysis file

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder

File folder

~\N

Cancel

Similarly, to import an analysis file, choose File -> Import Analysis from the top menu bar (File -> Chart ->
Import Analysis from the Console) to display the Import Analysis dialog. Locate the analysis file, select it
and press the Open button. If the chart you are currently using has the same instrument as the imported
analysis file, it will be opened in another analysis tab. If the instrument does not match the chart, a
message dialog will be displayed indicating that the import was successful and how to open the

imported file.

Import Analysis Dialog

Select an Analysis File to Import

4 Wl » ThisPC » Desktop » v O
Organize = Mew folder
~
[ Desktop AN Name
E Documents process explorer
‘ Downloads Receipts
&=/ Pictures b g repe
cursors repository
FXCM Test Stock Images
TA Analyses
install .
Taxes Select the file
MotiveWave Transact to import
@& OneDrive -$ Downloads
[ ] MSFT.NASDAQ - Rlternate 1.mwml
E This PC a1 My 5cans - Documents
I Desktop a1 My Scans - Pictures
|Z Decuments v oL

Search Desktop

X

e

= [ @

Date modified

/28/2012 2:32 PM

016 4:57 PM
116 11:52 AM

(232012 1:03 PM

2 1:27T PM

/202017 2:20 PM

F201411:19 AM

1
2/2015 11:39 AM

File name: | MSFT.MASDAQ - A

Click Open to
import the analysis

Analysis Files

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
File folder
Shortcut
MWML File
Shortcut
Shortcut

Cancel

~

L
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3.16 Components

Many different types of components can be added to a chart as part of your analysis. Examples of
components include Trend Lines, Price Labels, Channels, Commentary, Elliott Waves, and Markers.
Components can be added to a chart from the Components Panel or by using the Mouse Tools
(available from the tool bar).

3.16.1 Components Panel

The Components Panel organizes the available components in MotiveWave™. This panel is displayed

on the left hand side of the chart area and is organized into folders. You can hide this panel by clicking
on the ‘X’ in the top right corner of the panel. A toggle button is available on the right hand side of the
tool bar to show/hide this panel as well. Alternatively, choose View -> Display -> Components from the
top menu bar.

Components Panel

El

File Edit View Study Strategy Format Window

BRK.B - Primary Analysis - 15 min
Help

KA
¥y - X

BRKB =N ) W lewrQ v+ B[ @~[15mn - EEU RN Rl RONON -
Components X_BRK.B - 15min
¥ General ume 165.20
This button
e = Click "X to hide. shows/hides 165.00
Price Label Price Label the pane!
Y # -164.80
. I w *% J164.60
Support  Resistance H164.40
Zone Zone :

%I él 164.20

Time Label Time Label 1164.00

1163.80

Horizontal Extended
Line Horizontal
Line

+163.60

H163.40

i 16331

Vertical ~ Extended
Line Vertical
Line

H163.20

H163.00

» Basic ; [ | U|‘ e

» Commentary | Additional Component | U!IU M

» Markers [ ! l J1ez2.60

» Fibonacci i

T re— [T T———
L O | | T e e ) m L LL LT e

SELURETE 1200 1400 Jan27 1200 1400 Jan-30 _ 12:00 1400 Jan31 12.00 Feb-2017 1200 14.00 Feb02  12.00 14.00 16.00

» Gartley 1min Smin 10min  15min 20min 30 min  45min 1Thour 2hour 6hour 1day 1week 2week 1month >, = @y @ |#v B

Feb-02 14:22:57

3.16.2 Adding a Component

To add a component from the Components Panel, simply click and drag (using the left mouse button)
the component onto the chart area (see below). Alternatively, you can double click on a component, or
right click and choose Add To -> <Graph> to add it to the center of the chart.
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comprrs - oo
Sr |
L -{U W

Click and drag to
the chart area

T

Time Label Time Label

&

i

Release the mouse
button where you

- - want to place it
Horizontal Extended
Line  Horizontal : * ‘
Line i UT
I I ! ! !
Vertical  Extended i i :
Line Vertical i 1 i

Mouse Tools are available for some of the more common components. In some case these tools can be
more convenient than using the Components Panel. These mouse tools can be found under the Tools
dropdown on the tool bar. You can customize the tool bar to make certain mouse tools more
convenient to access. Short-cut keys are also available to quickly select tools. These keys typically take
the form of Ctrl + Shift + <Key> (see tool menu for key combinations, Note: on Mac OS X use Cmd

instead of Ctrl.)

Tools Dropdown

il BRK.B - Primary Analysis - 15 min®
File Edit View Study Sirategy Format Window Help
BRK.B ~Qlh &R &Y B W wrQ i~ + "I 2~[15mn ¥ A K|S =
Components X BRK.B -15min k Select Cir+Shift+5 | :
e e Volume W Drag Ctrl+Shift+D |
This is the tools drop (?‘ Zoom ClreShiitz i
1
= —= down. Click on the arrow % No Tool Cir+Shift+Y \
Price Labe! | EiisSiiE5e] to show available tools T Text Cirk+Shift+T.
Ruler Ctrl+Shift+U
T'H +U “\ Line Cirl+Shift+L .
- - l + < Eraser Ctri+Shift+E |
B - T Regression v |
S;ppo'l R&‘Z'E'tame T Fibonacci y 1
one one Elliott Wave v L Ai‘
Gartley I ' M Auto Gartley Cir+Shift+G
'?' é. # Channel Ctri+Shift+C A Auto ABCD
Time Label Time Label % Fork Ctri+Shift+F M Gartley
L Time Label M Bat
—= Price Label M Alternate Bat
_ _ ? £ Data Edit M, Buiterfly Ctrl+Shift+8
Horizontal Extended l Markers \ A}Q gl’ab Crab
Line Horizontal (_?ommemary ] 3 eep Cral .
Line 14534 ] I ![:]“T“ TI TfU' W, AB=CD Ctrl+Shift+=
: W Alternate AB=CD
! i w/ 3 Drives Ciri+Shiit+3
Vertical ~ Extended 1 w 50 Ctrl+Shift+5
Line Vertical | H L 1
Line 1 1 1
a Racir 1

N

The following example shows the usage of the Channel Tool to create a channel. This particular tool
requires three clicks to define the channel. Also the channel is drawn as you click the mouse.
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Ll CSCO - Primary Analysis - 15 min
File Edit View Study Strategy Format Window Help
csco  [rQ|E E R s-r@ Welgre i~ + TEl@~[15mn ~ L.
Components X |CSCO -15min i !
¥ General Velume I
Shows Active Tool | *
Price Label PHESIEEEE] Eirst Click i U
I
I
I
R N | TQ
Support  Resistance +lji H i
Zone Zone U ilj .
i
g4 U *
Time Label Time Label " ﬁl[:] i | 1‘# |
Ui Channel Tool
_ _ n h Three clicks are need to create +
. T 4’ the channel. The first two define *
Horizontal ~ Extended T the first line. The third places the *+ J] lu |
= Hortzlonla\ i second channel line. T H n}
ne l ﬁ |
. TU 5 — +' ﬂ |
Vertical ~ Extended i i u H Third click will
Line Vertical | ! create the
Line ' ' channel l
» Basic ! ' 7 |
» Commentary ! l
» Markers : : | !nﬂl‘ +
i i !
i I
» Fibonacci I ” H‘ “n! +q]

3.16.3 Selecting Components

You can select components on a chart by simply clicking on them with the left mouse button. When a

component is selected, you will typically see green resize points that indicate areas that you can move to
modify the component.

Select Component
I

I

I

I

I

I

i

Left click on a 1

\ component to select it. " j
X ¥ ]
é]Tl\ﬁ\ ‘

Green resize points
are displayed.

"Hw

ORCL - 15 min

If you want to select multiple components, simply hold down on the Shift key while clicking on other
components. The first component selected will have green resize points (primary component) and the
other components will display blue resize points (secondary components).
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MotiveWave

Primary component
has green points.

Select Multiple Components

o~ Seleciend type |
~ to edit byt E

Secondary components
have blue points.

53970
39.68
39.60

H40.40
H40.30
H40.20

H40.10

3999
% 39 87|
3985

H39.80

H39.50

Selecting multiple components can be useful if you want to move them as a group or delete them.
Some components such as trend lines have options from the right click menu (right mouse click) that
apply to the group. In the following example, you can make two (or more) lines parallel by selecting
them and choosing the “Make Lines Parallel” option from the right click menu. (Note: lines will be
drawn parallel to the primary component, ie the one selected first):

Hlmu“ =

Right click on the
selected component
to show menu.

T
+

Visibility
72 Create Alert

Show Info
Show Angle
Extend
[ﬂ Extend Left
Ratios

Line
Propeities

3.16.4 Deleting a Component

Deleting (removing) a component from a chart is straight forward. Simply click on the component to
select it and then press the ‘Delete’ key on the keyboard. Alternatively, right click on it and choose Edit

-> Delete.

Relative End Point

Make Lines Parallel

Ctrl+l

Ctri+E

L

N B

»

P

Pt

lﬁﬂ‘u

LYy

=¥= Show Midpoint
Circle Radius
Circle Diameter

4\ Flip Line

(' Rotate 90 Degrees

(' Rotate 45 Degrees

> Make Lijgs Parallel

This option will make
all selected lines

parallel to the primary
line (green points).

-40.40

54030

H40.20

If you want to delete all components from a chart, choose Edit -> Delete All from the top menu bar.
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3.16.5 Component Properties

Components may be modified from the Component Properties dialog and (in many cases) by using the
right click menu that is available via right click on a component. You can open the Properties dialog by
double clicking on a component or right click and choose Properties.

Accessing Component Properties

W ‘T””] — [
| ﬂ**‘llﬂM?I'U Hlmﬂﬂ\

 Show Fil ‘ Many of the properties

4 Show Middle Line Ctri+M can be changed from

‘< Flip Channel these menu options. ?ﬂm
Extend Ciri+E
Extend Left ﬁ— UJF [:] l 'm

il  Grte et
uU Y ‘u

ﬁ Ratios ]
1Y [y iy

2 O\

¥ 'U-m
Choose
Properties

i \

The following screen shot shows the Component Properties dialog for the Channel component. The
options available in this dialog will vary depending on what component you are editing.

Channel Properties Dialog
Channel Properties X

Format Visibility Ratios

Use the options below to change the display of the component.

Lines: 2 Lines A
Show Info
Show Angle
Show Middle Line
Extend
Extend Left

OK | Apply Save Defaults Cancel

3.16.5.1 Formatting

Formatting options such as color, font, line width/style, shading etc can be found under the Format tab
of the Properties dialog (double click on the component). For convenience several formatting options
are available on the tool bar for changing the component format. These buttons are context sensitive
and will apply to the selected component (see below). These buttons will appear inactive (greyed out) if
no component is selected.
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3.16.6 Working with Trend Lines

Trend lines are an important element of most all forms of market analysis. Several features are built
into MotiveWave™ to make working with trend lines easier.

Trend Lines can be created by using the Line Tool that is available from the tools drop down.

shil
File

AMZN
AMZ

Volu

Edit

N -1 day

me

quU

View

- Qlm

!

Tuﬂhlmgﬁm@

Study

Strategy
B E- @

Click here to see
the tools drop down

Format

*U'*|

[l

Selecting the Line Tool
AMZN - Primary Analysis - 1 day

TT

Window  Help
W Ee|lwrQ i~ + "B[T|2~]1day -
k Select CHr+Shilt+S
+/ W Drag Ctrl+Shift+D
@, Zoom Ctri+Shift+Z
¥ No Tool Ctri+Shift+Y
T Text Ctri+Shift+T
Ruler Ctri+Shift+U
~ Li%@ Ciri+Shift+L Select the "Line’ tool.
Hﬂl & Erdser Cirl+Shift+E Alternatively press
Regression g Ctrl + Shift + L keys
Fibonacci »
[J Elliott Wave v + ' !
*n Gartley g T !
ll,] %7 Channel Clri+Shift+C * i
% Fork Ctrl+Shift+F H l. i ‘ ﬁT+D’l
L Time Label L ' ﬁ ! i!ﬁ * !
—= Price Label
£ Data Edit D U
Markers b *
Commentary »

KA
'3

800.00

780.00

760.00

740.00

720.00

Creating a trend line requires two left mouse clicks. The first click defines the starting point for the line
and the second defines the end point. Once you have created the Trend Line, you can press the Space
bar to switch the tool back to the default Time Drag tool.
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ﬁA!LJ'!'lJrI U* Creating a Trend Line
T"’TH l'

Two left mouse clicks
will create a trend line.

I
I
I
I
I
I
I
|
I
I
I
I
I
I
I
I
I
I
|
I
I
I
I
i
T Cursor changes to
i the Line Tool cursor
I
I
I
I
I
I
I
I
I
|
I
I

When a trend line is selected it will display basic information about that trend line (such as the price
range and time span). You can adjust the line by moving the end points (green resize points). These
points will snap to key locations such as the top or bottom of price bars (hold down on the ‘Alt’ key to
disable this feature).

Adjusting a Trend Line

Hse0.00

§28.26)

T 84073
H J820.00

H800.00

780.00

' 1760.00

¥ Drag end point to i ]

: change its location : ]
. | 740.00

End point will
automatically snap to

End price points are shown

when line is selected. wlj
bar low and highs (see

‘|
red box outline) 1700.00

..'.'n'ﬂn.'nilnlnlﬂllﬂ”inﬂﬂnIn”n”IilI”Ii.lnﬂ“l-lﬂ”'ll|H"”I”nH|”I”ﬂn|ﬂh:"li|—”nnlh-lﬂll-lﬂl'lnhrl“ allll Rl Naulnnilndndin @

Common angles (such as horizontal, vertical, 45 degree etc) can be set by holding down on the Shift key
while moving one of the end points. Hold down on the Ctrl key while moving one of the end points to
maintain the current slope (angle) of the trend line.

H720.00
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Detailed information about the trend line can be found if you place the mouse cursor over the trend line
and leave it there for 2 seconds.

Trend Line Hover Popup

e i A B P P i A i P i A o et L e A

Place cursor
over line for 2
seconds

StarUEnd Prices

tart: 303 46
nd: 295.99 Range/Percent Move -J
TAT (-2.4616%)
_ 19 hour
Time Span and 76.6 hars
Price Bars May-14 7:44 - May161323

W e

Bt U M T I A T T A P B,

¥l

Several operations for working on trend lines can be found by right mouse clicking on the line to show
its context menu.

1.

Create Alert — Create an alert when the price crosses the trend line (see Component Alerts
section)

Show Info — Shows information about the trend line

Show Angle — Displays the angle of the trend line (in degrees)

Relative End Point — Calculates the end point relative to the start point instead of using a specific
time/value for the end point

Extend — Extends the Trend Line to the Right

Extend Left — Extends the Trend Line to the Left

Show Midpoint — displays the midpoint on the line

Flip Line — Flips the values on the start and end points

Circle Radius — Draws a circle using the trend line as the radius

. Circle Diameter — Draw a circle using the trend line as the diameter

. Rotate 90 Degrees — Rotates the trend line 90 degrees clock wise

. Rotate 45 Degrees — Rotates the trend line 45 degrees clock wise

. Make Lines Parallel — If you select multiple trend lines this will make them all parallel to the

primary line (the one with the green resize points)
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14. Make Lines Parallel and Equidistant — If you select multiple trend lines this will make them all
parallel to the primary line (the one with the green resize points) and equidistant between the

top and bottom lines.
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3.16.7 Custom Tools

Custom tools are based on existing mouse tools. A custom tool allows you to configure the default
properties of the component that is drawn using the tool. For example, you could create a custom trend

line tool that draws a blue dashed line (instead of a black solid line).

Custom tools can be created from the Preferences Dialog (Configure -> Preferences from the Console
menu bar). Click on Tool Bar, then on Custom Tools.
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Preferences

General Theme Chart Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email

-

Custom tools can be created based on existing tools. Click the add button below to create a new custom tool.

Click here to create
a new Custom Tool

OK | Apply Cancel

From the Custom Tools section, click on the add button (plus sign) to open the Add Custom Tool dialog.
The tool must be based on an existing tool, select this from the Base Tool drop down (Line tool in this
case). Optionally, you can change the color(s) for the tool icon (to make it more distinguishable). For
the purposes of this example we will choose blue as the primary icon color.

+ Add Custom Tool

Custom tools are based on an existing tool. Icon colors can be customized by
choosing new colors below. Click on the properties button below to customize
the settings for the component that will be created from using this tool.

Name: r Blue Dashed Line

Has ﬁ Choose the base \
I -

Icon Color 1:
Optionally, change
Icon Color 2: P . Y &
the icon colors.
lcon Color 3:

X

Customize Click on Customize to change
the properties of the
OK | Car component that will be created

Click the Customize button to open the Component Properties dialog and adjust the default settings. In
this case we would like to create a blue dashed line. This can be adjusted from the Format tab.
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Trend Line Properties

General Visibility Ratios

Use the options below to change the display of the component.

- — 0~ -]

Line:

Fill Color:

In our case, we want to
make a blue dashed line.

OK Cancel

After clicking the OK button in the two previous dialogs, you will see the custom tool added to the list

below:

Preferences X

o]

General Theme Chart Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email

-

Custom tools can be created based on existing tools. Click the add button below to create a new custom tool.

+

\\ Blue Dashed Line

Here is the custom
tool we just created

We changed the
primary color of the

icon to blue
-

L

sl P U P gl gl e P

The next step in using the custom tool is to add it to a tool bar so it can be accessed using the mouse.
Click on the Tool Bar tab to customize the tool bar. In this case we are going to customize the Top Tool

Bar to add our Blue Dashed Line tool to the left of our tools drop down.
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Py,

MotiveWave

“wamEREw--

o

General Theme Chart Sounds Ralios EllioltWave Gartiey TickCharts Orders Alerts Email

Preferences

X

-

Custom Tools Tool Groups

Use this panel to configure the actions available on the toolbar. Select the tool bar you wish to configure from the drop down.

Tool Bar: | Top ~ | |V/| Enabled
Available Actions: Tool Bar Actions:
+ Arrow Up Q, Quick Search
W, Auto ABCD Q, search for Instrument
M Auto Gartley { — Separator --
A Auto Wave B New Analysis
8 Balloon Callout = Save
g Bar Settings I§. Save As
M Bat & Open/Manage Analyses
Blue Dashed Line I8 Save As Image
B Bold f — Separator
[ Box -& ) Undo
= Box Callout - (™ Redo
{ — Separator -
Select the custom tool above and #{ Auto Analyze
click the right arrow button to add w/ My Group
it to the tool bar. 72 Create Alert
(Alternatively, just drag and drop i — Separator
the tool from the Available Actions Tools
list to the Tool Bar Actions list) &, Zoom Out
[ 0l Bar Type
B Circle 4l Bar Data
Reset || ResetAll
OK || Apply Cancel

-

After making the modifications above, the Blue Dashed Line tool will be added to the top tool bar (see
below). Click on the button to activate the custom mouse tool. Note: the tool tip for this button will
display the name of the tool.

el e e P o P i e i

~ MotiveWave - Console (fx2) 2 - X
File Edit View Siudy Sirategy Format Configure  Window  Help
usoil ~ Q| R B s~ @ |38 W~ 2\ w~ & 0~ M~|[+ "5T &2~|15min - |=~ =~ A~ >
il EUR/GEBP 1h Ll USOil 15m »% | 4+ l/} : B 4= = ,*
USOIl 15 mi | Blue Dashed Line Tool tip shows the name 5330
il - 15 min — . H53.
Custom ool icon ! of the custom tool L +
added here | l 'l ‘ I +IHT ‘h+ ggg;'
F himy i“! .

The screen shot below illustrates the new tool in action creating a blue dashed line:
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~ MotiveWave - Console (fx2) 2 - 0 x
File FEdit View Study Stategy Format Configure Window  Help
usoil  ~Q |l E B B G K wW~- BININY Q@ b~ M~ [+ |T[FT|2~[15mn ~ =- =- 4~ ”
Ll EUR/GBP 1h [ Lul USOIl 15m x | + B =+~
USOil - 15 min * + 53.20
| 5308
e
By bl P |
.#!___!ﬂ it . TT s cgz84)
+“'T“T++I *i* 1
it 4-!* ’,-"” Custom tool creates a blue 2.60
*“ “!ITT LU ’,/” dashed line using the changes
l .H.l+' *“*lh e that we applied in the

' 'I*“H“i 1'“1- “”,-"‘ Component Properties dialog. _ %%Bl

- 15220

’/"" ds2.00

. h - Hs1.80

3.16.8 Tool Groups

Tool Groups may be used to create a custom drop down button for organizing existing and custom tools.
This can help to optimize the available space on the tool bar(s). Tool Groups can be created from the
Preferences Dialog (Configure -> Preferences from the Console menu bar). Click on Tool Bar, then on
Tool Groups. Click on the add button (plus icon) to create a new Tool Group.

o
General Theme Chart EGEEEEIE SPunds Ra

Tool Bar Custom Tools [RElIRElfllei

Tool groups are used to organize tools under a drop

Preferences
fios Elliott Wave Gartle

Click on Tool Bar,
then on Tool Groups

Tick Charts Orders Alerts Email

X

-

+

Click here to create

a new Tool Group

OK

Apply

Cancel
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Choose a name for the tool group and add the desired tools from the Available Actions list to the Tool
Group Actions list. Click on the OK button to create the tool group. Note: the name identifies the tool
group and will also be used as the tool tip.

+

Add Tool Group

Tool groups enable you to organize several tools into a single drop down. Use the form below to

add/remove/re-order the too
r Choose a name for
ey My Tools the Tool Group
Available Actions: Tool Group Actions:

£ Data Edit

M, Deep Crab

# Diamond

W Drag

¥ Ending Diagonal
% Eraser

/< Expansion

- Extension

. Fan

M Gartley

A Impulse

A Leading Diagonal
\, Line

' Line

= Line Callout

% No Tool

I Note

@® Octogon

-

-

™\, Blue Dashed Line

% Fork

O Ellipse

M Auto Gartley
A Auto Wave

Drag and drop the desired tools
from the Available Actions list to
the Tool Group Actions list.

OK

Cancel

The newly created Tool Group will be added to the Tool Groups list in the Preferences dialog. The icon
for the first tool in the tool group will be used for the tool group.

o

Tool Bar Custom Tools L REl]

+

Preferences

General Theme Chart Sounds Ratios ElliottWave Gartley Tick Charts Orders Alerts Email (v

X

. My Tools

The first tool in the

list will be the icon
for the tool group

Wm—

Tool groups are used to organize tools under a drop down menu on a tool bar.

o,

i_ai et

The next step is to add the tool group to a tool bar so it can be used. Click on the Tool Bar tab in the
Preferences dialog and select the Top tool bar from the Tool Bar drop down. In this case we will add the
My Tools tool group just after the Blue Dashed Line tool that we created in the previous section.
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[ o] Preferences x

General Theme CnartSounds Ratios Elliott Wave Gartley Tick Chaits Orders Alerts Email =

Custom Tools Tool Groups

Use this panel to configure the actions available on the toolbar. Select the tool bar you wish to configure from the drop down.

Tool Bar: | Top ~ | V| Enabled
Available Actions: Tool Bar Actions
= == emey -
 Line Q, Quick Search
W Line Q, Search for Instrument

{ - Separator -

B New Analysis

= Save

[§l. Save As

%y, Move To Front & Open/Manage Analyses

+
My Tools Iii Save As Image

> Line Callout

[ Load Extensions
Marker Tools

®, Move To Back

News Hegdlines = || § — Separator -- 1
¥% No Tool - ) Undo
[ Note (" Redo
&% Object Viewer i — S — [
# Auto Analyze
Select the tool group above and 2 Create Alert

click the right arrow button to add i — Separator —
it to the tool bar. \\ Blue Dashed Line

(Alternatively, just drag and drop

the tool from the Available Actions &, Zoom Out
list to the Tool Bar Actions list) i Bar Type
Al Bar Data

Reset Reset All

OK | Apply || Cancel

The screen shot below shows the new tool group added to the top tool bar. When you click on the drop
down you will see the tools that were added in this tool group.

il US Index - Primary Analysis - 1 day ey - e X
File Edit WView Study Strategy Format Window Help

usindex |~ Q| B =~ 6 @ cIhN \'k'vQ b~ M~ + "8[T
US Index - 1 day | | N’ Blue Dashed Line
Volume ! % Fork Ctrl+Shift+F

. O Ellipse
Here is the new tool group that % Channel CIr+Shilt+C

i we created. When clicking on M Auto Gartley Cirl+Shilt+G X

: the drop down, you will see the M Auto Wave Ctrl+Shift+W | 1

i tools that we added. i I 1 T“I

| : : | |I‘I all I” II )
4 e s ek

3.16.9 Visibility

Visibility is a very useful feature in MotiveWave™ that enables you to specify the bar sizes where a
component is visible. This can be very useful to avoid clutter when switching bar sizes on a chart.
Visibility setting can be set from the Properties dialog or via the right click menu on the component.
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3.16.10

Visibility Menu
T
I
Right click on the |
component. 1
I
I
! |
I
Edit » |
H.! Format » | i
H 'U. i Visibility » | v Allintervals |
L/ 72 Create Alert 15 min only i
Show Info cri+1 >15 min i
Show Angle == 15 min i
Relative End Point <15 min |
Extend CtrHE <= 15[}?"‘ !
Extend Left | |
Ratios v i
Line " This option will make this
Properties T component only visible on
! w ' intervals at or below 15
fiT
u l!d]!“w‘m minutes
: ; ‘
: ?!lﬁ. oy ?‘?Du*ﬂl!
H LT L &
i !ﬁu i Iﬁ'.h. " has”l
Visibility Dialog
Trend Line Properties
General Format Eatine

J

Select visibility option from
the drop down (‘All' to be
visible on all bar sizes)

Use the drop down below to

Visibility: | == =

Bar Size: | 15 min -

Choose Bar Size

(defaults to current
bar size on the chart)

OK || Apply Save Defaulis

ponent will be visible.

Cancel

Object Viewer

+865.00

+860.00

+855.00

1850.00

845.00

+840.00

H835.00

The Object Viewer is a convenient dialog for managing components on a chart from a single location.
Components can be deleted from the chart and you can adjust the visibility and draw order. The Object

Viewer can be displayed from the top menu bar: View -> Display -> Object Viewer
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Object Viewer

Object Viewer: TSLA - Primary Analysis - 15 min

The following table contains all objects that are in this analysis.

Filter: Type: | All | Visible: | All v

X @ % ]

® These buttons affect ZYpe | Fitter V.iew using visibiity :

4 the draw order. Study BB(20,20,2.0,2.0) | these fields. == 15 min I
1 Study Volume All

7 Price Graph true  Impulse Minor: 11/14/2016 12:45 - 03/15/2017 08:30 All

8 Price Graph true Impulse Minute: 11/14/2016 12:45 - 12/28/2016 09:30 All

58 Price Graph true  ABC Correction Minute: 12/28/2016 09:30 - 01/03/2017 09:30 All

64 Price Graph true Impulse Minute: 01/03/2017 09:30 - 01/25/2017 09:30 All

85 Price Graph true  ABC Correction Minute: 01/25/2017 09:30 - 01/30/2017 10:45 All

Price Graph 2017 10:45 - 03/15/2017 08:30

[jgropemes
isibility

25 Price Graph

9 Price Graph true Right click 1o <h 4/2016 12:45 -
I CliCK To show
10 Price Graph true| 2 Move Front  49/14/2016| Double click a row to
context menu Move Back X N
14 Price Graph true Delete 11/18/2016| edit the properties
19 Price Graph frue Impulse Subminuette: 11/22/2016 09:30 - 11/23/2016 11:15
21 Price Graph true  ABC Correction Subminuette: 11/23/2016 11:15 - 11/23/2016 15:00
23 Price Graph true Impulse Subminuette: 11/23/2016 15:00 - 11/28/2016 10230
Impulse

Subminuette: 11/28/2016 10:30 - 12/01/2016 09:30

All
All
All
All
All
All

Close

3.17 Ratios

MotiveWave™ provides many different options for identifying time and price ratios. Fibonacci ratios are
perhaps the most commonly used ratios for analysis. Available components for Fibonacci analysis can

be found under the Fibonacci tab of the Components panel (not available in all editions):

Fibonacci Components
Components X TSLA_I__ 5 min

» General

» Basic

» Commentary
» Markers
v

Fibonacci

=

Retrace

/s

Extension

N

Expansion Click and drag a

component on to
the price plot

Retrace

Extension Expansion

g |

Circle Fan

The screen shot below shows an example of a Fibonacci Retracement. Yellow resize points can be used
to change the position of the labels and length of the ratio lines.
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Fibonacci Retracement
il TSLA - Primary Analysis - 15 min* Ho- W X
File Edit View Study Strategy Format  Window  Help
TSLA Q| kB E sr@E HElerQ (~+|"EI &2~|[15min - =- =~ O~ £ 0 m 8|3
TSLA - 15 min
255.00

54.00
Click and drag yellow
points left/right

53.00

25242 ( 0 0%(252 42]) )
: 2521
éf ,T.ﬂ " 12.6%(251.73) )
’7 =L
Fibonacci Retracement H251.00
{38 2%(250 62))

a7 i

4[%“0 Label as0.00

‘m R R e
; e +249.00

4—

i I#fﬁ’hﬁ —*.

—
———
— -
S
I
—
.
——
—mm
e

|
I 88.7%(248.24)
" H248.00
MotiveWave ‘ X X 24771) X : {100.0%(247.710)
Jan-31 12:00 12:00 Feb-2017 12:00 14:00 Feb-02 12:00 12:00 Feb-03 12:00
imin 5min 10min [ 15min_ 20min  30min 45min 1hour 2hour &hour 1day 1week 2week 1month 3month = iy @ |ol> 2

Feb-03 11:00:51

MotiveWave™ provides a lot of flexibility for working with ratios. If you would like to modify the ratio
properties for a particular component, right click on a ratio label and choose Ratio Settings (or just
double click on the label).

Ratio Settings

! ! H4253.00
25242 ¢ (0.0%@52.42))
! ! | 25219
! ﬂ ———{14 A%I2R1 771 .
| T Right click on a label and X Remove Ratio _251-51
i ) choose Ratio Settings H Ratio grettings
! ! , Ratio Preset  » fj2s51.00
| : | Preferences  » ]

e +- I Bl e : o) fas00
s !

[249.6
f1.890(249.51)

The Ratio Settings option will open the Properties dialog for the component and switch to the Ratios ->
Ratios tab.
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y

Ratio Settings Dialog

Retrace Properties x

General Format _Visibilty [y

Ratio Type [EEeg) Display

LU LN LN AL

0.0

382

786

114.6

138.2

178.6

261.8

%

%

£ R £ & & £ R

146

50.0

88.7

123.6

150.0

188.7

SN K KN KNS

4236

can be saved and applied

For convenience, presets
to other components

OK

R - - - -

L Save Preset

Apply || Save Defaults

236

61.8

100.0

127.2

161.8

200.0

v
v
v
v
v
v
v

E- - - -

686.0

Check to enable/disable specific
ratios. Click the edit button for
advanced display options.

Cancel

3.17.1 Customized Ratios

For each ratio, use the check box to the left to enable/disable. The input field can be used to enter the
ratio (in percent). Click on the edit button (pencil icon) to the right to specify how the ratio should be

formatted.

Ratio Settings Dialog

MotiveWave

!
-

Ratio Settings x
This dialog allows you to choose the specific ratios and set display
preferences.
Ratio: r 252 |9 Custom formatting can be
defined below by
Use Defaults: unchecking Use Defaults
QOutline: | None v
Line: | | -~ — 10~ ----- - Use Default
Text Color: |G ~
Fill Color: -
Font: Arial;14.0 Use Default
ancel

The custom settings chosen above for this ratio will look like the following:
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This is the
modified ratio

4

4

T!**ﬁm+ +.¢H

3.17.2 Ratio Display Preferences

14.6%(251.73)

23.6%(251.31)

38.2%(250.62)
(50.0%(250.07))
(61.8%(249.51))

78 6%(248.72)

The Display tab allows you to change how the ratios are displayed. The settings on this tab apply to all
ratio labels/lines in the component (unless explicitly adjusted for each ratio, see previous section).

Ratio Preferences

General Format _ Visibity [[ied)

Retrace Properties

X

Ratio Type Ratios EaEdEN

v | Show Ratio Labels
Extend Left

OK || Apply

Save Defaults

Use Defaults
) o These option affect all of
Rettio Origin: | SR M the ratio labels/lines
Label Align: | Right - {unless explicitly changed
on the Ratios tab)
Label Outline: | Rounded -
Label Color: Enabled
Linee | —10~ | — ~ | N ~ Alternating Colors
Fill Alpha: Fill Ratios

v | Show Ratio Price Show Source Lines

Extend Right

Save Preset

Cancel

3.17.3 Ratio Presets

Ratio Presets can be very useful save a ratio configuration and apply it to another component. This can
help to avoid a lot of duplicate work. Use the Save Preset button to save the current ratio configuration

for later use.
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Save Preset

Retrace Properties

General Format Visibility m

Ratio Type m Display

0.0
38.2
786

114.6
138.2

178.6

LN L LN LN LN L
LN LN L LN LN LN L

2618

- - - - - - - -

OK || Apply

146 |% v 236 %
50.0 (% v 61.8 %
88.7 % v 100.0 |%
1236 % v 127.2 |%
150.0 |% v 1618 %
188.7 % v 200.0 (%
4236 % v 686.0 %
Ratio presets contain all 9%
of the ratios and display
properties for the labels %
and lines
Save Preset
Save Defaults Cancel

When you save the preset, you will need to choose a name. Enter the name in the Save Ratio Preset
dialog (see below) and click the Save button.

Save Ratio Preset Dialog

Save Ratio Preset

This dialog allows you to save ratios settings to access quickly as a preset.
Choose a name for your preset below and press "OK! to save these settings.

Name: | My Ratios]

Fibonacci Blue
Fibonacci Green

Enter a logical name for
the preset and press the
Save button below.

Fibonacci Red
Fibonacci Alt Colors
Gann Blue

Gann Green

Gann Red

Gann Alt Colors

Existing presets
(MotiveWave comes
with several built in)

Save Cancel

Right click on a ratio label and choose Ratio Preset -> <Preset Name> to quickly apply a preset to a
component. Inthe example below, we are going to choose My Ratios that we defined above:
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Apply Ratio Preset

H253.00
Right click on a ratio label and T
choose: | = X Remove Ratio (:252 ia
Ratio Preset -> <Preset Name> Ratio Settings —215‘[5%‘

T : Ratio Preset  » | py Rwos ]
23.6%ee CICENCES Y Eiponacc Blue ]
Fibonacci Green (250_99
Fibonacci Red ]
* ! 38.2%(25062) Fibonacci Alt Colors ||
Gann Blue 1
* hef* * 50.0%(250.07)) Gann Green 250,00
Gann Red V24968
.Lm Gann Alt Colors 1

+

3.17.4 Global Ratio Preferences

Global ratio preferences can be configured in the Preferences dialog from the Ratios tab. This section
has two sub tabs, Presets and Defaults:

: H249.00
S W -7y yr e ]

Global Ratio Preferences
& Preferences X

General Theme Chart Tool Bar Sounds Elliott Wave Gartley Tick Charts Orders Alerts Email >
etauts

Choose the
This panel allows you to manage Ratio Preset% Ratios tab. Fuﬁnn to define a new preset

+

Name A Built In
Fibonacci Alt Colors true
Fibonacci Blue true
Fibonacci Green true - Hofth b -
o e e | T et et
Gann Alt Colors frue non built-in presets to edit. Click on
Gann Blue true the Add button ("+') to create a new
Gann Green true Ratio Preset.
Gann Red true
My Ratios false

OK || Apply | Cancel

The Defaults section enables you to assign the default presets to each type of ratio component. Ratio
components consist of retracements, fans, circles, Elliott Waves etc.
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g

& Preferences 5
General Theme Chart Tool Bar Sounds m Elliott Wave Gartley Tick Charts Orders Alets Email (v
_presers [

Ratios may be configured using presets.

Use the options below to specify the default preset to|

Choose a component to assign a
specific preset as the default
when creating a new instance of
the component.

Compoenent: I -Choose Component-

Preset: | My Ratios -

The follow attributes apply to the ratio tools (ie Fibor

v/ Show Ratio Source Lines
v Show Ratio Range Lines

Allow Vertical Resize

Allow vertical adjustments

of ratio height to quickly
hide/expose ratios.

OK | Apply || Cancel

3.18 Time/Price Guides

Guides can be added to the vertical and time axes. A guide is essentially a vertical (or horizontal) line
that has an attached indicator to show its value. There are two types of guides:

1. Price/Value Guide — Displays a horizontal line with an attached indicator in the vertical axis
2. Time Guide — Displays a horizontal line (across plots) with an attached indicator in the time axis

Guides can be added to a chart from the right click menu of the axis (choose Add Guide). This menu can
also be used to edit the guide or remove it. The location of the guide can be changed by clicking and

dragging it.
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Guides
il EUR/USD - Primary Analysis - 15 min* Ho- X
File Edit View Study Strategy Format Window Help
EURUSD |~ Q|h B & =~ @ Hw~ | w~Q I~ mMv + "E[T|&2~|15mn  ~
EUR/USD - 15 min

WVolume

Price Guide. Click and drag
indicator up/down to adjust
location. Double click to edit.

by 10

Right click on Price Axis,

choose Add Guide 71 Trade '

| 12 Create Alert

ﬂlﬁTU Mo \Fﬁﬁc?i'uﬁ':“s

|

U
!ﬁl{_q*iw,&.l?*ﬂlnﬂ’r#?ﬁ T'T*'?TT!Dﬂl?Tl Q'fl UT+¢.“*

.1: move All Guides
i
!i*?'m $in J1.07400
Click and drag indicator lH_H
to adjust location.
Double click to edit. —1.07200
AU | P TPTT (LTI T e — O T e L 1L e S 4577
Feb0Z 200 400 600 800 1{Feb0211:32[14.0 Time Guide. Guide  |2200 Feb03 200 400 600 800 10:00 12.00 14.00
RSIC.14) spans multiple plots. +%
= Y =]

X H1.08000
1.07000

Jan-19 Jan-22 Jan-24 Jan-25 Jan-26 Jan-29 Jan-31 Feb-2017 Feb03| 1-06000
1min 5 min 10min  15min  20min 30 min 45 min 1hour 2hour 6hour 1 clay 1week 2week 1 month =>4 L} v @ |- f'n‘

Feb-03 14:44:37

Guide Properties Dialog

Guide Properties x
Value: \—IH'DBO% v Double click on a
Line Width: | — 1.0 - guide to edit its
properties.
Style:

Label Color: v'| Use Line Color

Line color: | | NN ~
Text Color: | [ NG

OK Save Defaults Cancel

3.19 Percent Change Charts

Normally the price plot shows the historical prices. Percent change charts are an alternate view that
shows the change in the price between each bar as a percentage movement. A percent change chart
can be displayed by changing the bar type from the drop down on the tool bar to Percent Change.
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Percent Change Chart

ay MotiveWave

Lol EUR/USD - Primary Analysis - 15 min® b3/ VI
File Edit View Study Strategy Format Window Help
EURUSD |~ |Q |l & & &~ G [ W~ 2| w~> & oA~ M~ + T[T 2~ [15mn  ~ I »
EURIUSD (Close) - 15 min OHLC Bars 70-300%
- [ HLC Bars ]
Click to show | § candlesticks ]
drop down ¥ Candlesticks (Trend) Ho.200%
I 3D Candlesticks E
[l Candlesticks (Hollow) ]
| Candlesticks (Flat) 1
[/ Heikin-Ashi (OHLC) ;u_wu%
1 Heikin-Ashi (Candle) 1
/\,-\ A U+ Heikin-Ashi (Trend) A A E
\_, {11 Heikin-Ashi (Hollow) 10.000%
v /- PercentChange Choose Percent \/ 1
- Line Change E
£ Line (Shaded) H-0.100%
£ Line (Gradient) E
I Bars 1
1 Bars (Flat) Z
1 3D Bars Eﬁ
¥ No Bars ]
v Price Axis is now 3
—-0.300%
based on percent I ]
3 0.400%
-0.500%
MotiveWave (3340
2:00 400 6:00 8:00 10:00 12:00 14:00 1600 1800 20:00 22:00 Feb-03 2:00 4:00 6:00 8:00  10:00 12:00 14:00
1min Smin 10min  15min  20min 30min 45min 1hour 2hour Ghour 1day 1week 2week 1month =4 = ey @ =l B

Feb-03 14:59:51

By default, percent change charts are calculated from the left most point of the chart. This can be
changed to a specific bar by right clicking on the chart where you would like the calculation to begin.

Percent Change from a Specific Bar

il EUR/USD - Primary Analysis - 15 min® I S
Fle Edit View Study Strategy Format  Window  Help
EURUSD |~ |Q |l IR & &~ @[ 7[R W~ @~ & o~ My + T |2~ [15mn ~ »
EUR/USD (Close) - 15 min 0-300%
J0.200%
C0.100%)
Right click where you £} Chart Settings
/‘ want to calculate from | Edit Instrument A 10 000
\_, Percent Change  » | calculate From First Bar 1
\ Bar Size * | calculate FrofyThis Bar Choose "Calculate 1
Tick Interval * | Calculate From Last Bar From This Bar" E
Volume Interval  » | 4-0.100%
Range Interval  » E
Renko Interval  » E
Template b @
Link g 1
Add Study b
Tools g 1
Edit » 2—0.300%
View g ]
' Clear Local Data ]
H-0.400%
3-0.500%
MativeWave ¢ 3931)
2:00 400 6:00 800 10:00 12:00 14:00 16:00 1800 20:00 22:00 Feb-03 2:00 4:00 6:00 8:00 10:00 12:00 14:00
1min 5min 10min  15min 20min 30 min 45min 1 hour 2hour 6hour 1day 1week 2week 1month *=4 = ey @ |»v @

Feb-03 15:02:17

Two dashed lines will be displayed to visually indicate where the charts are being calculated (see below).
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Percent Change from a Specific Bar

Analyze rade. Evolve

il EUR/USD - Primary Analysis - 15 min~ b3/ VI
File Edit View Study Strategy Format Window Help

EURUSD |~ |Q |l B § B~ G (R W~ 2w~ & Av M~y + T[T &2~ |[15mn ~ I »
EUR/USD (Close) - 15 min N 10.000%
: H-0.100%

Percent change is now ]

calculated from here. ]
4-0.200%
[\ -0.300%
J-0.400%
-0.500%
1-0.600%
-0.700%
0.747%]
MotiveWave %

2:00 400 6:00 800 10:00 12:00 1400 1600 1800 20:00 22:00 Feb-03 2:00 400 600 800 10:00 12:00 1400

1min 5min 10min  15min 20min 30 min 45min 1 hour 2hour 6hour 1day 1week 2week 1month *=4 = ey @ |»v @

Feb-03 15:04:07

When combined with the Instrument Overlay, you can compare relative moves between instruments

directly on one chart:

Percent Change — Multiple Instruments

il EUR/USD - Primary Analysis - 15 min*
File Edit WView Siudy Sirategy Format Window Help
EURUSD |~ Q| B B S~ @ (| W~ 12| #w~ & o~ M~y + 5| T|2~|15min -

EUR/USD (Close) - 15 min
USDICAD (Close)SPX500 (Close)

~0.800%
¥

~10.600%

~0.400%

~40.200%

Calculated from

this location.
(v M’V\A‘\/\

MotiveWave

1-0.400%

e

700 400 600 5:00 71000 1200 1400 1600 716:00 20:00 2200 Feb03 200 400 600 B.00 1000 1200 1400  Teb05 17.00 15.00

i1mn 5min 10min  15min 20min  30min  45min  1hour 2hour 6hour 1day 1week 2week 1month 3month

= biv @ |0~ 2

3.20 Studies

Feb-03 15:368:08

MotiveWave™ has over 275 built in studies that can be used to display information on the price plot or

separately in a plot below the price.

There are essentially two types of studies:

1. Overlays — display information that is drawn on top of an existing plot (most typically the price

plot)
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2. Study Plots — display information that is displayed in a plot that is separate from the price plot.

3.20.1 Adding a Study

A study may be added to a chart by choosing one of the available studies can be found under the Study
menu from the top menu bar. This menu organizes some (not all) of the studies into logical groups
(based on author or function). The Add Study option enables you to search for a study instead of trying
to find it in a sub-menu. For convenience, a Recent menu is available to access recently used studies.

Study Menu
Labt EUR/USD - Primary Analysis - 15 min go- X
File Edit View | Study | Strategy Format Window Help
EURUSD ~ Q| I Jas Add Study Ctri+T X W~ 2| W~ Q 0~ M~ + "5 T &~|15min - »
EUR Recent ' Relative Strength Index (RSI) {10787
Click here to Instrugent » | Stochastic (Full) 1
search for a study | MOVINg Average » | Commodity Channel Index (CCI) -1.07900
Overlays » | simple Moving Average (SMA)
Astrological » | Exponential Moving Average (EMA) ]
Bar Patterns » | Moving Average Conv/Div (MACD) 407801
General ¥ | Moving Average of Oscillator (OSMA) ]
Volume Based * | Bollinger Bands 1
Welles Wilder » | Ichimoku Kinko Hyo d41.07700
T Bill Williams | Parabolic SAR ]
Tushar Chande " | Absolute Price Oscillator 1
T* T Marc Chaikin * | Dynamic Momentum Index J1.07600
Fl T ﬂﬁ Custom b L) ]
D Alexander Elder d 1
Bands Many studies are T4 07500
Bill Mars 3 grouped here by author 1
John Ehlers v or category ]
Oscillators g J11.07400
Performance d D ]
William Blau g ]
i H- 1.07300
i J1.07200
MotiveWave . : ‘ . . . . . . . ‘ . . £1.07105
22:00 Feb-03 2:00 300 4:00 5:00 600 7:00 800 900 10:00 12:00 14:00 Feb-05
1min 5min 10min [ 15min 20min  30min 45min 1 hour 2hour Ghour 1day 1week 2week 1month *=4 = oy @ |4~ B

Feb-04 10:17:07

If you choose Add Study, you will see the following dialog. This is a convenient way to search for a study
by typing it in into the Filter input (see below):
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When you add or edit a study you will see the study dialog similar to the one displayed below. Each
study will have different settings and configuration options. The available tabs will depend on the study,

Add Study Dialog

[ Add Study X
The following table contains all available studies. Select the desired study below and choose OK to configure the settings
Filter: | | Type: | All -
N
Name A Overlay Signal *
Enter text here to
AGGZ search for a study false frue [ ]
ATR true false
ATR Trailing Stops true true
Absolute Price Oscillator false false
Acceleration Bands true frue
Acceleration Oscillator false false
Accelerator Decelerator Oscillator false frue
Accumulation/Distribution Line false false
Accumulative Swing Index false false
Adaptive Smoothing Indicator T3 true false
Alligator true false
Aroon false false
Aroon Oscillator false false
Auto Trend Line You f:an import third party true false
studies from here.
Average Directional Index (ADX) false false
. - \/ - -
Import || Cancel

but all study dialogs will have an Options tab and a Signals tab (if it generates signals).

Study Dialog - SMA

Simple Moving Average (SMA)

SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is
the mean of the previous 10 days' closing prices.

Advanced Signals Options <rclick here for general T

X

study options
Inputs \—* L ¥ op J
If the study generates
. signals, you can
Input:
P configure them here
Period (bars): - ~ 0%

Fill Forward: |v/'
Display
Lne DN - || — ¢ This button will save the
settings from this study as
Indicator: - the default the next time you Play

create this study.

Save Defaults

Help | Cancel

Adjust the settings for the study and click on the Create button to add the study to the chart. For
convenience, you can click on the Save Defaults button to save the study settings for the next time you

create this study.

The following screenshot shows the Simple Moving Average (SMA) study from the Study dialog above.
Also shown is a Study Plot for the MACD study.
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MotvaWavr\

Analyze. Tra E

Study Legend

Simple Moving

Average Overlay

1Tmn 5Smin 10min 19 min 20 min

Chart Studies
sl EUR/USD - Primary Analysis - 15 min* T P
File Edit View Siudy Sirategy Format Window Help
EURUSD ~ Q |l @ R Ss~@™ IR W~ 2|lw~Q i~ M~ + "I~ [15mn  ~ »
EUR/USD - 15 min

Study Indicator for
the SMA Qverlay

T1 07400
H1.07200
MotiveWave 1.0707¢
800 1000 1200 1400 1600 1800 2000 2200 Feb-03 200 Study Plot for the | =35 —5'50 7400 Feb-05 17:00 19.00
MACD study
ACD(C,EMA,12,26,9) _\/_ 4+ ¥ H0.001000
[ammmamaman-———- R “““““___...1ullluullllll-. T P— aall = 0:00032

1-0.001000

3.20.2 Editing a Study

30 min

45min 1hour 2hour 6hour 1day

1week 2 week

1 month =4

#> @ |~|~ 8

Feb-03 16:52:42

If you would like to edit the settings on a study simply double click or right click and choose Edit Study.

SMA(C,20)

You can also right
click or double click on
the legend

Right click on the

!*erl Visibility
I

v Show Legend

study and choose Edit

ACDIC,EMA,12,26,9)

[agERR= A= |

1 min

Edit Study
[ EUR/USD - Primary Analysis - 15 min* B2 - X
File Edit View Siudy Sirategy Format Window Help
EURUSD ~ Q| @ B S~ @™ IR W~ 8|~ Q i~ M~y + FT|2~[15mn ~
EUR/USD - 15 min

l Ei*;s
!ﬁ te
Fhamgl1¥ i 1

1jptionydi? ‘rﬂlﬁ#ﬁ?" mhﬁnﬁ ¥ 1.07600

~1.07400

~1.07200

) Double click or right click
MotweWa‘ve | | | | | | | on the study plot to edit. | | | | | m_mr
8:00 10:00 12:00 1400 1600 1800 20:00 2200 Feb-03 0:00 1200 14:00 Feb-05 17:00 1900

4 % H0.001000
0.00032

1-0.001000

Smin  10min 15 min 20 min

30 min

45min 1Thour 2hour 6hour 1day 1week 2week

1 month =4

biv @ |-~ e

Feb-03 16:55:34
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3.20.3 Study Options

All studies will have an Options tab as the last tab when you create or modify its settings. This tab will

contain different values if it is an overlay or a study plot.

Study Options - Overlay

Simple Moving Average (SMA)

the mean of the previous 10 days' closing prices.

General Advanced Signals

SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is

X

Graph: | Price Graph b Graph/Plot where
Visibiity: | Al - this study is drawn

Bar Size: « |v| Use Chart Bar Siz By default, the chart bar size
7| Show L. - e is used. You can specify a
owLegen NOENAY | different bar size if you like.

Show Values In Legend Use Real VATUES

Bar Updates
Check this to update the
study from live ticks vs
the close of the bar

Update Remove Save Defaults Help

Cancel

Study Options — Plot

Moving Average Conv/Div (MACD)
Shows the difference between a fast and slow moving average of prices. MACD is often used to indicate
changes in market trends. Created by Gerald Appel in the 1960s.
General Display Advanced Signals
Graph: | MACD(C.EMA,12,26.9) ~ Optionally you can
overlay a study plot on
visibility: | Al ~ - another plot.
Bar Size: ~ | |¥| Use Chart Bar SiZe
Instrument: - v | Use Chart Instrument
Show Values In Legend Inverted
Bar Updates Use Real Values
Top Inset:
. Y Space (in pixels) to add to
Sotiom Inset. ﬁtﬁe top[;‘bfttom Lf the plot. J
Update Remove Save Defaults Help Cancel

3.20.3.1 Overlay Plot

When you create an overlay study, by default it will use the Price Plot. Optionally, you can choose one
of the existing plots to display the study. When you change the graph for the study, it will change the

input options. For example, if you want to display a simple moving average (SMA) on an RSI study plot,
you would choose the RSI(C,14) plot from the Options tab. When you choose this, the Input field (under
the General tab) will be updated to reflect the inputs available from the RSI plot.
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Simple Moving Average (SMA) X Simple Moving Average (SMA) x
SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is ‘SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is
the mean of the previous 10 days' closing prices. the mean of the previous 10 days' closing prices.
General Advanced Signals Advanced Signals Options
Graph: | RSIC,14)  ~ Choose RSl plot. This plot must Inputs - -
o already exist on the chart prior Available Inputs are updated
Misilily | to creating/editing this study. Input: | RSI(C.14) > hereltglre"echt the vda'uels .
N available in the study plot that
- - U . = 5
Bar Size: V| Use crmamcmarsr Period (bars): shift: [ | you chose under Options
/| Show Legend Underlay Fill Forward: |/
Show Values In Legend Use Real Values Display
Bar Updates tine: | DM ~- | —10~-| — ~
Indicator: ~ | I - Line /| Display
Update | Apply Remove Save Defaults Help Cancel Update | Apply Remove Save Defaults Help Cancel

HWWMM%W SR VR e S —
*ﬁ#l Jﬂ*.n* 1.07400

i

1.07200
Motive\Wave

5.00 1000 120 SMA Overlayon [5.00 2000 2200 Febd3 200 400 600 G500 1000 1200 14.00
RSICA4) RSI Plot

e 4 7
e SA e

1min 5min 10min  19min 20min 30min 45min 1 hour 2hour 6hour 1day 1week 2week 1month >4

Feb-03 17:07:05

3.20.3.2 Study Bar Size

By default when you create a study, it will use the bar size of the chart. When the chart bar size
changes, the study will be automatically updated to reflect the new bar size. MotiveWave™ does allow
you to choose a specific bar size for the study. This allows you to, for example, display a 1 day SMA
(Simple Moving Average) on a 15 minute chart. This feature also applies to study plots so you could
display a 10 minute RSl on a 15 minute chart (see example below):

Relative Strength Index (RSI) x
- . RSl is a momentum oscillator that measures the velocity and magnitude of directional price movement by
SEnpleWovingliveraySiEMA) * [ comparing upward and downward movements. Developed by J Welles Wilder In 1975,
SMA is an unweighted mean of the previous n bars. For example, a 10-day moving average of closing price is 5
the mean of the previous 10 days' closing prices. Cerclal i Atvanced i Sk
General Advanced Signals Graph: | RSI(C.14) -
Graph: | Price Graph - Visipility: | Al - -t
Visioiity: | A1~ - Bar Size: Use Chart Bar Size Ulncheck Use Chart B:ar
Size" and select 10 min
Bar Size: | 1 day - Use Chart Bar Size Uncheck "Use Chart Bar Instrument: - from the drop down.
Size" and select 1 day
| Show Legend underiay| from the drop down. Show Values In Legend Inveried
Show Values In Legend Use Real Values Bar Updates Use Real Values
Bar Updates Top Inset.
Bottom Inset:
Update Remove Save Defaults Help Cancel Update || Apply Remove = Save Defaults Help Cancel
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ahil EUR/USD - Primary Analysis - 15 min™ Ey = 2
File Edit View Siudy Sirategy Format Window Help
EURUSD ~ O | = & s~ @™ KW B|lew~-Q i~ mMm~ + "5[T |2~ 15min -

EUR/USD - 15 min
[ﬁ\H C.20) [5 min]SMA(C.20) [1 day]

|
TS
I

+”l_ﬂ-

Bar sizes displayed
in the legend

ﬁ”*-*uﬁi*+TL.
'm'[] 'JTTH

y

M

'lw**w ' "T'Tﬁh i | T+

This is a 5 min EMA
displayed on a 15 min chart

iy
‘ !“ﬁ'l*“\ $.n*

This is a daily SMA
displayed on a 15 min chart

14:‘00 15:‘00 18![]0 20:‘00 22:‘00 FetIJ-OS 2:‘[][] 4:00 Silﬂﬂ 8:00 10![]0 12:‘[]0 14:‘00 Feb-05 1?:‘00 19:‘00
RSI{C,14) [10 min Plot title shows 2 -
________________________ bar size AL /‘\—/J \‘/\,\ P

imin smin 10min  15min 20min  30min  45min  1hour 2hour Ghour 1day 1week 2week 1month >4

Feb-03 17:13:32

3.20.3.3 Study Plot Overlay

Study plots may be overlaid on other plots. You may have noticed this feature already with the Volume
overlay on the default layout of the Console:

Volume Overlay

WW"‘[T S
otttohy
| e

<

PP A A Ay

1
e

Volume Overlay

[with Moving Average) !
. {3363J00
H-IH"H‘lﬁl‘ll'ﬂHﬂHlﬂl”mn_n.lln;_"_'n—;:llrmml ﬂﬂH'ﬁllﬂﬂ"llﬂEﬂﬁnnmp nnnnn : ::Fnimw—.nﬂﬂnullnﬂml IInL ) . ¢
%5 4:00 g:00 12:00 Apr27 19:00 Apr-28  4:00 g:00 1200  16:00 20000 Apr-28  4:00 g:00 12:00 16:00
)i___ l .l..___c:"—”‘/‘:ﬁ.f.ic:"\ - |.‘= i, | - | o ___l M.L-n_'___i:'\*—-""\l_’:‘j.

You can change the overlay plot for a study from the Options tab. A study plot can be overlaid on the
Price Plot or other study plots. The following examples show a CCl plot on the Price Plot and an RSI plot

on a Stochastic plot:
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Plot Overlay
Lanl EUR/JSD - Primary Analysis - 15 min™ R

File Edit View Siudy Sirategy Format Window Help
EVRUSD ~ Q |l i@ & S~ @™ IR W 2w~ Q (I~ mv + T[T &2~[15mn  ~ I

: H*i¢u¢i*+T*

CCI(20)

!
!%WJD

i

CCl displayed 4;.
on Price Plot H Ij

.

Ive\Vave i

1 1 1 1 1 1 1 1 1 1 1 H 1
Feb-03 1.00 2.00 3.00 400 500 6.00 7.00 800 900 10:00 12:00 RSl displayed on Feb-05 1700
Stochastic Plot
STO Full{14 5 3) e T~ L
RSI(C,14) A f""\ ﬁ:/ \—/—\\:% \/ _,f/‘;[\’
= \y %Q-/"\,\
N Y /adl N
e =
1min 5min 10min [ 15min 20min  30min 45min 1 hour 2hour Ghour 1day 1week 2week 1month *=4 = v @ |+~ &

Feb-03 17:20:13

3.20.3.4 Study Visibility

For convenience, you can specify that a study is only visible on certain bar sizes. This is similar to the
visibility feature for components. By default a study is visible on all bar sizes. You can change this from
the Options tab:

Study Visibility
Commodity Channel Index (CCI) X

CCl was designed to identify cyclical turns in commodities. CCI assumes that commodities move in cycles, with
highs and lows coming at pericdic intervals. It is recommended to use 1/3 of a complete cycle as a time frame
(ie: for a 60 day cycle use 20 day CCI).

General Advanced Signals

Graph: | Price Graph -
visibiity: | <=~ |[ 30min -] select the
) applicable bar size
Bar Siz /| Use Chart Bar Size
Instrumen| Choose the = /| Use Chart Instrument
operation here
d Underlay
Show Values In Legend Inverted
Bar Updates Use Real Values
Top Inset: In this case the CCl study
Bottom Inset: will enly be visible on
- v

the charts display 30 min

Overlay: | Bottom or smaller bar sizes

Heignt

Update || Apply Remove Save Defaulis Help Cancel
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3.20.4 Signals

Some studies generate signals. Signals occur when a specific event occurs with the study. For example,
a signal may be generated in a CCl study where the CCl value crosses above the top guide. These signals
can be used to show alerts, play sounds or even send an email notification. Note: if you want to send

emails,

you will need to configure your email (SMTP) settings in the Preferences dialog (Configure ->

Preferences from the Console menu bar). You will find these options under the Email tab.

Study Signals
Commeodity Channel Index (CCI) x

CCl was designed to identify cyclical turns in commodities. CCI assumes that commodities move in cycles, with
highs and lows coming at periodic intervals. It is recommended to use 1/3 of a complete cycle as a time frame
(ie for a 60 day cycle use 20 day CClI).

General Advanced Options

Signal: | CCI Above Top Guide - All

Enabled:
This can be used to specify that
All Bar Sizes: v/ v this signal will only be
triggered for a specific bar size.

Show Alert: | Yes =

Play Sound: | Yes ~ |V Use Preset Sound
Sound File:

Send Email: | No -

Email Address: Note: In order to send an email you

will need to configure your SMTP
settings in the Preferences Dialog.

Update = Apply Remove Save Defaults Help Cancel

3.20.5 Instrument Overlay

An instrument can be overlaid on top of the price plot by choosing Study -> Instrument -> Instrument
Overlay from the top menu bar. This action will open the dialog displayed below. Type (or select from
the drop down) the instrument that you would like to overlay in the Instrument field. Click on the

Create

1.
2.

© N oW

9.
10.

button to add this overlay to the price plot. This dialog has the following elements:

Instrument — Type or select the instrument.

Bar Type — Choose the type of bar you would like to display for the overlay (default is a line
chart)

Line Source — If a line chart is chosen, this option allows you to choose the input source for that
line (ie closing price, opening price etc)

Shift — the number of bars to shift the study forward (negative value for backward). Uncheck
Lock Shift to enable dragging of the overlay backward or forward using the mouse.

Style — For line charts, choose the color, thickness and style of the line.

Show Axis — displays the axis for the instrument on the left hand side of the price plot

Inverted — Click to display the overlay upside down

Bar Updates — Click to enable live updates to the overlay instead of updates on the close of the
bar

Show Legend — Shows the overlay in the study legend area

Show Label — Displays a label at the end of the overlay for the Instrument symbol
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Instrument Overlay Dialog

Instrument Overlay X
This dialog allows you to overlay an instrument on the price graph. Click
on the search or add existing instrument button to specify the
instrument. Click Create to create the study.
Instrument: | hoose Symbol-| - | Q)
Bar Type: | ~ ~ Type or select the
bol f thi
Line Source: | Close >ymborfrom tnis
drop down
Shift: v/| Lock Shift
styie: | I ~ || —10~- | — ~
v'| Show Axis v'| Show Legend
Inverted v'| Show Label
v'| Bar Updates
Cancel

The example below shows an instrument overlay for the USD/CAD pair on top of the price plot for the
EUR/USD pair. The axis for the USD/CAD pair is displayed on the left hand side and has indicators for the
current prices. With Auto Scale enabled, dragging the chart left or right will automatically scale the
values for the overlay.

Instrument Overlay Example

ahil EUR/USD - Primary Analysis - 16 min™ KM - ¥ x
File Edit View Siudy Sirategy Format Window Help
EURUSD ~ Q |l | & S~ 6™ [ W~ 2|#~-Q I~ m~ + BT 2~ [15mn  ~
1.30550 EUR/USD - 45 min |
USDICAD (Clése)
1.30500f S | ee
Legend / ‘ + l ol
1.30450( / | T :
/ -1.07800
//\,_.——f | 1
1.30400F ]
\ A~ l J1.07700
1.30350F [\ | 1
.' |j . / | 1
130300 . L +1.07600
(1.30282 T [ﬁ%'* [j.r T+ _ q] [ . il ]
o | |
1.30250[) D 'f l \ [y / ]
- A N L WSDICAD 11 07500
/ | [N )
(13085 |_J'] ' [ 1
. Overlay Axis ?- HI] II C?verla: asa I [Labe| 11 07400
1.30150 * | | Une Chart I‘ 1
II | ]
1.30100 JH- II II __1707300
\ ]
1.30050F / 1
- / +1.07200
1.30000F f i
MotiveWave N 1
L L L L L L L L L L L L L L
Feb-03 1:00 2:00 300 400 500 6:00 7:00 800 9:00 10:00 12:00 14:00 16:00 Feb-05
imin 5min 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month *=4 = ey @ w1

Feb-03 17:29:54

The vertical scale of the overlay can be adjusted by clicking and dragging the space between the overlay
axis and the price plot. Dragging from the top or bottom will add more top/bottom space. Drag from

the middle to adj

ust both at the same time.
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Instrument Overlay — Vertical Space

[alsk EUR/USD - Primary Analysis - 15 min™®
File Edit View Study Strategy Format Window Help

EURUSD ~Q | @ B &~ B9 WKW 2| wrQ > M~ + ™[I | &2~ | 15min -
130550} EURIUSD - 45 min s

H uspicap (clbse

[ H J |
1.30500f . —/ Auto scale applies to -

F Vertical space can be / | both the main H
1.30450 adjusted by dragging the | instrument as well as +|:|. 1

i : ) H1.07800

[ axis up/down S o—r I the overlay instrument Q 1
1.30400f : 0 ]

Ho H1.07700
1303500 [\ ]
1303000 d1.07600
(302821 [ﬁﬂ»- ]
130250F D _ ]

" SDICAD r]1-07500
1.30200F
(1.30185 ]

i H1.07400
130150 ]
|t e et O s e W S
If auto scale is disabled, you can click and drag the overlay up or down to adjust the location of the
overlay relative to the main instrument axis.

Instrument Overlay — Adjust vertical location
Ll EUR/USD - Primary Analysis - 15 min* 2 o- O X
File Edit View Study Strategy Format Window  Help

EURUSD ~ Q|K i@ B &S~ 6|9 w2 w~-Q i~ My + ™ T 2~|15min = So =
1 30600f, EURIUSD - 5 min

[| USD/CAD (Close

F Make sure Auto
1.30550F Scale is off H—
130500 Wﬂl J1.07800
1304500 Click and drag the HIJ ]

F overlay up/down to H1.07700

[ adjust vertical %T 1
1.30400F " * ¢

L position. + 1
1 30350 qu]”" H1.07600
1303000 1
082 {1.07500
1.30250 _ 1

i SDICAD H4.07400
1302005 ]
1.30185 ]
; SMEDE . H1.07300

e il

The horizontal location of the overlay can be adjusted by changing the value of the Shift field in the
Instrument Overlay dialog. A positive value will shift the overlay into the future and a negative value
will shift it into the past. If you uncheck the Lock Shift option you will be able to adjust the shift by

dragging the overlay to the left or right with the mouse.
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Instrument Overlay Dialog — Disable Lock Shift
Instrument Overlay X
Modify the properties below and click Update to apply your changes.
Instrument: | USD/CAD - |
Bar Type: | /~~ «
Line Source: Close -
) D Uncheck to allow
Shilt: — horizontal drag of
styie: [N ~ 10 ~| the overlay.
v/| Show Axis v'| Show Legend
Inverted v'| Show Label
v Bar Updates
Update || Remove || Cancel
Instrument Overlay — Shift
[ EUR/USD - Primary Analysis - 15 min* 62 - X
File Edit View Study Strategy Format Window Help
EURUSD ~ Q |l Im & =~ @™ [ W~ 2|~ & I~ my + BT 2~[15mn  ~ =~ =v
1.30800F EUR/USD - 45 min
USD/CAD (Clése)
1.30550( I Eei
I H'
130500 Click and drag to the left/right +|:|. —1-07800
to adjust the shift. Make sure Q )
1.30450 to uncheck "Lock Shift" in the Hﬂ
Instrument Overlay dialog. 14 07700
1.30400f ¢ 1
1.30350; 41.07600
i
(130282 41.07500
130250 USDICAD In this case we have
shifted it into the past 14 07400
%; (negative shift)
1.30150f 11 07300
1.30100F
41.07200
1.30050f
MaotivelWave o
1 1 1 1 1 1 1 L 1 1 1 1 1 1
Feb03 1:.00 2:.00 3:00 400 500 6:00 7.00 800 900 10:00 12:00 14:00 16:00 Feb-05
imin 5min 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month >4 =E oy @ |#~ B

= ® O 11:02:43, 1.07595

Qs

3.21 Strategies

Feb-03 17:37:32

A strategy is a special type of study that may be used to automate or partially automate trading. In
addition to displaying the study information, a Control Box is made available that allows the user to

activate/deactivate a strategy and

view important runtime information.

MotiveWave™ supports two modes for strategies:

1. Automatic — Once the user activates the strategy, it will automatically buy and sell based on the

internal logic.

2. Manual - In this mode, the user tells the strategy when it is OK to enter.
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Motive

MotiveWave™ comes with around 30 built-in strategies. These can be found under the Strategy menu

(from the top menu bar).

DEMA Strategy
Detrended Price Osc Strategy
Div Bars Allg Filt Strategy
Ease Of Movement Strategy
Elder Ray Index Strategy
Fisher Transform Strategy
Klinger Volume Strategy

IMA Cross Strategy
Mass Index Strategy
Price Zone Strategy
afility |

Strategy Menu
sl EUR/USD - Primary Analysis - 15 min
File Edit Wiew Study | Strategy | Format  Window —tala
EURUSD |~|Q | B | Add Strategy Choose Add Strategy to " T 2~|15min >
EURIUSD 14 Recent b search for a strategy
Click on the Bill Williams '
Strategy Menu G{ueral * | Buff Average Strategy I#i
: Tushar Chande * | Centre of Gravity Strategy *
Welles Wilder  » | Coppock Strategy +TL
William Blau ' | D Three Ten Strategy l

The following screen shot illustrates the Moving Average Cross strategy. This strategy will buy when the
Fast MA crosses above the Slow MA and sell when it crosses below (see triangle markers below). Each
strategy will have a control box (bottom left corner). This will enable you to edit the strategy and
activate it. The control box also displays status information.

MA Cross Strategy
il EUR/USD - Primary Analysis - 15 min 2 B
File Edit View Siudy Sirategy Format Window Help
EURUSD ~ Q| K B s & w2 w~Q i~ My + ™8T c,"" 15 min -
EUR/USD - 15 min
]\! f,/ ]
—_1,07?00
*+ ~1.07600
Strategy
Control Box 1
=1.07500
MA Cross strategy C' This is an example of an automated
- - - strategy. Buys and sells will be 71.07400
Activate Activate/Deactivate automatically placed when the fast
_ Button MA crosses the slow MA. i
Position: /A —4 07300
Entry Price: NIA
Unrealized PL: N/A =
Status Labels
Realized PIL: N/A ﬁ 1-07200
Total PL: N/A ]
MotiveWave . : ‘ . . . . . . . ‘ . . ¢ 107105
22:00 Feb-03 2:00 3:00 4:00 500 600 7:00 800 900 10:00 12:00 14:00 Feb-05
imin 5min 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month *=4 = ey @ w1

Feb-04 10:20:35
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3.21.1 Manual Strategies

o

MotiveWave™ allows you to create strategies that respond to user input to enter or exit a position. This
can be very useful as a way to help direct and manage exit points for user initiated trades. For an
example of how this works, see the Trade Manager strategy.

The following screen shots show the configuration options for Trade Manager. On the first tab
(Entry/Exit) you can setup the entry order and up to 3 exit orders. The Stop Loss tab provides options

for the stop loss order.

Trade Manager x

This simple trading strategy allows you to setup an entry point and automatically create exit orders with break
even and an ATR stop. Market entry occurs when the latest bar closes up (if long) or the |atest bar closes down
(if short).

S)YIS08 Stop Loss  Strategy Panel

Trade Manager x

This simple trading strategy allows you to setup an entry point and automatically create exit orders with break
even and an ATR stop. Market entry occurs when the latest bar closes up (if long) or the |atest bar closes down
(if short).

Entry/Exit Sirategy Panel

exit points. Click on the Stop
Loss tab to setup a stop loss.

18t EXIt Pips Lots
2nd Exit: Pips: Lots /| Enabled
3rd EXit: Pips Lots: /| Enabled

Cancel

Save Defaults

Entry Break Even

Trade Lots: Time In Force: | GTC  ~ Max Loss: 0=

Exit This strategy enables you to Break Even (Pips) Cover (Pips) Enabled: v/
setup an entry order withupto3 ATR Stop

ATR Enabled: |v

ATR Period: ATR Muttiplier:

Create | Save Defaults || Cancel

From the Trade Manager Control Box, you can choose Long (buy) or Short (sell). When you click the
Activate button, the strategy will enter on the close of the bar.

Y

Trade Manager C x

———
LS PR

S
|

N TN

Choose Long or Short
and Click Activate to

15 min 30 min

10 min

Activate enable this strategy
Position: NIA |J_'|L
. i wom,, #
Entry Price: N/A ‘I‘ I &1 * T
Unrealized PL: N/A l u *D =k
Target P/L: NIA L
L1 Reward/Risk: N/A I
Realized P/L: NIA D
O+
Total PL: N/A
— T
MativeWave .ﬁﬁu !
1 1 1 1 1 1 1 1 1 1 1 1
21:00 Feb-03 2:00 300 400 500 600 7:00 800 900 1000 12:

1 week 2 week

Once the strategy is active, the title bar will flash (indicates an active strategy) and the Activate button
will be replaced by Cancel (deactivates the strategy) and Enter Now (creates a market order to enter the

position).
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Title Bar flashes

when active

in

Trade Manager C X
Cancel Enter Now Cancel/Enter Now
provides manual L
Position: NIA control on the strategy |j *hi*é ee
Entry Price: NIA +|_| Iﬁ¢ d D T
Unrealized PL: N/A ‘ =
Target P/L: NIA t
Stop P/L: NIA +|:|
+o1  Reward/Risk: N/A ﬂ
Realized P/L: NIA D
Total PL: na HT
MotiveWave B .ﬁﬁu T TITI
21 !UO Fel;-[]3 ZZIUU 3:IUU 4:IUU 5:I[][] SZIUU ?:IUU SZIUU 9:I[][] 10:00

in__ 30 min ho 6 hour 1 d.

When a position is entered in the strategy, the labels in the control box will display the open position,
current unrealized P/L (profit or loss), target P/L, stop P/L among other information.

AT N e A T T T e JMWMMWM\WWW/‘mm
| CEREEDC (]
i q2320.0
Trade Manager (& X ]
23100
Close Now Exits position and ‘ These orders were ™4
--d _ deactivates strategy ] created by the opleee E LMT-RP 12301.5 [0k
Position: 3 strategy 42300 0
Entry Price: 22918 ] )
Unrealized PL: H-‘ 22941
RE Target P/L: 60.00 [ L
-C L . - Status labels reflect a0 L-I 2290.0
Stop PIL: Ern o i N '
) position, target P/L 2287 4
Reward/Risk: 2.00 ]
and stop loss E
| Realized P/L: N/A [s7p-RP 3@2231.5 (BN
Total PL: e 2280.0
i ——
mwgwg+* 1 1 1 L 1 1 1 1 1 1 1 1 1
Feb-03 2:00 300 400 500 600 7:00 800 900 10:00 12:00 14:00 Feb-05 17:00
1min 5 mi 10min [ 19min__20min 30 min 45min 1 hour 2hour 6hour 1da 1week 2week 1 month ==y

3.21.2 Strategy Configuration

The configuration options for a strategy will vary, but there are some settings that apply to many

strategies.

The first panel is the Trading Options panel. This panel enables you to configure the following:

Trading Options:
1. Trade Lots — This determines the quantity on the orders that are used to entry and exit positions.
The Trade Lot is multiplied by the default quantity to determine the actual quantity.
2. Position Type — Use this option to indicate if the strategy can have long and/or short positions
3. Use Account Position — Use the existing position that exists in the selected account.
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Enter On Activate — If enabled the strategy will create an initial position when you activate the
strategy
Close On Deactivate — If a position is open when the strategy is deactivated, it will be closed at

Bar Updates — If enabled, the strategy will respond to live bar updates instead of waiting until

5.

market price.
6.

the close of the bar.
7.

Underlay — If enabled, the strategy will be drawn behind the price bars.

Trading Sessions:

The Trading Sessions section enables you to define sessions where the strategy may be active. In
between trading sessions, the strategy will be automatically deactivated.

1. Session 1 —defines the first trading session with a start and end time
2. Session 2 — defines the second trading session
3. Time Zone — optionally specify the time zone for the hours defined in Session 1&2
4. Close On Session End — Closes an open position when the session ends
Trading Options Panel
MA Cross Strategy x
The strategy is based off the Moving Average Cross study. Trades occur when the fast moving average crosses
the slow moving average.
General Display Trading (o] ()W Strategy Panel Signals
Trading Options
Trade Lots: _1 ry Number of lots to
_ trade in each order
Position Type: | Both v
Use Account Position v/| Close On Deactivate Underlay
Enter On Activate Bar Updates
Trading Sessions
Session 1: Start: @ End: (0] Enabled Valid Trading
Session 2: Start: ® End: ® Enabled times
Time Zone: bl
Create | Save Defaults = Help | Cancel
Strategy Panel

The Strategy Panel tab allows you to choose what labels are displayed on the control box. The available

labels will depend on the strategy.

1. Show Position — displays the current open position

2. Show Entry Price — shows the average entry price for the open position
3. Show Unrealized P/L — shows the current unrealized profit/loss for the open position
4. Show Realized P/L — shows the current realized P/L
5. Show Stop P/L —shows what the profit/loss would be if the stop loss level is reached
6. Show Target P/L —shows that the profit/loss would be if the target level is reached
7. Show Risk Ratio — shows the risk level (target p/I divided by stop p/I)
8. Show Total P/L — current total profit/loss since this strategy was activated
Version 5.0 ©2017 MotiveWave™ Software Page 116 of 213



MotiveWave™ Moti
User’s Guide &

Strategy Panel Options
MA Cross Strategy X

The strategy is based off the Moving Average Cross study. Trades occur when the fast moving average crosses
the slow moving average.

General Display Trading Options BEIEIGH MaEUEN Signals

v/ Show Position

/| Show Entry Price These are labels to
| Show Unrealized P/L display in the control box.

v/ Show Realized P/L

v/| Show Total P/L

Create Save Defaults Help Cancel

3.22 Software Development Kit (SDK)

Custom studies and strategies can be programmed using our Software Development Kit. For more
information on this, please visit our website: http://www.motivewave.com/support/sdk.htm

3.23 Tool Bar

A tool bar is available from the Console or from a Chart Window and contains a convenient set of
buttons for performing common operations on a chart. This tool bar may be configured from the
Preferences dialog (Configure -> Preferences from the Console menu bar). Additional tool bars may be
added to the bottom or sides of the window.

Actions can be added or removed from a tool bar by selecting them on the right side (to add) or left side
(to remove or re-order) and use the left and right arrow buttons in the center. You can re-order the
buttons and add separators (or spacing) by selecting the action on the right and side and using the
buttons to the far right.
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Tool Bar Preferences

e

Preferences X

-

General Theme CharlSounds Ratios Elliott Wave Garlley Tick Charis OCrders Alerts Email

Custom Tools Tool Groups

Use this panel to configure the actions available on the toelbar. Select the tool bar you wish to configure from the drop down.

Tool Bar: | Top v/| Enabled

Available 4 -Choose Tool Bar- ar Actions:
Wy 3 Driv| More than one tool k Search ™
w50 |Top2 bar may be added to  |rch for Instrument Use these buttons to
W AB=C| Bottom the window parator change the order of the
& Add S| | et [ New Analysis buttons or add )
las Add ran = sove separators and spacing
i Alert {5, Save As

Bar Size Selector
W AltemMarcmo—co & Open/Manage Analyses

M, Altemate Bat 81 Save As Image
/& Annotation i - Separator

2 An
A Arrow
4 Arrow D

1 Arrow Up
W Auto AF
M Auto G
A Auto Wi
B Balloon
§- Bar Settings

Choose 1 or more actions
from the left side and use
the right arrow button to
add them to the tool bar

W Tool| button to remove them from
@, Zoo the tool bar

. il Bar Type
Alterrjatlvely, drag a?d 4 BeT T
| drop items from Available
and Tool Bar Actions. Reset | ResetAll
ok || apply || cancel

MotiveWave

~wangEEw--
A vz T ie. Evoly

Additional tool bars can be added to the windows by selecting the desired tool bar from the drop down
and checking the Enabled box to the right.

Top2 and Left Tool Bars Enabled

[ SPX500 - Primary Analysis - 15 min 62 - X
File Edit View Study Strategy Format Window Help
SPX500 |~ Q |l & B =~ @] [ W~ 2w~ & I~ M~ + T 2~[15mn  ~
BB KTl N 7 el My v ffy o~ B~
» SPX500 - 15 min D
a | I
L
k I% ﬁ T **ﬁ'{'ﬂ 1
T I !
In this case, both top tool bars have T ]
22925
/\ been enabled as well as the left side ]
4 tool bar. Optionally a bottom and right ]
\\‘\_ hand side tool bar could be displayed D 12290.0
Pl T D ]
ﬁ'\' 122875
- p
e ]
no f 12285.0
m- " T :
¥ Iﬁgj-“ TD T 122825
] ]
_'_|:]q 122800
iy 4 |j This is the Bar Size Selector
i F ! I:I'I""D Tool Bar. It can also be 2775
= - D‘¢-¢Q-D+"' configured in Preferences.
T Motivewlﬁlj ! 274.
Feb-03 200 3:00 400 500 6:00 7:00 8:00 95:00 10:00 12:00 14:00 Feb
1min Smin 10min  15min 20min 30min 45min 1hour 2hour 6hour 1day 1week 2week == = vy @ &+ A

Feb-04 11:05:51
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3.24 Lock Studies

The Lock Studies feature is a convenient way to keep the current set of studies on a chart when you

change the instrument. Choose View -> Lock Studies from the top menu bar to enable this feature on
the selected chart. To change the instrument on a chart, type the new symbol into the Quick Search
box on the left side of the tool bar and press the Enter key.

[

MotiveWave

The following two screen shots illustrate the usage of the Lock Studies feature

Enable Lock Studies

Pivot Points(1 da)

¢ Components Alt+C
= Semi-Log Scale
3 Replay Mode
£ Cursor Data Alt+D
¥ Snap Wave Points F5
#{ Auto Analyze F&
o
v oal tzg; EEJO:LS - Choose View -> Lock

INTC - Primary Analysis - 16 min*

File Edit View Study Strategy Format Window Help
INTC - Link W Q I+ "I &~|15min -
INTC - 15 min Display ’

Studies from the top
menu bar

] Group Stiatties
I, Show Volume
@) Increase Hide Below Degree  Ciri+1
@ Decrease Hide Below Degree Cirl+|

*ﬁyD

Alternatively, click this
button on the tool bar

T° Reset Vertical Spacing
v ik Show Extended Data 41640
(' Clear Local Data .
A
&2 Compact F7 5
=36.30
ﬁM tiveWave H36.20
11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 16:00 17:00 18:00 19:00
| +x
2 J0.4000
~0.2000
e 0.008590 ]
1min Smin 10min  15min 20min  30min  45min  1hour 2hour 6hour 1day 1week 2week 1month 3month s ey @ ¢+ &

Lock Studies — Change Instrument

Feb-04 11:13:09

File

Edit

Enter new symbol
in the Quick
Search Box

View

GOOGL - Primary Analysis - 156 min™
Format  Window Help
I e~ §~[F]E[E 2-]15mn  ~

Study  Strategy

i Daily Volume Profile

Hnuh!

Existing set of studies remain

N

J] on the chart when the H818.00
ﬂ' ﬁ* instrument is changed.
Dd] l ' 816.00
hdl N
—H814.00
Motive\Wave = H812.00
15:00 Feb-02 11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 16:00 17:00
v
Chaikin Money Flow(20) NN X

W

1 min

5 min

10min 15 min  20min 30 min 45 min

1hour 2hour Ghour 1day 1week 2week 1month 3 month =

Feb-04 11:15:13
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3.25 Lock Scroll

Lock scroll is a convenient way to maintain the same position across multiple charts when using the
scrolling feature to move forward or backward on the historical price axis. Choose View -> Lock Scroll
(from the top menu bar) or use the button available on the tool bar to enable this feature.

When this feature is enabled all charts that are part of the same Link Group will scroll to the same
position when one of the charts is scrolled. If the chart is not part of a link group, but rather on a

Console page. All charts that are on the same page will scroll with chart.

Enable Lock Scroll

Lock Scroll Enabled

(> MotiveWave - Console (google)
File Edit View Study Strategy Format Configure Window  Help
AAPL M Link » W Q@ -+ ™I || 5min - |
Ll GOOGL 15 Display g
GOOGH 15 m ¥ Components Alt+C /\ : }
P ; Semi-Log Scale Alternatively, !
I ﬂ'f"-, J Replay Mode click this button !
% B CursorData Alt+D !
¥ Snap Wave Points F5 ; !
# Auto Analyze F6 - |
v ™F Lock Scroll Choose View -> Lock Scroll i
14 Lock Lyudies from the top menu bar i
[ Group Studies !
Ul Show Volume DI‘?“I :
@ |ncrease Hide Below Degree  Ctrl+1 |[:]TT '-|-¢++-+.,¢u, i [
@ Decrease Hide Below Degree Cirl+| * h. ¢DU*?:I
e
T7 Reset Vertical Spacing “'T+¢D? e !ﬂ]! et
MofiveWave | ./ ;) Show Extended Data |ty
- | L L L L
Jan-26 (™ Clear Local Data 12:00  14:00 Jan-31 12:00 Feb-2017 1200 143
1min  5Smin v = Show Tabs 1hour 2hour 6hour 1day 1week 2week 1 montha
——— ¢ compact F7 —,
(%]
Lt MSFT 1h oy & 7|l AAPL 5m %
MSFT - 1 hour AAPL - 5min |
Volume i

~ MotiveWave - Console (google) L
File Edit View Study Strategy Format Configure Window Help
GOOGL |~|Q W & R E-@|" K 2 w~- @ i~[+[=T e~ [15mn  ~ | 28X 5D
Ll GOOGL 15m x | + [E
GOOGL - 15 min 860.00
" i¢¢ Lock Scroll is
.‘?p.“lmnuv‘? o I]AT'Iu'i u enabled £50.00
! D “Hobray, :
+ L] |
Dragging the chart left or
' right will move the charts
T I, below in sync.
?TD L -
I[:] i Wooking, | . o ; []! ik, + *Tl&l‘un;nl,u.ﬂ,*._n“!_
‘l.‘ ¢u¢-d="+¢?¢u ?} ?Iﬁ ~ ""ED LI (ol PR
MotiveWave T f ! Muismtoscrn 70
" " " " " " I " " e " " "
12:00 1400 Jan-27 1200 14:00 Jan-30 12:00 1400 Jan-31  12:00 Feb-2017 12:00 1400 FelFeb-02 17001 1400 Feb-03 1200 14:00 16.00

1min 5min 10min | 15min | 20 min 30 min  45min 1 hour 2hour 6 hour/1day 1week 2week 1month 3month = ey @ &
Ll MSFT 1h x | + B ||l AAPL 5m x | + = "
MSFT -1 hour ﬁhm’ i AAPL -5 min 1291
ﬁ I | li 12905
ﬂlxﬂ 1 h ?
| b
b1 | I'.ll HWU
H () ? H [ 12880
™ | -
] Tl | '?.l |'i ﬁu Hg I DTM 12860
il LS L M il
s I A 0 Lt g o
stvan il i
TP e vatvorisvs | , , ‘ ‘ L
Jan-24 Jan-26 Jan-30 Feb-2017 Feb-03 Feb-06 Feb-07 Feb-08 11:00 12:00 13:00 14.00 15:00 16:00 17.00 18:00
1min 5min 10min 15min 20 min 30 min 45 min 1 hour =7 = g @ |=|~ | 1min  5min 10min 15min 20min  30min 45min 1 hour =7 = gy @ @ B
il Home Wl Charts X .8 Account [&! Scan  {l{ Optimize News  + m N O

=88

Feb-02 11:15,836.99 0:820.85 H:821.46 L:820.35 C:820.35 V.14 4K R:11.11

Feb-04 11:26:36
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3.26 Study Templates

For convenience, studies can be organized into templates. A template contains one or more studies
with specific settings. To create a template, simply add and configure all of the studies you want to
include on a chart. When you are satisfied with the studies and their settings, choose File -> Template ->
Save As Template (from the top menu bar, Note: File -> Chart -> Template -> Save As Template from the

Console).

Create Template (Step 1)

il MSFT - Primary Analysis - 15 min® BHo- W X
File | Edit View Study Strategy Format Window Help
Ll New Chart Window CtieN (<) KB W~ ~[+ | T|R~|15mn  ~ i @[3 >
il New DOM Window —
) New Time&Sales Window
Ll New Chart Tab - 63.68
& New Analysis L Df? de360
& Manage Analyses -|- 3
I3 Save Cirl+S [ +0.618 1350
i Save All Cirl+L 05 1
IS, Save As 63.43
Template ' B Spve As Template 7
&' Import Data = Mdhage Templates easn
&' Export Data T -
ala Import Analysis Ctri+K - Ll
& Export Analysis Ctri+J ad . 1l of th di 76320
3 Save As Image A. jcon_ igure all o the studies you 8P
D wish to include in the template on a A3 1
isconnect § 83.07
Exit chart. Choose File -> Template -> Save
| !u ‘ As Template to create the template —463.00
mpy J62.50
62.80
MotiveWave 0.5
1 I 1 1 I 1 : ; : : : : ;
15:00 Feb-02 11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14
: (Alternatively, click on this x
CEICEN- 1?}.% L ] ] drop down and choose ___@
e o Yt 3
Save As Template
H-400.0K
H-800.0K
imin Smin 10min ' 15min  20min 30min 45min 1hour 2hour &hour 1day 1week 2week 1month 3month =E gy @ |y B2

Feb-04 11:30:40

Save As Template Dialog (Step 2)

Last Updated
Choose a name for the
template

MNo content in table

Click Save As

=, Save As Template X
Enter a name for the template and click the Save As button. To overwrite an
existing template, select the template from the table below.

Template Name: [ My Template]
N a +

Save As Cancel

A study template can be applied to another chart by choosing File -> Templates -> <Template Name>
from the top menu bar (Note: File -> Chart -> Templates -> <Template Name> from the Console). Short
cut keys are available to make this more convenient. Short cut keys are Alt + 1, Alt + 2 etc where the

number key applies the template in the order they were created.
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Apply Template

I 4 I\/Iotive-'} A

LT 1T T L

File | Edit View

[ Ll New Chart Window
i New DOM Window

Ll New Chart Tab

B New Analysis
& Manage Analyses

]

Save All

IS, Save As
Template

B Import Data

& Export Data

ala Import Analysis

s Export Analysis

81 Save As Image

Study

D) New Time&Sales Window

Ctrl+L

T
Ctri+K
Ctrl+J

700

Strategy
ciri+N B |

AAPL - Primary Analysis - 15 min
Format  Window Help
I 2w~ & 0~ [+ "5|Z]&~|15min

-

& Manage Templates

Mﬁemplate Alt+1

Select the template from
the menu (note keyboard

short cut is Alt + 1)

.
-

1200 1300 1400 1500 Feb-03 1100 1200 1300  14:00

130.25
130.00
129756

129.50

129
129.05|

12875

128.50

128.25
128.16

128.00

Template is also
available from the

drop down

Disconnect
Exit
MotiveWave :
" i
15:00  Feb-02
1 mi
=

Template

Smin  10min | 15min  20min  30min 45min 1hour 2hour 6hour 1day 1week 2week 1month 3month

AAPL - Primary Analysis - 15 min™ N - X
File Edt View Study Strategy Format Window  Help
[ER -k ® R s & CIR e ey prEE[TIev15mn - I ai %3 >
AAPL - 15 i H H130.50
My Templat Legend displays the
+1.00
name of the template
u*u d130.00
+0.618
This is the template 3129 50
after it has been applied +05
I to this chart.
T ' *é -L?L—'I
| 0
]+H THTEey
128.16
. d128.00
tiveWave =
" " r ! ! T
1500 Feb-02 1100 1200 13:00 1400  15:00 Feb03 11:00 1200  13:00 1400 1500 1600  17.00
CE(C,EMA,2,13) | +x
s X L2 R A—
x == =
i -4.0M
imin Smin  10min 15min  20min  30min 45min 1hour 2hour 6hour 1day 1week 2week 1month 3month s gy @ ¢l B

3.26.1 Removing a Template

To remove a template from a chart (including any associated plots). Right click on the template name (in

the study legend).

Remove Template

Lk
File  Edit = =
AAPL - Right click on the
template name
AAPL -15
My Terolate i
Edit »| ¥y unde Cirkz
|_| Cut Cirl+X
Copy Ctri+C

y  Format
o]

[F] Paste Ctrl+
x Delet& Delete Choose Delete

IX 2le~Q i~TE

AAPL - Primary Analysis - 15 min®

window  Help

&2« | 15 min

= I
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3.26.2 Managing Templates

Your existing templates can be managed from the Manage Templates dialog. Choose File -> Templates -
> Manage Templates (from the top menu bar). From this dialog you can rename, delete or change the
order of the templates. The template order affects the short cut keys (Alt + 1, Alt + 2 etc). Changing the
order will affect which template applies to each short cut key sequence.

Manage Templates Dialog
Manage Templates b4

=

The list below contains the available templates. From here, you can rename
and remove templates using the buttons below

Name Last Updated *
My Template
Moving Averages 1

Moving Averages 2

Trade Setup 1

Exit Strategy 1 The order of these templates affects
the short cut keys (Alt+1, Alt+2 etc).
To change the order select and use
the up/down buttons below.

Rename Delete up down Import Export Close

3.26.3 Import/Export Templates

For convenience study templates can be exported and imported into a workspace. This can be useful for
sharing templates or moving them between workspaces. Both of these operations can be done from the

Manage Templates dialog (see previous section). The Import/Export buttons can be found at the
bottom of the dialog.

=5

= Manage Templates X

The list below contains the available templates. From here, you can rename
and remove templates using the buttons below.

Name Last Updated *
My Template
Moving Averages 1
Trade Setup 1
Exit Strategy 1

Select a template above
and click Export to save it
to an external file

Click the Import
button to import an
existing template.

A¥4
Rename Delete up down Import Export Close

3.26.4 Template Preferences

Preferences for study templates can be found in the Preferences dialog. Click on Chart then on

Templates. A default template can be configured (check the Use Default option). This will be displayed
whenever you create a new chart.
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The Link Templates option will apply a template to all charts that are part of the link group (if

configured, see the Chart Linking section).

Template Preferences

o

General Theme E®GENS

Preferences

Tool Bar Sounds Ratios Elliott Wave Gartley Tick Chaits Orders Alerts Email

X

-

Chart Settings Indicators Labels QEEylEIEG Options Bar Sizes Bar Size Selector

all charts.

This option enables you
to setup a default
template for all new
analyses

Use Default

Default Template: >

Template Title: | Name Only -

v/| Confirm Overwrite Studie

This option affects
what is displayed in

v/ Link Templates
the Study Legend

This indicates that templates
should work in conjunction
with Chart Linking

OK Cancel

Apply

The settings below enable you to change the behavior of chart templates. The default template (if enabled) will be added to

3.27 Linking Charts

Chart linking is a powerful feature that enables you to apply an action to a set of charts (instead of a

single chart at a time). By default charts are unlinked (no link group assigned). There are a few different
ways to assign a link group to a chart. The simplest is to choose the link group from the status bar at the
bottom of the window (Note: this also works for DOM and Time/Sales windows).

Link Chooser

AF,.‘_,_.HTT‘—\—/“

WH

e e

Hyg

Select the link color group i
Motivd from the color options E

ii+

I I
12:00 13:00

14| Feb02 14.45

T\ J Fepuz 1100
1 min SMH 10min 15 min  20min 30 min 45min  1hour 2hour &
5 €b-02 14:45,129.05 0:128.13 H:128.22 L:127.96 C:128.2"
There are three modes for linking charts:
1. Instrument (Symbol) — In this mode, changing the symbol on one chart will change all charts in

the link group to the same symbol

2. Time (Bar Size) — If the bar size is changed on a chart in this mode, all linked charts will change to
the same bar size
3. None (Replay Mode) — This mode is for linking charts together for use in replay mode (linked
charts are part of a replay group)
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LT T T T

Link modes can be chosen for each link color individually. These options can be found in the
Preferences dialog (Configure -> Preferences from the console menu bar).

Link Mode

Tneme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email =

o] Preferences X

General Keyboard Mouse Fonits Quick Search Ticker Tape EELISHGE Dock Trading Hours Simulated Accot (=

This panel defines the type of linking to be used in MotiveWave. Linking may be tied to the selected instrument (default), bar
size or none (used for replay mode)

Default Link Type: | Instrument N v/| Use Default
PRIy [nstrument

Type of link can be chosen
for each link color
individually.

Bar Size
@ Red Link:
None (Replay)

@ Green Link: [PISTOment _‘v

@ Blue Link -
Yellow Link: >

@ Orange Link: -

@ Purple Link: -

@ Maroon Link: -

@ Navy Link -

Pink Link: -

@ Dark Green Link: -
@ Brown Link: -

OK || Apply | cancel

Other windows such as the DOM and Time/Sales windows can also be given a link group. In the example
below, two charts and a DOM Window have been assigned the same link color. Choosing a new symbol
from the quick search box from one of the windows will automatically change the symbol for all
windows in the link group.

Linked Example Step 1

&

12:00

Tmi #H“%
L

[ ] INTC - Primary Analysis - 15 min* - " X|e DOM (simulated - INTC) - W X
File Edit View Study Strategy Format Window Help File Options Window Help
M [FJalmE s s-@DCcEelere i~ + ST e~[1amn  ~ | » |[INTC ~ || Limit Order ~ [ 1003]= T}
S 687| 10 20 30 50 (100 150 200
GCL :
PIL Orders Bid Price Ask Orders Volume *
Choosing a new symbol - 3664
from the drop down will 3663
switch the symbol in all of + 26.62
GGG the "Green" linked windows
ilj_'l 3661
Lo *J' *_L E]F'- ‘ D*_ 36,60
GLYHO ? T * -
36.59
GMG
GNC 36.58
L L L L L L L L L L 36.57
GMNS gy 1200 1300 1400 1500 Feb03 1100 1200 1300 1400 1500 16:00 556
1min 5min 10min  15min  20min 30min 45min 1hour 2hour 6hour 1day >4 E e |+~ 8 T
= 36.54
[ ] INTC - Primary Analysis - 15 min™ Z: = .f x 2653
File Edit View Study Strategqy Format Window  Help
INTC R EE sr@CIK e (-[F][T[E e-[15mn - | » 3651
@ INTC - 15 min 36.50
36.49
36.48
36.47

36.46

36.44

0

13:00

200

0

NIA Buy Mkt

500 Feb03 100 7200 1300 1400 1600 1600 1700 1800 LG s |

1min 5min 10min [15min 20 min  30min 45min  1hour 2hour 6hour 1day =4

= kv @ |4~ M 0.04 | simulated ~
Feb-06 9:07-55 I
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Linked Example Step 2
[ ] GE - Primary Analysis - 15 min - " x|e DOM (simulated - GE) = o R
File Edit View Study Strategy Format Window Help Help
GE Yl H o=@ Kelere i+ F[Ee-[15mn -~ » |lGE ~ [ 100 2= @ O
® GE-15min [} 2980)| 10 20 30 50 100 150 200
volume Price Ask | Orders Volume *
H
- 29.79
U ﬁ*ﬁ¢?¥lhg+l ¢+_I_H *Q 2978
2977
E' . ! H;l 29.76
wot ﬂl g
~ —____ . 2974
L L | (. R S lﬂ .DHHH-HHI‘H.. , p——
11:00 1200 13:00 14:00 15:00  Feb-03 11 UO 12:00 13.00 14:00 15:00 1600 17:00 29.72
1mn 5min 10min 15min  20min 30min 45min  1hour 2hour 6hour 1day =4 s v @ ¢~ B o7
Feb-06 9:13:27
® GE - Primary Analysis - 15 min 52 - S BES
File Edit View Siudy Strategy Format Window Help 2968
INTC ok E sr@ Kelera o-ETE 0~ (15mn -~ 2967
@ GE-15min =] 2966
Volume
2965
T l 29.64
- 2963
H- mwuwl wﬂ I
2961
ol ; gﬁ
*#ﬁ' 0 0 [
j v
ol Mo —mm B wBEE A ﬂ l- mﬂﬂ-nm- L [seri i |

11:00 12:00 13:00 14:00

1500  Feb-03 11 UD 12:00 1300 14:00 15:00 1600 17:00

imin 5Smin 10min 15min 20min  30min 45min 1hour 2hour 6hour 1day =4

= v @ |0y 8

Feb-06 9:13:27 =

simulated b

Feb-06 9:13:27

3.27.1 Linking With Templates

As discussed in the Study Templates section the linking feature can be used in conjunction with the

Study Templates. If enabled (see Preferences dialog, Chart -> Templates tab), applying a template to

one chart in the link group will apply the template to all charts in the link group.

3.27.2 Link All

If you are working with the Console window (or a Desktop), you will notice an additional linking option,
Link All. This option will link all charts that are on the current page. This provides a convenient way to
link all the charts on a page with one click (instead of choosing a link for each chart).
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~ MotiveWave - Console (google) x - m’ X
File Edit View Study Strategy Format Configure  Window  Help
MSFT vl B A e @0 ClR ey @ i~ [FEIT S5m0~ #®8XGmD R
Lml AAPL 15m x | + &2 No Group ISFT 15m* x | +
& AAPL 115 min H Choose Link All from & &"K All "SFﬂlﬁ“: min
! o I] l the link drop down ed Link 1A
e . nom . Green Link ¥ "
- THion,, SIS RS E ® Blue Link ! J(
Charts show the Yellow Link ! +
link group to the @ Orange Link ! “
left of the title @ Puple Link | *Iﬁ h++'
@ Maroon Link 1 *H‘ *!ﬂlh n+ * o
: @ Navy Link ! il ¢* ﬂl]+
1 Pink Link 1
i @ Dark Green Link i U' ﬂl‘ ”HT “ﬁ”m“uime
: ® Brnu\‘fn Link ! . ﬁﬁ] L;ﬂ*“ﬁdnﬁ
|
s
m»é\ﬁlavd MotiveWave :
Feb2017 1200 1400 Feb02 1200 1400 Feb03 1200 1400 1600 Feb2017 1200 1400 Feb02 1200 1400 Feb03 1200 1400 1600
1imin Smin 10min 15min  20min 30min 45min 1hour *7 = @i @ |=|> g|{1min Smin 10min [ 15min 20 min 30min 45min 1 hour 7 = v @ |o|+ B
Ll GOOGL 15m x | + B 7|[lal 18V 15m x| + = "
< GOOGLI - 15 min '626.13 & 1BM- 15 min 176.34)
! } Ja250 | ot ;
| | i
! TIé 1 hyeoa +
' i} []' 4 Hs2250 ! I h,;l’,]* bt
| " M |
uﬂl*T: ' qi I * pEPIRE) } ‘ J l. ﬁm
I I
; i IH on
%D*l#‘r? i ' M‘ﬁ*n meﬁ Het7.50 Dﬂﬁ | | it ~*|]+ I u”
! " & 4 . I
' i o It
| i —815.00 i '| ﬁ!-’:l
Alternatively, you can _— ! 1 H‘H”‘“'I . MI'“N -
Molivf selact it from here . . . . . . 181250 i il Hﬂlnlﬂiﬂﬂlﬂﬂ |ﬂ|mllpnﬂnnlnﬂmﬂ Iﬂ lun] ﬂﬁl
Feb-02 1200 14:00 Feb03 1200 1400 1600 Feb20i7 1200 1400 Febd2 1200 1400 Feb03 1200 1400 1600
1 min II /ﬁin 10min | 45min 20 min 30 min 45min 1 hour *>7 = v @ |=|> 2 ([1min 5min 10min  15min  20min 30 min 45min 1 hour **7 = vy @ =+ A
|l Hom' |l Chars X @ Account [ Scan  {lf Optimize News  + m N O

Feb-06 9:17:29

3.28 Working with Chart Windows

3.28.1 Compact Mode

Compact mode strips away the tool bar, menu bar and status bars to maximize the chart area on a chart
window. Use the compact/uncompact button on the right hand side of the title bar to switch between
regular and compact modes.

Compact Button

%Primary Analysis - 15 min Ky - K
ft Window  Help
K elwy @ §v + T[T

&2« | 15 min

Click here to switch to
compact mode

The screen shot below illustrates a chart window in compact mode. Notice that the chart area fills the
entire window to optimize the use of screen space. Click on the uncompact button on the tool bar to
return to normal mode.
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[otal GE - Primary Analysis - 15 min e X
GE - 15 min 0 29 80)
Volume

to normal mode

Click here to return

* i —29.55
29.54]
) S —— L - — R §56.5
Mmﬂﬂ-lﬂlmﬁﬁ-q.ﬂI-..ﬂ-ﬂ Iﬂllllﬂ.ﬂl.lﬂﬂﬂﬂ-nmilﬂ.l ,
11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 16:00
1min Smin 10min  15min 20min 30min 45min 1hour 2hour Ghour 1day 1week *=3 = @y @ ¢+ B

The behavior of compact mode can be configured in the Preferences dialog (Configure -> Preferences
from the console menu bar). This allows you to specify what elements should be displayed in Compact

Mode.
o) Preferences i
Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Emall (=
:arch  Ticker Tape Linking Dock Trading Hours Simulated Account Watermark Auto Update EeGlls=ladlilbhizl (=
Select the features below that you would like to show or hide when viewing a Chart window, Chart Group or the Console
while in Compact Mode.
I
Show Tab:
ow 1abs These apply to the
Show Page Bar Console and Desktops
Show Menu Bar
Show Tool Bar
Show Status Bar
OK || Apply Cancel
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3.28.2 Tile Windows

o’/

The Tile Windows feature is useful to arrange your charts on a single monitor without having to position
the windows manually. Start by arranging the chart windows roughly where you would like to place
them. Once you have done this, right click on the title bar of one of the chart windows and choose Tile
Windows (alternatively, press Ctrl + W). Note: on Mac OS X choose Window -> Tile Windows from the

top menu bar.

Tile Windows Before

il MSFT - Primary Analysis - 15 min™ .;= - " X | [ TSLA - Primary Analysis - 15 min Moo T x
MSFT - 15 min H 63.70 TSLA 48 chid
il i P ENEVA H252.00
Always On Top
GE‘ 15 mi Right click on the title bar E§i\e Windows Ctri+wW
ume and choose Tile Windows or Cascade Windows £251.54)
press Ctrl + W Restore Windows %
Window Size I T H;l
=1 H29.ru
ﬁ Jk u* : r Hﬁ J251.00
DT*H; L Lj H29.65 4250.50
LJ'] 2963
29.61 H250.00
29.60
Motive\Wave 29.59 H
L L 1 I 1 1 I i 1
11: CID 12 UO 13 00 14:00 15:00 1100 12:00 13:00 14:00 15:00 Feb-06
1min Smin 10min _15min 20 min > 1' I i : i< 1I5min . 20min 30 min 45 min =g = sy @ |[#r 2
. T T 813 29
] Hﬂﬂ-ﬂmllﬂ.l ; acoiid B " &'l
1100 1200 1300 1400 1500 Feb-06 T . _L
1 min  5min  10min [ 15min 20 min  *3g = v @ |=l~ oo -
T I 1 +245500.00
él ‘ ‘ FI I i - 245378 00)
* l Iﬂﬂee-*ﬂ. 82200 J245000.00
HT *W TN ik ﬂ
D 820.00 1244500.00
?+|j 8193
ool L
lntivewave MutweWav‘e . . . . ! | .l-|_||_| _-. ..-_*-ﬂ &
500 Feb3 00 1200 1300 14 1100 1200 1300 1400 1500 Feb06 1200 1300 14.00 1500 Feb-06
imin 5min 10min  15min_ 20min 30min 45mi{ 1Min 5min  10min  15min 20 min > = v @ |~ 2| 15min 20min  30min g = ey @ |4 2
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il - y Analysis - 18 min’ AR - w 2| Lt GE - Primary Analysis - 16 min AR - & 2 Lt TSLA - Primary Analysis - 16 min AR - x
MSET - 15 min {6370)| GE .15 min i TSLA - 15 min 1253 50
Volume
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_ Uag.70 253.00
1j63.50 D 2968 n <;
2 252.60
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H63.40 29.65
EEX 252 00
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imin 5min  10min  15min >4 = gty @ |=|~ g2 | 1min S5min 10min 15 min =5 = v @ =l 2| 1min 5min  10min  15min =44 = gy @ ¢+ B
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T
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* * _l_|j H128.60 _ i)
1816.00
&5] **Tﬁ-ﬂﬁ Qi2sa0),, . I Il £45200.00
Motivelave ) ; MotlveWav:e ‘ ) ‘ . ._-.ﬂ I13[].[]0
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3.28.3 Cascade Windows

Similar to the Tile Windows feature, Cascade Windows arranges the windows that are on the screen on
top of each other offset from the top left corner. Choose Window -> Cascade Windows from the top
menu bar to arrange the windows in this fashion.

Cascaded Windows

MotiveWave - Console (gooale) 2o o x|
f Lo AAPL - Primarv Analysis - 15 min B2 L x|
o GE - Primarv Analvsis - 15 min =2 x|
M BRK.A - Primary Analysis - 15 min B Lt x|
wd A1 MSFT - Primary Analvsis - 15 min* £z . x|
S G o L GOOGL - Primarv Analvsis - 15 min 2 L x|
II-J* G(8 " o Lt TSLA - Primary Analysis - 15 min* I S
N
] | File Edit View Study Strategy Format Window  Help
' 6l TsLA ~oalmEE sr-ED IR E|lwr_Q §- + B[IZ]&2~[15mn - | P
TSLA ;15 min
M EJ 253.02)
[ 1]
Lol 3
s i l < 314
“ iy TP |
TQT Tﬁ:‘?“j + T T -D 251.00
250.63
l: Lm H J250.00
1w JJE
ll——’H‘ =249.00
1|
= M
HL I J248.00
1| Mulive\-’?la e
- ; . . ; . ; . . ; .
B 1 Feb-02 11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 Feb-06
[ 1mn 5min 10min  15min  20min 30min 45min 1hour 2hour Ghour 1day 1week 2week 2 = v @ 4 B
= ¢

Feb-06 9:47:48
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3.28.4 Window Sizes

For convenience, the window size can be set from the Window menu (Window -> Window Size ->
<Size>). This can be a useful feature for taking a screen shot or video. Choose Custom to specify a size
that is not one of the presets.

Window Sizes

[l TSLA - Primary Analysis - 15 min T I
File Edit View Study Strategy Format Window | Help
TSLA ~ Q| K B Ery@ED 3 Bring All to Front v 44
TSLA 15 min Tile Windows CIr+W !
Cascade Windows
Restore Windows
Always On Top 55300
DUITIENT HEE 2 Custom Choose this option :
MotiveVWave - Console (google) A25x%344 to specify a custom
i AAPL - Primary Analysis - 15 min 450x385 width/helght ]
L GE - Primary Analysis - 15 min 530x530 =252.00
TD ‘% “ﬁg BRK A - Primary Analysis - 15 min 640480 ]
MSFT - Primary Analysis - 15 min*® 640x505 T-I- Ij ]
GOOGL - Primary Analysis - 15 min 800x500 —D _:251 00
TSLA - Primary Analysis - 15 min 960x540 1=
1 ' 960X¥45 (250.63
1024x768 E
1200x840 d250.00
L 1280x720 3
1280x768
1280x800 ]
1280x1024 3249.00
1440x900 E
1920x1080 E
. Q248.00
MUtivevYa © 1 1 1 1 1 1 1 1 1 1 1 |
Feb-02 11:00 12:00 13:00 14:00 15:00 Feb-03 11:00 12:00 13:00 14:00 15:00 Feb-06
imn 5min 10min  15min  20min  30min  45min  1hour 2hour 6&hour 1day 1week 2week =3 = vy @ 9> B

Feb-06 9:52:29

3.29 Replay Mode

Replay mode is a very useful feature that enables you to go back in time and replay market data. This
can be very useful to practice your trading or to test your custom studies and/or strategies. The replay
mode control can be accessed from the chart menu bar: View -> Replay Mode (Note: there is also a
button on the right hand side of the tool bar). When you click this menu item you will see the Replay
Mode bar appear at the bottom of the chart.

Displaying Replay Mode

sl BRK.B - Primary Analysis - 15 min 1 VI
File Edit | View | Study Strategy Format Window Help
BRK.B - Link »wv Q@ I~ + TE[I]2~[15mn ~ 2m e[ WEmY »
rRKB 15 mil D‘Splav g
A 3£ Components Alt+C 116425

= Semi-Log Scale i Alternatively, click on
¥ 5 Reflay Mode Choose View -> 4 the Replay Mode icon {1464 gg
E_‘ Cursor Data Alt+D Replay Mode (from _L on the toal bar.
¥ Snap Wave Points F5 the top menu bar) L m iﬁ l - 163.8
#%{ Auto Analyze F6 * + - &' * + 163,79
! ™% Lock Scroll il.?lm

A4 Lock Studies

[] Group Studies HF +163.50
+ I, Show Volume
@ Increase Hide Below Degree  Ctrl+1 1632
@ Decrease Hide Below Degree Ctri+]
17 Reset Vertical Spacing 163 00
v i Show Extended Data
C‘ Clear Local Data
2 Cnmpact TT 16275
i ’_l q162.50
T - — - 713K
IH]“IIHIH L] -ll N T rer—" TR | . (KL
1500 15:00 Feh 02 1100 1200 13:00 1400 15:00 ReplayBar 790 1200 1300 1400 1500 Feb 06 11:00
1imin 5min 10min [ 15min  20min 30min 45min 1hour 2hour 6 nourWek 2week 1month 3 month E gy @ |+~ B
o | | w | W stat 22017 [E|[e30Am @ BRKB 15m BarData & % X

Feb-06 9:55:50
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Replay mode can be started by choosing a start date and pressing the power button.

Turn On Replay Mode

o

e, e
TWN\/?NSZ.BO

Use the 'Power’ button
to turn replay mode

on/off
13:00 14:00 " FeT00 12000 1300 14:00 1500 Feb-0_
1%/ 5min  10min 15min  20min  30min 48min 1howr 2hour 6hour 1day 1week 2week > = kv @
BRK B 15m Bar Data & 3} X

[CHN. | W m  Stat|262017  (@|[930AM O

A -

Use these controls to

———— | calect a start date/time. - - e - Click here for advanced
Miml | (=il | | U..II—II..-H-HIFI—!:—H—!—-. I configuration options

Feb-06 9:58:53

Use the play, fast forward, reverse and stop buttons to step forward through the data. These buttons
work as follows:

1.

nkwn

Rewind — This will restart the replay mode from the beginning

Play — Step forward in time by 1 tick

Forward — Play ticks until the next bar is reached

Fast Forward — Play ticks continuously

Stop — Stop playing ticks. This is only active if forward or fast forward buttons have been clicked
above.

Replay Buttons
T e e e e T e i

Step forward
by 1 tick

—== ﬁm‘mmlﬂl-m

Stop Replay 7500 Feb-2017

I I I I I I I
11:00 12:00 13:00 14:00 15:00 16:00 17:00

1Tmin 5 min

0min 15 min 1hour 2hour 6hour 1day

2W45min
W | B start 212017 |B||9:30AM |©| Feb-01 9:30

1week 2week > S v @ |+l B
BRK.B 15m BarData & £ X

Feb-06 10:04:53

Restart from
beginning

Play date/time

continuously

Current replay
next bar

When you are working in replay mode will work as if you are trading live back in that time frame. A
special replay account is created to manage orders, positions and historical trades.

3.29.1 Replay Settings

Replay settings can be accessed by clicking the gear icon on the right hand side of the Replay Mode bar.
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Replay Settings Dialog

0 Replay Settings X

Replay Mode enables you to replay market movements using historical data. This may be useful for testing a
strategy or practici lliott Wave Counts).

Choose from Bar Data,
Minute Data and Historical
Tick Data (if available)

If supported by yol
minute bars.

other wise MotiveVWave will r

Use the replay

account to

Replay mode may practice trades

(either in a Chart Group or C

Source Data: | Bar Data - Generate Ticks Replay Accoun

Real Dela
Y Account ID:  REPLAY-1

/| Step Until Price Change
Base Currency: | USD -
Speed Factor:

Cash Balance: 100000.00
Tick Delay (ms):

V| Include Commissions

EIT 1B TEL Linking allows you to
Replay Link: replay several charts
together in sync.
Cancel
Replay Data Settings:

The following settings apply to the playback of data in replay mode:

1. Source Data — Options for source data include:
a. Bar Data — Each bar is used to generate 4 ticks: open, high, low and close
b. Minute Data — Minute data will be loaded from the data service to generate ticks (each
minute bar will have 4 ticks: open, high, low and close
c. Tick Data — If your broker/data service provides historical tick data, then this may be used

2. Generate Ticks — If this is enabled MotiveWave will generate a set of ticks to (beyond OHLC) for
playback. This option does not apply to the Tick Data option

3. Step Until Price Change — If enabled it will keep playing ticks until the price changes when
pressing the play button (instead of a single tick at a time).

4. Real Delay — If this option is checked, MotiveWave will simulate the delay between ticks by using
the tick timestamps. Use this if you would like to simulate the actual playback of ticks in real
time

5. Speed Factor — Applies to Real Delay option above. Allows you to speed up (or slow down) the
play back of ticks in real time

6. Tick Delay — this is the delay to add between the play of each tick.

7. Bar Delay — this is the delay to wait between the playback of each bar.

8. Replay Link — Use these options to link the replay mode across multiple charts.

Replay Account:

The replay account is useful if you intend to place trades in replay mode. If this is enabled, a special
account will be created (see Account page in the Console) to track all orders, positions and historical
trades for the replay session.

1.

2.
3.
4

Account ID — This is the name of the account ID that will track trades

Base Currency — This will default to your base currency, but you can change it if you like
Cash Balance — Opening cash balance when you enable replay mode

Include Commissions — Check if you want trade commissions to be included in the P/L
calculations.
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3.29.2 Linking in Replay Mode

The linking feature in MotiveWave™ enables you to use replay mode across several different charts at
the same time. The following steps explain how to include multiple charts in the same replay session:

1. Select the charts that you want to include and choose the instruments and bar sizes
2. Choose the same link color for each chart (make sure the link type is “Replay”)
3. Edit the Replay Settings

4. Choose the link and press the “Update” button

Replay Linked Settings

5 Replay Settings X

Replay Mode enables you to replay market movements using historical data. This may be useful for testing a
strategy or practicing analysis techniques (such as Elliott Wave Counts).

If supported by your broker, tick data may be used, other wise Motive\Wave will reconstruct the movement using
minute bars.

Replay mode may be linked with other open charts (either in a Chart Group or Console or set of linked charts).

Source Data: | Bar Data - Generate Ticks Replay Account
Real Delay
Account ID:  REPLAY-1
v/ | Step Until Price Change
Base Cumency:  USD =

Speed Factor:

Cash Balance: 100000.00 3

Tick Delay (ms):
I /| Include Commissions

Bar Delay (ms):

Replay Link: | &

-
[
=]
[+
1

& Page
@ Red Link
@ Green Link

Cancel

@ Blue Link
Yellow Link

@ Orange Link

@ Purple Link

@ Maroon Link

@ Navy Link
Pink Link

@ Dark Green Link

@ Brown Link

Note: if choosing a
color link, make sure the
link type is "Replay”

The following screen shot shows 4 charts that are part of the Red group and using the same replay

session:
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Replay Sessmn Linked Charts

L] EPH7 - Primary Analysis - 15 min - x|® CLEH7 - Primary Analysis - 5 min t S X
@ EPH7 - 15 min H @ CLEH7 -5min
Vo | Volume:
. J2284.00 ﬂ 53.35
Red link chosen for Ei:
each chart that is part In this example, all charts that are part of E330
of the replay session. ;
the Red group will be part of the replay S
1 session. When playing a tick from this 2281.75 5325
: T window, ticks will also play in the other
: | chart windows (regardless of bar size). i ] ds320
H H2280.00 l £
H u Lty MT L1 1 i il 5345
H n u & Preferences X
| ! I
! S50 Theme Chart Tool Bar Sounds Ratios ElliottWave Gartley Tick Charts Orders Alerts Emall = i
! U ? 9278.00 - Y 5310
¢ql+ General Keyboard Mouse Fonts Quick Search Ticker Tape Dock Trading Hours  Simulated Accol '
H ! 15305
s This panel defines the type of linking to be used in MotiveWave. Linking may be tied to the selected instrument (default), bar
H Ja276.00 size or none (used for replay mode),
“ 1 55 Js3.00
T i SR | Default Link Type: - Use Default
> H This replay bar controls 5205
! all 4 charts that are 00 + & Link Al | Instrument  ~
1
| eV R . nany i ‘ﬂﬂlﬂﬂ . . . . "a: I“_F"(he replay group Boi @ Red Link | None (Replay)
900 2100 FebZ0i7 200 400 600 800 1000 7200 1400 e (red fink] |
imin 5min 10min 15min 20 min 30min 45min 1hour 2hour Ghour 1day 1weeR /3 = ® Green Link: | Instrument
O | > v m| m]| sat|ano07  [m|e30am [ Fepor a:30 EPH7 15m TickData @ &% X | 1min | 5r] @ Blue Link | Instrument -
YMHT - Primary Analysis - 30 min # _ 2 x|e Yellow Link:  Instrument - S
%"M”Lm’"‘i" ® NGEH ® Orange Link: | Instrument -
e Volume 73400
19880 @ Purple Link: | Instrument -
19871
@ Maroon Link | Instrument -
J1sss0
H3.350
@ Nawy Link: | Instrument -
'W J1ss40 l Pink Link: | Instrument -
T ] @ Dark Green Link:  Instrument -~ d3300
roszo|
@ Brown Link: | Instrument >
Jrss00 13260
Jrs7s0
43200
jreree oK || Apply || cancel
1
i
il w&!lnls»ﬂl h T.l‘ﬁmﬂ‘
gl || . . . R . . g EP—— ;ﬂL Sl 1] [ e | W . . . .
Bﬂﬂ 12:00 16 UD - 12:00  16:00 Feb-02 4:00 8:00 1200 16:00 Jan-29 12:00 Jan 31 12:00 Feb-2017 12:00 Feb-02 12:00 Feb-03 Feb-05
1min 5min 10min 15min  20min 30min 45min 1hour 2hour 6hour 1day 1week **3 = imin 5min 10min 15min 20min 30min 45min 1hour 2hour 6hour 1day 1week >3 =E v @ ¢ @

Using replay mode inside of the Console (or a Desktop) can be much more convenient when Page linking

is used (default).

All charts that are part of the page will be included in the replay session.
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~ MotiveWave - Console (CQG2) 3 SV
File Edit View Study Strategy Format Configure Window Help
EPHT kSl NENC Al IKB2lw~rQ 0~ + F[E|2~|15mn ~ | LW e XEED R
EPH7 15m x | + = *|[YMH7 5m x | + &
EPH7 -15min | YMH? - 5 min
Volume || Active Chart. When playing Volume 19890
I| next bar, the bar size of this ( 19886)
|| chart will be used. U d19880
|
‘ | -
i
i huL 71985
| i,
I When using Replay Mode inside of i 1119860
| U HJ Lth ﬂ!ﬂT a Console (or Desktop) all charts h
| D nl;l iéﬁ* l[]lj that are part of the page are
| U !lil included in the replay group. ﬂ 19850
L
T ! b A
all H [N, Mkl
‘T] ‘ &*ljlllﬁuﬁuu ! [TPC ey I]'r I -
- I a
| Iﬂ ! u
Motvieve g ) ‘ ) ‘ woweteve Tl e h ) ) ‘ ) )
Feb-2017 300 500 700 900 1200 1400 1600 2000 500 700 300 500 10:00 1100 1200 13.00 1400
imin 5min 10min | 15min_ 20min  30min 45min 1hour 2 hour g imin | 5min_ 10min 15min 20min 30min 45min 1hour 2 hour g = v @ 4> @
NGEHT 45m x | + CLEH7 1h x | + = "
EHT - 45 min i CLEHT -1 hour i
? " ! Volume |
i i
l | | v g
: [jf ! 5398
i | J] 5316
i | ‘ | ﬂ
Jr fJ ' ! | 53.00
Tﬁ T’ | 'D*#T !ﬁ. ﬂ T
i i
“ ! ¢+l ! 5280
i 1
i m# h g
! 5260
ll:] +| D“ *- n !,\% : 46 5K
i 3
I?DT [ | |]+r ﬁ 'I ! wl Link type is g
- = —_ P - o - "Page" (all charts 77K
| Hlﬂiﬂ R—— ‘ Current Replay Time A I J e Ll on the page]
Jan-31 12:00 Feb-2017 12:00 Feb-02 1200 Jan31 1200 12.00
imin Smin 10min 15min 20min 30min | 45min | 1hour 2hour ~g\/ = lg2v @ |+~ EA|[1min Smin 10min 15min 2¢ Active Chart (chartto which [75nour >-4 BV
—_— the controls ie play, pla: N
G | > [ 0w | B stat 212017 [m|[930am [@] Feb019:44:59 next bar et apglv)v P EPH7 15m Tick Data (? &} X
Ll Home Ll Replay X + m B O

Feb-06 11:02:30

3.30 Alerts

Alerts are a useful way to receive a notification when a particular event has occurred. This could be as
simple as a price for a particular instrument has been reached or a trend line has been crossed. More
advanced examples include comparing values from different studies.

Active alerts can be managed centrally from the Alerts panel in the Console. By default, this is included
on the Home page. You can add an alerts panel anywhere in the console from the Add Tab button to
the right of any panel tab.

Alerts Panel
Y ek H

T G T T e R Pt PP VY e ]
1 *I¢+¢+ﬂ++|* o ;
1
: % L ] %H ﬁu simulated -
i | LTI N/A N/A
i D‘Hﬂﬁ ‘i hhalm"“*i MFW i | Entry/Exit »
! ™ | Active alert o Ty
Motive - - ) ! ) . . i . . on a chart
Jar| This tab shows activated 7377 Feb 2017 120 Feh0? 1700 1400 Feb03  12:00 1400 Febld
1 min | alerts (history) min 30min 45min  1hoUN| An Alerts panel canbe |1 WeeK 2week 1month >4 = oty @ |v|> M
=NvsE (D / SNASDAQ(21) [TF Alerls x |+ a:dEd a”\’“;hzre from IR N
Alerts (4) | History (1) il Chart the New Tab button
= Watch List N )
Symbol 4 Replay Nan g Depth OF Market Last Value Order Expires Activated Chart
AAPL N Price Crosses 127.15 9 Time and Sales 130.21 el
GE N Price Crosses Tenkan Sen o C'US" Table 29,66 el
-Sen( 11 Position Table g Click the Chart button =
BRK.B N Price Crosses 163.03 @, Trace History Table 16366 to show the chart that El
MSFT N Price Crosses EMA(C,100) | - Account Table 63.44 Optionally, orders contains this alert ‘ C |
News can be triggered
[&1 Scanner
i} Optimizer The 'C" button will
9 Alert Tab{y cancel (delete) this alert
Ll Home X Ll Charts .8 Account  [&@ Scan  {lf Optimize News  + m b O
=

Feb-06 11:26:29
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3.30.1 Price Alerts

The simplest type of alert is a Price Alert. A price alert does not require a chart in order to execute. It
will triggered by the bid/ask or last price of an instrument. Price Alerts can be created directly from the
Alerts panel or from the Price Axis of a chart.

Create Price Alert — Alerts Panel

Right click on the price axis

%"""“""“""“""ljl" and choose Create Alert

) Y

’*+¢'"‘+-+¢Hnﬁm !

i i

i 1 1 i 1 1
? 12:00 14:00 Feb-06 12:00

ﬁ

~—1%¢ | Entry/Exit »
120.00

e e — e A e
“Feb-2017 IO 1400 Feh02 1200 1400 Feb03  12b0~1400 Feb-06 1200 14— """
1min 5min 10min (15min  20min 30 min 45min 1 hour =7 = gy @ |4+ B
=S NYSE(35) = NASDAQ(21) |F Alerts x | + B c el E
Alerts (3) | History (2) Create Alert |
Symbol 4 Replay Name Last Value Order Expires it

Click here to create S
AAPL N Price Crosses 127.15 13012 a Price Alert lc|
BRK B N  Price Crosses 163.04 163 .55 le|
MSFT N  Price Crosses EMA(C,1 63.50 |c|

Create Price Alert — Price Axis
B Trade T

.- m Order Bid/Ask
EIm

Trade 10 F| =~
Create Alert
“arCancel Alerts
Add Guide
simulated v
NIA  NIA

The following dialog is shown when an alert is created from the Alerts panel. Alerts created from the
Price Axis are similar except for the ability to choose an instrument (this is assumed from the chart).

Create Alert Dialog

73 Create Alert X
| it

Instrument Choose Symbol J

Symbol: | AAPL - || O

Symbol Position Bid Size Bid Ask Ask Size Last Price
AAPL 0 130.02 130.06 0 130.04
Parameters
Condition: = Price || Crosses - 130.05 % Indicator
Trigger Multiple
Label:
Label and comments will
Comments: | £ thig is not checked, the be included if an email
alert will disappear after notification is sent
the first time it is triggered
Notificatiol
Show Alert | Yes This section defines how a
naotification is sent when

Play Sound: | Yes ~ |V Use Preset Sound the alert is triggered.

Sound File: e

Send Email: | No >

CK || Save Defaults || Delete || Cancel
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Settings available in this panel are as follows:

1. Parameters

a.

b.

Condition — This defines the criteria for triggering the alert. The first field (input) can be
any of the ticker inputs (last price, bid/ask high/low etc). The last field can be an absolute
price. Alternatively, it could be a relative value (click the Indicator box) such as Last Price,
Best Bid or Best Ask. In the case of a Price Alert, this will be an absolute value in most
cases. Three types of operators are available for comparison:
i. Crosses — Input crosses above or below the second input

ii. Crosses Above — Triggers the alert only if it crosses above the second input

iii. Crosses Below — Triggers the alert only if it crosses below the second input

iv. Touches — Triggers an alert if the target value is touched or crossed
Trigger Multiple — If this option is checked, the alert will still be valid after it is first
triggered. In this case this alert will be triggered indefinitely until it is explicitly cancelled.
Label / Comments — These fields enable you to add your own text to an email notification
that is sent when the alert is triggered

2. Notification

a.
b.

Show Alert — If true the Alert History window will be displayed when the alert is triggered
Play Sound — A sound will be played when the alert is triggered. This can either be the
preset sound or a specific sound file that you can specify.

Send Email — If enabled (and email sending has been configured), an email will be sent to
the given email address when the alert is triggered.

3.30.2 Study Alerts

Alerts can be based on values that are generated as part of a study. These types of alerts execute in the
context of a chart and require the chart to be open in order to be active. Similar to a price alert, you can

create a study
Create Alert.

alert by right clicking on the vertical axis (of the Price Plot or a Study Plot) and choosing

Create Study Alert
e, e e,

He2.75

'
'

iwwwj_JJJJJJJJJJJJl
]

I I i 1 1 i I I i 1 1 I
;2:00 14:00 Feb-02 12:00 14:00 Feb-03 12:00 14:00 Feb-06 12:00 14:00 16:00

| _.J_.___._.JJJJJJJJJJJJ_H i Right click on the vertical _%
el [ L ! |

"l axis (of the price graph or 10,0500

i a study plot) and choose i .

|| Create Alert :;rﬁ Create Alert
j’- =7 Cancel Alerts

=-0 Add Guide

|
|
| -
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Create Study Alert Dialog

Create Alert

7
=0 Avvanced Trace

Parameters

Condition: | MACD(C.EMA,12,26)

-

Crosses

Label: Contains available

study inputs from the
selected study plot

Comments:

Notification

Indicator

A\

If Indicator is checked, the
same set of study inputs
will be available for a
relative comparison

v 01174 5

Show Alert: | Yes ~

Play Sound: | Yes ~ V| Use Preset Sound
Sound File:

Send Email: | No -

Delete

Save Defaults

Cancel

Two types of comparisons can be made with a study alert:

1.
example)

Absolute Comparison — A study value is compared to a specific value (ie -0.1174 in the above

Relative Comparison — A study value is compared against another study value (in the same plot).

Click on the Indicator field to enable a relative comparison.

Relative Comparison

Notification

o Create Alert b4
Advanced Trade
m Check Indicator Box
Parameters I—\
V
Condition: | MACD(C,EMA,12,26) * || Crosses - ’ MACD Signal(9) - I v/| Indicator
Trigger Multiple MACD(C.EMA,12,26)
Label: These are the values MACIRSignaI(S)
from all studies within MACD Hist(12,26,9)
Comments:

the same plot.

EMA(MACD(C EMA,12 26),20)

Show Alert: | Yes

Play Sound: | Yes
Sound File:

Send Email: | No

-

w | |w/| Use Preset Sound

OK Save Defaults

Delete

Cancel

The example below illustrates a study alert where the value of one study KAMA(C,20) crosses the value
of another study (Tenkan-Sen(9)). The alert is displayed where the intersection point would be between

these two values.
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Study Alert — Relative Comparison

v-u-T.n _N
H64.50
H64.25
164.00
. Alert is aligned where
Green line is Orange Line is the intersection point
KAMA(20) Tenkan-Sen(3) would be d637s

. .
: i
A ! )
i !-.--' iz KAMA(C,20) Crosses Tenkan-Sen(9) |Gl s
| i >
(YL al
I S !
|
!
|

Double click to
edit the alert

3.30.3 Component Alerts

Some components can be used to generate alerts. For example, you could create an alert for when a
moving average crosses a trend line. If you would like to create this type of alert, right click on a trend
line and choose Create Alert.

Create Component Alert

e | T

e] Right click and choose
Create Alert

Edit 0
Format 0
Visibility »
T2 Create Aleﬁ?
Show Info Cirl+l
Show Angle
Relative End Point
Vv Extend Ctri+E
Extend Left
Ratios 0
Line
Properties
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Component Alert Dialog
Create Alert X

o
m Advanced Trade

Parameters

Condition: Crosses v || TrendLine ~

Price

Bid
Label: Some components (such
Ask

as Fork, Channel) have
Day High multiple options here.

Comments:

Day Low
Notification pay open

Day Close
52 Week High
Play Sound: | 52 \Week Low Preset Sound

Sound File: | KAMA(C,20) Study values can be J

Show Alert:

used here as well
Send Email: | No -

OK Save Defaults Delete Cancel

In the example below the study value KAMA(C,20) was chosen to cross the trend line. The alert label
shows the current crossing value. Press the ‘C’ button to cancel the alert. The alert may be edited by
double clicking the alert label or via right click and choosing Edit Alert.

Trend Line Alert

A,

!

Dotted line shows where
the current intersection
pointwouldbe T T .

AT P e

Current crossing
value displayed here

%

463.30

Click here to
cancel the alert

In this case a study
value was chosen.

i T

Double click 163.10

label to edit

163.00

[

3.30.4 Trading From Alerts

Trades can be placed when an alert triggers. Click on the Trade tab of the alert dialog to define an order
that will be placed when the alert is activated.
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Alert - Trade Options

{o; Edit Alert

Alert  Advanced

v/| Place Trade on Alert Activated

Alternatively, choose a

ymbol: different instrument

MSFT v | Q

Check this box to

Symbol Position Bid Size
place an order when
the alert is activated P/ | 0 63.47 63.51
Buy sell
Account: simulated bt
Quantity: =
Type: | MKT - Choose the order type _]
Expires: | MKT
T
Limit
& sTP Optionally, you can attach a limit
P wim (profit) and/or stop/trail order.
Trail | TRAIL
OK Save Defaults Delete Cancel

Size Last Price

0

63.49

Orders can be placed on a different instrument from where the alert was triggered. Market, Limit and
stop orders are supported as order types. Optionally, you can attach a limit (profit) order and/or

stop/trail order.

3.30.5 Advanced Alert Settings

Additional options on an alert can be specified from the Advanced tab. This tab enables to you adjust

time times when the alert is applicable (or expires) and the display properties.

Alert — Advanced Settings

(o Edit Alert

Alert gRGUENE Trade

Time In Force

Use these to specify
times of the day when
the alert is active.

v/| Show Cancel Btn
v/| Show Label

v/| Show Line

OK Save Defaults Delete Cancel

Time Zone: ~ |/ Use Defa
£ Sets an expiration date/time 1
Expires: | 2/7/2017 B [2:00PM @V Enabl
Session 1. Start: 9:00 AM @®| End: 4.00 PM ®| |V Enabled
Session 2: Start: @© End: O] Enabled
Display l\
Alert Align: | Right -

Time In Force

The Time In Force section allows you to set an expiry date/time for an alert and optionally define times

of the day when the alert is active.
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1. Time Zone — The dates and times specified in this section will use the same time zone defined for
the chart. This may optionally be overridden by unchecking the Use Default box.

2. Expires — Check the Enabled field to the right to specify a date/time when the alert will expire
and be removed.

3. Session 1 — Defines a time of the day when the alert will be active
4. Session 2 — Define a secondary time of the day when the alert will be active.

Display

The Display section allows you to override default display attributes for the alert.

3.30.6 Alert History

The Alert History window displays alerts that have been triggered in the past. Choose View -> Display ->
Alert History Window from the top menu bar. If the chart where they were activated is still available, a
Chart button will be available to view the chart that they originated from.

Show Alert History Window

~ MotiveWave - Console (google) 2 - 7 x
File Edit | View Study Strategy Format Configure Window Help
AAPL - Link v wv @ §v +[WIT[2v[15mn  ~ 4 = >
Ll AAPL 15m . Display * | 3 Ccomponents Alt+C B = =
. Components Alt+C ¢ Trade Panel Alt+T ' )
- o ! 130.4
AAPL-15min = o0 i o9 Scale : D 'L!
3 Replay Mode = : S
5 ili DOM Panel , + 130,19
€ Cursor Data At+D | /) Time & Sales Panel | e ] 130'0[%'
[ _j inpr\-"u’are Points Eg News Headlines i H Note: The Alert History Window will ’
v = Lcl:cllji S:?O";;ZE NEWS_V'ewer display when an alert is triggered,
4 Lock Studies j @ gﬁ;gleiesﬂieei:?r provided "Show Alert” is set to Yes b
= ) 4129.50
E=d Group Studies £ Cursor Data Window ]
‘ * + Ll Show Volume B Study Log
@ Increase Hide Below Degree  Ctri+1 % Object Viewer Alt+V ]
@ Decrease Hide Below Degree Ctri+] ™ Alert History Window Choose View -> Display H129.00
17 Reset Vertical Spacing 7 T Show Alert Hist&y -> Alert History Window {_128.9(”
+ ik Show Extended Data v 47 Show Analysis DD ' ]
C Clear Local Data v W Show Commentary § | d128.50
v - Show Tabs v 4 Show Trend Lines ! ]
52 Ccompact F7 |V Menu Bar i
e RV | BRIAL P TR, < S U PR UE AV USSP O ~a
Alert History Window
Py

Alert History X

The following alert(s) have been triggered. Press Close to cancel this dialog.

Symbol Bar Size Replay Signal Name Last Value Order Activatedv Chart +*

BRK.B 15 min N Trend Line  Price Crosses 163.12 13:18:43
GE 15 min N Price Crosses 29.65 11:26:37
MSFT 15 min N Price Crosses 63.41 11:25:03

This button will show
the chart where the
alert was triggered

This will clear all alert
history from the workspace
L'
Clear History

Historical alerts are also visible directly on the chart. Icons are displayed when and where (what price)

and alert occurred. If you place the mouse cursor over one of the alarm clock icons, you can view
detailed information.
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Historical Alerts on the Chart

FMMWTMMWWM

These icons

indicate where
an alert occurred

()| Price Crosses 163.14

k. Activated: 13:18:43
Last Value: 163.12
Bar Size: 15 min
Signal: Trend Line

P e MR

|
%rlmﬂi I

Alert history can also be found under the History tab of the Alerts panel (in the Console):

Hover of the alert to show
detailed information

]
]
]
]
]
]
]
]
]
]
]
]
]
]
|
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
]
|
]
]
I
T
]
I

Click on History tab

A,

At iy,

i rCtn s

BRK.B 15 min N Trend Line Price Crosses 163.14 163.12 131843
GE 15 min N Price Crosses Tenkan-Sen(9 2965 11:26:37
MSFT 15 min N Price Crosses EMA(C.20) 63.41 11:25:03

= NYSE (35) |/ = NASDAQ (21) [T Alerts x | + im 8 & o 7
Alerts (1) | History (3) |
Symbol & Bar Size Replay Signal Name Last Value Order Activated Chart

lml Home % il Charts 8 Account  [@' Scan  {}f Optimize News  + m N O

Feb-06 14:32:36

3.30.7 Alert Preferences

Global alert preferences can be configured in the Preferences dialog (Configure -> Preferences from the

Console menu bar). The alert preferences will be found under the Alerts tab (see below).

Alert Preferences
el Preferences %

General Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders @alEis=g Email >

The following fields allow you to configure preferences for Alerts.

Display

Alert Align: | Right -
v/| Show Buttons |v' Show Labels v Show Lines

/| Show Alert |v/| Play Sound | | Send Email |v/| Attach Image Default
notifications
Other

Show a triggered
Max Alert History: (Days

alert on the chart.
/| Show Alert History (on Chart)

v/| Alert Order Warning Show a warning if closing a
V/| Alert Deactivate Waming chart that has active alerts.

v'| Show Warning on Clear Alert History
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3.31 Ticker Tape

Ticker tape displays a rolling set of prices for a selected set of instruments across the top of the Console,
Desktop or Chart Window. This option can be turned on by choosing View -> Display -> Ticker Tape from
the top menu bar.

Show/Hide Ticker Tape

&~ MotiveWave - Console (google) 2 - W X
File Edit | View @ Study Strategy Format Configure  Window  Help
BRK.B M Link » W Q I~ + ™| T |2~ ]| 15min - PRI
BAC 23.11 3 % Display ’ 3£ Components Alt+C  ).02% DIS 109.46 $-0.76% EBAY 32.01 4-0.19% F 12.48 $-0.64
.| Components Alt+C & Trade Panel Al+T [ E]
dil AAPL 15 - ]
I_-im. = Semi-Log Scale /\ _l_ =
BRK.B-15mil 5 Replay Mode i DOM Panel [‘;icker Tape 165.00
Volume £ Cursor Data Alt+D ) Time & Sales Panel ]
¥ Snap Wave Points F5 News Headlines
\ Auto Anah"'ze F6 MNews Viewer
v " Lock Scroll v Bar Size Selector ' PPPY
. ) ; 163.93
¢D A4 Lock Studies @ Bird's Eye View T*ﬁﬂ“"miﬂ é-inJ,[ﬂI 4 ]
[]‘ [’I]rﬁl ] Group Studies iy i ]
yﬂl Hl’llTHJ £ Cursor Data Window 4 ID | F. ]
v I, Show Volume B Study Log b 1
@ Increase Hide Below Degree  Cirl+t & Object Viewer Alt+V 12913]
@ Decrease Hide Below Degree Ctrl+| iT Alert History Window ]
o ﬂﬂ I% Reset Vertical Spacing v £ Show Alert History ” — - ]
RN v @& Show Extended Data v 4% Show Analysis ] |I|[|II.n|n|pnnnII lnnulln , >~ , 125K
14:00 c Clear Local Data + # Show Commentary 12:00 1400 Feb-06 12:00 14:00 16:00 1800
1min 5min| v M Show Tabs V 4 Show Trend Lines 1week 2week 1 month =4 = ey @ ¢~ B
- &% Compact F7 17" MenuBar a ; -
= NYSE (35) = NASUAW(ZT) [FErAEIS X T 7 ool Bar im & o "
Alerts (1) [History (3) 7 Status Bar Choose View ->
) Display -> Ticker Tape
Symbol 4 Bar Size Replay Signal v Tlckegam J  Activated Chart
B I e W e T e e P T y T Y APl — o -"‘m\-

The instruments and display of the ticker tape can be configured from the Preferences dialog (Configure
-> Preferences from the Console menu bar). Click on the General tab, then on the Ticker Tape sub tab.
This panel has the following options:

1.

box on the left

ounkwnN

Font — Font size for the instruments displayed on the ticker tape section
Scroll Speed — Relative speed for scrolling the instruments

Show Ticker Tape — Default for displaying the ticker tape in a chart window
Show Change — Shows the change since the day open
Show Change % - Shows the change since the day open as a percent

Instruments — Instruments may be added or removed by using the tool bar at the top of the list
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Ticker Tape Preferences
o] Preferences x

Theme Chart Tool Bar Sounds Ratios ElliottWave Gartley Tick Charts Orders Alerts Email >

General Keyboard Mouse Fonts Quick Search EEGCEEWE Linking Dock Trading Hours Simulated Accol =

This panel allows you to configure the instruments that are displayed in the ticker tape panel as well as other display settings
-Choose Symbol- - QB Font: Arial;14.0

AAPL - Apple Inc Scroll Speed: | Medium -
AEO - American Eagle Outfitters /| Show Ticker Tape
AMZN - Amazon.com Inc Use these buttons to

AXP - American Express add/remove instruments ST SIS

BAC - Bank Of America Corp
BTU - Peabody Energy

C - Citigroup Inc

CAT - Caterpillar Inc

CSX - CSX Corporation

DE - Deere Co

DIS - Walt Disney Company
EBAY - eBay Inc

F - Ford Motor Company
FCX - Freeport-McMoRan Copper & Gold Inc.
FDX - Fed Ex

GE - General Electric

G8§ - Goldman Sachs

HAL - Halliburton

HD - Home Depot

HMC - Honda Motor Co Ltd

HPQ - Hewlett-Packard Co

IBM - International Business Machines

Total Instruments: 37

V| Show Change %

OK || Apply Cancel

3.32 Short Cuts

MotiveWave™ provides a number of convenient ways to do common tasks quicker. This section
explores some of these options.

3.32.1 Menu Short Cut Keys

You may have noticed already that when displaying a menu, a key combination is displayed on the right
hand side for some of the items in that menu. This key combination may be used as a short cut to
access that item without using the mouse to show the menu and select the item.

In the example displayed below, the short cut keystroke for accessing the Line tool is: Ctrl + Shirt + L.
This means that you can hold down on the Ctrl (Control key), Shift and press the L key on the keyboard
(all at the same time) to switch your mouse tool to the line tool. You may find this to be much faster
than using the mouse to select the tools drop down and choose the line tool menu item.
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Keyboard Short Cuts
(> MotiveWave - Console (google)
File Edit View Study Strategy Format Configure Window  Help
AAPL > QA E B s~ @ Wl i~ + ™ T &2~|15min -
Ll AAPL 15m X |Lul MSFT 15m*  |wl BRKB15m* i K Select Cirk+Snift+S
AAPL 15 e | v W Drag Ctri+Shitt+D ; n
@, Zoom Cirl+Shift+Z ! Ijl D ]
% NoTool  Cir+Shift+Y ; q ‘[j“'. I N
T Text Cirl+ShiftsT i T
g D ! Ruler Ctri+Shift+U i
\ Line Ciri+Shift+L
& Eraser Cirl+Shift+E Short Cut Keystroke
* _I_ Regression »
- Fibonacci "
, Elliott Wave ’
Gartley N J"*'El:
: 4z Chann :

Please Note: by convention tool short cuts all have the sequence Ctrl + Shift + <key>. This makes it
easier to remember them.

3.32.1.1 Custom Keyboard Short Cuts

Keyboard short cuts can be customized in the Preferences dialog (Configure -> Preferences from the
Console menu bar). Start by unchecking the Use Default option. With this option unchecked, you can
double click on any of the actions (or select and press the edit button) to assign a keyboard short cut.

Custom Keyboard Short Cuts

Lo

Preferences

EE2EE] meme cChart ToolBar Sounds Ratios Eliott Wave Gartiey Tick Charts Orders Alerts Email (v

x

General JLGLLEGN Mouse Fonts Quick Search  Ticker Tape Linking Dock Trading Hours  Simulated Accot (=

This panel allows you to configure ¢
to assigniremove a keyboard short

v'| Use Defaults

Uncheck to modify
keyboard short cuts

|
@
|
|
@
|
|

i

Always On Top

/& Annaotation Mouse Tool

Apply Template 1
Apply Template 2
Apply Template 3
Apply Template 4
Apply Template &
Apply Template 6
Apply Template 7

Annlv Temnlate 8

Action Shortcut
W/ 3 Drives Mouse Tool Ctr+Shift+3
W/ 5-0 Mouse Tool Ctri+Shift+5
W AB=CD Mouse Tool Ctri+Shift+=
-+ Active Tickers
[4d Add Strategy
|4 Add Study Ctri+T

I Alert History Window
W, Alternate AB=CD Mouse Tool
M, Alternate Bat Mouse Tool

Double click on an
action to assign a
keyboard short cut

Alt+1
Alt+2
Alt+3
Alt+4
Alt+5
Alt+6
Alt+7
Alt+8

OK || Apply || Cancel

s for commonly used features. Double click on an action below

From the Edit Shortcut dialog, simply press down on the key sequence that you would like to assign to
the action. The key sequence will appear in the grey box (see below).
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Edit Shortcut Dialog
» Edit Shortcut X

Type the keyboard shoricut or press the delete button to clear
the current shortcut for the selected action.

/& Annotation Mouse Tool: Ctrl+Shift+L X

OK Cancel

Press down on
keyboard keys to
assign a short cut

3.32.2 Mouse Wheel

If your mouse has a wheel, you can use this to perform the following actions on the chart:

1. Time Shift — Move the graph to the left or right (depending on wheel direction)

2. Adjust Bar Width — This will effectively zoom the graph in or out
3. Adjust Vertical Space — Changes the space available at the top or bottom of the graph

The default action for the mouse wheel is to time shift when it is moved back or forward. If you hold
down on the Alt key and move the mouse wheel, it will adjust the bar width (ie zoom in or out).

This behavior can be adjusted from the Preferences dialog (Configure -> Preferences from the Console
menu bar). Click on the General tab, then on the Mouse sub tab.

Mouse Wheel Preferences

o) Preferences X

=R 1reme Chat_ Tool Bar_Sounds Ratios Elliott Wave _Gartley _Tick Charls_Orders _Alerls Email__ (=

General Keynoardeonts Quick Search Ticker Tape Linking Dock Trading Hours Simulated Accol (v

You can configure the mouse wheel to do one of the following (Note: Alt Wheel Action is the using the mouse wheel while
pressing the Alt key)

- Time Shift- Moves the time period. (Hint: use the Ctrl & Shift keys to change the scrolling speed)
- Bar Width - Changes the width of the price bars.
- Vertical Spacing - Addsiremoves space from the top and bottom of the graph.

Wheel Action: | Time Shift = Invert Reverse the behavior based
on the wheel direction
Alt Wheel Action: | Bar Width v Invert

Disable Mouse [Yheel

This is the action
performed when the Alt

key is pressed while
moving the wheel.

OK || Apply Cancel

3.32.3 Mouse Click Options

Keyboard modifiers: Shift, Ctrl and Ctrl + Alt when used with a left mouse click can be configured to do
specific actions. The default behavior is as follows:
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1. Shift + Click — Creates Text Comment. When you perform this short cut an entry box will appear
for you to enter text. Just type your comment and press Enter (or Esc) to create it.

2. Ctrl + Click — Creates a Price Guide at the location of the mouse.

3. Ctrl + Alt + Click — Creates a Time Guide at the location of the mouse.

These actions may be configured from the Preferences dialog (Configure -> Preferences from the
Console menu bar). Click on the Chart tab then on the Chart Settings sub tab. The following actions are

available to choose from for each click shortcut:

=

Text — Creates a text box to enter text
Note — Creates a Note component
Box Callout — Creates a Box Callout component

©®ONOU AW

Line Callout — Creates a Line Callout component
10 Annotation — Creates an Annotation component

Balloon Callout — Creates a Balloon Callout component

Price Guide — Creates a price guide at the mouse location
Horizontal Line — Creates a horizontal line at the mouse location (extended left and right)
Time Guide — Creates a time guide at the mouse location
Vertical Line — Creates a vertical line (extended up and down) at the mouse location

11. Curly Annotation — Creates a Curly Annotation component

Mouse Click Shortcuts

<& Preferences

General Theme QeiEul Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts Orders Alerts Email

X

-

[oiEUssisinlvil Indicators Labels Templates Options Bar Sizes Bar Size Selector

The fields below allow you to adjust the default settings for charts.
Default Tool: | ¥ ~
Revert to Default Toal: [V

BarType: | 0 ~
Bar Scheme: | Normal v

Bar Size: | 15 min >

Bar Thickness:  — 1.0 ~
Axis Style: | Inside -

Shade: | None v

Shift + Click: | Text bt

Ctrl + Click: | Price Guide

Line Method: | No Action

Price Guide
Fill Area:
Horizontal Line

Fill Alpha:
Vertical Line
Text
MNote
Box Callout

Balloon Callout
Cancel

OK || Appl
Line Callout H

Max Linear Bars:

Max Mon Linear Bars:
Minimum Bars:

Popup Delay (seconds):
Bar Width (Pixels):
Price Axis Spacing:
Time Axis Spacing:

Top Inset (pixels):

Bottom Inset (pixels):

M .
Short Cuts

Study Layout:

ouse Click Pars:

(3%} o]
al |a| |5 & o
| 0] [0] [ °>

Time Zone:

25000 ¥

15000 ¢

v'| Enabled

ES

Harizontal b

v'| Use Default

Calendar Days

3.32.4 Other Shortcuts

The following are some other shortcuts that you may find useful.
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Ctrl + Mouse Drag (Copy)

o

Hold down on the Ctrl key and drag a component to create a copy of it. This can be very useful for
example to create a line that is parallel to another line. The mouse cursor will change to the following to

++++
indicate that you are creating a copy: {'\XS

Copy Line

1508 |
1005 min

15.06 |
1005 min

Hold down on the Ctrl
key and drag the line
to make a copy

W'W

MW

. T P ¥

|
T**$T1D

F)

Revert To Default Tool (Space Bar)

When switching to a mouse tool, you can quickly switch back to the default mouse tool (Time Drag Tool)
by pressing the Space Bar. This can be more convenient than pressing Ctrl + Shift + D. Alternatively,
you can change the behavior of the mouse tools to automatically revert to the default tool when an
action is completed. This can be adjusted from the Preferences Dialog. Click on the Chart tab then on

the Chart Settings tab.

Default Mouse Tool

Le]

Preferences

General_Tneme [JEEIH] ToolBar Sounds Ratios Elliott Wave Gartiey Tick Charts _Orders _Aleits _Email

X

(¢ELRTINIEN Indicators Labels Templates Options Bar Sizes Bar Size Selector

i~

Normal

Bar Type:.
Bar Scheme:

Bar Size: 15 min -
Bar Thickness:  — 1.0 ~
Axis Style: | Inside -
Shade: = None -
Shift + Click. | Text
Ctrl + Click: | Price Guide
Cirl + Alt + Click: | Time Guide
Line Method: = Time/Price v
Fill Area

Fill Alpha; 25 ¢

Check this option to
revert to the default
mouse tool after an
action is completed

The fields below allow you to adjust the default settings for charts
Default Tool % ~ Ds{ab“h m:;fe tool | Linear Bars: [ 25000 =
can be se ere
Revert to Default Tool V| ~ ax™on Linear Bars: 15000 5

imum Bars:
(seconds): | Enabled
jdth (Pixels):
Price Axis Spacing:
Time Axis Spacing:
Top Inset (pixels)
- Bottom Inset (pixels)
- Display Bars %
- Study Height (pixels):

Study Layout:

| ABLLS

4

4)

4)

Horizontal b
Time Zone: -
V| Use Default

Calendar Days

OK || Apply | Cancel
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4 Trading

There are lots of ways to place and manage trades within MotiveWave™. In this section will explore
some of the convenient features for dealing with orders, positions and trades. Some of the trading
features such as supported order types may vary depending on the broker you have chosen for the
workspace.

4.1 Account Management

The Account page in the console provides a convenient view of current account information as well as
open orders, positions and historical trades. The columns displayed in each section will vary depending
on the broker or data service that you chose for your workspace.

Account Page

~ MotiveWave - Console (fx2) H - "X
File View Configure Window Help | Active Accounts I
=4 |28 Q B »|[.8 Accounts (2) x%/' e
I 15:51:01 X

Default Account Curre... Balance Equity Unrealized PL  Session PL Total PL Day PIL Usd Mr Usbl Mr Usbl Mr% GrossPIL  +
250 50 1l
35.27 120.00 6,264.77 9842% 1,02013 |

N Simulated usD 99,640 41
N 05434250 AUD 5,364 .64 6,384.77

sell
Rs:082 [ 101 | Re037
095027 0.99621

15:51:05 X

=

Rs:0.14 [ 076 | RE004

130050 [IEEHN 131376

Use these buttons to
manually refresh the

data from the broker
\ %]

Rs:042 | 000 | RE:0.18

ez 12791

W, Orders (4) % | + + w7
Rs-032 043 | RE0O Account  Tieket symbol OrderDate Expires Action Quantity Type  Price  StopiTral StopPIL  Limit Limit P/L Fill Pricé, Filled Status Grouj*
05434250 70419087 SPX500 1546113 GTC 1 LMT 22893

05434250 70419088 USDICAD 154626  GTC 10K LMT 1.31085 c

05434250 70419100  EUR/USD 154818 GTC 10K LMT 107742 100 (RS c

05434750 70419094 AUD/USD 154743 GTC 10K LMT 076546 BT R 1505 c

Attached Orders
Historical Trades I
Lo

14 Positions X | ® Trades (EE) + + z .

Open Positions (B)| Summary Closed Positions

¢ kount Ticket Symbol Quantity Entry Price Stop/Trail Stop PIL Limit Limit P/L Unrizd P&L Pips Roll Last Price Open Time
o . -2 EUR/JPY 10K 128.382 = 09 -827.8 0.000 25-Jan-16 10:41:44
pen Positions
-7 SPX500 1 2276.8 138 00 Feb-02 13:29:32

05434250 24732295  USDICAD 10K 128506 2344 726 000000 04-Jul-16 155529
05434250 25025390  SPX500 1 21296 161.0 -31.39 0.0 13-Sep-16 10:58:13
05434250 25025991 1 21296 161.0 -31.39 0.0 13-Sep-16 10:58:13
05434250 25025992 | Click here to show the 1 21296 1610 -3139 0.0 13-Sep-16 105813
05434250 24948839 | Account page 1 21856 1050 -3515 0.0 23-Aug-16 22:49°58
05434250 28092818 1 22763 EETYT] 143 112 00 Feb-02133020
'/ 29285 1232
Ll Home il Charts 8 Account X [ Scan  1lf Optimize — + m o

Feb-06 15:51:05

This is the default layout for the Account page. You can add these panels anywhere within the Console
or Desktop. Simply click on the Add Tab button (Plus Icon) next to the existing tab where you want to
add the panel.
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Add Account Panel
S NYSE (35) = NASDAQ(21) ™ Alers| .o add L+
Account Ticket 0| Tab Button 1 \(,:Vh?”h Lt Time Action Quantity Avg Price
= alCl 15!
Simulated SIn-12 SiM-13 DICAL [fj Depth OF Market 16-Jun-16 9:11:02 SLD 30K 1.30!
Simulated SIM-7 SIM-11 USD/CAE-{D).Tima.and Salas Elundp 440007 010 20K 1.28
[ |
Simulated SiM-12 SIM-11 usDicAL o OrderTable Choose one of these to add 10K 1.28
11 Position Tablg Order, Positions, Trades or an
Simulated SIM-T SIM-8 USDICAL @, Trade History Table A . o] ’ 10K 1.2
ccoun ane
Simulated SiM-4 SIM-7 USDICA!] -& Account Table 10K 1.32
Simulated SIM-4 SIM-6 USDICAL ©' T 09-Mar-16 15:41:03 BOT 10K 1.32
|z Scanner
Simulated SIM-4 SIM-5 USDICAL {1} Optimizer 03-Mar-16 14:41:48 SLD 10K 1.33
Simulated SIM-2 SIM-3 EUR/JPY T3 Alert Table 02-Feb-16 14:43:05 SLD 10K 131.
simulated Siv-2 SiM-1 EUR/JPY 25-Jan-16 10:41:44 BOT 10K 128.
05434250 24732295 64273443 USD/CAD 04-Jul-16 15:55:29 BOT 10K 1.28
A — 4

4.1.1 Account Panel

The Account panel displays information about each available account in your workspace. The columns
displayed will differ depending on the broker that you chose for your workspace. The Unrealized PL
column is common to all brokers and displays the current unrealized profit/loss for all positions that
belong to each account.

Accounts Panel

LIRSS Set As Default Account

Right click and choose
Set As Default Account

€,390.60 1,025.

Summary of unreali
profit/loss for open

positions for each account

® Accounts (2) X | + =R
Default Account Curre... Balance Equity Unrealized PL Total PL Day PIL Usd Mr Usbl Mr Usbl Mr%¢  Gross P/L Hedginga +
Y Simulated usD 99,640.41 -f28.62 -359.59

120.00

98.12%

6,270.60

colum

zed

Available columns will depend

on the broker(s) chosen for
the workspace.

Cllck here to choose

ns to display

The Default column indicates which account is the default for placing orders. You can change the
primary account by right clicking on the desired account and choosing Set As Default Account. This
setting is important to avoid accidentally placing orders on the wrong account.

Default Account

3 EUR/USD - Primary Analysis - 15 min ey — x
Format Window  Help
19 1K W 2w @ i+ My + 8T 2[15mn  ~ I »
1 Trade x
} --------------------------------------------------------- _sTP 10k@-10.0 (R =] order Biaiask
i H1.07800
] Buy Mkt
_______________________________________________________ " E
H1.07700 ="
2— --------------------------------------------------------- -LMT 10K@10.0 -1 | Cancal 0¥ |
i 41.07600
{ : simulated
{ _l_ Default account is the
i * default in all account drop
I Jf'+ T downs for placing orders | "En FXCM - 05434250
i "oy
LA e i
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4.1.2 Orders Panel

The Orders panel displays the currently active orders in one convenient location. The Group column
indicates orders that are linked as either OCO (One Cancels Other) or OSO (One Submits Other). The
Status column displays the current order status (green for active). Click on the ‘C’ to cancel an active
order.

Orders Panel

Click here to refresh
orders from the broker

Click here to

=, Orders (4) X | +
create an order

Acco..  Ticket  Symbol Order Date Expires Action Quan.. Type  Price  Stop/Tr.. Stop.. Limit  Limit
0543425(70419087 ~ SPX500 154613  GTC 1 LMT 22893 o
Group color indicates
0543425(70419088  USD/CAD 154626 GIC 10K LMT 131085 linked orders
0543425(70419100  EURIUSD  15:48:18  GTC 10K LMT 107742 -10.0 10.0 [hsss
0543425(70419094  AUD/USD 154743 GIC 10K LMT  0.76546 100 100 IR Click C to

cancel an order

Click on a
cell to edit

Color indicates order
status. Howver over
for explanation

Orders can be edited from here directly by clicking on the appropriate table cell (see below). If an order
has outstanding changes, the status column will change to show a ‘T’ and a ‘D’. Click on the ‘T’ to
transmit (submit) the changes to the broker or on ‘D’ to discard the changes.

Edit Order
= Orders (4) x | + + cwm 7
Acco..  Ticket  Symbol OrderDate Expires Action Quan.. Type Price  Stop/Tr.. Stop.. Limit Limit.. FillPr.. Filled Status Groug*
0543425(70419087  SPX500 1546113  GTC 1 LMT 22893
0543425(70419088  USDICAD 154626  GTC 10K LMT  1.31085

-

] DAY SELL 10K 1.07742
47:43| GTC 10K "WMT 076346 10.0

Click on these cells
to edit the values

Alternatively, right click an order to see additional options. Double clicking on an order will show the
Order Ticket dialog.

0543425(70419100
0543425(70419094

Click on a
 cell to edit

Press 'T' to transmit order,
'D' to discard changes

Orders Panel Options

W Orders (4) X | +

Acco... Ticket Symbol Order Date Expires Action Quan... Type Price  Stop/Tr... Stop.. Limit Limit.. FillPr.. Filled Status Groug+*
Rioht click =** Order Ticket 1 e 22823 ¢
ongorder ancel Order This option will | 131085 <
05434257 R/ Cancel All =] cancel all 107742 | pouble click on an c
0543425(70419094  AUD/U CancelAllfor instument active orders | 076545 | order row to show the c

Open Chart Tab
Cpen Chart Window
Open DOM Window
Edit Instrument

Order Ticket Dialog
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4.1.3 Positions Panel

The Positions panel shows the currently open positions (and closed for some brokers). Individual
positions can be closed (at market price) by clicking on the Close button (right hand side). If you would

like to close all positions, right click on a position and choose Close All Positions.
Click here to
refresh positions \
+ A

~
Click here to add
positions that are outside
Account Ticket Symbol  Quantity ~Entry Price  Stop/Trail  Stop PIL Limit LimitPIL  UnrizdP&L  Pips  Roll  Las{ .fthe broker account

EUR/JPY 10K -829.4

A Edit Position
“3 X Delete Position 28506

+ Add Position 21296
Close Now

Positions Panel

11 Posilions x | ® Trades (68) +
Open Positions (8)| Summary Closed Positions

128.382

Simulated 8iM-2

Simulated  SIM-7

2297 726
31.39
31.39
1615 -31.39
105.5 -35.15
148 -1.12

Actual columns available will
depend on the broker(s)
configured for the workspace

Close All Positions
05434250 25025992 SPX501 Open Chart Tab 21296
05434250 24948889 SPX50| Open Chart Window | 2185.6

05434250 28092818 spxs0 - CQpen DOM Window 2376 3
Edit Instrument

Click on "Close" to close
individual positions at
market price

Total unrealized P/L
for all positions

- 290.94 -1232

If you have enabled the simulated account, you can add positions manually by clicking the Add Position
(Plus Icon) button on the top right corner of the panel. This is a useful feature if you would like to track
positions that are managed outside of the broker or data service that you are using. The following
diagram shows the Add Position dialog. It has the following fields:

1. Instrument —select the symbol for the instrument

Opened Date — This is when the position was originally opened
Quantity — Number of shares, contracts etc

Avg Price — Average entry price for the position

Commission — Optionally enter a commission to track fees.

nkwn

Add Position Dialog

+ Add Position 4

sition to the Simulated
| to monitor existing

Use this dialog to aq Choose an
Account. This feat| Instrument

positions that you h nal broker.
Instrument: |[EfleIEN -
Opened Date: | 2017-02-06 17:14 i

quantty: [ 10 5]=- X
Avg Price: 82162 = Enter quantity
. and average
SorrEE .
purchase price

oK Cancel

For some brokers (such as FXCM) they provide a bit more information on position such as the recently
closed positions. Specifically for FXCM hedging accounts, a summary tab is included to roll up individual
position totals.
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y

Open Positions

Current Open
Positions

" Positions
Summary Closed Positions (1)""—1_

Open Positions (10)

Note: Available columns and options
[ available will depend on the broker(s) that

! R tly Closed
SR des (72) + J scently tlose you have chosen for your workspace. + 2.

If multiple positions per
instruments are allowed, this tab
will roll them up into a single
summary row for each instrument

Account Entry Price Stop/ Trail Stop PIL Limit Limit P/L Unrlzd P&L Pips Roll Last Price Open Time Close a #
Simulated K 128.382 0.000 25-Jan-16 10:41:44 (RSl
Simulated (if multiple per 1 2276.8 0.0  Feb0213.29:32 (eI
05431250 2g10g| NStrumentisallowed) 1.31085 0.00000 0:10:11 [
05434250 24732295 USDICAD 10K 1.28506 (&) 3217 7.30 0.00000 04-Juk-16 15:55:29 OGS
05434250 25025990 SPX500 1 21296 167.2 3162 0.0 13-Sep-16 10:55:13 [eE
05434250 25025991 SPX500 1 21296 Double click on these cells 167.2 3162 0.0 13-Sep-16 10:58:13 [JISINES
05434250 25025992 SPX500 1 21296 to add stop and/or limit 1672 3162 0.0 13-Sep-16 10:55:13 [eE
05434250 24948889 SPX500 1 2185.6 orders to these positions 1112 35.38 0.0 23-Aug-16 22:42:58 [JERES

37038 1243
Summary Positions

11 Positions x | ® Trades (72)  + + .7
Open Positions (10) | Summary | Closed Positions (1)

Account symbol SellP/L Sell Pips Sell Amt Avg Sell Close Buy Close Sell Avg Buy Buy Amt BuyP/L Buy Pips PIL Pips = Roll Closea +
Simulated EURLIPY 0 0.000 0.000 120023 128382 . LR 8359 0.00
Simulated SPX500 0.0 0.0 22973 22768 205 000
05434250 USD/CAD 66.8 0K 131085 1.31659 131640 1.28506 2560  7.30
05434250 SPX500 aq 0.0 22973  2189.9 107.4 -131.59

Realized P/L

-97.34 434.81 377.47 -124.3
Closed Positions
1) Positions X | ® Trades (72)  + + 2.7
Open Positions (10) Summary | Closed Positions (1) |
Account Ticket Symbol Quantity Open Price Close Price PIL Pips Open Time Close Time Roll Commission & +
05434250 28103128 AUD/MUSD 10K 0.765456 0.76431 RENGY -11.5 Feb-06 18:03:32  Feb-06 19:04:30 0

-15.05

0.0

4.1.4 Trades Panel

The Trades panel displays historical trades (ie filled orders). Columns displayed on this page will vary

depending on the broker chosen for the workspace. Some brokers only report a limited

number of

historical trades. For this reason, you should rely on the account management tools provided by your

broker to ensure accurate reporting of historical trades.

Trades Panel

11 Positions | ® Trades (72) x | + oz 7
Account Ticket Order ID Symbol Time Action Quantity Awvg Price PIL Commissiona +
Simulated  SIM-12 SIM-13 USDICAD 16-Jun-16 9:11:02 SLD 30K 1.30305 0 (]
Simulated  SIM-7 SIM-11 USDICAD 15-Jun-16 11:28:27 SLD 20K 1.28998 0
Simulated  SIM-12 SIM-11 USDICAD 15 lun 16 11-28:27 SLD 10K 1.28998 0
simulated  SIM-T SIM-8 USDICAI Columns displayed here will  [21:26 SLD 10K 1.29099 0
simulated Silt-4 SIM-7 UsD/CAl vary depending on the broker 456 s1D 10K 1.32151 5 0
Simulated  SIM-4 SIM-6 uspicag chosen for the workspace. h1:03 BOT 10K 1.32447 0
Simulated  SIM-4 SIM-5 USDICAD 06-Mar-16 14:41:48 SLD 10K 1.33993 0
Simulated  SIM-2 SIM-3 EURLPY 02-Feb-16 14:43:05 SLD 10K 131424 0
Simulated  SIM-2 SIM-1 EURIPY 25-Jan-16 10:41:44 BOT 10K 128.382 0
05434250 28103125 70419088 USD/CAD Feb-07 0:10.11 SLD 10K 1.31085 0
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4.2 Simulated Account

S

For convenience, MotiveWave™ has a built in simulated account that you can use to practice your
trading. If you chose a data service for your workspace, then this account will be enabled by default. If
you are using a broker, it is recommended that you use a demo account if provided by your broker
instead. Broker demo accounts will provide a better simulation of their trading environment and
supported order types and behaviors.

The simulated account can be configured from the Preferences dialog (Configure -> Preferences from
the Console menu bar). Click on the General tab then on the Simulated Account tab. This panel has the
following fields:

1.

2.
3.
4

hd

Enabled — Check this box to enable or disable this account
Base Currency — Base currency for the account

Case Balance — Initial Cash Balance

Fill Immediate — If checked market orders will be filled immediately at the current bid/ask value
instead of waiting for the next trade
Include Commission — If checked, commissions will be included when placing trades.
Reset Account — Click this button to reset the account back to the initial cash balance.

Simulated Account Preferences

o

Preferences

=R rreme chart ToolBar Sounds Ratios Elliot Wave Gartley Tick Charts_Orders _Alerts _Email

x

-

:neral Keyboard Mouse Fonts Quick Search Ticker Tape Linking Dock Trading Hours ESlipglilEiEhiptelijig ~

The Simulated Account is p :
When placing orders agail| ~heck this box to f
Enabled: |V enable this account

Base Currency: | USD

Cash Balance: 9964041 ¢

-

hat locally tracks orders, positions and trades against a virtual 'account’.
| information is transmitted to your broker.

v'| Fill Immediate

/| Include Commission

Reset Account

OK || Apply | Cancel

If you have the simulated account enabled, you will see an entry in the Accounts panel for this account.
The account id will be ‘Simulated’.

Version 5.0

©2017 MotiveWave™ Software

Page 156 of 213



MotiveWave ™
User’'s Guide

Simulated Account

9 Accounts (1) x | + 5 IR
Default Account Currency  Balance Unrealized PL SessionPL  Total PL a *
hd Simulated usD 100,000.00

Simulated Account

4.3 Commissions

Commissions can be calculated by MotiveWave™ using the simulated account, in replay mode or as part
of Strategy Back Testing. If you would like to include commissions, these can be configured from the
Commissions dialog (Configure -> Commissions from the Console menu bar).

1. Base Cost — This is the base cost of a trade. Some brokers offer flat rates for commissions. If this
is the case, just enter the cost here.

2. Unit Cost — Some brokers charge based on the number of units (ie quantity) that are part of an
order (ie shares, contracts etc).

3. Unit Size - If a unit cost has been specified this is the lot size.

Commissions Dialog

‘& Commissions

The following tabs allow you to set the default commission structures for each
type of instrument.

Cash (Forex)

%Base cost for a trade
Base Cost

Unit Cost: Use these fields to define a
Unit Size: m cost per number of units

traded. Ignore if your broker

upaate || can has a flat rate per trade

The above dialog enables you to define a commission structure that applies to each type of instrument.
Some instruments may have their own specific commission structure. If this is the case, you can
override this from the Instrument dialog (right click on the chart and choose Edit Instrument, click on the

Commissions tab).
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Instrument Commissions
Edit Instrument - AAPL X

Modify the fields below and press OK to save your changes.

Base Cost:
Unit Cost:
Unit Size:

v | Use Default Commission

Uncheck this to

override the default
commission structure

OK Order Presets Delete Cancel

4.4 Order Presets

Order presets are convenient for defining default order attributes. Defaults can be defined generically
by the type of instrument or specific to an instrument. General order presets can be accessed by
choosing Configure -> Order Presets from the Console menu bar.

This dialog has a tab for each type of instrument. Each panel will have the following fields:

1.
2.

W NoU AW

Order Type — Default type of order to be placed

Time In Force — Defines the expiration time of the order. Available types will depend on the
broker.

Trigger OTH — If checked, the order can be triggered outside of regular trading hours

Offset — Default offset (in pips) from the current price when placing an order

Limit Offset — Default offset (in pips) from the current price when placing a limit order

Stop Offset — Default offset (in pips) from the current price when placing a stop order

Trail Offset — Default offset (in pips) from the current price when placing a trail order
Default Quantity — Default quantity when creating a new order

Increment — Increment (or decrement) size when adjusting the order quantity

. Preset Quantities — The quantities in the list box will be available from a drop down menu next

to each quantity field. These values are also available from Quantity Selector in the DOM.
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General Order Presets Dialog

(W] General Order Presets X

The following tabs allow you to set the default values when placing a new order per type of instrument. Order
presets can be tailored for a specific instrument by right clicking on the instrument and from the popup menu

click: Edit -> Order Presets.
A tab will exist f h f
e Index Cash (Forex) <r a0 will exist Tor each type o

instrument supported by your

Settings broker(s) or data service(s)

Order Type: | LMT ~ Offset: [ 10 2] (Ticks)
offset [ 10 2]

Time In Force: - Limit t [ 10 3] (Ticks)

Stop Offset: [ 10 2] (Ticks)

Default order quantity Trail Offset: m (Ticks)
Order Sizes

Default Quantity: Increment:

Add
Increment for

10 adjusting the order
20 quantity
30
50 Preset quantities

available from the
100 drop down next to
150 the quantity field
200 ;

Update Cancel

If you would like to change the order presets for a specific instrument, edit the instrument (right click on
a chart and choose Edit Instrument) and click on the Order Presets button at the bottom of the dialog.

Edit Instrument Dialog
Edit Instrument - AAPL X

IModify the fields below and press OK to save your changes.

(e EEIN Commissions  Advanced

Type: | Stock -
Symbol: { AAPL]
Historical Instrument: v Enabled

Symbol Display: = AAPL
Title:  Apple Inc

Exchange: = NASDAQ | +
Description: Apple Ip

Click here to adjust
the Order Presets
for this instrument

OK Order Presets Delete Cancel
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Order Presets - Instrument

o

Order Presets: Apple Inc

This form sets the default values when placing a new order for this instrument. These values
override the values that are set in General Order Presets (from the top menu: Configure -= Order

Presets).
Settings

X

Time In Force: | DAY~ Limit Offset. Ticks)

Order Sizes

Default Quantity: Increment: 10 =

Add

10
20
30
50
100
190
200

Update || Cancel

4.5 Chart Trading

Perhaps the most convenient way to create orders in MotiveWave™ is by using the tools available from

a chart. There are several ways to do this:

1. Price Axis — Trades can be placed directly from the price axis

ounkwnN

45.1 Chart Orders

Active and filled orders may be displayed and adjusted directly on the chart. Click on the Show Orders

button on the tool bar to toggle the display of orders on the chart.

Buy/Sell buttons — The Buy/Sell button labels can be optionally added to a chart

Context Menu — Use the trade items available in the context menu of the chart (right click)
Trade Panel — Use the trade panel that may be displayed on the right hand side of the chart
DOM Panel — The Depth of Market panel can be displayed on the right hand side
Strategies — As explained in the section: Strategies
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(™) MotiveWave - Console (google) B2 - X
File Edit View Study Strategy Format Configure  Window  Help
BRKE  |~|Q|E & & &~ @ X 2w~ Q i~ +[@WERv[15mn _ ~ A(Ee [N S imD SR
Lol AAPL 15m Ll MSFT 15m  |Lil BRK B 15m % | Ll GE 15m + A B = = <
— | T \ E
BRK.B - 15 min i ]
| Click here to d1e5.00
* * show/hide orders i
v His450
| T i lJI ! Click and drag 1
! } 'H.“ ! 1 label to adjust ]
" | k “ i *: H164.00
| Lok : t1638
v l\ L h I by gl |
HFM 'lh Click 'X' to i ! MT Lk ! li 18350
remove I 3 * ]
T i These orders are configured as a .+“.+ *“.+ " IL Click 'C' to
! Bracket Order. The parent Buy Limit H-
| l o Tl i cancel order i
| R ! m l_ Order has an attached limit and stop . . i 1o * 1628
::---' } *H‘ T order. Green arrow lines visually P T“+&|'
H I T | indicate that they are connected. : £162.5:
- [Fied over | | 1 .
| i
STP-SIM 100@162.09 [& 18200
i 1
i i
Motz ave : i S A S S Orderlabel ([, ]
14:00 Jan-31 12:00 Feb-2017  12:00 14:00 Feb-02 12:00 1400 Feb-03 12:00 1400 Feb06 12:00 14:00 Feber——rrve— 400 16:00 1800
1min 5min 10min  15min  20min  30min 45min  1hour 2hour Ghour 1day 1week 2week 1month 3 month = ey @ |4 @
|l Home % il Charts {8 Account [0 Scan  {}f Optimize News  + T ]

Feb-07 15:56:28

The price of an order can be adjusted by clicking and dragging the order label up or down. By default
the order will automatically be submitted with the modified price. This default can be changed in the
Preferences dialog (see Order Preferences section). If “Auto Submit Modified Orders” is turned off,

then you will need to press the ‘T’ button to transmit the modified order to the broker.

Adjust Chart Order Price

H164.50

l i Click and drag label E H164.00
} H up/down to adjust P £163.85
) Ti T the price . 1]
i t| 116350
! Te, el t*l :
; W |

By default order will be submitted | L] k1629
when releasing the mouse button. '

162.5

—————————————————— LMT-SIM 100@162.42 e

162.00

D o T .
[ —

1
|
I I

1
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1
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Double click on the order label to display the Order Ticket dialog. A context menu can also be accessed
by right clicking on the order label.
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Order Context Menu

| 16400

A i ﬂ ‘
163.8
_l__j_ﬂig!fﬂ__l I ! . i
TI'TI“T. Right click on the dit Order TICI(et r163.50
! order label to show ancel Order 1
the context menu Cancel All I
| ; | n V| £162.93)
| 162 58
------ . SR S— et
------ S {
STP-SIM 100@162.09 [ ~Hie200

| |
00 1400 Feb-06 1200 1400 Feb-07 1200 1400 1600 1600

4.5.2 Trade History

Historical trades can be displayed directly on the chart by clicking the Show Trades button on the tool
bar. Detailed information on each trade can be displayed by placing the mouse cursor over one of the
trade arrows.
Trade History
USD/CAD - Primary Analysis - 156 min™ S I

View Study Strategy Format Window Help
QIR & B 5~ 69D Hw~ 2 w-Q (i~ My + [T 2~|15min -
I

10K

min PL:-4.47 l
| Pips:-5.5
L '
Down arrow indicates sell, ‘*
up arrows indicate buys.

Wi

Click here to toggle
the display of
historical trades

T
I
I
I
: |
I
! ‘ | 14 30600
| 10K N
| ! 130537
1 ! ) Pipe: 65 ‘ 1-30500
| 54 r The arrow indicates the 10K
! ! .T average price for the trade PL:15.33
| N . Pips:20.2 H1.30400
| Historical Trade 10K I I
I 10K )
| PL:-26.19 PL:-26.19 E1.30311i'
! Pips:-34.5 Pips:-34.5 +
1 '|'T I
! + i‘l‘ “ Ir 1.30200
I
! Tr I * *
: 1 “ f A I 1.30100
i Account REPLAY-1
: Place the mouse cursor BOT 10K@1.30109 H1.30000
i over the trade to show :45,{Feb-01 23:29:59
| detailed information ips:2( PL 1533
: . Pips:20.2 d4 29900
I
| |
| L | L L L L . \ . | L L L L L L . , G290

“eb-2017 300 500 700 9:00 12:00 14:00 16:00 1800 20:00 22:00 Feb-02 2:00 4:00 6:00 800 10:00 12:00 14:00 16:00

4.5.3 Price Axis Trading

Orders can be created directly from the price axis by simply clicking where you want to place a limit
order. If you move the mouse over the price axis, you will notice that the mouse cursor will change to a
blue/red target (depending if you are above or below the current price). You will also notice that there
is a label that shows the price.
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Price Axis Trading — Limit Buy Order
il USD/CAD - Primary Analysis - 15 min* 3o X
File Edit View Study Strategy Format Window  Help

(W [~]Q b W& s~ @D IR W 2 e @ §- M~ + T[T 2~ [15mn - AW %X »

USDIGAD - 15 min

If the cursor is above the
current price, a sell limit
order will be created.

|
'
This is the limit price
that will be chosen
for the order

Place the cursor where you want
to create a limit order. Motice
the cursor is a blue target with
'LMT" in the bottom right.

Iim B %4

Press the left mouse button once to create a limit order at that price using the default quantity for the
Instrument (see Order Presets). Note: place the cursor above the current price to create a Limit Sell
order, and below to place a Limit Buy order.

| vyt

'M’ H'Tlm'h |!‘

l

]
T+'!'.‘*1T.Fi++71*'+*

y
FT.|¢I¥!,*+I!I+

S

By default, this order will just be created (not submitted to the broker). You can optionally modify this
order and click the ‘T’ (transmit) button to submit the order to the broker.

Price Axis Trading — Adjust Order

il USDICAD - Primary Analysis - 15 min* - X
File Edit View Study Strategy Format Window Help
usbicAD |~ Q |l Bl B s~ @ IR Wy 2 e~y & iy My + | T |2 [15mn - 2y 8 K >
USDICAD - 15 min 1.32135
* Click and drag the order label 31 32000
iiHT*T. up/down to change the limit price. )
Double click to show the Order Ticket R
h I dialog or right click to show options. ,%gﬂﬂ)
$1 I
| o IhI I o
"“i L S 4131600
Lo

1.31400

Limit order created (but not Press 'T' to transmit the
I i submitted). Default quantity order to the broker or
# ‘ | I!. used [10K) and the price is set 'D' to discard (remove) 1.31200
'H T+!' i “!'! where the cursor was clicked.
i IJ.! -*l" | r*' 3131000
i ULTRT O [ }‘
e I—

4.5.3.1 Price Axis Order Types

You can place different types of orders from the price axis by holding down on the following keys while
clicking the left mouse button. The quantity for all of these orders will be the default quantity assigned
to the instrument.

1. No Key — Limit Order, the limit price will be the value at the current mouse location

[
[k, o}

a. WT Limit Buy — cursor is below the current price
a1

[k, o]
b. WT Limit Sell — cursor is above the current price
2. Ctrl Key — Stop Order, the stop price will be the value at the current mouse location

[l
[k, o}

a. sTF Stop Buy — cursor is above the current price
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Taal

b. Tt Stop Sell — cursor is below the current price
Shift Key — Market Order, sell or buy at the current market price (best bid/best ask)

Caal
[, o]

a. miT Buy Market — cursor is below the current price.

b. T Sell Market — cursor is above the current price
Ctrl + Shift Key — Limit Order + Attached Limit & Stop orders. A limit order will be placed with
the limit price equal to the current mouse location. A limit and stop loss order will be attached
to the limit (parent) order.

a. WTst Buy Limit + Sell Stop/Limit

Tl

[, ]
b. wTsLSell Limit + Buy Stop/Limit

The mouse cursor will change depending on which modifier key you are pressing when moving the

cursor over the price axis.

4.5.3.2 Price Axis Context Menu

The context menu (right click on the price axis) also has a menu for creating orders (see diagram below).

Price Axis Trade Menu

{ ---------------------------------- 1.31509 ?, ‘éradnte - ¥ | Limit Order
- - 1.3 L Lreale Aler Stop Order

( s (]| 7 e | daretons

5 ] Add Guide Trail Order

{ the context menu —:1_31200 Limit+Stop

: ] Limit+Trail

3 3131000 Stop+Stop

S ] Stop+Tralil
3 Limit+Stop/Limit
41.30800 Limit+Trail/Limit
. 1.30730 Stop+Stop/Limit
] Stop+Trail/Limit

4 {1-30600 OCO Limit+Stop

1 1 OCO Limit

; 1 30400 OCO Stop

Mw

4.5.4 Buy/Sell Buttons

For convenience, buy and sell buttons can be added to the chart. These buttons are available as Chart
Labels. Double click on the chart (or right click and choose Chart Settings) to open the Chart Settings

dialog. You will find the Buy Button and Sell Button labels under the Label tab.
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Enable Buy/Sell Buttons

#

o

General Scaling Bar Settings Theme Display JELRES

Chart Settings

Watermark Trade Elliott Wave

The list below shows the labels that are displayed on the price graph (such as Spread, Day Range etc).

Available Labels

DUaier e
Day Close

Day High

Day Low

Day Open

Day Range

Day Range %
Dividend Rate
Eamings Per Share
Extended Data
Last Bar Close
Last Bar Diff

Last Bar Time

Last Price
Last Time
Open Interg
P/E Ratio| Look for the Buy/Sell
Pip Cost Button options in the
o |t
Profit/Losg

section
Roll Buy
Roll Sell
Sell Button

Spread
Volume

-

=<

Labels

Buy Button

OK || Save Defaults

Reset Defaults Cancel

MotiveWave

LT T T

If you would like to create a buy or sell order, click on the Buy or Sell buttons that are directly on the

chart. This will open an Order Ticket dialog that you may use to create your order.

Buy Sell Buttons

A8
File Edit View  Study
USD/CAD

USDICAD -15 min ED

Strategy
~ Ok & & sr&E

Click either of these

buttons to show the
order ticket dialog

USDI/CAD - Primary A
Format Window Help

IR W~ 2|~y Q |

A P e i

-

The Order Ticket dialog may look different depending on the broker you are using. The following dialog
is from a workspace configured for CQG:
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Order Ticket Dialog
= New Order: EPH7 X
Symbol Position Bid Size Bid Ask Ask Size Last Price
EPHY 587  2281.75 2282.0 211 #22815
Buy sell
Account: | SIMmwaveapi ¥ Current Price
Quantity: =- Available options will
Type: | LMT - depend on the broker(s)
that you have chosen for
Limit Price: | 22885 = your workspace.
Expires: | GTC -
Limit
Use this section to
Stop attach orders
Trail
m Discard Presets

455 Context Menu

The context menu (right click on the chart area) has options for placing orders and adjusting trading
settings.

Context Menu - Trading Options

EPH7 15m x | + 2.’
EPH7 - 15 min 2292.00
Volume
2291,2%}
i + u L* Hz290.00
Right click on L& Chat seltings +i H2289.00
chart area Edit Instrument '|'
Bar Size
Tick Interval ‘|' H2288.00
Volume Interval v
Range Interval 2287.00
L Renko Interval
[ ] | Template
i i —f * lll Link Hz286.00
ﬁ -‘— ! Add Study
' Tools L
—r % ] Buy H2285.00
Eglt " Sell Trading Options
View 1 Cancel Al H2284.00
+ ik Show Extended Data £ Refresh Orders
(' Clear Local Data £ Refresh Trade History
H H2283.00

45.6 Trade Panel

The trade panel is a convenient tool for managing orders and positions from the chart. This panel can be
displayed by choosing View -> Display -> Trade Panel from the top menu bar (or press Alt + T). There is
also a button available on the tool bar that toggles the display of this panel.

The Trade Panel has three tabs that provide different trading options.

4.5.6.1 Position Tab

The Position tab may be used to manage your current position for the chart instrument. It has the
following elements:

1. Buy Market Button — Creates a market order to buy the given quantity at the market price
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2. Sell Market Button - Creates a market order to sell the given quantity at the market price

3. Quantity — This is the quantity for the market orders. It will default the value in order presets

4. Flatten Button — If you currently have an open position, this button will close the position at
market price

5. Cancel All - If you have open orders for the chart instrument, this will cancel these orders

6. Break Even — Creates an exit order at the break even price.

7. Reverse Button — If you have an open position this will close that position and open a position in
the opposite direction. For example, if you were currently long 10K, this would close the long
position and open a short position for 10K

8. Account Choice — Enables you to choose the account for the orders

9. Position Label — Displays the current position (N/A for no position). If the label background is
blue, then the position is long. Short positions will have a red background as well as a negative
number for the quantity.

10. P/L Label — Displays the current unrealized profit/loss for the open position. A loss will be

displayed with a red background (and a negative sign). A profit will be displayed with a blue
background. If there is no open position, this label will display N/A.

Trade Panel — Positions Tab

§eWave - Console (CQG) e o o B
Toggles the display
? &> | 15min - {O‘F the Trade Panel (ke ]
| ¥
£ 2291 __25 Trade x
i I g Order Bid/Ask
; =2290.00
e I ol ] EI B
‘ _‘_ Order Quantity =
U2283.00 Flatten | | Cancel All
] Break Even | Reverse
+2287.00
Account Choice SIMmwaveapi v
-12.50
Current Position (Blue I hd
background indicates Long) hyt
—EREEEE ] | | 13)= oc <[ W%
H2283.00
2282 50
272527,
e . e, PP ]

4.5.6.2 OrderTab

The Order tab is used to create or modify existing orders. New orders can be created by clicking on the
Buy or Sell buttons. An existing order can be modified by selecting it on the chart (left click on the label).

1.

Buy Button — Indicates if the order is a buy or sell. If no order is selected on the chart, you may
click on this button to create a buy order.

Sell Button — Indicates if the order is a buy or sell. If no order is selected on the chart, you may
click on this button to create a sell order.

Quantity — quantity for the selected order. This will default to the order preset if it is a new
order.
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the visible fields below (ie limit price, stop price etc).
5. Limit/Stop Price — Depending on the type of order these fields may be visible underneath the

Order Type field.

‘&

Order Type - list of available order types (broker dependent). The selected choice will influence

6. Time In Force — effective time for the order. Day orders will expire at the end of the day. GTC
orders last until they are cancelled (Good Till Cancelled). The options available in this field will
vary depending on the broker.

primary order is filled

Limit — Use this option to attach a limit (profit) order. This order will be activated when the

Stop — Use this option to attach a stop order. This order will be activated when the primary

order is filled and will be an OCO (one cancels other) order with the limit order above.

9.
10.

Trail — Use this option to attach a trailing stop order (instead of the stop order above).
Submit/Modify Button — Click this button to submit the order to the broker. This button will

have a red background for sell orders and a blue background for buy orders

11. Discard/Cancel — Discards (for new orders) or cancels the order

12. Account Choice — Account for the order. For new orders, this will default to the Primary account
(set in the Accounts panel).

Trade Panel — Order Tab

i\ﬂotiveWave - Console (CQG)
Ip
T &2~ 15min -

'
Llen,,

wmmwwwnﬁﬂ-—r}w\u

Click Buy or Sell

2289.00

. Hozss.00

------------------ g LT 1@2287.75 T Ol
H2287.00
17286.00
H2285.00

To modify an existing
order, click on the label to
select. Order form will

show the order attributes.

229125 Trade

to create an order —
Buy

Use these options -
to attach orders SIMmwaveapi h
1@2283 50

sition [[EHIag Bid/Ask

Sell

Quantity: =

Type: | LMT -

Limit Price: 228775 ¥

Expires: GTC v
Limit
Stop

Trail

m Discard

P
|
I
1
1
I
I
1
I
I
1
I
I
I
I
I
I
1
|
\
=
=
=
=
?
[}
=)
l
=
=
(©)
i
I
|

4.5.6.3 Bid/Ask Tab

The Bid/Ask tab shows a Buy/Sell box (with best bid and best ask prices). This tab is convenient for
placing buy and sell orders at market and monitoring the spread between the bid/ask prices. You can
double click on either the Sell or Buy boxes to submit a market order.
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Trade Panel — Bid/Ask Tab
i MotiveWave - Console (CQG) - 7 X
w  Help s
+ =T 2~[15mn - LI Sz KONk )
£
Trade Double click to X

Y

k225125

if the bid/ask goes up
or down.

{This will flash blue/fred

ALMT 1@2287.75 T D

Double click to
Sell at market

T A oA b,

Position Order|

EPH7

285%

228

Buy at Market

10:17:07

525

Entry/Exit

Breakout

4.5.6.4 Entry/Exit Strategies

Entry/Exit strategies provide a convenient way to place combinations of orders in a single click. The
entry/exit section can be found on the Trade Panel as well as the DOM (Depth of Market, hidden by

default).

The following screen shot shows the Entry/Exit section of the Trade Panel. Strategies can be created,
modified or removed by clicking on the edit button located in the top right corner of the section.

If you would like to execute a strategy, select it from the available strategies drop down and press the
execute button. Parameters such as Lot Size, Time In Force and Offset Size can be adjusted in the fields

below.
Entry/Exit Setups
f MotiveWave - Console (CQG) TR S
i Help
§+ T|#~[15mn  ~ 24 (m e X G E oS R
: E
£2291.25 Trade b4
+I i Order Bid/Ask
52290.00
§ " | O3 €13
s J. " H Cre=
-‘-* d2288.00
12287.00 Edit/Manage
Click here to execute Strategies
+ ] the strategy
—_2286 00
e '2285 57 | Entry/Exit \ v
Breakout v >
1 =- | GTC - 10 3
4 A
H f22 ;
g ] Lot Size Order Time Offset size
2 15282 00 In Force (in ticks)
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MotiveWave™ comes with several built-in strategies that you use or modify to suit your needs:

1. Breakout — Creates buy/sell stop OCO (one cancels other) orders above and below the current
market price. This can be useful if you are expecting the price to shoot up or down in the near
future and you want to get in on the trend.

2. Fade — Creates limit OCO orders above and below the current market price.

3. Brk Up/Fade Down — Creates a Buy Stop Order (above the current price) and a Buy Limit Order
(below the current price) (OCO Orders) to enter the market long.

4. Brk Dn/Fade Up — Creates a Sell Stop Order (below the current price) and a Sell Limit Order
(below the current price) (OCO Orders) to enter the market short.

5. Bracket Exit — Creates a limit order to exit a position and a stop order as a stop loss. Both of
these orders are OCO orders.

6. Scale Out — 2 — Creates two limit exit orders and two stop loss orders to scale out of a position.

7. Scale Out — 3 — Creates three limit exit orders and three stop loss orders to scale out of a
position.

Entry/Exit strategies can be managed by clicking on the edit button to show the dialog below.

Manage Entry/Exit Strategies Dialog

- Entry/Exit Strategies X

The list below contains the available Entry/Exit Strategies. These
strategies make it easy to quickly setup entry and exit orders.

Breakout
Fade
Brk Dn/Fade Up
Bracket Exit
Scale Out - 2
Scale Qut- 3

Select one of the
strategies to activate

Click here to create j| the buttons below.

a new strategy
| \/
L

New | Edit | Remove | up | down || Close

Click on the New button to create a new strategy or select an existing strategy and click on the Edit
button. The Entry/Exit Strategy dialog will be displayed to allow you to configure Entry and/or Exit
orders for this strategy. If it has both types of orders, the exit orders will be created when the entry
orders are filled. The following fields apply to this dialog:

1. Name — This is the name of the entry/exit strategy and will be displayed in the drop down

2. Absolute Offset — By default the offset will be multiplied by the Offset Size in the Entry/Exit
panel. If you specify an absolute offset the offset (ticks) will be used as is.

3. Offset — This is the distance (in ticks) from the current price. If the absolute offset is not checked,
this value will be multiplied by the offset size in the Entry/Exit panel.

4. Lots — This is the number of trade lots that will be setup as the quantity for the order. This
number will be multiplied by the Lot Size field in the Entry/Exit panel.

Entry Orders
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You can specify up to five entry orders for the strategy. Each entry may have one or two orders. If two
orders are specified, then these orders will be submitted as an OCO (One Cancels Other) pair.

Exit Orders

Entry/Exit Strategy Dialog

» Entry/Exit Strategy x

This dialog allows you to define a custom entry and/or exit strategy. Relative (vs absolute) offsets may be used
to have different offset values per instrument. In this case the actual offset will be a multipier of the Offset field
in the Order Presets.

=
Name: | Trade Setup 1 Absolute Offset

Entry Crders 2qgelpi= e

Select the entry orders below. Each entry may consist of 1 or 2 orders. If two orders are specified, they will be
submitted as an OCO order (One Cancels Other). The Offset and Lots fields are relative to the Order Presets
for the instrument.

Entiy1| LMT ~ | SELL ~ |Offset | 1 2] Lots | 12]
- ~  Offset Enabled
Optionally setup entry
Entry 2 Offset Lot orders for this strategy.
- ~ | Dffset Each entry may have up to
two orders which will be
Entry 3 - v Ofset Lots configured as OCO orders.
- ~ | Offset
Entry 4 b ~ | Offset Lots
- ¥ | Offset
Entry 5 b ~  Offset Lots
- ~ | Offset

OK Cancel

Similar to the entry orders, you can specify up to 5 exit orders. If this strategy has entry orders, then
these orders will be created after the corresponding entry order has been filled. Each exit can have a
limit (profit taking order) and a stop/trail order (stop loss order). These orders will be submitted as an
OCO (One Cancels Other) pair. If Auto Adjust Size is checked, the lot size will be adjusted to match the
currently open position.

Entry/Exit Strategy Dialog — Exit Orders

(%] Entry/Exit Strategy X

This dialog allows you to define a custom entry and/or exit strategy. Relative (vs absolute) offsets may be used
to have different offset values per instrument. In this case the actual offset will be a multipier of the Offset field
in the Order Presets_

r
Name: | Trade Setup 1 Absolute Offset

Entry Orders Iamﬁ

Select the exit orders below. Each exit consists of a Limit and an optional Stop/Trail order. If two orders are
specified, they will be submitted as an OCO order (One Cancels Other).

Auto Adjust Size

; Optionally setup exit
Bidt1 - Limit ClEE 3 Enaibled Lots 1= orders for this strategy.
~ | Offset Enabled *1'| Each exit may have up to
. - two orders which will be
Exit2  Limit Ofrset configured as OCO orders.
Lots
~ | Offset
Exit3  Limit Offset
Lots
~ | Offset
Exit4  Limit Oifset
Lots
~ | Offset
EXit5  Limit Offset
Lots
~  Oftset
OK Cancel
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4.5.7

Preferences

The behavior and appearance of orders can be modified from the Preferences dialog (Configure ->
Preferences from the Console menu bar). Click on the Orders tab

1.
2.
3.

10.
11.
12.
13.

Price Axis Trading — Enables or disables the ability to trade from the price axis
Buy/Sell Box Trading — Enables or disables the ability to trade from the Buy/Sell boxes
Use Pips for Attached Orders — Indicates if pips vs price should be used when determining the
offset from the parent order.
Confirm Closing Positions — Displays a confirmation dialog when clicking on the close button for
a position.
Auto Submit Modified Orders — If this option is enabled, dragging an order on a chart will
automatically submit the price change to the broker (instead of requiring an extra step to
transmit the change by clicking on the ‘T’ button)
Send Email on Filled Order — Sends an email to the configured email address when an order is
filled. Note: you must configure your email settings (see Email tab)
Send Email on Rejected Order — Sends an email to the configured email address when an order is
rejected. Note: you must configure your email settings (see Email tab)
Show Client OCO Warning — Display a warning when placing a client OCO order. Some brokers
do not support server side OCO orders. In these cases MotiveWave™ will simulate the OCO
order on the client side.
Show Client Attach Warning — Similar to the option above, MotiveWave™ will display a warning
to remind you that the attached order is a client order (not submitted to the server initially).
Create Order — Mouse click to create (but not submit) an order
Show Order Ticket — If checked, the Order Ticket dialog will be displayed when creating an order.
Auto Submit — Mouse click to create and submit an order (double click by default)
Price Axis Key Modifiers — This section may be used to customize what types of orders may be
created from the price axis.

a. Default (No Key) — defines the type of order created when the mouse is clicked with no

modifier key

b. Shift Key — defines the type of order created when the mouse is clicked while pressing the
Shift Key

c. Ctrl Key — defines the type of order created when the mouse is clicked while pressing the
Ctrl Key

d. Ctrl + Shift Key — defines the type of order created when the mouse is clicked while
pressing the Ctrl and Shift Keys
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Order Preferences

MotiveWave

Lol

General Theme Chart Tool Bar Sounds Ratios Elliott Wave Gartley Tick Charts AIE.‘ItS Email

=

Preferences X

Limit, stop and market orders can be created (and submitted) directly from the price axis.

Create Order will create the order on the graph giving you the epportunity to transmit the order (clicking the 'T' button). Auto
Submit will save time by creating the order and automatically submitting the order to your broker.

Order quantities can be configured in Order Presets. Keyboard modifiers (Ctrl, Shift and Ctri+Shift) may be configured to
place different order types from the price axis. Hint: if you are above a price indicator, hold the Alt key to place an order.

Options

| Price Axis Trading | Buy/Sell Box Trading

v'| Confirm Closing/Reversing Positions |v/| Auto Submit Modified Crders
Send Email On Filled Order Send Email On Rejected Order

v'| Show Client ©CO Warning v'| Show Client Attach Warning
Create Order. | Single Click =~ Show Order Ticket

Auto Submit: | Double Click
Price Axis Key Modifiers

Default (No Key): | Limit Order -

Shilt Key: | Market Order - These fields may be

Cirl Key: | Stop Order - used to change the

price axis behavior
Ctri+Shift Key: | OCO Limit -

OK | Apply || cancel

The Display tab provides options for displaying orders on charts:

[ o) Preferences
General_Theme Chart ToolBar_Sounds Ratios Eliott Wave Gartiey Tick Charts [[Elaeg Alerts Email
Submission EEEJEV

Use this dialog to configure how orders are displayed on charts.

-

Order Align: | Right =

v'| Show Buitons

| Show Li Use these options to
ow Lines change how orders are
v/| Show Filled Orders displayed on charts.

v'| Show Filled Lines

Filled Order Align: | Left -

OK || Apply || cancel
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4.6 Depth Of Market (DOM)

MotiveWave™ provides a Depth of Market (DOM) feature that allows you to see bid and ask prices/sizes
beyond the best bid and best ask provided this is supported and permissioned from your broker/data
service. Depth of Market can be accessed as a panel on a chart, a panel in the console or from a
separate DOM window (File -> New -> New DOM Window from the Console menu bar).

The following screen shot shows an example of a DOM window. Current position information can be
found at the bottom of the window. The table area contains several different columns which are
configurable from the Preferences dialog.

1.

P/L — Displays what the profit/loss would be for your open position at each price interval. Profit
levels are displayed with a light blue background, losses show in pink.

Orders — Shows active orders. Sell orders are in the left Orders column, buy orders are in the
right Orders column. The example below shows a limit sell order for 1 contract on the right hand
side. You can click and drag the label to adjust the limit price or cancel the order by clicking on
the ‘C'.

Bid — shows the current bid sizes at each price level. For convenience a histogram is displayed in
the background to show the size of the bid relative to the other prices.

Price — This is the price ladder. It shows prices in increments of 1 tick. The last price has a dark
blue background and shows the last traded size. Best bid and best ask prices have yellow and
green backgrounds. Day high and day low have blue and red backgrounds.

Ask — shows the current ask sizes at each price level. For convenience a histogram is displayed in
the background to show the size of the offer relative to the other prices.

Volume — Displays historical price action at each price level. This column will update as live
trades are made.
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DOM Window
im DOM (16857688 - EPHT)
File  Options Window Help
EPHT ~ | Limit Order - =- 'i‘
1 2 3,5 10 15 20
PiL Orders Bid Price Ask Orders Volu
2291.50
Order Quantity — LOCK{UHIOCk
Selector This column 2291.25 Trading
displays active 2297\00
buy orders
137.50 Y Day High
125.00 goo0 1346
112.50 229025 1079
100.00 2290.00 1382

87.50 Profit/Loss
75.00 Ladder

2289.75 1374
2289.50 1247

62.50 2289.25 1218
50.00 2289.00 1162
a7 2288.75 1395

This column
displays active
sell orders

Last trade price and

SIMmwaveapi

23| guantity (currently 2288.50 1146
12| covering best offer) 404
400 2283.00

-12.50 1105 229 202K
-25.00 1334 2 Best Bid Histogram 15.3K
-37.50 1274 2xoT 7327
-50.00 1440 228700 6720
-62.50 77 2286.75 8721

1181 2286.50 10.5K

Account Choice 111K 611 11.8K

Position:

* || Flatten |Cancel All | Reverse

4.6.1 Trading From the DOM

By default the DOM is locked, this prevents trades from being placed directly from the table. Click on
the Lock/Unlock button on the tool bar to enable trading from the DOM table. Limit and stop orders
can be placed by clicking on the Bid and Ask columns. You will notice the mouse cursor changes when
you move it over the bid and ask columns:

1. Buy Limit

button.

[
[, o]

PiL: N/A  Spread: 0.25

ouy e | senme]

Feb-08 11:39:47

wT - This cursor will display over the Bid column and below the current best bid price.
A limit order will be placed with the given quantity when a row is clicked with the left mouse

el

[k, o]
2. BuyStop =™ -This cursor will display over the Bid column and above the current best ask price.
A stop order will be placed with the given quantity when a row is clicked with the left mouse

button.
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Taal

3. Sell Limit w7 -This cursor will display over the Ask column and above the current best ask
price. A limit order will be placed with the given quantity when a row is clicked with the left

mouse button.
Taal

[k, o]
4. Sell Stop =™ - This cursor will display over the Ask column and below the current best bid price.
A stop order will be placed with the given quantity when a row is clicked with the left mouse

button.
DOM Orders
in DOM (16857688 - EPH7Y) = ' 4
File  Options  Window  Help Preset Quantities
EPH7 ~ | Limit Orger - =. Jcan also be
R 5 10 15 20 accessed from here
PIL Orders | Order Quantity Ask orders ||ndicates that
Quantity Selector 2289.75 ETI-‘ODCkO:;‘ 15
75.00 2289.50
62.50 228925
50.00 2289.00 15.9K
3750 2288.75 1150 10.5K
25.00 2288.50 1061 179K
12.50 2288.25 1145 16.4K
2288.00 1034 262K
-12.50 2287.75 1193 24 0K
-25.00 2287.50 1093 17 4K
Mouse cursor changes to 228725 1020 11.5K
show what type of order 228700 1020 15 TK.
will be placed. Left click 2986.75 960 15 2K
with mouse button to
create and submit order. - 121K
3 813 2286.25 7051
-100.00 {*}!53 2286.00 11.0K
thr
o 06K nnn%?;; 10.0K -
Position: i@kectai] P/L: EEtid] Spread: 0.25
SiMmwaveapi ~ || Flatten | Cancel All | Reverse m
Feb-08 11:55:18
Order Combinations

Other types of order combinations can be created by choosing a different option from the order type
drop down on the tool bar. The following example shows the Limit + Stop/Limit option. A limit order
will be placed and a stop/limit order will be appended as a bracket order.
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DOM Order Types

m DOM (16857688 - EPH7) - X
File Options Window  Help
EPHT ~ [ Limit Order - 1 2= IR .}
DN
PIL | Stop Order Price Ask Orders Volume *+
g750  Trail Order 228975 c 17.2K
7500 |Limit+Stop 2289.50 1068 28 7K
g250 | LimiteTrail 2289.25 1154 26.4K
5000  Stop+Siop 2289.00 1307 15.9K
ars50 | Stop+Tral 2288.75 1119 10.5K
25.00 m 2288.50 1102 17.9K
1250 | Limit+TraifLimit 2288.25 1135 16.4K
| StoptStop/Limit | 5588 09 1120 26.2K
1250 2287.75 1131 24.0K
R o oo

In the example below, the Limit + Stop/Limit option has chosen. The cursor will display LMT SL when
hovering over the Bid/Ask columns. One left mouse click will create a limit order at that price and
attach a stop and limit order above and below the current price.

Placing a Limit + Stop/Limit Order

Feb-08 12:01:15

i DOM (16857688 - EPH7) N
File Options Window Help
EPH7 ~ | Limit+Stop/Limit 12| = o o 3
[172 3 5 10 15 20 A

PIL  Quimit + Stop/Limit Price ol AsK Orders | Volume |*
2500 |type chosen 2288.50 1182 c 17.9K
12.50 2288.25 1108 16.4K
26.3K
12,50 369  2287.75 25 1K
25.00 1246 2287.50 18.2K
37.50 1135  2287.25 13.2K
-50.00 989  2287.00 17.3K
62,50 992  2286.75 19.6K
75.00 951  2286.50 14.1K
-87.50 120 228 " 7135
-112.50 o 2281 reated when clicking here 11.4K
125.00 1068 228 9581
137.50 2285.25 8154
-150.00 2285.00 17.4K
162.50 228475 16.5K
175.00 2284 50 19.1K
-187.50 228425 21.5K
-200.00 2284.00 21.5K
212,50 228375 33.4K
-225.00 228350 -sTP1 ¢ 337K
-237.50 2283.25 21.0K

10.2K 1193 113K
Position: [flevrrxn] /L [EBED] spread: 0.25
SiMmwaveapi v | Flatten |CancelAll| Reverse E D
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Adjusting Orders

g

The price of a stop or limit order can be adjusted by dragging the order label up or down. The order
ticket dialog can be displayed by double clicking on the order label. From this dialog you can change
other attribute such as the Time In Force or the order quantity. An order may be cancelled by clicking

on the ‘C’ button to the right of the order label.

Adjusting Orders from the DOM

N T v R P Ay i e e P,

112.50 2290.25 1237
100.00 2290.00 1391
87.50 72

Double click on an

order label to see the 15

75.00

62.50 Order Ticket dialog. 39
50.00 L U344 Click "C" to Cancel

11.3K
14.5K
172K
28.TK

37.50 2288.75 264

4.6.2 Position Panel

AV4 10.6K

25.00 P 2@2288.50 -L§$ 1 s 19.3K
12.50 1065 2288.25 174K
ey —— Click and drag the 2

12,50 1060 2287| order label up/down 26.6K
-25.00 1054 2287 to adjust the price. 18.4K
-37.50 1042 22875 13.2K
-50.00 996 2287.00 173K

i e e N R e e e i i L Ol ]

The panel at the bottom of the DOM displays information on your current position and provides

management options. It has the following elements:

1. Position — Current open position. This is displayed as quantity@average entry price. A blue

background indicates a long position (red for short)

2. P/L-Current profit/loss. Blue background for profit, red for loss.
3. Spread — Difference between the bid and ask price
4. Account — account to use for placing orders
5. Flatten Button — Closes the open position at market price
6. Cancel All Button — Cancels all active orders for this instrument
7. Reverse Button — Reverses the currently open position at market price
8. Buy Mkt Button — Buys at market price using the quantity at the top of the DOM
9. Sell Mkt Button — Buys at market price using the quantity at the top of the DOM
Position Panel
-75.00 HES 2156500 141K
Current open position }g 9 Current unrealized 7135
for selected account rofit/loss
Account for 6.0 " 11.0K
placing orders 10.4K \/ 484 10.9K
Position: l@kettia Pl Spread: 025
SIMmwaveapi ~ | Flatten | Cancel All| Reverse m
Feb-08 12:07:22
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4.6.3 Centering

In an active market, bid and ask prices may change quite rapidly. In some cases these values may
appear above or below the current price ladder. The price ladder will automatically center itself in 5
second intervals, but you can manually re-center the DOM prices by clicking on the Re-Center button.

4.6.4 Preferences

DOM preference can be adjusted by choosing Options -> DOM Preferences from the top menu bar.
Alternatively, click on the Preferences button on the tool bar. This dialog has the following fields:

1. Rows — number of rows to display in the DOM table

2. Time In Force — expiration for orders placed through the DOM

3. Show Quantity Selector — toggles the display of the bar that allows you to quickly choose a
preset quantity

4. Show Order Ticket Window — if enabled the order ticket dialog will be displayed when creating
an order from the DOM

5. Double Click to Place Order — if enabled a double click (instead of a single left click) will be
required to create an order from the DOM

6. Show Grid — shows the outline around each cell in the DOM table

7. Show Totals — displays the totals bar at the bottom of the table
8. Show Entry/Exit — toggles the display of the Entry/Exit strategies panel at the bottom of the
DOM
DOM Preferences
fel DOM Preferences X
Rows:
Time In Force: DAY v

v/| Show Quantity Selector
Show Order Ticket Window
Daouble Click to Place Order
Show Grid

v'| Show Totals
Show Entry/Exit

Save Defaults Cancel

The columns displayed in the DOM table can be chosen from the plus button on the right hand side of
the column header:

Display Columns

i DOM (16857688 - EPH7) o ) E

File Optons Window Help

EPHT v || Limit+Stop/Limit ~ [ 1 2|=- ro &

12 3 5 10 15 20
P/L Orders Bid Price Ask Orders Volume
75.00 2289.50 1162 28.7K v PIL
62.50 2289.25 1062 26.7K :: gi;ders
50.00 2289.00 1142 214K [ price
3750 2288.75 1066 29.0K v Ask
25.00 2288.50 1128 -LMT1 B 33.21c| ¥ Orders
1250 2288.25 1167 28.7K Jl Volume
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4.7 Option Chains

Groups of options (Stock and Future Options) can be managed from the Option Chain panel in the
Console. If your broker supports options, you will see an “Options” page at the bottom of the Console
window.

An option chain panel enables you to see the available options organized by strike price for a given
expiry date. In the example below we are showing available options for AAPL that expire on Feb 24,
2017. By default 20 options (configurable) are displayed that are nearest the money. For convenience,
a black divider line shows where the current price is trading for the underlying symbols.

Buy and sell orders can be placed directly from the option table by clicking on the Buy/Sell buttons that
are next to each Put/Call pair. Current positions and profit/loss are also visible on the table for each
option.

Option Chain

~ MotiveWave - Console (tradier) B - X
File View Configu —
AAPL Feb-24 17 x | + Underlying Symbol | & 0 = = -
Underlying Q Search || Feb-24 17 + =_ Available Expiry Dates
symbol Position Bid Size  Bid Ask  Ask Size LastPrice
AAPL 3 13165 13166 8 131 65% Underlying Price
Position  PIL Orders Bid Size  Bid Ask  Ask Size LastPrice Strike Price LastPrice Bid Size  Bid Ask  AskS.. Orders PIL Position
1@0.10 277 0.10 0.11 234 0.10 138.00 83 6.90 7.20 3l Buy  sen
336 014 0.15 215 0.15 137.00 12 595 620 B Buy | sen
219 021 022 261 0.20 136.00 510 1,030 5.00 5.20 5 +1@4.90
515 0.31 0.32 150 0.31 135.00 437 1,039 410 425 e Buy | sen
146 0.48 0.48 142 047 134.00 370 534 330 3.40 472 " sen
17 0.72 0.74 a0 072 133.00 264 31 259 262 38 " sen
120 1.07 1.10 186 1.08 132.00 198 99 193 1.08 66
86 154 156 82 152 131.00 143 118 40 4 68 T sk
66 212 215 50 214 130.00 1.05 101 179
84 282 2.86 45 275 129.00 0.69 120 %8 70 143 __
985 365 375 a3 357 128.00 050 343 047 048 133
1,196 4.50 475 547 451 127.00 0.34 167 0.33 0.34
1@5.40 673 550 575 154 558 126.00 0.25 297 0.24 0.25 194
1151 6.50 6.75 647 6.54 125.00 019 215 019 020 374
5 7.55 7.75 673 7.60 124.00 0.16 418 0.15 0.16 225
| AWM Click on the B 50 | Target Account ]; Order Quantity ] 123.00 014 328 0.13 0.14 227
I OFtions Page b 55 ™\ /975 561 \/ 960 122 00 012 200 012 013 937
——— [ 12]= |pAY  ~="oOrderTime Flatten | Cancel All
il Home Ll Charls 8 Account @& Op{iuns x @ Scan  {lf Optimize  + In Force ) m Ny O

Feb-08 13:27:19

4.7.1 Placing and Managing Orders

The easiest way to place a limit or stop order is to click on the Buy or Sell button next to the call or put
option that you would like to trade. When you click on this button an Order Ticket dialog will appear
that will enable you to adjust the order. Defaults such as Account, Quantity and Time In Force can be set
at the bottom of the panel.
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Option Chain — Placing Orders
~ MotiveWave - Console (tradier) Ho- L X
File View Configure Window Help
AAPL Feb 2417 X | + - S
Underlying | AAPL Q, Search Feb-24 17
Symbol Position Bid Size Bid Ask Ask Size Last Price
AAPL 14 131.62 13163 13162
Position PIL Orders Bid Size Bid Ask Ask Size LastPrice Strike Price Last Price Bid Size Bid Ask Ask S... PIL Position
1@0.10 1.00 Buy Sell 215 0.11 0.12 353 0.10 138.00 424 6.90 7.20
Buy Sell 217 0.15 0.16 221 0.15 137.00 88 595 6.20
Ruv Sall 207 021 02 234 n20 13600 510 529 505 520
@ Options Order: AAPL
Symbol Current prices for the ize Bid Ask Ask Size Last Price
AAPL underlying as well as the 14 1318 131.63 2 131.62
AAPL170224P00134000 option are shown here 190 Adjust the properties of your 2 3.70
order and click the Submit
Account:  simulated - Custom button below to submit the
) ~ order to the broker.
Spread Side Exp Strike rder Type TIF
Single - - Feb2417 ~ | 13400 ~ | Put =~ 325 5| LMT ~ DAY ~
Close Click Buy/Sell button
to open Order Ticket
1,130 6.50 6.70 614 6.54 125.00 0.19 253 0.19 0.20
602 7.55 7.70 526 7.60 124.00 0.16 215 0.16 017
1,051 8.50 8.70 488 863 123.00 0.14 272 0.14 0.15
584 9.55 a75 703 ags 122 00 0 PRl cuy | se I
- Use these fields to set
simulated - =- | DAY - Flatten |Cancel All
Ijl default for orders (Account, |—|
|l Home LWl Charts .8 Account & Options X |2 Scan  {lj Optimize  + Quantity and Time In Force) m Ny 0

Feb-08 13:40014

Open orders can be canceled by clicking on the ‘C’ button next to the order. All open orders in the
option chain can be cancelled by clicking on the Cancel All button in the bottom right corner.

Market orders can be placed by using the buttons in the bottom left corner. These orders will be placed

on the put/call option that is selected in the table above.

If you have open positions, these can all be closed by clicking on the Flatten button in the bottom right

corner.
Option Chain — Managing Orders
~ MotiveWave - Console (tradier) oo T X
File View Configure Window Help
AAPL Feb-2417 X | + T
Underlying | AAPL Q Search || Feb-24 17
symbol Position Bid Size  Bid Ask  Ask Size LastPrice
AAPL 13 13167 13168 18 413168
Position PIL Orders Bid Size Bid Ask Ask S... Last Pri... Strike Price LastPri... Bid Size Bid Ask Ask S... Position
263 0.08 00e 210 0.08 139.00 569 7.80 815 298
1@0.10 202 0.11 012 232 0.10 138.00 a7s 6.85 7.20
200 0.16 017 314 0.15 137.00 322 = aas
172 023 024 193 0.20 510 770 Double click order
163 0.34 035 186 0.33 135.00 437 725 | 20! to modify.
144 0.51 053 337 0.51 134.00 370 1" 335 Press 'C' to
176 0.77 079 124 0.75 133.00 264 38 259 264 cancel this order
71 112 114 69 112 132.00 1.97 61 195 197
- 9% 158 160 54 160 131.00 1.43 66 1.41 1.44
50 217 219 76 216 130.00 1.02 26 100 #102
13 286 289 32 290 129.00 070 128 0.71 072
404 365 380 315 367 128.00 048 186 0.48 0.50
Market orders can be placed 460 475 401 489 127.00 034 188 034 035
-1@5.40 ::;Elydt';e::':'s;::tsz dbrl;:f_m 5.60 575 545 561 126.00 026 242 025 026 S:' d":i'i;'l;ze”
6.60 675 629 6.66 125.00 020 239 019 021 option chain
m 672 7.60 775 554 7.60 124.00 016 200 0.16 047 (1o es all open
w simulated v [ 12|= | DAY ~ posttions &t Flatten || Cancel Al

Charts  J8 Account @ Options X |2 Scan

i Optimize

+

market price.
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4.7.2 Option Spread Strategies

MotiveWave™ supports several common spread strategies:

1. Vertical

2. Calendar
3. Diagonal
4, Straddle
5. Strangle

6. Back Ratio
7. Synthetic
8. Butterfly
9. Condor

10. Iron Condor
11. Vertical Roll
12. Double Diagonal

13. Double Calendar

The spread strategy can be chosen when creating an option order (click on the Buy/Sell buttons on the

option chain table).

-] Options Order: AAPL X
Symbol Position Bid Size Bid Ask Ask Size Last Price
AAPL 4 131.73 131.74 9 +131.74
AAPL170224P00133000 Options that are part 34 2.56 2.58 52 2.64
of the strategy will be
AAPL170224P00134000 displayed in this table 77 3.30 335 562 3.70
Account: | simulated - Custom
Spread Side Qty Exp Strike Type Price Order Type TIF
| Vertical - ] BUY ~ [  12%|= Feb2417 ~| 13300 ~  Put ~ LMT | DAY ~
Single SELL 1 Feb-24 17 134.00 * Put
Submit Close
| Calendar
Diagonal
Straddl Available Spread Strategies.
Taddle Choose Single to place a
Strangle single option order (no
Back Ratio spread strategy).
Synthetic
Buiterfly

Condor

4.7.3 Preferences

Preferences for the Option Chain can be modified by clicking on the Preferences button (gear icon) in
the top right corner. This dialog has the following elements:

1. Max Rows — Maximum number of rows to display for the option chain. Click on Show All Options

to display all available options

2. Show Calls/Puts — By default both calls and puts are displayed in the table. This drop down

allows you to choose Calls or Puts or both.

3. Table Font — Font and size for the text displayed in the table
4. Show Grid — Displays a border around each cell in the table
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5. Sort Descending — Sorts descending by strike price

6. Show Order Ticket — Shows the order ticket dialog when placing a market order

7. Show Order Panel — Shows the section at the bottom of the option chain for managing orders
8. Show Quote Panel — Shows the quotes for the underlying symbol at the top of the panel

9. Update Button — Applies these changes and closes the dialog

10. Call Columns Button — Click on this button to choose the columns displayed for Call Options
11. Put Columns Button — Click on this button to choose columns displayed for Put Options

12. Save Defaults Button — Saves these settings as the default for other Option Chain panels

13. Cancel Button — Cancels changes and closes the dialog.

Option Chain Preferences Dialog

o Option Chain Preferences X
Max Rows: 20 = Show All Options
Show Calls/Puts: = Calls and Puts v

Table Font: Arial;13.0
Show Grid
v'| Sort Descending
Show Order Ticket

v | Show Order Panel Click here to choose
Call and Put columns.

v'| Show Quote Pans!

Update Call Columns Put Columns Save Defaults Cancel

Call and Put columns can be adjusted by clicking on the Call Columns or Put Columns button (see dialog
above). The columns available will depend on what is supported by your broker. The dialog below
shows available columns for Tradier Brokerage.

Choosing Call/Put Columns

Choose Call Columns X

You can customize the columns displayed for the Call table by selecting the column below and
using the '<' and "=' buttons to add or remove displayed columns.

Available Columns Selected Columns
Change Position
% Change PIL
Delta Select columns on the Orders
Gamma !eft O:jrfgb:)a:td us: the oIl S1e
=" and "<’ buttons to
Implied Vol add or remove them. Bid
Intrinsic Value Ask
Rho Ask Size
Spread Last Price
Symbol
Theta =
Time Value =33
Vega Use these buttons
Wolume to change the
column order.

Available columns will

depend on what is

supported by your broker.

|

Cancel
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5 Desktops

Desktops provide a convenient way to organize charts and other panels in one window. A Desktop is
essentially another Console window and uses the same docking framework to layout pages.

Choose File -> New -> Desktop from the Console menu bar to create a Desktop window.

Create Desktop Window

v

{

File | Edit

New
Open

Chart
Backup
Restore
Disconnect
Shutdown

MotiveWave - Console (tradier)

View Study Strategy Format Configure Window  Help

' | §B New Page & i~ + "W I~ [15min -
¥ | = New Watch List

il New DWIOD ﬁchoose File -> New -> New Desktop
| Ll New Chart Window Cir+N from the Console menu bar.

I New DOM Window

) New Time&Sales Window
Custom Instrument

L

+

++*T*'*' |

Enter a unique name for the Desktop from the New Desktop dialog and click the OK button to create.

New Desktop Dialog

Latsl New Desktop

Desktops can be used to organize, charts, watch lists etc
together into a single window. Enter the name of the Deskiop
below and press the OK button. ' me
already exists, it will be opened| Enter a name and
click the OK button

I

MName:

OK IManage Cancel

X

The follow screen shot shows the default layout for a Desktop window when it is first created. The
default layout includes two pages: Charts and Charts 2.
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Desktop Window — Default Layout
~ Desktop - My Charts Ho- X
File Edit WView Study Strategy Format Window Help
[AAPL] CaE = e s G | ©2|lw~-Q 1~ + F[T]@~[15mn  ~ I A R )
AAPL 15m x | + = .7
AAPL-Tomin +ﬂ”"+]’| “t 4ot 13175
= ¥
I hhhn—*-ﬂ--.--—.-- TT'F“i‘“'TJ-**uI**ﬂ“
131.22)
'T J131.00
g - ]
", 1" T L ]
i I :
l! Bt Tl H130.00
R d129.00
|.l’l Ll*'h“' ]
wm)é\’fave
14:00 16:00 1800 Feb-06 9:00 12:00 14:00 16:00 18:00 Feb-07 9:00 12:00 14:00 16:00 Feb-08 9:00 12:00 1400 16:00 1800
1min 5min 10min [15min  20min 30min 45min 1hour 2hour 6hour 1day 1week 2week 1month 3month = v @ |»v B
MSFT 15m X | + & *|[1BM15m x | + = .7
MSFT - 15 1 (6381 | 1BM - 15 niin I o
] Volume | l+l+T" -
Click here to add ] * l
* - a new panel tab *' +T TT'#“I
I - } 363.60 l '
‘*I in g W f I E T‘ ll s
L
TN 2 P
‘ Hy f ‘ - i i "
-
.| Default layout ey i |h"|] — — _ —
Motive has two p:ges . . , , , ® - h“ll“lll'“'ﬂl - 'I"I‘III"I----“![L .
i} 2:00 14:00 EehN8 __ 12:00 14:00 1600 | Feb-07 12:00 14:00 Feb-08 10:00 12:00 14:00 16:00
1min_3Ain_10min__15min 20 m| Click here to add = aiv @ |#|~ #|[1mn 5min 10min 15min  20min  30min >g = @iy @ |~ B
Ll Charts X Lul Charts2 | + anew page. m N O

Feb-08 14:52:47

To open or manage existing Desktops, select File -> Open -> Open Desktop from the Console menu bar:

Open/Manage Desktops

s

(] MotiveWave - Console,
File | Edit View Study Strategy Format Configure Window  Help

New v B W v @ X 2@~ Q 4~ + "B[IT|2~][15mi
Open LI

o pe g 8p22 ‘v[:JZBtELOE% Choose File -> Open -> Open Desktop
Chart = b ' to manage existing Desktop windows

& Backup : |

&t Restore : | I
Disconnect i * - i
Shutdown ; I B

L J'

When you close a Desktop (by clicking on the ‘X’ button in the top left corner), the group is not deleted
but still exists in the repository. If you want to permanently remove a Desktop, select it in the Manage
Desktops dialog and click the Remove button.

"
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Manage Desktops Dialog

l Manage Desktops x

The list below contains all of the available Deskiops that you have created. Select a row and

press Remove to permanently remove a Desktop. Rename allows you to change the name of
the selected Desktop.

Select a Desktop and use the
buttons below to open, copy rename
or delete the Desktop window.

A

Open | Copy | Rename || Delete | Close

5.1 Changing Desktop Layout

Since a Desktop is essentially another Console window, see the section: Changing the Default Layout for
details on how to configure a custom layout.
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6 Scanner

MotiveWave™ has a built-in scanner for looking for trade setups across a given set of instruments and
bar sizes. There three types of patterns that you can search for:

1. Elliott Wave — Elliott Wave patterns such as Wave 2, 3, 4, 5 and Wave E (in a triangle)
2. Gartley — Harmonic patterns including all XABCD type patterns, AB=CD, 5-0 and Alternate AB=CD
3. Study Conditions — Criteria based on study values

When you first start MotiveWave™ you will see a page at the bottom of the window named Scan. Click
on the page tab to show the screen below.

Scan Page
~ MotiveWave - Console (google) o3
File Edit View Study Strategy Format Configure Window  Help
ORCL ~| O | B B e~ 6 W w~rQ v +[®=IT]&~]15min - L W8N O mD PR
& --Choose Scan- x | + = WE «” ||l —Choose Scan— x | + = WE b
—Choose Scan— = /\ —Choose Scan—  ~
sy ‘pol Bar Size Scan Time A Barlindex Click here to Symbol Bar Size Scan Time This button links the ore *

create a new scan. results produced in this
panel with the active
chart at the bottom.

Alternatively, choose

--New Scan-- from
the drop down

Ll ORCL 15m x | + [E
ORCL -15 mi | I 540740
Volume i li+ Llu +i. Il " * 40.35
‘ +¢ Hii (!
Lo »:, '“* i *!| ‘J'*‘*I ' ll“ i 40 20
Tl . ! This chart may b d to ** i 7
4 Y be usel * '
l display a result from one of J" * “ I. l““l lf"* L1 a0
bl L i ! ,
h i. * i I the scanners above. ! i! U0
L Jerut
l 3 "l gl |
i* |H+ | . .‘ L ii+ |
! “ ﬁ | J3a80
i ‘ ‘
ﬁﬂhﬁ.ll.n dn‘ i pealliallantas |II ||1I Click on Scan Page il gt ,.n.nll btminnns e re gl anassanpninnesy L — p -||I T TP . 7903
14:00 Jan-31 12:00 Feb- 201? 12:00 14 00 Feb-03 12:00 14 00 Feb-06 12 00 14 00 Feb-07 12 00 14 00 Feb 08 12:00 14:00 16:00 1800
1min 5min  10min [15min = 20 min aMn 45min  1hour 2hour 6hour 1day 1week 2week 1month 3 month =S v @ |¢v A
il Home bl Charis 8 Account  [2d Scan X f}j Optimize News  + i N O

Feb-08 15:09:11

6.1 Creating a Scan (Gartley Scanner)

If you would like to create a new scan, choose —New Scan—from the —Choose Scan—drop down or
press the New Scan button on the right hand tool bar of the scanner panel. This will open a wizard that
will guide you through the process of creating a scan.

New Scan
&+ —Choose Scan— X | + i I IC e
—-New Scan-- - ] /\_
--Choose Scan-- Bar Size Scan Time A Bar Ind{ Or, press re *

this button
Select -New Scan--

from the drop down.

The screen shot below shows the first page of the scanner wizard. Enter a name for the scan and select
the type of scanner from the drop down below. In this example, we will choose Gartley as the type.
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Scanner Wizard Page 1

New Scanner

New Scanner

This Wizard will enable you create a scannner to scan for specific patterns or conditions across a number of different
instruments

1. Specify Name and Type of Scan
2. Specify Instruments to Scan
3. Specify Criteria

Click 'Next' to continue.

r
Name: = Gartley XABCD Patterns Enter a name for
Tvee: - the scanner.

Elliott Wave

Gartley A Select the type from
Study the drop down

Press the Next
button to continue

to the next page

MNext = Cancel

On the next page of the wizard, you will be prompted to select 1 or more instruments and/or watch lists.
If a watch list is chosen, all of the instruments that are in the watch lists will be included in the scan. The
order of the instruments and watch lists will be considered when the scan is executing.

Scanner Wizard - Instruments
Scan for Gartley Patterns

Specify Instruments

Add instruments below by clicking on the "Add' (+ sign) or 'Search’ (magnifying glass) buttons below. Alternatively you can
add a WatchList by clicking on the 'Add Watch List' button. MotiveWave will scan the instruments in the order specified
below. Use the Up and Down arrows to adjust the order.

-Choose Symbol- QB =
NY’
NASDAQ Optionally add watch
Use this control to add ,I;;g;u(:es lists to the scan list
specific instruments. Top 50 Stocks
Key Stocks

The next button will
activate when 1 or more
instruments/watch lists
are added.

Total Instruments: 0

< Back Cancel

Click on the Add button to add a bar size to the list box. Any size linear bar or non-linear bar (ie Range,

Renko, etc) may be added. Check the Extended Data box at the bottom of the dialog to use data that is
outside of regular trading hours.
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Scanner Wizard — Bar Sizes
[ Scan for Gartley Patterns x
Specify Bar Sizes

Add/Remove bar sizes below by clicking on the Add (green '+') or Remove (red 'X") buttons below. MotiveWave will scan the
instruments (see previous panel) using each bar size in the order specified below. Use the Up and Down arrows to adjust
the order.

=+
A

Click here to add a
bar size to the list.

+ Add Bar Size X

Select the type of bar size and parameters below.

Bar Size: | Linear h
You can choose any
bar size, even Range,
Interval: 15 3 Renko etc

Cancel

Interval Type: | Minute

Next button will be
activated when 1 or more
bar sizes are added.

if this is checked, data
outside of regular trading

hours will be included. \/

Extended Data

< Back Cancel

The final page of the Gartley scanner wizard enables you to choose the type of Gartley pattern to search
for as well as the historical data range where the pattern may occur. If you would like to search for all
forms of the XABCD pattern (ie Gartley, Bat, Butterfly, Shark, etc) then choose XABCD (All) as the
pattern.

Scanner Wizard — Gartley Pattern
it Scan for Gartley Patterns X
Specify Criteria

Select your scanning criteria below. The Pattern determines the type of Gartley pattern that you would like to find. For
example, Butterfly will search for Butterfly Pattern that is nearly complete

Minimum and Maximum bars may be used to help constrain the timeframe.

Pattern: = XABCD (All) - Choose the Gartley Pattern
- ) from the drop down.
Minimum Bars:

Maximum Bars: Use All Available Data

Min/Max bars may be used to define
the historical range where the pattern
may be identified. All available data
will use all of the data that is currently
available in the local database.

Finish button will
create the scan and
make it available in

the drop down.

6.2 Executing a Scan

The following screen shot shows the new scan ‘Gartley XABCD Patterns’ that we created above and the
results from running executing it on the latest available data. If you would like to execute this scan,
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select it from the drop down and press the Start button (see below in the upper left scanner panel). The
progress bar will show how far the scan is progressing (see upper right scanner panel below).

Results will display in the table area of the scanner panel as they are found. This table will display:

1. Symbol —instrument where the pattern was found

2. Bar Size — Bar Size the pattern was found on

3. Scan Time — When the pattern was found

4. Pattern — The specific pattern that was found

5. Score — Score rating: Fair, Good, Very Good, Excellent

To display a scan result in the chart panel below left mouse click on the table row. Note: this will only
work if the Link button is selected (see top right button area for the scanner panel below)

The results displayed in the scanner table are unnamed analyses that are kept in computer memory. If
not explicitly saved, these analyses will disappear the next time you execute the scan or if MotiveWave™
is restarted. When one of these results is opened in a chart window or panel, you may save the analysis
to the repository by clicking on the Save button (see tool bar).

You may find that the full pattern that was found is not entirely visible when you display it in the chart.
Click and drag the time axis to the right to zoom out or select a higher bar size.

Scanner Results

[3.] "]

& MotiveWave - Console (google) Ky - A X
File Edit View Study Strategy Format Configure Window Help
cosT Yl N O Welwr @ 0+ + [T~ 15min - Progress Indicator LA 2N EoReR « )
|i Gartley XABCD Patterns x | + 2 B T~ .|[lit Gartley XABCD Pattems x | + \/ IO
V
Gartley XABCD Patterns  ~ || Start /\ | Gartley XABCD Patterns ~ || Restart | [N Scan Comple\»;Link P
Scan Time & Pattern Click here to edit Symbol Bar Size Scan Time & Pattern Hu:n'!—]

the selected scan. DU 15 min 15:34:01 Bat Good l

BIDU 15 min 15:34:01 Alteratp-—a Very Good

BIDU 15 min 15:34.01 Crab ery Good
atiny

BIDU 15 min 15:34:01 Shark & Excellent

CosT 15 min 15:34:03 Shark Excellent

FSLR 45 min 15:34.06 Bat
FSLR Selecting a row in the results will 15:34:06 Alternaty SPecific
FSLR show the pattern in the chart panel 153406 Crab Pattern found

below (provided the link button is

New scan is now Click the Start button to

available in the begin search for patterns
that match the criteria.

E2iD AR2ANE Shark Eair

[l COST 15m* % | T enabled above) B .
: T =
: L
X 113KA}== — == = 18848
By default the analyses are in f\f i ,mlln-muﬂT '@;E‘élpm gt 16831
memory. If you would like to ‘TT* J'*“'I"T"*'T. i .1* 58 U0
save this specific analysis for T" W 167.50
later use, click the Lt
Save button on the tool bar. A 186.00
T
i
b 164.00
.~ T |
. i
R | ul |}
o B
i ! e J162.00
W
e : ; s s : : s . : s s . s s s :
14:00 Jan-31 12:00 Feb-2017 12:00 14:00 Feb-02 12:00 14:00 Feb-03 12:00 14:00 Feb-06 12:00 14:00 Feb-07 12:00 14:00 Feb-08 12:00 14:00 Feb-09 12:00
imin Smin 10min 15min  20min  30min 45min 1hour 2hour Ghour 1day 1week 2week 1month 3 month = v @ |0~ 2
il Home  Lil Charts 8 Account [ Sean % {lf Optimize News  + LK

Feb-08 15:40:55

6.3 Editing a Scan

You can edit a scan to change its instruments, bar sizes or criteria. Select the scan from the drop down
in the scanner panel and click the Edit button from the button area in the top right corner of the panel.
Alternatively, click on the Manage Scans button to open the Manage Scans dialog.
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Edit Scan
it Gartley XABCD Pattems x | + = B
Gartley XABCD Pattemns ~ ~ || Start AD(
Symbol Bar Size Scan Time 4 Pattern

Select the scan from the drop
down and click the Edit button.

Manage
Scans button

MotiveWave

NSRRI T T
et L LT L

Analyze. Trade. Evolve

The Manage Scans dialog enables you to create, open, edit, rename or remove existing scans. Select a
scan from the list area and use the buttons on the tool bar to open, edit or delete existing scans.

Manage Scans Dialog

i Manage Scans
The list below contains all of the available

and press Remove to permanent]
name of the selected scan.

these buttons to

Click here to
create a new scan

Select Scan and use

. open, edit or delete

ou have created. Select a row
allows you to change the

Close

Edit Scan Dialog

Edit Scan: Gartley XABCD Patterns

Optionally, change the name of the scan below.

m Instruments Bar Sizes Criteria I4— Adjust other properties
J from these tabs.

Name: [barlley XABCD Patterns <L—' o

ptionally change
Type: -

l the name here

Click the OK button

when you are finished.

OK || Apply | cancel
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6.4 Elliott Wave Scanner

The example shown above is for the Gartley scanner. You can also search for Elliott Wave patterns by

choosing Elliott Wave as the type when you create a new scan. Selecting instruments and bar sizes is
the same for all scan types.

New Elliott Wave Scan — Page 1
[ New Scanner x
New Scanner

This Wizard will enable you create a scannner to scan for specific patterns or conditions across a number of different
instruments.

1. Specify Name and Type of Scan

2. Specify Instruments to Scan

3. Specify Criteria
Click 'Next' to continue

Name: [ Elliott Wave 3 \

Type: Ellioit Wave

Choose Elliott
Wave as the type

Next = Cancel

On the Specify Criteria page you can choose the Elliott Wave pattern that you are searching for. The
following patterns are currently supported:

1. Wave 2 — This will search for an Elliott Wave pattern when the top level wave is currently in a
Wave 2. Wave 2s are commonly used as trading setups since wave 3 tends to be the longest
wave.

Wave 3 - Finds patterns where the top level wave is currently in wave 3

Wave 4 - Finds patterns where the top level wave is currently in wave 4

Wave 5 - Find patterns where the top level wave is currently in wave 5

Wave E (Triangle) — Finds patterns where the top level wave is in wave E of a triangle

vk wnN

The Decompose Levels specify how many levels down the top level wave should be decomposed in to
smaller waves. Choose Decompose All to decompose the wave to all possible levels.

The Minimum and Maximum bar settings can be used to define the historical data range. If you check
Use All Available Data MotiveWave™ will load all data from the local database.
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Elliott Wave Scan Criteria
[ Scan for Elliott Wave Patterns X
Specify Criteria

Select your scanning criteria below. The Pattern determines the high level wave pattern that you would like to find. For
example, Wave 2 will search for a top level Impulse Wave that is currently in Wave 2.

Minimum and Maximum bars may be used to help constrain the degree of the top level wave. Optionally, the results may be
decomposed to 1 or more levels.

Patten: | Wave 2 - Select the type of pattern
. 3 from this drop down
Minimum Bars:

Maximum Bars: Use All Available Data
Decompose Levels: Decompose All

< Back Cancel

The following screen shot shows the results of searching for a Wave 2 pattern. To view a particular
result, click on the row in the results table. You may need to zoom the chart out to see the full pattern
depending on how much data you specified in the scan criteria.

Elliott Wave 2 Search Results

~ MotiveWave - Console (google) B = F =3
File Edit View Study Strategy Format Configure  Window  Help
acom  ~|O | B H s~ @D CIK B e @ i~ + T[T 2~|1day x I L meNXEGmMOER
it Elliott Wave 2 % | + = K I© 7| [l ~Choose Scan— x | + il W 2
Elliott Wave 2 ~ || Restart | I Scan Complete —Choose Scan— | Sitart
Symbol Bar Size Scan Time 4 Pattern Score * Symbol Bar Size Scan Time a4  Barlndex Score *
FSLR 15 min 17:10:08 Wave 2 Fair '
FSLR 15 min 17:10:08 Wave 2 Good
17:10:24 Wave 2 Good
SBUX 15 min 17:10:25 Wawva 2 Fair
SBUX 1 day 17:10:27 Wave 2 Fair
TXN 15 min 171043 Click on a row to show
Ll QCOM 1D* X ‘ + the pattern below. B
T
QCOM -1 day W) |
5 | 1
( ) (B) i 75.00
3 4 C |
A | 2
3) | l 2 @ & * ; & H70.00
, ® b5 W, © g 'ﬁ“l el A M @95
& @fe) ) 1 TT*-TT ® i 'lfﬂf“&l})‘ﬂ J65.00
4, *. LA
*l”‘ Pl auhyh *'l' “!P- 4 @ 4 3 ¢ 1
a
Iy s 7y ! rJs0.00
) ! ! 4
I
.p"'r‘" i 4 '—. This is the top level 1155.00
J | @ Thystrn wave 2 that we were 5289'
I ~ X
! D searching for. 150,00
w 3
I
MotiveWave ! H
Aug-2016 Sep-2016 Oct-2016 Nov-2016 Dec-2016 Jan-2017 Feb-2017 Mar-2017 Apr-2017 May-2017
imin Smin 10min 15min  20min  30min  45min  1hour 2hour 6&hour 1day 1week 2week 1month 3 month = v @ |4v B
Ll Home bl Charts 8 Account [t Scan % 1l Optimize News  + (LT

Feb-08 17:12:51
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6.5 Study Scanner

The study scanner enables you to search for study conditions that include 1 or more studies. When you
create a new scan, choose Study as the type from the Type drop down. Selecting instruments and bar
sizes is the same for all scan types (see Creating a Scan (Gartley Scanner) section for details).

Study Scanner — Page 1
[ New Scanner X
New Scanner

This Wizard will enable you create a scannner to scan for specific patterns or conditions across a number of different
instruments.

1. Specify Name and Type of Scan

2. Specify Instruments to Scan

3. Specify Criteria
Click 'Next' to continue

Name: [ Trade Setup |

Type: | Study - Choose Study
as the type.

Next = Cancel

On the Choose Studies panel, you can select one or more studies to include as part of the scan. Click on

the add study button to add a study to the list box below. When you click this button, you will be able

to search for the study that you want to add and configure its settings (see following screen shots).
Choose Studies Panel

Lt Scan for Study Conditions X

Choose Studies

Specify the studies (and their settings) that you want to include in this scan.

Minimum Bars:
+

Click here to add and

configure a study for
the scanner

< Back Cancel
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Add Study Dialog

Py,

MotiveWave

[ Add Study

The following table contains all available studies. Select the desired study below and choose OK to configure the settings.

Filter: | RSI Type the study name Type: Al -

to filter the list L R Overlay signal =
Fast&Slow RSI false true
Laguerre RSI false false
RSI Bars true true

RS Divergence

false

Relative Strength Index (RSI)
Reversing MACD
Stochastic RSI

Select the study and click

OK below to configure its
parameters

OK || Import | Cancel
Configure Study
Relative Strength Index (RSI) X
RSl is a momentum oscillator that measures the velocity and magnitude of directional price movement
by comparing upward and downward movements. Developed by J Welles Wilder in 1978.
Advanced
Inputs
Input: | Close -
Method: | SMMA  ~
Period (bars): 14 &
Lines
Rsitine: I ~- —10~ | — ~
Top Fil: | Sgegeomees - ||/ Display
Bottom Fill: = Sgegegeees - ||/ Display
RS Indicator: ~ || I - Line v Display
Update Cancel

In the screen shot below, we have added one study to the scan, RSI(C,14). Additional studies could be
added by clicking the add button. In this example, we are just going to work with one study.
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Choose Studies
Specify the studies (and their settings) that you want to include in this scan.

Minimum Bars:
+
RSI(C.14)

Scan for Study Conditions

This is the minimum
number of bars to

load when evaluating
the studies

This the RSI
study just added

< Back

Next >

Cancel

The last page of the scanner wizard asks you to define the criteria for evaluating the scan. Click on the
add condition button to add a condition to the list. There are two types of evaluation methods:

1. All—-In this method, all conditions defined on this page must be met in order for it to be
considered a match. This is the default evaluation method.
2. One or More — In this method, only one of the conditions defined on this page must be met for it
to be considered a match for this scan
3. Lookback Bars — Number of bars to look back and evaluate the study criteria. 0 indicates the
most current bar.

Study Criteria
2 Scan for Study Conditions b
Study Criteria
Specify scanning criteria based on the studies entered in the previous panel.
Eval Method: | All ~ | Lookback Bars Number of bars to look back
when evaluating. '0" will
+ just look at the latest bar.
]
Click here to add a Two options -h.ere:
. All - all conditions must be met
condition based on
. ) One or More - only one of the
the studies defined on .
. study conditions need to be met
the previous page.
—
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In the Study Condition dialog (see below) you can define a condition based on a variable that is
generated from one of the studies you defined. A variable may be compared against a specific value or
compared against another variable. The fields in this dialog are as follows:

1.
2.

Study — Choose the study that you configured on the Choose Studies page

Bar Index — In most cases the comparison is done with the current bar, but you may choose
historical bars by choosing a specific index

Variable — This field will be populated when you choose the study. Each study will export 1 or
more variables. You can see these variables in the Cursor Data Window/Panel

Operator — This is the comparison operator for comparing the variable to the value. Valid
options include: > (greater than), >=, < (less than), <=, =, Crosses, Crosses Above, Crosses
Below

Relative Comparison — Indicates if the variable should be compared against a specific value or
against another variable.

Value - If not a relative comparison, this field will contain the specific value you are comparing
against.

Add Study Condition Dialog
[ Study Condition X

This dialog allows you to specify a condition to evaluate as part of the
scan.

Study: | RSI(C,14) ~ Choose the study

Bar Index: v/| Use Current Bar

Variable: | RSl These are output
variables generated
by the study

Relative Comparisorr

Operator: | =

Add || Cancel

If you checked the Relative Comparison option, the dialog will change to allow you to choose a study and
variable for comparison. The Price Bar option allows you to compare to the Open/High/Low/Close
values of the price bar. In the example below, two EMAs were added to the studies list and its
comparing the EMA(C,20) value to the EMA(C,50) value to see if the first value is above the second.

Add Study Condition Dialog — Relative Comparison
[zt Study Condition b4

This dialog allows you to specify a condition to evaluate as part of the
scarn.

Study: | EMA(C,20) ~
Bar Index: v'| Use Current Bar
Variable: | EMA b
Operator: | = -
/| Relative Comparison

Study: | EMA(C,50) ~

Bar Index: v/| Use Current Bar
variable: | EMA -
Add || Cancel

The screen shot below shows the results of running this scan. In this case we only found one result
where the RSl value is greater than 80.
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/A  MotiveWave

Study Scanner Results

~ MotiveWave - Console (google) e o o
File Edit View Study Strategy Format Configure Window  Help
acoM |~ Q| E @ B &~ 6§l K Elw~Q 0~ +[FWIT 2~ [15mn ~ | 4G N EmD SN
Trade Setup x]+ =l ChooseScan—x]+ =i 2
Trade Setup ~ Restart [ Scan Complete —Choose Scan—- « | Siart
Symbol Bar Size Scan Time A Bar Index Score * Symbol Bar Size Scan Time a Bar Index Score o

u.
'ulll
Motiveviave

Ll JCP 15m* x | + \
JCP 15 min ! ' ‘
EMA(C.20) EMA(C.50) ! In this case we found 1 result
I where the RSl value is above 80
i
| ™
I
i iI|!*r|,r'l'| I I
; i ; i
| " LT 1 h e L
1

\

14:00 Jan-31 12:00 Feb-2017 12:00 14:00 Feb-02 12:00 14:00 Feb-03 1200 14:00 Feb-06 12:00 14:00 Feb-07 1200 14:00 Feb-08 12:00 14:00 Feb-09

RSI(C,14) | 84.1
:\/\,_,v—-\,-/\ /—\_IFH\ A 20°00)
i
|

imin 5min  10min  15min  20min 30min 45min 1hour 2hour 6&hour 1day 1week 2week 1month 3 month

il Home  Lbl Charts .8 Account [t Scan x {lf Optimze 5 News  +

=928 Y

8 &
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7 Strategy Back Testing

Strategy back testing is a special type of historical testing that allows you to determine how a strategy
would have performed if it had actually been run during past historical time periods and market
conditions. It does not guarantee how your strategy will perform in future market conditions, but will
allow you to identify any potential issues or vulnerabilities against past market conditions. This allows
you to ‘test’ and tweak your strategy without having to place actual trades. See the Wikipedia page on
strategy back testing for more information.

MotiveWave™ has highly advanced strategy back testing options through our Strategy Optimizer. The
default layout of the MotiveWave™ Console has a page called Optimize (see bottom of the console
window). Click this tab to show the strategy optimizer page.

Optimizer Page - Console

v MotiveWave - Console (google) I

File view Configure Window Help
i} Untitied | + |

Symbol Parameters Start End Net Profit Gross Profit Gross Loss Executions Commissions ax Drawdown +
Click here to create a
new strategy analysis

[T chat Repoits Periods Trades Executions

Metric All Trades Long Trades Short Trades +

No content in table

This is the Optimize page
that comes with the default
layout of the Console

lul Home  Lul Charts (8 Account  [& Scan [} Optimize x =\ News  + L]
Feb-09 9:33:26

7.1 Creating a Strategy Analysis

From the Optimize tab of the Console, click on the New Analysis button (see screen shot above). This
will launch a wizard that will walk you through the process of creating an analysis of your selected
strategy.

MotiveWave supports 3 types of Strategy Analysis:

1. Back Test - This option enables you to execute your strategy with specific settings over a given
set of instruments and a specific bar size/time frame. This can be useful to determine how your
strategy may have performed with past data and specific settings.

2. Optimize - The profitability of a strategy will vary depending on how it is configured. This option
will enable you to specify a range of settings for the strategy and test many different
combinations of these settings to determine which combination is "optimal".
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3. Walk Forward - Sometimes knowing the optimal settings for a specific range of data is not
enough. Just because a strategy performed well for a specific bar size and time frame does not
guarantee that it will continue to perform well in the future. Walk forward testing helps to
mitigate this problem by stepping forward in time after every iteration of a time frame.

The following screen shot shows the first panel of the New Strategy Analysis wizard. From here you can

choose your strategy and specify the type of analysis you wish to perform.

New Strategy Analysis — Page 1

strategy over the given range of data
Walk Forward - Optimize strategy and move
the data range forward after every iteration.

i New Strategy Analysis
New Strategy Analysis
This Wizard will enable you to create and configure a new Strategy Analysis to optimize a strategy across 1 or more
instruments.
1. Choose Strategy
2. Specify Instruments Click here to choose
3. Specify Criteria your strategy
Click 'Next' to continue.
r
Strategy: Choose Strategy
Type: | Back Test N
Back Test 3 Back Test - Run the strategy with specific
Optimize settings over the given range of data.
Walk Forward Optimize - Run several combinations of the

Cancel

7.1.1 Strategy Settings Panel

Once you have chosen the strategy and analysis type, click on the Next button to specify the settings for
the strategy. If you chose Back Test, then you will just need to specify the specific settings for this

strategy (see below). In this case we have chosen the "MA Cross Strategy":
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MA Cross Strategy Settings
bt Strategy Settings (MA Cross Strategy) X
MA Cross Strategy

The strategy is based off the Moving Average Cross study. Trades occur when the fast moving average crosses the slow
moving average.

Trading Options

Fastinput Close -

Fast Method | EMA -

Fast Period 10 %
Slow Input | Close - Bal:kl'l.'est - These settings are
specific to the strategy that you chose
Slow Method | EMA - on the previous panel. In this case
. = we just need to choose what we want
AEIFEEL for the MA Cross Strategy

< Back Gancel

Alternatively, if you chose Optimize or Walk Forward as the type, the next page of the wizard will look
more like the following screen shot. This panel will enable you to specify the range of possibilities for the
configuration of the strategy. MotiveWave™ will build combinations of the strategy settings based on
this input.

Optimize/Walk Forward Strategy Settings

it Strategy Settings (MA Cross Strategy) x
MA Cross Strategy
The strategy is based off the Moving Average Cross study. Trades occur when the fast moving average crosses the slow
moving average.
Trading Options
FastInput | open l
Hold Ctrl (Cmd on OSX)
Midpoint to select multiple options
High
Low
Fast Method SMA
EMA l
SMMA Use this panel to define the range
MEMA of parameters to use for this
WMA study. MotiveWave will generate
Fast Period Min- | 10 ¢| Max: | 10 ¢| Step: | 1 ¢| combinations based on this input.
Slow Input | open l
Midpoint
High
Low
Slow Method SMA
EMA l
< Back cancel
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7.1.2 Choose Instruments Panel

The next page of the wizard allows you to choose the set of instruments (symbols) for the analysis. A
specific set of instruments may be chosen by clicking on the Add Instrument button or the Search
Instrument button. Additionally, you may specify one or more watch lists to specify a group of

instruments.

Choose Instruments Page

i Strategy Settings (MA Cross Strategy)
Instruments
Add instruments below by typing the symbol in the search box or by clicking the 'Search’ (magnifying glass) button below.

Alternatively you can add a WatchList by choosing one from the Waich List drop down. MotiveWave will backiest the
strategy on the instruments in the order specified below. Use the Up and Down arrows to adjust the order.

-Choose Symbol- , ~ QO B =~
= NYSE NYSE
NASDAQ

Indices % Optionally select a watch
ASX list from the drop down
Top 50 Stocks

Type a symbol in here Key Stocks
and press Enter to
add it to the list.

This panel allows you to choose 1
or more instruments for the
analysis. Optionally, you may
choose one or more watch lists
that contain a set of instruments.

Total Instruments: 57

< Back Next = Cancel

7.1.3 Data Settings Panel

If you choose Back Test or Optimize as the analysis type, then your data settings panel will look like the
following. This panel allows you to choose the range of data and bar size for the analysis. Ideally you
should use historical tick data (see Source Data field) for the analysis since will give the closest
approximation of a real world test. Unfortunately not all brokers or data services provide this data (or
enough of it). In these cases you can generate ticks from either the source data or 1 minute bars.
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Data Settings
] Strategy Settings (MA Cross Strategy) X

Data Settings

The settings below allow you to specify the time frame and bar size for analysis. If historical tick data is not available, you
can generate tick data from the source bars.

Bar Size: | 1 day - Select the bar size
Start Date: |11/8/2016 B Choose the date range
End Dale: |2/82017  |E@ for this analysis.

¥ ‘gular Trading Hours (RTH) Data

Source Data: Generate Ticks

Ideally historical tick data
Bar Data - Use the source bar size to should be used (if available).
generate an Open, High, Low and Close ticks Alternatively ticks can be
Minute Data - Load minute data and generated from the historical
generate OHLC ticks from those bar or minute bars

Tick Data - Use historical tick data (if
available from your data service/broker)

< Back Next = Cancel

The walk forward data settings are a little bit different. Two more parameters are available to define the
Optimize Period and Walk Forward Period. Optimize Period defines the size of the optimization
window (the number of days to include in each walk forward iteration). If the Anchor option is enabled,
the Start Date will remain fixed for each iteration. Effectively, this means that the optimize period will
increase by the walk forward period each walk forward iteration (ie: 60, 90, 120 etc days in this
example).

Data Settings — Walk Forward Testing
i Strategy Settings (MA Cross Strategy) X

Data Settings

The settings below allow you to specify the time frame and bar size for analysis. If historical tick data is not available, you
can generate tick data from the source bars.

These are the data settings for Walk
Forward optimization.

Start Date:  11/8/2016 |E Optimize Period - defines the
number of days included in each
walk forward iteration.

Source Data: | Bar Data - Generate Ticks Walk Forward Period - Defines how
many days to move forward in each
iteration.

Bar Size: | 1day >
End Date: | 2/8/2017 BB
Regular Trading Hours (RTH) Data

Optimize Period (Days) Anchor

Walk Forward Period (Days): 30 5

This option will keep the original
start date in each iteration
instead of moving forward by the
walk forward period.

<pack Cancel
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7.1.4 Execution Settings Panel

Execution settings specify the runtime behavior for the analysis. Commissions can be included in the
profit/loss calculation and can be configured from the Console menu bar (Configure -> Commissions).
Slippage can also be enabled to account for market orders. During periods of lower volume market
orders may not be filled at the current bid/ask prices. This parameter assumes that the order will be
filled the given number of ticks away from the bid/ask price.

Execution Settings
i Execution Settings (MA Cross Strategy) x

Execution Settings

The options below allow you to specify order and account settings when the strategy is optimized.

Initial Account Value: 100000 &

Include Commission:

Fill On Bid Ask: This panel is used to specify the account

Slippage (Ticks): and execution settings. Optionally,

commissions may be included.

Slippage enables you to account for
market orders that are not always filled at
the bid/ask price. This can enable you to
get more realistic results.

< Back cancel

7.1.5 Optimizer Settings Panel

If you chose Optimize or Walk Forward as the analysis type, then you will see the Optimizer
Settings panel as the last panel in the wizard. MotiveWave currently supports two types of optimizer
algorithms:

1. Exhaustive - this algorithm will evaluate all combinations of the strategy settings to find the
optimal result. This algorithm will find the optimal settings for the strategy. This is a good option
if the number of combinations is relatively low.

2. Genetic - employs a natural selection approach to find an optimal combination without having
to evaluate all possible combinations of the strategy settings. For more details on how this works
see Wikipedia: Genetic Algorithm.

7.1.5.1 Exhaustive Optimization vs. Genetic Optimization

There are many types of optimization. The most common types used for strategy optimization are
Exhaustive Optimization and Genetic Optimization. Both types of optimization have benefits. It’s just a
matter of figuring out which type of optimization is most appropriate for the results you’re looking for.
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7.1.5.2 Exhaustive Optimization

Exhaustive Optimization will run through and test every possible combination of inputs to determine the
absolute best possible performance solution. But, because it will run through every possible
combination, running an exhaustive optimization can take a very long time. The time required to run an
exhaustive optimization is dramatically increased when a large number of inputs or parameters are used
in the search.

To reduce the amount of time required to run the exhaustive optimization, you can limit the number of
inputs or parameters used to a small number, or use genetic optimization instead.

7.1.5.3 Genetic Optimization

Genetic Optimization (or Genetic Algorithm Optimization) is based on the concept of biological
evolution, or natural selection. In relation to trading strategy optimization, genetic optimization will start
by randomly selecting a number of combinations to test. From those selected, it will determine which of
those combinations have the best potential and discard the rest. Then it will continue to test the
remaining ‘best potential’ combination candidates until it arrives at the close-to-best input or parameter
performance solution.

Because genetic optimization does not test every possible combination, it will not arrive at the absolute
best possible performance solution, like with exhaustive optimization, but the time it takes to arrive at a
close-to-absolute best performance solution is dramatically shorter.

Genetic Optimization is best suited for running an optimization with many inputs or parameters. The
larger the sample size is, the longer it will take to complete the optimization, but if the sample size is too
small, the genetic optimization results may be less accurate.

Optimizer Settings
i Optimizer Settings X
Optimizer Settings
The options below allow you to configure how the optimizer behaves

IMax Results:

Optimize Metric: | Net Profit -

Optimizer Algorithm: | Exhaustive N This panel is applicable to Optimize and

Exhaustive Walk Forward Testing types.

Genetic Exhaustive will evaluate all possible

combinations of the strategy settings.

Genetic optimization applies a genetic
algorithm to find an optimal combination
(without evaluating all possible
combinations).

< Back Finish Cancel
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7.2 Strategy Analysis

Once you have created and executed a strategy analysis, you can look at the results in the strategy
optimizer (see below). The analysis will contain one or more execution instances in the summary table at
the top of the window. Select the instance that you want to view and it will be displayed in the panel
below the table.

Strategy Analysis Metrics
'~ MotiveWave - Console (google)

KA
"$
1
3
1
X

File View Configure i

11 Untitied* When you save the analysis, Es =5
you can specify a name.
Walk Forward /\_

Symbol Parameters start End Net Profit Gross Profit Gross Loss E ions Commission 5:'“" hglre tosave L
D — e analysis.
AXP C.EMA 16,C,EMA 20 (Fast Input F Mar/03/14 Mar/03/15 8 2 og
AXP C.EMA 14,C,EMA 20 {Fast Input F Apr/02/14 Apri02/15 ‘ 52 (52 10 $0.00 $195.0

T $0.00 $540
$0.00 $62.0

AXP C.EMA 12 C,EMA 24 (Fast Input,F May/02/14
C.EMA 10,C,EMA 26 (Fast Input F Jun/01/14
C.EMA 14,C.EMA 20 (Fast Input F Jul/01/14
AXP C.EMA 16,C EMA 22 (Fast Input,F Jul/31/14

mcnan Reports Periods Trades (11) Executions (12)
Date Jul/01/14

U Select an execution
8l instance from the table to
JJ see the details below.

Strategy MA Cross Strategy
Type Walk Forward
Symbol AXP
Bar Size 1day

These tabs show

[EMA.20 (Fast Input, Fast Method, Fast Period, Slow Input, Slow Method,Slow Period)
different information

about the analysis.

Metril:—J All Trades Long Trades Short Trades +*
Total Net Profit (Inc Commissions) $1,319.00 ($120.00) $1,449.00
Total Profit (Gross - Loss) $1,319.00 ($120.00) $1,449.00
Gross Profit $1,851.00 $285.00 $1,566.00
Gross Loss ($532.00) ($415.00) ($117.00)
Commission $0.00 $0.00 $0.00
Profit Factor 3.479 0.687 13.385
Max. Drawdown $337.00 $277.00 $60.00
Max Drawdown (%) 0.33% 0.28% 0.06%
Total # Trades 1 5 6
Percent Profitable 36.36% 20.00% 50.00%
# Winning Trades 4 1 3
P — = 1 2
Ll Home il Charts 8 Account |2 Scan  flf Optimize x =y News  + m N

Feb-09 10:53:15

The following screen shot shows an example of the Chart tab of the strategy analysis. This tab displays a
visual representation of the executed trades that occurred for the selected execution instance.
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Strategy Analysis Chart
~ MotiveWave - Console (google) M o O
File View Configure Window Help

i Uniitied| + T
Walk Forward

Symbol Parameters Start End Net Profit Gross Profit Gross Loss { c issi Max Drawdown *
AXP C,EMA,12,C,EMA 24 (Fast Input F May/02/14 May/02/15 7 $0.00 s5400
C EMA,10,C.EMA 26 (Fast Input F Jun/01/14 Jun/o1/15 7 $0.00 $620

C.EMA,14,C,EMA,20 (Fast Input,F Jul/01/14 Julioii15 2 $0.00

5 $0.00 $226.0

AXP C.EMA,16,C,EMA,22 (Fast Input F Jul’31/14 Julizis
AWIDY A A ot lnn Avimi0n0 A 7 [ JaWatal £4 NN3 00
Metrics Reports Periods Trades (11) Executions (12)
AXP -1 day ‘ ’
] *"h”"h Q’ This chart shows a visual ! H95.00
representation of the trades !
ion of th d
that occurred during the | End time F‘
1]" execution of this iteration.
~90.00
| N
: \'f‘\.-
! | T
! :Iﬁk‘\ i el Hes.00
I A | .,
1 .,
|| Hover over trade | Tl |
! to see details Teagih "l‘l. - Jlj by I'lril”
, ) li § '] Entry Time: Jan-08 04-0 | 180.00
Start time for ! ll'rl i Sell 100@91.44 | R
. . I Exit Time: May-14 04:00 8
the iteration ! f Buy 100@80.34 m' h R ‘
1 ! PIL: 1,110.00 " | ‘
: ! Pips: 1110.0 ﬁ 1'75—00
H 1 Cumulative P/IL: 1,611.01
| 1 Cum. Net PiL: 1,611.00
i i Max Price: 91.61
N | ' Min Price: 76.53 I
ki T T g T Tl sy I 1 2
Jun-2014 Jul-2014 Aug-2014 Sep-2014 Qct-2014 Nov-2014  Dec-2014 Jan-2015 Feb-2015  Mar-2015 Apr-2015 May-2015  Jun-2015 Jul-2015 Aug-2015

1mn 5min 10min 15min 20min  30min 45min  1hour 2Zhour Ghour 1day 1week 2week 1month 3 month = v @ [+~ B
Ll Home Ll Charts .8 Account ilf Optimize % =\ News  +

Several visual reports are available under the Reports tab. The available report types can be found in the
Report dropdown.

Strategy Analysis Reports
~ MotiveWave - Console (google) ey - e X
File View Configure Window Help

ij untitied*| + o o
Walk Forward

Symbol Parameters Start End Net Profit Gross Profit Gross Loss E { Ce ission: Max Drawdowr *

7 $0.00 s5a.00
562.00

C.EMA12,C,EMA24 (Fast In May/02i14  May/02/15
C.EMA10,C.EMA26 (Fast InJun/01/14  Jun/o1/15
C,EMA,14,C,EMA 20 (
AXP C.EMA16,C,EMA2Z (Fast In Jul3114  Jul31/15
AXP C.EMA 16.C.EMA 22 (Fast In Aug/3014 _ Aug/30115
Metrics Chart Periods Trades (11) Executions (12)

Report: | Net Profit ~ | Period: | Day OfWeek  ~ Long/Short | Both  ~ This panel contains various visual
Net Profit reports for the selected execution

instance. Choose the report type |-----—-—----
cumuiaive Pror from the Report drop down.
1,250/ Trades Profiloss kommoomoommodeimeee b

5 $0.00 $226.01
7 $0.00 $1,093.0t

$1.500.

Entry Efficiency
$1.0004 Exit Efficiency
Efiiciency

5750.

$500.00

$250.00 r========== A4

$0.00

($250.00)

($500.00)
Sunday Meonday Tuesday Wednesday Thursday Friday Saturday

il Home Ll Charts .8 Account [t Scan  {if Optimize x =\ News  + m o
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The Periods tab groups trades together based on the selected period (hourly, daily weekly etc). Each

row in this table displays summary information.

Julig1i1s

C.EMA,16,C.EMA.22 (Fast Input, Fa Juli31/14

(%] MotiveWave - Console (google) ey - 2 X
File View Configure Window Help
ili Untited™| + s =
Walk Forward
Symbol F'aramelers Start End Net Profit Gross Profit Gross Loss E 15 c ion Max Drawdown *
AXP C.,EMA,12,C,EMA 24 (Fast Input Fa: May/02/14 May/02/15 7 $0.00 $54 0-.
C.,EMA,10,C,EMA 26 (Fast Input Fa: Jun/01/14 Juni01/15 $62.0

$226.0

C EMA16.C.EMA 22 (Fast Input Fa Aug/30/14 Augi30/15 7 50.00 $1.093.00

Metrics Chart Reports Trades (11) Executions (12)
Period: Long/Short | Both =

Perig 20 Min Interval Gross Profit GrossLoss  #Trades % Winning.. AvgTrade AvgWinni.. AvgLosing.. LargestWi.. LargestLo..  MFE MAE ETD % of Trades |+
Sepgs | HoUr Interval 50.00 1 100.00% 5411.00 50.00 $411.00 50.00 $77600 $5500 536500 9.09%
sep10 D2V OrWeek b 1 0.00% $000  ($130.00) 5000 ($13000) $4300 $16500  $173.00 9.09%
Sep23 Il This repert groups 1 (4 50.00 (545.00) 50.00 (545.00) §12200 $25800  $167.00 9.09%
Sepa4 | eV trades based on the 1 $0.00 ($8.00) 50.00 (58.00) $71.00  $3200  579.00 9.09%
oct30 selected period 1 0.00% 50.00 ($12.00) 50.00 ($12.00)  $1006.00 $52.00 $1,016.00 9.09%
Jan-08 1 100.00% 0 §285.00 50,00 $285.00 0,00 $63000 $65.00  $345.00 9.09%
May-14 1 100.00% §1,110.00 5000 §1,110.00 5000  §1491.00 $37.00  $381.00 9.09%
Jun17 ( 1 0.00% ( $0.00 (70.00) $0.00 ($70.00) $12500 $154.00  $196.00 9.09%
Jun-18 1 0.00% $0.00 ($50.00) $0.00 ($60.00) $1800 $12200  $78.00 9.09%
Jun-30 1 0.00% 1207.00) $000  ($207.00) $000  ($207.00) $168.00 §$25000  $375.00 9.09%
Juk-01 1 100.00% $45.00 $0.00 $45.00 $0.00 $52.00  $24.00 $7.00 9.09%
Il Home Ll Charts .8 Account [& Scan  {lf Optimize X =\ News  +
—

The Trades tab shows all of the trades that occurred. A trade includes the entry into the trade as well as
the exit out of the trade. This allows you to see the profit/loss that occurred with each trade.

(¥ MotiveWave - Console (google) w - u X
File View Configure Window Help
14 Untitied* | + | -
m Walk Forward
Symbol Parameters Start End Net Profit Gross Profit Gross Loss c ion Max D "+
o NI UG Wi - BT INPGGT SN T S > »orou I
AXP C,EMA 16,C,EMA 22 (Fast Input,Fa Aug/30/14 Augl30/15 7 $0.00 s1,002.00
AXP C.EMA 14,C EMA 20 (Fast Input, Fa Sep/29/14 Sep/29/15 9 $0.00 $1,125.0
AXP C.EMA 16,C EMA 22 (Fast Input Fa Oct/29/14 Octi29/15 9 $0.00 $1,741.00
AXP C,EMA 16,C,EMA 26 (Fast Input,Fa Nov/28/14 NOV/28/15 8 50.00 51,450.0
AXP MA 16.C EMA 26 (Fast Inpul Fa Dec/28/14 8 £000 $148001 |
Metrics  Chart Reports Periods Executions (12)
Trade # Sym... Quantitya Entry Price ExitPrice Entry Time  Exit Time PIL Pips Commission Cumulativ... Cum. Com... MAE MFE ETD Bars  *
1 AXP 100 93.51 89.40 Jul-14 4:00:0052p-14 4:00:00 $0.00 $0.00 $5500  §77600  $365.00 3
2 AXP 100 89.40 88.10 iep-14 4:00:00 iep-14 4:00.00 j 30.00) P s2s1.00 $0.00  $165.00 $4300  $173.00 |
3 AXP 100 88.10 88.55 ep-14 4:00:005ep-14 40000 $0.00 $236.00 $0.00 $258.00 $122.00 $167.00 |
4 AXP 100 88.56 88.47 5ep-14 4:00:0052p-14 4:00:00 m $0.00 $0.00 $32.00 $71.00 $79.00
5 AXP 100 88.47 88 59 5ep-14 4.00:00 Jct-14 4.00:00 ( $0.00 0 $0.00 $5200  $100600  $1,01800 2
6 AXP 100 8859 9144 Dct-14 4:00:00 lan-15 4:00:00 $0.00 $0.00 $65.00 $630.00 $345.00 41
7 AXP 100 91.44 £0.00 $37.00  §1,491.00 $381.00 g
8 AXP 100 8034 79 64 fay-15 4:00:00 Jun-15 4:00:00 ( . $0.00 $154.00 $126.00 $196.00 2]
9 AXP 100 79 64 80 24 WN-15 400:00 1115 4:00:00 m $0.00 $0.00 $122.00 $18.00 $78.00
10 AXP 100 80 Tabular view of all the trades in-15 4:00:00 $0.00 $000 525000  $16800  $375.00 i
11 AXP 100 7g (entry and exit) that occurred 1 15 40000 $0.00 $0.00 $24.00 $52.00 $7.00
in this execution
lul Home bl Charts S8 Account [& Scan  {}f Optimize X =\ News  + O
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The Executions tab displays all of the filled orders.

~ MotiveWave - Console (google) e o =
File View Configure Window Help
i Untitied™ | + E= = e
m Walk Forward
Symbol Parameters Start End Net Profit Gross Profit Gross Loss i Co issi Max Drawdown *+

Anr VIR, 10,0, LIVIM,22 (1 3% IHPULT 89Ul 17 15 R " 2u.0u scev
AXP C.EMA 16,C,EMA 22 (Fast Input Fa Augi30/14 Aug/30115 7 $0.00 $1,093.0/
AXP C,EMA 14,C,EMA 20 (Fast Input Fa Sep/29/14 Sepi29115 9 $0.00 $1,125.0
AXP C,EMA,16,C,EMA 22 (Fast Input,Fa Oct/29/14 0Oct/29/15 9 $0.00 $1,741.0
AXP C.EMA 16,C,EMA 26 (Fast Input Fa Novi2&/14 Now/28/15 8 $0.00 $1,480.0
AXP MA16 IMA.26 (Fast Inp aDec/2814 5 8 £0.00 $1.480.00 |

Metrics Chart Reports  Periods Trades (11)

D symbol Time Action Quantity Avg Price Entry Price Type PIL Pips Commission Position *
162035 AXP 22-Jul-14 04:00 SELL 100 9351 93 51 Entry 0.0 $0.00 -100
162036 AXP 08-Sep-14 04:00 BUY 200 89.40 93.51 SAR 4110 $0.00 100
162037 AXP 10-Sep-14 04:00 SELL 200 8810 8940 SAR -130.0 $0.00 -100
162038 AXP 23-Sep-14 04:00 BUY 200 88.55 88.10 SAR -45.0 $0.00 100
162039 AXP 24-Sep-14 04:00 SELL 200 88.47 88.55 SAR 8.0 50.00 -100
162040 AXP 30-Oct-14 04:00 BUY 200 8859 8847 SAR 120 $0.00 100
162041 AXP 08-Jan-15 04:00 SELL 200 91.44 88.59 SAR 285.0 $0.00 100
162042 AXP 14-May-15 04:00 BUY 200 80.34 91.44 SAR 1110.0 $0.00 100
162043 AXP 00 SELL 200 7964 8034 SAR 700 $0.00 -100
162044 AXP Tabular view of all the 00 BUY 200 80.24 79.64 SAR 60.0 $0.00 100
162045 AXP exscutions that occurred oy SELL 200 7817 8024 SAR 2070 $0.00 -100
152046 AXP {executed orders). Do BUY 100 7772 7817 Exit 450 $0.00 0
il Home Ll Charis @ Account (2! Scan  {if Optimize X =) News  + i N O
—

Feb-09 11:18:43
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8 Custom Instruments

MotiveWave™ allows you to create custom instruments that are based on 2 or more existing
instruments. There are 3 types of custom instruments:

1. Spread — Displays the difference between two instruments
2. Ratio — Displays the ratio by dividing the price of one instrument by another
3. Index — Allows you to combine the prices of 2 or more instruments into an index

To create a new custom instrument, choose File -> New -> Custom Instrument from the Console menu
bar:

(Y MotiveWave - Console

File | Edit Wiew Study Strateqy Format Configure  Window  Help

New ' fl New Page & i~ + FEE &2
Open ¥ | = New Watch List
il New Desktop
Chart ¥ | Ll New Chart Window Cirl+N
&1 Backup il New DOM Window
& Restore ) New Time&Sales Window .
Disconnect Custom INstrument Choose File -> New ->
Shutdown Custom Instrument

N

This will open a wizard to guide you through creating a custom instrument. You will need to enter a

unique symbol for the instrument (it cannot match any existing instrument in the workspace). In the
following example we are going to create a custom index (US Dollar Index). The minimum tick value

specifies the minimum amount for each change in the instrument price.

(Y Create Custom Instrument x
Custom Instrument
A custom instrument allows you to combine and display live and historical data from multiple instruments. Enter a unigue

symbol for your instrument and choose from the following types:

1. Spread - Displays the difference between two instruments
2. Ratio - Displays the ratio by dividing the price of one instrument by another
3. Index - Allows you to combine the prices of 2 or more instruments in to a unified index.

Symbol: r US Index Symbol must be unigue
among all instruments
Type: | Index hd in your workspace

Title: | US Dollar Index

Description:

Minimum Tick | 0.01

Next = Cancel
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The US Dollar Index measure the relative value of the US Dollar vs a set of foreign currencies. For more
information see the definition on Wikipedia: https://en.wikipedia.org/wiki/U.S._Dollar_Index. In this
case we need to include 6 different currency pairs and use the exponent option to assign a weight to
each one (Note: EUR/USD and GBP/USD need to be inverted):

1.

ukhwnN

6.

EUR/USD - 57.6% weight (inverted) (Euro dollar)
USD/JPY — 13.6% weight (Japanese Yen)

GBP/USD — 11.9% weight (inverted) (British Pound)
USD/CAD — 9.1% weight (Canadian Dollar)
USD/SEK — 4.2% weight (Swedish Krona)

USD/CHF - 3.6% weight (Swiss Franc)

These values are multiplied together and then multiplied by 50.14381 (see link above for the reason for
this number).

(Y Edit Custom Instrument - US Index (Index) x
Choose Instruments (Index)

Click the Add button to add instruments to your custom index (minimum 2). When adding an instrument, you can optionally
specify a multiplier to adjust (or normalize) the price. The index will be calculated using the sum of each instrument muliplied
Click here to_|&2 (MTINSTRIAEXP1)) + (M2(INSTR2EXP2)) + (M3 (INSTRI*EXP3))..).

add a symbol [avert to invert the final calculation (ie: INDEX = 1/ INDEX) and optionally adjust the final price by an

Operation: | Multiply — ~ Multiply the
r
Multiplier: | 5014348 values together

((1/ EURIUSD)"0.576)

(USD/IPY*0.136)

((1/GBP/USD)*0.119) Inverted

(USD/ICAD™0.091)

(USDISEKM0.042)

(USD/CHF*0.036) v Instrument Dependency X
Select an instrument from the drop down and optionally
specify a multiplier to adjust the weighting for the index.

Mumpner r
Exponent is used to
Inverts the t: 0.576 assign the weight
value v Inverted
Cancel

< Back Finish Cancel

The following chart shows daily candles for the custom index that we created above. Incoming price
updates will also be calculated using the formula that was defined for the instrument.
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File Edit View Study Siralegy Format Window Help
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Custom instruments can be edited/managed from the Manage Instruments dialog (Configure ->
Instruments from the Console menu bar). The easiest way to display all custom instruments in the
workspace is to sort the table by the Type column (ascending). If you double click on a custom
instrument, the Custom Instrument Wizard will be opened allowing you to edit the instrument.

/

MotiveWave - Console (fx2)

w
File Edit View Study Strategy Format | Configure | Window  Help
usDollar R ESNN B e~ G | ¥ & Workspaces rMw £ "B T2~ 15min
lul EUR/GBP 1h Ll USDollar 15m X | Ll USQil 15 ii Instivments ‘ii Choose
-+l Active Tickers )
1 i Configure -> Instruments
USDollar . 15 min & Repository g

[Ti!*'i'“l

)

£} Preferences

i@l Save Configuration
Order Presets
Commissions

(' Clear All Local Data

[£] Update License

&) Choose Language

il Layout

T'Hl A

m‘”l‘ ;ﬁ*ﬂ“““ﬂ

TI'

e S
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The following table ¢
these instruments. (

Sortby type || key to select multiple rows).

Manage Instruments X

nts that currently exist in the local database. From this dialog you can add, remove or edit

Symbol: ascending Type: | All ~ | Exchange: | All -
—

Symbol Type v Currency Exchange Description Source +
CAD Oil Custom usD NOMNE Canadian Dollar Vs US Qil Ratio FXCM .
US Index Custom US Dollar Index
UsDollar CFD
JPN225 CFD Double click or select FXCM
GER30 CED and press the Edit EXCM
p—— A0 ﬁﬁ:zents button below. p—

ITA40 CFD FXCM
SUI30 CFD EUR FXCM EXCM
ESP35 CFD EUR FXCM FXCM
HKG33 CFD HKD FXCM FXCM
AUS200 CFD AUD FXCM FXCM
NAS100 CFD usD FXCM NASDAQ 100 FXCM
SPX500 CFD usD FXCM SROELD FXCM
US30 CFD UsD  FXCM | Click here to FXCM
UsOil CFD USD  EXCM SS:LZ:'I:::J et FXCM

Total Instruments: 468

Q, Search

£ Import || Define Custom " Edit » Delete Advanced Cancel
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